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Objectives 

• gain insight to history of spreadsheet,  

• analyse the importance of spreadsheet,  

• understand how to navigate through a spreadsheet. 

• learn about how to craft formulas,  

• understand common errors in spreadsheets,  

• know the differences between Sheets and Excel. 

 

Introduction 

Have you ever heard of the term “spreadsheet”? 

• The use of spreadsheets is synonymous with digital software and large online databases.  

• But the spreadsheet has been organizing various aspects of our lives for hundreds of years.  

• Nowadays, the spreadsheet is such an integral part of any computer that you won’t often 
find one that doesn’t already have some sort of spreadsheet software pre-installed.  

• In fact, the boom in computer usage over the years may not have been so prominent without 
online spreadsheets. 

• Let’s take a look at the history and evolution of spreadsheets and the vital role they play in 
our lives today. 

 

Why is it Called the Spreadsheet? 

• The term spreadsheet might seem strange to those who associate it with only its digital 
capability.  

Dr. Jaskiran Kaur, Lovely Professional University 
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• However, the spreadsheet is quite a literal reference to its original form hundreds of years 
ago. 

• Back then, a spreadsheet was a ledger book full of huge sheets of paper that would quite 
literally spread across the table.  

• Rows and columns divided these sheets for manually entering data using a pen or pencil. 

The Original Spreadsheet Looks Something Like This: 

 

How are They Generally Used? 

• Accountants would primarily use these ledger books for a variety of finance-related 
scenarios that handled a lot of data.  

• A whole spreadsheet could cover aspects such as accounts receivable, investments, 
inventory and expenses.  

• Everything accountants needed to know was right there in one place, so they could easily 
make important decisions. 

 

1.1 The History of Spreadsheets 

• From hundreds of years ago to now, the spreadsheet has evolved from its humble 
beginnings to something that’s powerful enough to help organize the operations of multi-
billion dollar enterprises.  

• After the rise of the digital revolution, its digital counterpart replaced the physical 
spreadsheet. 

• Let’s explore the transformation of this new spreadsheet form in more detail. 

Where it All Began? 

• Even though in the early 70s the first computer had been created along with electronic 
spreadsheet software such as LANPAR, they didn’t gain as much traction.  

• Even though LANPAR could replace paper-based spreadsheets entirely, the computers were 
simply too costly, bulky, and scarce to the public. 

• Instead, it wasn’t until the late 70s and early 80s when the personal computer made its way 
into the market that the online spreadsheet really took off.  

• VisCalc was the first spreadsheet program for personal computers. Dan Bricklin and Bob 
Frankston officially created VisCalc in 1979.  
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 VisCalc came pre-installed on the Apple II computer, which ended up creating a lot of 

excitement amongst home users.  

 This led to many other companies following suit, including IBM, which came up with their 

own product – the IBM PC.  

 It was the spreadsheet utility that contributed to the skyrocket of the PC market that 

continued to thrive over the upcoming decades. 

 Spreadsheet software on personal computers was a monumental moment for many.  

 However, during the early 80s, computers were still command-line operating machines.  

 Spreadsheet programs such as SuperCalc, Multiplan and Lotus 1-2-3 were advanced 

enough; they just lacked the user-friendly nature like many operating systems at the time. 

 Then came along the graphical user interface (GUI). This made handling programs such as 

spreadsheets much easier.  

 Visual components replaced the text-dominated features across the entire software.  

 This completely transformed the user-friendly nature of the spreadsheet and exponentially 

increased its use among home users.  

 Excel 1.0 was the very first GUI-based spreadsheet program that Microsoft specifically built 

for Macintosh.  

 Later on, they transitioned Excel to the Windows environment, and there was no looking 

back.  

 Since then, Microsoft Excel has been the most dominant spreadsheet software over the last 

two decades. 
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• Although Microsoft Excel has remained the ultimate spreadsheet software even today, 
there remain several notable competitor spreadsheet applications on the market.  

• These include Apple’s Numbers (part of the iWork productivity suite), Neo Office 
spreadsheet and WPS spreadsheet.  

• There have also been a number of non-proprietary, free, open-source alternative 
applications such as Open Office.org, Libre Office Calc, Calligra Sheets and Pyspread. 

 

1.2 What’s Happening with Spreadsheets Now? 

• Spreadsheets have come a long way over the past few decades, and they are continuing to 
become more intuitive, flexible and powerful than ever.  

• In just the past few years, spreadsheet software now offers powerful analytical tools to turn 
data into useful insights.  

• The most notable is their visual representation, that now helps businesses project future 
developments for their companies.  

• Moreover, cloud-based spreadsheets are now a key part of many organizations.  

• Google Sheets offers the most popular free cloud-based spreadsheet program that now 
ranks number 2 in the world, just behind Microsoft’s Excel.  

• This has revolutionized the way businesses can work, allowing offline collaboration 
anywhere, increasing productivity for many. 

• The latest phenomenon in the spreadsheet world is the automation of spreadsheet processes.  

• Now, there are various tools available in the market to automate the collection, input and 
analysis of your data into spreadsheets, so you don’t have to worry about a thing.  

• The potential of these automation tools is almost limitless, too.  

• Now, businesses can build and scale a variety of complex systems through the simple 
connection of spreadsheets.  

• Businesses now have fully functioning CRM or ERP platforms, thanks to spreadsheets.  

• With automation tools specialized in spreadsheets such as Sheetgo, you can build workflows 
that will continue to automate themselves for any period of time.  

• With intelligence like this, almost anything will be possible in the future. 
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1.3 Importance of Spreadsheets 

1. Spreadsheets are free. 

2. Spreadsheets require minimal training. 

3. Spreadsheets are customizable. 

4. Spreadsheets can be more collaborative than other tools. 

5. It’s easy to manipulate and analyze data. 

6. One can integrate spreadsheets with certain tools. 

7. Spreadsheets are quick and easy to add into a workflow. 

8. Spreadsheets are fantastic tools for financial documents. 

9. One have access to countless spreadsheet templates. 

10.  One can visualize data. 

11. Budgeting and Spending Help 

12.  Assisting with Data Exports 

 

1.4 Navigating Worksheets in Excel: Overview 

• Navigating worksheets in Excel lets you view different worksheets in a workbook.  

• To move from one worksheet to another, click the worksheet name tab of the worksheet to 
view.  

• The worksheet name tabs appear in the lower-left corner of the workbook. 

• If you have many worksheets in a workbook or give worksheets very long names, you 
may not be able to see all the worksheet name tabs.  

• This is because they begin to slide underneath the horizontal scroll bar to the right.  

• Only when this occurs can you then click the “Previous Sheet” and “Next Sheet” buttons 
to the left of the worksheet name tabs.  

Lovely Professional University 5



Spreadsheet Modelling (Using Excel)  

Notes 

• Doing this then moves the worksheet tab names out from underneath the horizontal scroll 
bar.  

• Keep clicking until you see the one you want to view. At that point, then click its 
worksheet name tab to view it. 

 

 

Navigating Worksheets in Excel: Instructions 

1. To move from one worksheet to another in Excel, click the worksheet name tab of the 
worksheet to view from the set of worksheet name tabs in the lower-left corner of the 
workbook. 

2. Alternatively, to move to the previous worksheet using a keyboard shortcut, press “Ctrl” 
+ “PageUp” on your keyboard. 

3. Alternatively, to move to the next worksheet using a keyboard shortcut, press “Ctrl” + 
“PageDown” on your keyboard. 

4. Only after you have worksheet name tabs that have slid underneath the horizontal scroll 
bar can you then click the “Previous Sheet” and “Next Sheet” buttons to the left of the 
worksheet name tabs to move the names of the worksheet tabs out from underneath the 
horizontal scroll bar until you can see the one you want to view. 

5. At that point, then click its worksheet name tab to view it. 

6. Alternatively, right-click either the “Previous Sheet” or “Next Sheet” buttons to select the 
name of the worksheet to view from the “Activate” dialog box that appears. 

7. After selecting the sheet name to view, then click the “OK” button to activate the selected 
worksheet. 

 

1.5 Formulae in MS-Excel 

• Spreadsheets are used in every organization to sort, classify and calculate data.  

• Knowing how to manipulate and calculate data is a relevant skill for any student working 
in a lab, internship, summer position or early career position.  

• Microsoft Excel's power is in its ability to calculate and display results from data entered 
into its cells.  

• To calculate anything in Excel, you need to enter formulas into its cells.  
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• Formulas can be simple arithmetical formulas or complicated formulas involving 
conditional statements and nested functions.  

• All Excel formulas use a basic syntax starting with “=”. 

 

Create a simple formula in Excel 

• You can create a simple formula to add, subtract, multiply or divide values in your 
worksheet.  

• Simple formulas always start with an equal sign (=), followed by constants that are 
numeric values and calculation operators such as plus (+), minus (-), asterisk(*), or 
forward slash (/) signs. 

 

Let’s Take an Example of a Simple Formula. 

1. On the worksheet, click the cell in which you want to enter the formula. 

2. Type the = (equal sign) followed by the constants and operators (up to 8192 characters) 
that you want to use in the calculation. 

  For our example, type =1+1. 

Notes:  

• Instead of typing the constants into your formula, you can select the cells that contain the 
values that you want to use and enter the operators in between selecting cells. 

• Following the standard order of mathematical operations, multiplication and division is 
performed before addition and subtraction. 

 

3. Press Enter (Windows) or Return (Mac). 

Let's take another variation of a simple formula. Type =5+2*3 in another cell and 
press Enter or Return. Excel multiplies the last two numbers and adds the first number to the result. 

ERRORS 

• MS Excel is popular for only its most useful automatic calculation feature, which we achieve 
by applying various functions and formulas.  

• But while using formulas in Excel cell, we get multiple types of errors. 

The error can be: 

1. #DIV/0 

2. #N/A 

3. #NAME? 

4. #NULL! 

5. #NUM! 

6. #REF! 

7. #VALUE! 

8. ##### 

9. Circular Reference 

1 – #DIV/0 Error 

• #DIV/0! Error is received when we work with a spreadsheet formula, which divides two 
values in a formula and the divisor (the number being divided by) is zero. It stands for 
divide by zero error. 
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2 – #N/A Error 

• This error means “no value available” or “not available.” It indicates that the formula 
cannot find the value that we suppose it may return.  

 

 

 

3 – #NAME? Error 

• This error is displayed when we usually misspell the function name. 

 

 

4 – #NULL! Error 

• This error is usually displayed when cell references are not specified correctly. 
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• We get this error when we do not use the space character appropriately. The space 
character is called the “intersect operator,” which specifies the range that intersects each 
other at any cell. 

• In the below image, we have used the space character, but the ranges A2:A12 and B2:B12 
are not intersecting; that is why this error is displayed. 

 

 

5 – #NUM! Error 

• This error is usually displayed when a number for any function argument is found invalid. 

• For example: To find out the square root in excel of a negative number is not possible as 
the square of a number always has to be positive. 

 

 

6 – #REF! Error 

This error usually comes when 

1. We accidentally deleted the cell which we referenced in the formula. 

2. We cut and paste the referenced cell in different locations. 
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7 – #VALUE! Error 

• This error comes when we use the wrong data type for a function or formula.  

• For example, we can add only numbers. But if we use any other data type like text, this 
error will be displayed. 

 

8 – ###### Error 

• This error is displayed when the column width in excel is not enough to show the stored 
value in the cell. 
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9 – Circular Reference Error 

• This type of error comes when we reference the same cell in which we are writing the 
function or formula. 

 

 

1.6 What is the Difference Between Worksheet, Workbook, and 
Spreadsheet? 

• To create or maintain our daily work report on the computer, some software’s available 
there which allows users to keep daily work secure in the form of a workbook, 
spreadsheet as well as a worksheet.  

• Microsoft Excel is well-known software to do such kinds of tasks, apart from that 
nowadays Google Sheets is also the best option to maintain and create daily work-related 
files. 

• Sometimes there is confusion like situations go to create where users do not get the exact 
meaning of spreadsheet, worksheet, and Workbook. While some users think that all of 
these things are the same, though there is so much similarity between them some basic 
aspects differ from each other. 

1. Workbook 

The workbook is a set of one or more worksheets, where you can make and save your professional 
as well as personal documents securely. 

The workbook is also a file/book, but it is a bunch of worksheet files, where one or more files you 
can add. The workbook can be used on different platforms like a school assignment, Professional 
content files, Business related files. But every time you will get to see multiple numbers of 
worksheets added to the workbook file. 

2. Spreadsheet 

As we told you earlier that some software allows users to create their work-related files, here a 
spreadsheet is one kind of software through that users can organize their data in a row and 
columns. With the help of a spreadsheet, users can do calculations in between that row and 
columns. 

Users get options to edit, format and create worksheets within a spreadsheet, that’s why any user 
can easily fill their data into columns and rows available in a spreadsheet. While organizing and 
keeping data secure is much easier with the help of spreadsheets. 

3. Worksheet 

Normally worksheet is a single page of the file where user can fill their data into rows and columns, 
the data into rows and columns is popularly known as a worksheet. 

With the help of a worksheet, users can create their educational, school work-related, professional 
as well as business-related file. You can also handle tax forms and accounting-related work also 
with the help of a worksheet. 
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Difference Between Worksheet, Spreadsheet and Workbook 

WORKSHEET SPREADSHEET WORKBOOK 

1. Worksheet is a single 
page file/spreadsheet, 
where rows and columns 
are available, You can 
easily fill your data into 
that row and column. 

1. Spreadsheet is a program 
that allows users to create a 
work report. 

1. Workbook is a bunch/bundle of 
spreadsheets, in the workbook, there 
may have one or more worksheets 
can be available. 

2. The data which are 
filled into rows and 
columns is called a 
worksheet or worksheet 
report. 

2. Spreadsheet is a large 
platform where users can 
create many worksheets as 
well as workbooks. 

2. Workbook is a program that 
depends on worksheets as well 
spreadsheets. 

3. To create a worksheet 
on the computer, you 
need to enter it into a 
spreadsheet. without 
that, it is an almost 
impossible task. 

3. Spreadsheet is a program 
that’s why to create 
workbooks and worksheets, 
the spreadsheet is so 
important and essential. 

3. To create a workbook you need of 
a spreadsheet and worksheet, then 
only its creation is possible. 

4. You can add a 
worksheet to the 
workbook by creating it 
with the help of a 
spreadsheet. 

4. You can create a 
workbook as well as a 
worksheet in the 
spreadsheet program. That’s 
why you don’t need to add a 
spreadsheet anywhere 
among these two(Workbook 
and Workbook). 

4. In Workbook you can add many 
Worksheets, but the creation of a 
workbook is possible only with a 
spreadsheet. 

5. You can use 
worksheets to create 
school assignments, 
professional work 
reports, business reports 
as well as accounting-
related work details. 

5. Spreadsheet allows you to 

create any kind of work 

report as with the help of 

this you can create as many 

work report files that much 

you want. 

5. Into the workbook you can add a 

bunch of worksheets, so if you need 

to add multiples of worksheets that 

are related to different topics that 

time you can add them in the 

workbook. 

6. Worksheet contains 
matrix rectangular cells 
which arrange there in a 
tabular form of row and 
column. 

6. Spreadsheet is a program 

of such matrix rectangular 

cells in the form of row and 

column. 

6. In the workbook there is an 

association available of such kinds of 

features with work-related data. 

7. It is an easy task to add 
a worksheet into the 
workbook, as well as 
create a worksheet into a 
spreadsheet. 

7. You can create both 

worksheets as well as 

workbooks so easily within 

a spreadsheet. 

7. It is not a simple task to add one 

workbook to another workbook. 

8. Data analysis and 
manipulation are only 
possible with a 
worksheet, not with the 
workbook. 

8. You need to create a data 

report first on to worksheet 

via spreadsheet then only 

you can analyze as well as 

manipulate that. 

8. It is not possible to data analysis 

and manipulation with the help of a 

workbook. 
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Summary 

 Microsoft Excel is a powerful spreadsheet program developed by Microsoft and is a part of 

the Microsoft Office suite of applications. 

 Excel provides a grid-based interface with rows and columns, allowing users to organize and 

analyze data efficiently. 

 It supports various mathematical, statistical, and financial functions, enabling users to 

perform calculations and manipulate data easily. 

 Excel allows users to create and format spreadsheets, including tables, charts, and graphs, to 

present data visually. 

 Users can input data into cells and use formulas to perform calculations, such as summing up 

values, finding averages, or calculating percentages. 

 Excel offers a range of built-in functions and formulas, such as SUM, AVERAGE, IF, 

VLOOKUP, and COUNT, which can be used to perform complex calculations and data 

analysis. 

 It provides features like sorting and filtering data, which allow users to organize and extract 

specific information from large datasets quickly. 

 Excel supports data visualization through various chart types, including bar graphs, line 

charts, pie charts, and scatter plots, helping users understand data trends and patterns. 

 Users can create macros in Excel to automate repetitive tasks, saving time and increasing 

efficiency. 

 Excel files can be saved in various formats, including .xlsx, .xls, .csv, and .pdf, allowing users 

to share and collaborate on spreadsheets with others. 

9. Worksheet is always a 
single sheet. 

9. No limit to creating a 

worksheet and workbook 

within a spreadsheet. 

9. Workbook is a bundle of 

worksheets, while you can create 

many workbooks in a tp 

spreadsheet. 

10. In each cell of the 
worksheet user can enter 
the date, time, number, 
Excel formula as well as 
a math formula. 

10. With the help of a 

spreadsheet users can 

perform mathematical and 

arithmetic operations, also 

statistical well as and 

financial operations also can 

be performed there. 

10. that task can be performed on 

any spreadsheet and worksheet, for 

that workbook is compatible. 

11. Worksheet is a 
specific set of data. 

11. In spreadsheet-specific 

worksheets as well as a 

general form of data can be 

available in the workbook. 

11. In the workbook general form of 

data is available. 

12. Interlinking between 
two worksheets is so 
easy task. 

12. In a spreadsheet, You 

can link data between two 

worksheets into the same 

workbook. 

12. Establishing a linkage between 

two workbooks is no easy task due 

to security issues. 

13. The fundamental 
form of the worksheet is 
just like a single page of 
any book. 

13. Spreadsheet 

fundamental form is like a 

whole program where you 

can create either a single 

page or a whole book. 

13. The fundamental form of any 

workbook is like one kind of book 

whose can be any number of pages 

(worksheet)present into that. 
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Keywords 

 Spreadsheet: Microsoft Excel is primarily used as a spreadsheet program, allowing users to 

organize and manipulate data in a grid-based interface. 

 Formulas: Excel provides a wide range of built-in functions and formulas that enable users to 

perform calculations and data analysis, such as summing values, finding averages, and 

performing complex mathematical operations. 

 Data Analysis: Excel offers features and tools for data analysis, including sorting, filtering, 

pivot tables, and charts, allowing users to analyze and visualize data to gain insights and 

make informed decisions. 

 

Self Assessment 

1. The files that are created with Spreadsheet software are called 

A. Package 

B. Program 

C. Worksheet 

D. Spreadsheet 

 

2. Which is used to calculate and analyze a set of numbers? 

A. Improve 

B. StarCalc 

C. Spreadsheet 

D. Database 

 

3. A Spreadsheet, sometimes is called as 

A. Cells 

B. Worksheet 

C. Menus 

D. Notebook pages 

 

4. Which bars have shortcut icons for frequently done tasks in the Spreadsheet? 

A. Main Tool bar 

B. Object bar 

C. Formula bar 

D. Menu bar 

 

5. The Spreadsheet VisiCalc contains 

A. 63 columns and 254 rows 

B. 256 rows and 256 columns 

C. 10000 rows and 256 columns 

D. 36000 rows and 256 columns 
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6. Which is used to print the worksheet with grid lines? 

A. Grid checkbox 

B. Check box 

C. Text box 

D. Dialog box 

 

7. Which shortcut icon is used to select and insert functions? 

A. Functional Auto pilot 

B. File series 

C. Function wizard 

D. Category 

 

8. Star Office Calc has a variety of 

A. Buttons 

B. Functions 

C. Formulae 

D. Options 

 

9. The cells are addressed in terms of 

A. Row and column labels 

B. Row labels 

C. Rows 

D. Columns 

 

10. Which of the following data can be typed into a Spreadsheet cell? 

A. Formulae 

B. Text 

C. Numbers 

D. All of these 

 

11. Which bar is used to display options? 

A. Menu 

B. Function 

C. Formula 

D. Status 

 

12. The intersection of rows and columns creates 

A. Cells 

B. Worksheets 

C. Spreadsheets 

D. None of these 
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13. Worksheet data can be viewed in forms of 

A. Charts 

B. Graphs 

C. Charts or graphs 

D. Data 

 

14. By pressing  ____  key and type in the range you want, the suggested range will be accepted. 

A. Backspace 

B. Open 

C. Close 

D. Enter 

 

15. Address of first cell in the worksheet is 

A. A 

B. A0 

C. A1 

D. 1A 

 

Answers for Self Assessment 

1. C 2. C 3. B 4. B 5. A 

6. A 7. C 8. B 9. A 10. D 

11. A 12. A 13. C 14. A 15. C 

 

Review Questions 

1. What is Microsoft Excel and what is its primary purpose? 

2. How does Excel organize data within its interface? 

3. What are some common mathematical and statistical functions available in Excel? 

4. How can you create formulas in Excel, and what are some examples of commonly used 

formulas? 

 

 
Further Readings 

https://blog.sheetgo.com/spreadsheets-tips/history-of-spreadsheets/ 

https://blog.hubspot.com/sales/dangers-of-using-spreadsheets-for-
sales#:~:text=Spreadsheets%20make%20it%20easy%20to,a%20certain%20phrase%20or%20p
arameter. 

https://www.teachucomp.com/navigating-worksheets-in-excel-instructions/ 

https://support.microsoft.com/en-us/office/create-a-simple-formula-in-excel-11a5f0e5-
38a3-4115-85bc-f4a465f64a8a 

https://www.wikihow.com/Type-Formulas-in-Microsoft-Excel 

Lovely Professional University16



Unit 01: Introduction to Spreadsheets  

Notes 

https://www.wallstreetmojo.com/errors-in-excel/ 

https://www.gyanipandit.com/en/difference-between-worksheet-workbook-and-
spreadsheet/ 
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CONTENTS 

Objectives 
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2.1 Different types of data in MS Excel 

2.2 Fill Handle 

2.3 Rows and Columns 

2.4 Protecting Worksheets and Workbooks 

Summary 

Keywords 

Self Assessment 

Answers for Self Assessment 

Review Questions 

Further Readings 

 

Objectives 

• understand about entering different types of data in MS Excel. 

• understand how to use fill handles. 

• understand how to manage rows and columns. 

• understand the process and steps of protecting worksheets and workbooks. 

 

Introduction 

• The information entered to a cell is known as data and can adopt four basic forms--text, 
number, formula or function. 

• A text entry is characterized by its first character being a letter, a space or a punctuation 
mark.  

• Text entries (often known as labels) are used to enter descriptive comments to the 
worksheet.  

• This could be your name at the top of the sheet, or a descriptor of the worksheet's purpose, 
or a list of names of clients about whom you have information.  

 

2.1 Different types of data in MS Excel 

Text. Entry 

• The fundamental feature of a text entry is that arithmetic calculations cannot be performed 
on them.  

• They are for descriptive purposes only. 

Numerical Data Entry 

• Numerical data entries, on the other hand, commence with a positive or negative numeric 
character and contain only numerical characters thereafter.  

Dr. Jaskiran Kaur, Lovely Professional University 
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• They are the raw data to which calculations can subsequently be applied and are entered 
directly to the sheet in the form: 

    23 or -19 or 167. 

• It is important to note that text characters, spaces or punctuation marks must not be 
included before or after numeric characters if the contents of the cell are to be used for 
calculations.  

• For example, 23 is a valid numeric entry that could be subjected to an arithmetic process 
(squared, cubed, etc.), but 23rd (as in the 23rd of lune) is a text entry that cannot be 
manipulated mathematically.  

• As long as Excel receives numbers, and only numbers, then the entry will be treated 
numerically, but once a non-numeric character such as a letter of the alphabet is 
introduced the whole entry usually  becomes textual. 

Formula Entry 

• Formula entries are what distinguish a spreadsheet from a calculator.  

• They are algebraic rather than arithmetic concepts and allow general rather than specific 
computations to be performed. 

• For example, suppose your annual salary is 20000 and your partner's is INR 25000. Your 
combined income is clearly INR 45000. 

• Enter your salary (as a number) into the Al cell of your worksheet and your partner's to 
the A2 cell. 

• The task to be undertaken is to write an expression (in A3, say) that will compute the 
combined income. 

• At first sight you might be tempted to write, in A3; 

    A1+A2 

• but if you do, then you will find that it appears as text rather than as the required 
numerical answer of 45000. 

• Try it now. 

• The reason for this is that, as we saw above, any entry that commences with a letter will be 
treated by Excel as text and will not produce a numerical result. 

• Clearly the problem being faced is to distinguish, for example, the 'A' of the cell reference 
A1 from 'A' as in the first character of a text label such as Asset value. 

• Excel allows this to be done quite simply by placing an equals sign (=) in front of any 
entries that require arithmetic computation on the basis of formulae using cell addresses. 

• Thus, 

=A1+A2 

Excel Function Entry 

• The final form of entry to an active cell is an Excel function. 

• Excel contains a large number of pre-programmed functions that can perform 
sophisticated tasks as required.  

• In Excel, a function, like a formula, is always preceded by an equal's sign if it is the first 
entry to a cell.  

• Then the name of the function must be supplied, followed by an opening bracket.  

• There then follow the arguments of the function.  

• Some functions only have one argument, but others have several, in which case each 
argument is separated by a comma.  

• That was: 

=Al+A2 
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• The same result could have been obtained by using the SUM function. This contains only 
one argument -the range of cells to be summed; and so we could write: 

=SUM(A1:A2) 

 Now, while typing =SUM(A1:A2) is in fact slightly less efficient than typing =Al+A2, this 

would not be the case if we were required to sum, say, the first 100 rows of column A. 

 Using a formula, we would have had to type: 

=A1+A2+A3+ ..and so on until ..A99+A100 

 Clearly, this is very tedious, especially in comparison with the functional alternative: 

=SUM(A1:100) 

 Appropriate Excel functions will be introduced throughout the text as and when they are 

required.  

 Some are indispensable for serious quantitative analysis, but in other cases there may be 

no alternative to writing a formula of your own, in which case you have created what is 

known as a user-defined function. 

 Finally, Excel functions and user-defined functions can be used together without 

difficulty.  

 

2.2 Fill Handle 

 Fill Handle is a feature in Excel that enables you to auto-complete a list in a row/column by 

simply dragging it using your mouse. 

 A basic understanding of fill handle in Excel could save you some time and make you more 

productive. 

 ‘Fill Handle’ is a tool that you can use to autocomplete lists in Excel. 

 For example, if you have to enter numbers 1 to 20 in cell A1:A20, instead of manually entering each 

number, you can simply enter the first two numbers and use the fill handle to do the rest. 

 Let’s first understand where is the fill handle in Excel. 

 Suppose you have the data as shown below: 

 

Here are the steps to use the fill handle to quickly insert numbers up to 20. 

• Select the data set. 

• Hover the mouse over the bottom-right edge of the selection, you would see a plus icon 
appear –        

Let’s Have a Look 

 Click the left button on the mouse and drag it down. Excel identifies a pattern of the first 2 

numbers (an increment of 1) and uses that to fill that entire series. 
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• If you have data in the adjacent column, you can also hover the mouse over the right edge 
of the selection and double click.  

• It will automatically fill the list to the last cell based on the data in the adjacent column. 

How it actually works? 

• For example, if I double-click on the fill handle (as shown below), it will fill the column till 
cell A11 (since there is data until cell B11 in the adjacent column). 

Examples of Using Fill Handle in Excel 

• Autofill Numbers that Increment/Decrement by 1 

• Autofill Weekday Names 

• Autofill Dates 

Auto Fill Options 

• While fill handle recognizes patterns and fills the list, it also gives some additional options 
you can use. 

• As soon you drag the mouse (or double click) and autocomplete the list, you will see the 
Autofill option icon at the bottom right of the list. 

• When you click on this icon, a list of options becomes available.  

• These options are different for different types of data (numbers, dates, days). 

2.3 Rows and Columns 

 By default, every row and column of a new workbook is set to the same height and width.  

 Excel allows you to modify column width and row height in different ways, 

including wrapping text and merging cells. 

To modify column width: 

• In our example below, column C is too narrow to display all of the content in these cells.  

• We can make all of this content visible by changing the width of column C. 

• Position the mouse over the column line in the column heading so the cursor becomes 
a double arrow. 

 

• Click and drag the mouse to increase or decrease the column width. 
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• Release the mouse. The column width will be changed. 

 

To AutoFit column width: 

• The AutoFit feature will allow you to set a column's width to fit its content automatically. 

• Position the mouse over the column line in the column heading so the cursor becomes 
a double arrow. 
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• Double-click the mouse. The column width will be changed automatically to fit the 
content. 

 

To modify row height: 

• Position the cursor over the row line so the cursor becomes a double arrow. 

 

• Click and drag the mouse to increase or decrease the row height. 
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• Release the mouse. The height of the selected row will be changed. 

 

To modify all rows or columns: 

• Instead of resizing rows and columns individually, you can modify the height and width 
of every row and column at the same time.  

• This method allows you to set a uniform size for every row and column in your 
worksheet. In our example, we will set a uniform row height. 

• Locate and click the Select All button just below the name box to select every cell in the 
worksheet. 

 

• Position the mouse over a row line so the cursor becomes a double arrow. 

• Click and drag the mouse to increase or decrease the row height, then release the mouse 
when you are satisfied. The row height will be changed for the entire worksheet. 

Lovely Professional University24



Spreadsheet Modelling (Using Excel)  

 

Notes 

 

Inserting, deleting, moving, and hiding 

• After you've been working with a workbook for a while, you may find that you want 
to insert new columns or rows, delete certain rows or columns, move them to a different 
location in the worksheet, or even hide them. 

To insert rows: 

• Select the row heading below where you want the new row to appear. In this example, we 
want to insert a row between rows 4 and 5, so we'll select row 5. 

 

• Click the Insert command on the Home tab. 

 

 Click the Insert command on the Home tab. 
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 The new row will appear above the selected row. 

 

 When inserting new rows, columns, or cells, you will see a paintbrush icon next to the 

inserted cells. This button allows you to choose how Excel formats these cells. By default, 

Excel formats inserted rows with the same formatting as the cells in the row above. To 

access additional options, hover your mouse over the icon, then click the drop-down 

arrow. 
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To insert columns: 

1. Select the column heading to the right of where you want the new column to appear. For 
example, if you want to insert a column between columns D and E, select column E. 

 

2. Click the Insert command on the Home tab. 

 

3. The new column will appear to the left of the selected column. 
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When inserting rows and columns, make sure to select the entire row or column by clicking 
the heading. If you select only a cell in the row or column, the Insert command will only insert a 
new cell. 

To delete a row or column: 

It's easy to delete a row or column that you no longer need. In our example we'll delete a row, but 
you can delete a column the same way. 

1. Select the row you want to delete. In our example, we'll select row 9. 

 

2. Click the Delete command on the Home tab. 

 

3. The selected row will be deleted, and those around it will shift. In our 
example, row 10 has moved up, so it's now row 9. 
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It's important to understand the difference between deleting a row or column and 
simply clearing its contents. If you want to remove the content from a row or column without 
causing others to shift, right-click a heading, then select Clear Contents from the drop-down 
menu. 

 

 

To move a row or column: 

Sometimes you may want to move a column or row to rearrange the content of your worksheet. In 
our example we'll move a column, but you can move a row in the same way. 

1. Select the desired column heading for the column you want to move. 
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2. Click the Cut command on the Home tab, or press Ctrl+X on your keyboard. 

 

3. Select the column heading to the right of where you want to move the column. For 
example, if you want to move a column between columns E and F, select column F. 

 

4. Click the Insert command on the Home tab, then select Insert Cut Cells from the drop-
down menu. 
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5. The column will be moved to the selected location, and the columns around it will shift. 

 

You can also access the Cut and Insert commands by right-clicking the mouse and selecting 
the desired commands from the drop-down menu. 
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To hide and unhide a row or column: 

At times, you may want to compare certain rows or columns without changing the organization of 
your worksheet. To do this, Excel allows you to hide rows and columns as needed. In our example 
we'll hide a few columns, but you can hide rows in the same way. 

1. Select the columns you want to hide, right-click the mouse, then select Hide from 
the formatting menu. In our example, we'll hide columns C, D, and E. 

 

2. The columns will be hidden. The green column line indicates the location of the hidden 
columns. 
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3. To unhide the columns, select the columns on both sides of the hidden columns. In our 
example, we'll select columns B and F. Then right-click the mouse and select Unhide from 
the formatting menu. 

 

4. The hidden columns will reappear. 
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Wrapping text and merging cells 

Whenever you have too much cell content to be displayed in a single cell, you may decide to wrap 

the text or merge the cell rather than resize a column. Wrapping the text will automatically modify 
a cell's row height, allowing cell contents to be displayed on multiple lines. Merging allows you to 
combine a cell with adjacent empty cells to create one large cell. 

To wrap text in cells: 

1. Select the cells you want to wrap. In this example, we'll select the cells in column C. 

2. Click the Wrap Text command on the Home tab. 

 

3. The text in the selected cells will be wrapped. 
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Click the Wrap Text command again to unwrap the text. 

To merge cells using the Merge & Center command: 

1. Select the cell range you want to merge. In our example, we'll select A1:F1. 

2. Click the Merge & Center command on the Home tab. In our example, we'll select the cell 
range A1:F1. 

 

3. The selected cells will be merged, and the text will be centered. 

 

To access additional merge options: 

If you click the drop-down arrow next to the Merge & Center command on the Home tab, 
the Merge drop-down menu will appear. 
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From here, you can choose to: 

 Merge & Center: This merges the selected cells into one cell and centers the text. 

 Merge Across: This merges the selected cells into larger cells while keeping 
each row separate. 

 Merge Cells: This merges the selected cells into one cell but does not center the text. 

 Unmerge Cells: This unmerges selected cells. 

Be careful when using this feature. If you merge multiple cells that all contain data, Excel will keep 
only the contents of the upper-left cell and discard everything else. 

Centering across selection 

Merging can be useful for organizing your data, but it can also create problems later on. For 
example, it can be difficult to move, copy, and paste content from merged cells. A good alternative 
to merging is to Center Across Selection, which creates a similar effect without actually combining 
cells. 

 

To use Center Across Selection: 

1. Select the desired cell range. In our example, we'll select A1:F1. Note: If you already 
merged these cells, you should unmerge them before continuing to step 2. 

2. Click the small arrow in the lower-right corner of the Alignment group on the Home tab. 

 

3. A dialog box will appear. Locate and select the Horizontal drop-down menu, 
select Center Across Selection, then click OK. 
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4. The content will be centered across the selected cell range. As you can see, this creates the 
same visual result as merging and centering, but it preserves each cell within A1:F1. 

 

 

2.4 Protecting Worksheets and Workbooks 

 Sometimes while sharing your spreadsheets you may not want the receiver to change the 

content of your worksheet or perhaps change only specific content and leave the rest 

untouched.  

 To protect your worksheet from being edited by other people, Excel offers a protection 

feature.  

 By following a couple of steps you can set protection to your work. 

Protect an entire workbook from editing: A workbook can be protected by encrypting the 
workbook with a password, making the workbook read-only, or protecting the structure of a 
workbook. 

Encrypt a workbook with a password: 

To prevent other people from accessing your Excel files, protect them with a password. Head on to 
the file menu and do the following:  
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Step 1: Select File > Info. 

Step 2: Select the Protect Workbook box and choose Encrypt with Password. 

 

Step 3: Enter a password in the Password box, and then select OK. 
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Step 4: Confirm the password in the Re-enter Password box and then select OK. 

 

TIP: Excel can’t retrieve your password once forgotten hence it’s advised to keep it easy to remember. 

Making a workbook Read-only : 

By making a workbook read only the user can read the content of the file and then enable editing if 
the user wishes to make changes, it gives the user a hint to be cautious about editing the file. 

To make a workbook read-only open the Excel file you want to protect and then : 

Step 1: Head on to File>info  

Step 2: Select the Protect Workbook box and choose Always open Read-Only. 
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Step 3: Open the file and a warning will be displayed stating the author prefers the file to be 
opened in read-only mode. This makes the user aware of the author’s concerns. 

Protecting the structure of a workbook:  

To prevent other users from viewing hidden worksheets, adding, moving, deleting, or hiding 
worksheets, and renaming worksheets, you can protect the structure of your Excel workbook with 
a password.  

Step 1: Click on Review tab>Protect workbook (under Changes ). 

 

Step 2: Enter a password in the password box. 
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Step 3: Click ok and re-enter the password to confirm and hit OK again. 

To remove the password from the workbook Head on to Review > Protect Workbook > type in the 

password and the workbook will be free from the password. 

Protecting a worksheet from editing:  

To protect the Workbook from editing follow the below steps: 

Step 1: Open the worksheet you want to protect. 

Step 2: Head on to Review tab > Protect sheet.  

 

Step 3: This opens a project sheet dialog and prompts you to enter a password for the sheet. You 
can check the boxes you want the user to be able to edit after protection and uncheck the rest. 
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Step 4: Hit OK and confirm password  (don’t lose this password).  

Your sheet is now protected, try typing into the sheet and see what excel prompts! 

As a developer if you want to make changes to your sheet you can hit the unprotect sheet under 
the review tab>enter the password> make the changes. 

Protect specific cells from editing:  

By default, every single cell in an Excel worksheet is locked. So if you head on to the Review tab 
and hit protected every single cell in the worksheet gets protected and no one can make any 
changes. But if you want the user  to be able to edit certain cells  and leave the rest unedited then 
follow these steps : 

Step 1: Open the file you want to protect.  

Step 2: Select the cells from the file that you want the users to be able to edit and make changes 

to(cells you want to unlock). 

 

Step 3: Then under the font section click on the arrow pointing downwards icon on the bottom-

right (called font settings) 

 

Step 4: As the Format cells dialog box opens up, head on to Protection, turn off the locked 

property for the selected cells, and hit ok. 

Lovely Professional University42



Spreadsheet Modelling (Using Excel)  

 

Notes 

 

These cells are no longer locked and can be edited by the user. Deciding which cells should be 
locked and which shouldn’t is important while protecting the sheets. 

Step 5: Head on to the Review tab > Protect sheet. This opens a protect sheet dialog and prompts 
you to enter a password for the sheet. You can check the boxes you want the user to be able to edit 
after protection and uncheck the rest. 

 

Step 6: Hit OK and confirm password  (don’t lose this password).  
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Step 7: Click ok and re-enter the password to confirm and hit OK again. 
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Summary 

 Rows and columns in MS Excel can be managed by inserting, deleting, or adjusting their size. 

You can easily insert or delete rows and columns to accommodate data changes or to organize 

your spreadsheet effectively. 

 You can adjust the width or height of rows and columns to fit the content or enhance 

readability. Excel provides options to auto-fit the width or height based on the content or 

manually specify the size. 

 Excel also offers features to hide or unhide rows and columns, which can be useful for 

temporarily hiding data or focusing on specific sections of your spreadsheet. This helps in 

managing large data sets and improving the visibility of important information. 

 Protecting worksheets in MS Excel helps secure the data and prevent unauthorized changes. It 

allows you to control who can edit, delete, or move data within the protected sheet, ensuring 

the integrity of your spreadsheet. 

 Excel provides various protection options, such as password protection, which requires a 

password to unprotect the sheet and make modifications. This adds an extra layer of security 

to prevent unauthorized access. 

 Additionally, you can specify specific cells or ranges to be locked or unlocked within a 

protected worksheet. This allows certain areas to remain editable while protecting the rest of 

the sheet, ensuring data accuracy and preventing accidental modifications. 

 

Keywords 

 Inserting/deleting rows and columns: Refers to the ability to add or remove rows and 

columns in an Excel worksheet. Inserting rows or columns allows for expanding the data set 

or inserting new information, while deleting rows or columns removes unwanted data or 

adjusts the structure of the worksheet. 

 Adjusting row height and column width: Involves modifying the height of rows and the 

width of columns in Excel. This adjustment helps in accommodating the content within cells, 

ensuring readability and proper alignment of data. 

 Hiding/unhiding rows and columns: Refers to the ability to temporarily conceal rows or 

columns in an Excel worksheet. Hiding rows or columns can be useful when you want to 

focus on specific data or temporarily remove information from view. Unhiding rows or 

columns allows for revealing the hidden data when needed. 

 

Self Assessment 

1. You can navigate around an Excel spreadsheet by: 

A. Pressing the space bar on your computer keyboard. 

B. Using your mouse to click the green File button in the top left hand corner of your screen. 

C. Using the navigation bar with an up pointing arrow and down pointing arrow on the right 

hand side of your screen. 

D. By using the screen maximizing block in the top right corner of your screen. 

 

2. How do you know which cell in Excel is currently selected? 

A. The selected cell will be highlighted. 

B. It will have a black border around it and the contents of the cell will appear in the formula 

bar (above the grid). 

C. There is no way of telling which cell is selected.  

Lovely Professional University 45



Unit 02: Basic Function and Utilities  

 

Notes 

D. The number of the selected cell will appear on the status bar at the bottom of the screen. 

 

3. How do you delete numbers from a cell? 

A. You have to press the same numbers on your keyboard. 

B. By pressing delete several times. 

C. It is not possible to delete numbers from a sheet once they have been inserted. 

D. By selecting the cell and pressing the delete button on your keyboard. 

 

4. What is the horizontal navigation bar at the bottom right of a spreadsheet used for? 

A. To move the view of the spreadsheet to cells on the right or left of the screen. 

B. To expand the screen and make it fill your screen. 

C. To add horizontal lines to the spreadsheet. 

D. To navigate upwards and downwards through a spreadsheet. 

 

5. How do you delete text or numbers from many cells at the same time? 

A. It is not possible to do this.  You have to select each cell individually. 

B. Hold down the control key on your keyboard and press delete. 

C. Enter the number of cells you wish to delete into a blank cell and press enter twice. 

D. Hold your left mouse button down whilst dragging the mouse cursor across all the cells you 

wish to select, then press delete. 

 

6. A user wanted to create a numbered list numbered: 1 -10.  When they used the Autofill 

Handle it created a list of 10 number 1s (as pictured above).  What is the solution? 

A. Insert the formula =Sum(1) in the first cell before using the Autofill handle to increment 

each successive fill by 1 step. 

B. On the Home tab, go to the Editing group and click the Fill button. 

C. Select cells A2 to A11.  On the Home tab select Merge and Centre to create a numbered list. 

D. Click on the Autofill Options icon that appears just after completing an Autofill and select 

‘Fill Series’ from the options. 

 

7. For which of the following lists can you NOT use the Autofill function? 

a) Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday. 

b) Apples, Pears, Oranges, Passion Fruit, Bananas. 

c) January, February, March, April, May, June. 

d) You can use Autofill to create all of the above types of lists. 

 

8. How would you create a list where you need a word followed by a number? For example 

Participant 1, Participant 2, Participant 3 all the way to Participant 200, for example? 

A. First type the word ‘Participant’ in the first cell then use the Autofill handle to copy the 

word down to 200th cell.  Then insert a number in the first cell and copy it down using the 

Autofill handle again. 

B. Type the word and number ‘Participant 1’ in the first cell and then copy it down to the 200th 

cell. 

C. You need to create a customized list to do this using Autofill options located in the Excel 

Options – General section. 

D. None of the above options are correct. 

 

9. Which of the options listed at a-d below will assist me in creating a workweek roster that 

contains only the days:  Monday, Wednesday, Friday and Saturday? 

A. Create a list containing Monday, Wednesday, Friday and Saturday.  Select the entire list and 

use the Autofill handle to fill out the roster with this series. 
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B. Create a customized list containing Monday, Wednesday, Friday and Saturday using the 

Custom Lists option located in the Advanced Options – General section in the Backstage 

view. 

C. Both options a and b are correct. 

D. Neither option a nor b is correct. 

 

10. How can you use Autofill to QUICKLY recreate the list pictured in the example above? 

A. Type the first number in the series, ‘0’, then drag the fill handle down and select ‘Series’ 

from the Autofill Options. 

B. Launch the Fill Options dialogue box in the Editing group.  Check the options for ‘column’ 

and ‘linear’.  For step value insert ’50’ and for stop value insert ‘450’ and press OK. 

C. It is not possible to use Autofill to copy down lists of non-sequential numbers. 

D. Type ‘0’ in the first cell and ’50’ in the second.  Select both cells and then use the Fill handle 

to drag down to the ‘450’ value. 

 

11. The letters in Excel represent the... 

A. Rows 

B. Columns 

C. Cells 

D. Data 

 

12. The numbers in Excel represent the…. 

A. Rows 

B. Columns 

C. Cells 

D. Data 

 

13. What is the cell in the worksheet in which you can type data? 

A. Main cell 

B. Open cell 

C. Active cell 

D. Absolute cell 

 

14. The intersection of a row and column. 

A. column 

B. row 

C. cell 

D. active cell 

 

15. What does the Protect Workbook function do? 

A. It protects all the worksheets in a workbook from being reformatted or typed into 

B.  It adds a password to access the worksheet. 

C. It prevents worksheets from being inserted, deleted or moved. 

D. It saves a workbook in a way that will allow only a select group of people to access to it. 

 

16. Casey is doing a very confidential company budget worksheet in Excel.  How can she 

prevent anyone, including the IT department, from being able to open the file and view its 

contents? 

A. By clicking on the Home tab, selecting Protect Sheet and entering a password to prevent 

access to the sheet. 

B. By clicking on the Info tab in the Backstage View, selecting Protect Workbook – Encrypt 

with Password and entering a password. 

C. By clicking on the Review tab and selecting Protect Workbook and entering a password for 

protecting the sheet. 
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D. All of the options listed above will block access to the workbook 

 

Answers for Self Assessment 

1. C 2. B 3. D 4. A 5. D 

6. D 7. D 8. B 9. C 10. D 

11. B 12. A 13. C 14. C 15. C 

16. B         

 

Review Questions 

1. How can you insert a new row in an Excel worksheet? 

2. What is the purpose of adjusting the column width in Excel? 

3. How do you hide a specific column in Excel? 

4. What are the steps to delete multiple rows in Excel simultaneously? 

5. Explain the importance of adjusting row heights in a worksheet. 

6. What is the purpose of using the "Text" data type in Excel? 

7. How does Excel handle dates and what data type is used for dates? 

8. How can you format a cell or range of cells as currency in Excel? 

9. What is the difference between the "Number" and "Percentage" data types in Excel? 

10. How can you apply a custom data format to a cell in Excel? 

11. What happens when you double-click the fill handle in Excel? 

12. How can you use the fill handle to fill a series based on an existing pattern in Excel? 

13. Is it possible to customize the default behavior of the fill handle in Excel? If so, how? 

14. How can you use the fill handle to quickly populate a range with a formula that references 

adjacent cells in Excel? 

 

 

Further Readings 

• Business Data Analysis Using Excel, David Whigham 

• https://trumpexcel.com/how-to-use-fill-handle-in-excel/ 

• https://edu.gcfglobal.org/en/excel/modifying-columns-rows-and-cells/1/# 

• https://www.geeksforgeeks.org/protecting-excel-worksheets-and-workbooks/ 
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Objectives 

In this unit, we will  

• Get an Introduction to Range 

• Study Naming a Range 

• Understand the concept of functions and formulae in MS- Excel. 

• Understand the concept of absolute and relative referencing in MS- Excel. 

• Understand the concept of working across sheets in MS- Excel. 

 

Introduction 

• Whenever we see the word range in excel, we refer to it as a cell or a collection of cells in 
an excel spreadsheet.  

• It can also be used to refer to the adjacent cells or non-adjacent cells in the dataset.  

• In excel, each range has its defined set of coordinates or positions, unlike A4:A7, B5: F9C, 
etc. 

• You can perform many operations with ranges in your Excel worksheet, unlike copying 
the dataset, moving data from one position to another, formatting cells, and even you can 
name your range.  

 

3.1 Range 

Select a Range 

• While working with excel, you may want to select a multi cell range so you can easily 
make a command for all the cells at once.  

• For example, let's suppose you can highlight the headers in the cell range A2:E2.  

• You select the range and change the background colour of the cells. 
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A. Select contiguous range of cells 

Select the cell from where you want to start selecting your range. In our case, we have selected the 
B2 cell. 

Drag your cursor to the last cell of your range. As you can see, we have dragged our pointer to the 
D5 cell. 

 

Hence the range B2: D5 got selected. 

 

Similarly, you can select any range of cells in your Excel worksheet. 

B. Select non-contiguous range of cells 

Select the cell from where you want to start selecting your range. In our case, we have selected the 
B2 cell. 

 

Lovely Professional University50



Unit 03: Spreadsheet Calculations  

 

Notes 

Hold the 'CTRL' key on your select and the various non-adjacent cells. We have selected B2:B6, 
C3:C6, D4 range of cells. 

 

 

Types of Ranges 

1. Vertical Range 

Vertical range refers to the selection of the cells within a column. For example, in the 

below image, the vertical range is A1:A5. However, if you select the entire column, the 

vertical range would be A: A. 

 

2. Horizontal Range 

Horizontal Range refers to the selection of cells within a row. For example, in the below 

image, the horizontal range is A2:E2. However, if you select the entire row, the vertical 

range would be 2:2. 
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3. Mixed Range 

Mixed Range refers to the collection of cells formed by combining adjacent rows and 

columns. For instance, in the below example, the mixed Range is A2: E10. 

 

4. Multiple Selection Range 

To define a range, it's not necessary to select only the adjacent cells. Therefore with 

Multiple Selection Range, a collection of non-adjacent cells are selected. For instance, in the 

below example the Multiple Selection range is B4, B8, C7, D5, D8, E6. 

 

Move a Range 

By default, if you move a range of cells in excel, it will move the data from one location to another 
along with its formatting such as font, text or number format, cell borders, font colour, etc. 

Follow the given below steps to move a range of cells in Excel: 

1. Select the range of cells you want to move from one location to another in your excel 

spreadsheet. 
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2. As soon as you select the cells, you will notice the entire range of selected cells become 

active with a green box around it. 

 

3. Move your cursor to the green border, and you will see that the cursor changes to a four-

headed arrow icon. 

 

4. Using the arrow moves the cell to another location within the same Excel 

worksheet. Unlike here, we can move it to column E. 

 

Copy/Paste a Range 

By default, if you copy a range of cells in excel, it will copy the data from one location along with 
its formatting such as font, text or number format, cell borders, font colour, etc. and paste it to its 
new location. 

Follow the given below steps to copy & paste a range of cells in Excel: 
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1. Select the range of cells that you wish to copy. 

 

2. Put your cursor on top of your selected cell and right-click on it. The following window 

will be displayed. Click on the Copy option. Or you can directly press the shortcut key, 

i.e., CTRL + c. 

 

 

3. Select the cell from where you want to start pasting the copied cell. Either right-click on 

the cell and select the paste option or press the 'CTRL + V' option directly. 

 

That's it, your data (along with its formatting) will be pasted to the new location of your excel 
spreadsheet. 
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Named Range in Excel 

A named range is an amazing excel feature used to define the name for a collection of cells or 
ranges in a worksheet. Named range works as an added advantage as it helps to calculate functions 
and formulas quickly. 

To add a named range in your Excel worksheet, follow the below steps: 

1. Select the range of cells for which you want to define the name. 

 

2. Go to the ribbon toolbar located at the top of your Excel window. Click on the Formulas tab -> 
Defined Names group -> Define Name option. 

 

3. The New Name window will open (as shown below). In the descriptive name textbox, enter any 
suitable name for the range. In our case, we have entered Student_Marks as the name for the 
selected range. 

 

4. After specifying the name, it's time to specify the range of cells from which you want to apply the 
name; therefore, in the "Refers to" box, select the range from your Excel worksheet. 
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5. Once done, click on the OK button. 

 

5. The window will be closed, and when you return to the spreadsheet, you will notice the 

name Students_Marks is highlighted in the Name box for the selected range of cells (as 

shown in the image below). 

 

6. Now that we have defined the range's name, we can directly use the name Student_Marks 

in formulas to refer to the named range of cells. For example, type the below formula in 

your excel worksheet. 
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=SUM(Student_Marks) 

 

8. The SUM formula will quickly calculate the sum of all numbers present in a defined range and 
will give you the following result. 

=SUM(Student_Marks) 

 

8. The SUM formula will quickly calculate the sum of all numbers present in a defined range and 
will give you the following result. 

Result: 55 

Lovely Professional University 57



Spreadsheet Modelling (Using MS Excel)  

 

Notes 

 

Excel Named Range - Makes it Easy!! 

• Excel Named Ranges makes it easy to refer to data sets in Excel. 
• You can create a named range in Excel for each data category, and then use that name 

instead of the cell references. For example, dates can be named ‘Date’, Sales Rep data can 
be named ‘SalesRep’ and sales data can be named ‘Sales’. 

 

Benefits of Creating Named Ranges in Excel 

• Use Names instead of Cell References 
• No Need to Go Back to the Dataset to Select Cells 
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• Named Ranges Make Formulas Dynamic 

3.2 Absolute, Relative, and Mixed Cell References in Excel 

 A worksheet in Excel is made up of cells. These cells can be referenced by specifying the row 

value and the column value. 

 For example, A1 would refer to the first row (specified as 1) and the first column (specified 

as A). Similarly, B3 would be the third row and second column. 

 The power of Excel lies in the fact that you can use these cell references in other cells when 

creating formulas. 

Now there are three kinds of cell references that you can use in Excel: 

1. Relative Cell References 

2. Absolute Cell References 

3. Mixed Cell References 

Understanding these different types of cell references will help you work with formulas and save 
time (especially when copy-pasting formulas). 

What are Relative Cell References in Excel? 

Suppose we have a data set shown below: 

 

To calculate the total for each item, we need to multiply the price of each item with the quantity of 
that item. 

For the first item, the formula in cell D2 would be B2* C2 (as shown below): 
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Now, instead of entering the formula for all the cells one by one, you can simply copy cell D2 and 
paste it into all the other cells (D3:D8). When you do it, you will notice that the cell reference 
automatically adjusts to refer to the corresponding row. For example, the formula in cell D3 
becomes B3*C3 and the formula in D4 becomes B4*C4. 

 

These cell references that adjust itself when the cell is copied are called relative cell references in 
Excel. 

When to Use Relative Cell References in Excel? 

Relative cell references are useful when you have to create a formula for a range of cells and the 
formula needs to refer to a relative cell reference. 

In such cases, you can create the formula for one cell and copy-paste it into all cells. 

What are Absolute Cell References in Excel? 

Unlike relative cell references, absolute cell references don’t change when you copy the formula to 
other cells. 

For example, suppose you have the data set as shown below where you have to calculate the 
commission for each item’s total sales. 

The commission is 20% and is listed in cell G1. 

 

To get the commission amount for each item sale, use the following formula in cell E2 and copy for 
all cells: 
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=D2*$G$1 

 

Note that there are two dollar signs ($) in the cell reference that has the commission – $G$2. 

What does the Dollar ($) sign do? 

A dollar symbol, when added in front of the row and column number, makes it absolute (i.e., stops 
the row and column number from changing when copied to other cells). 

For example, in the above case, when I copy the formula from cell E2 to E3, it changes 
from =D2*$G$1 to =D3*$G$1. 

Note that while D2 changes to D3, $G$1 doesn’t change. 

Since we have added a dollar symbol in front of ‘G’ and ‘1’ in G1, it wouldn’t let the cell reference 
change when it’s copied. 

Hence this makes the cell reference absolute. 

 

When to Use Absolute Cell References in Excel? 

Absolute cell references are useful when you don’t want the cell reference to change as you copy 
formulas. This could be the case when you have a fixed value that you need to use in the formula 
(such as tax rate, commission rate, number of months, etc.) 

While you can also hard code this value in the formula (i.e., use 20% instead of $G$2), having it in a 
cell and then using the cell reference allows you to change it at a future date. 

For example, if your commission structure changes and you’re now paying out 25% instead of 20%, 
you can simply change the value in cell G2, and all the formulas would automatically update. 

 

What are Mixed Cell References in Excel? 

Mixed cell references are a bit more tricky than the absolute and relative cell references. 

There can be two types of mixed cell references: 

 The row is locked while the column changes when the formula is copied. 

 The column is locked while the row changes when the formula is copied. 

Let’s see how it works using an example. 

Below is a data set where you need to calculate the three tiers of commission based on the 
percentage value in cell E2, F2, and G2. 
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Now you can use the power of mixed reference to calculate all these commissions with just one 
formula. 

Enter the below formula in cell E4 and copy for all cells. 

=$B4*$C4*E$2 

 

The above formula uses both kinds of mixed cell references (one where the row is locked and one 
where the column is locked). 

Let’s analyze each cell reference and understand how it works: 

 $B4 (and $C4) –  In this reference, the dollar sign is right before the Column notation but not 

before the Row number. This means that when you copy the formula to the cells on the 

right, the reference will remain the same as the column is fixed. For example, if you copy the 

formula from E4 to F4, this reference would not change. However, when you copy it down, 

the row number would change as it is not locked. 

 E$2 – In this reference, the dollar sign is right before the row number, and the Column 

notation has no dollar sign. This means that when you copy the formula down the cells, the 

reference will not change as the row number is locked. However, if you copy the formula to 

the right, the column alphabet would change as it’s not locked. 
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How to Change the Reference from Relative to Absolute (or Mixed)? 

To change the reference from relative to absolute, you need to add the dollar sign before the 
column notation and the row number. 

For example, A1 is a relative cell reference, and it would become absolute when you make it $A$1. 

If you only have a couple of references to change, you may find it easy to change these references 
manually. So you can go to the formula bar and edit the formula (or select the cell, press F2, and 
then change it). 

However, a faster way to do this is by using the keyboard shortcut – F4. 

When you select a cell reference (in the formula bar or in the cell in edit mode) and press F4, it 
changes the reference. 

Suppose you have the reference =A1 in a cell. 

Here is what happens when you select the reference and press the F4 key. 

 Press F4 key once: The cell reference changes from A1 to $A$1 (becomes ‘absolute’ from 

‘relative’). 

 Press F4 key two times: The cell reference changes from A1 to A$1 (changes to mixed 

reference where the row is locked). 

 Press F4 key three times: The cell reference changes from A1 to $A1 (changes to mixed 

reference where the column is locked). 

 Press F4 key four times: The cell reference becomes A1 again. 

 

3.3 Formulae and Functions 

Formulas and functions are the building blocks of working with numeric data in Excel. This article 
introduces you to formulas and functions. 

What is Formulas in Excel? 

FORMULAS IN EXCEL is an expression that operates on values in a range of cell addresses and 
operators. For example, =A1+A2+A3, which finds the sum of the range of values from cell A1 to 
cell A3. An example of a formula made up of discrete values like =6*3. 

=A2 * D2 / 2 

 "=" tells Excel that this is a formula, and it should evaluate it. 

 "A2" * D2" makes reference to cell addresses A2 and D2 then multiplies the values found 
in these cell addresses. 

 "/" is the division arithmetic operator 

 "2" is a discrete value 

 

Formulas practical exercise 

We will work with the sample data for the home budget to calculate the subtotal. 

 Create a new workbook in Excel 

 Enter the data shown in the home supplies budget above. 

 Your worksheet should look as follows. 
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We will now write the formula that calculates the subtotal 

Set the focus to cell E4 

Enter the following formula. 

=C4*D4 

HERE, 

 "C4*D4" uses the arithmetic operator multiplication (*) to multiply the value of the cell 
address C4 and D4. 

Press enter key 

You will get the following result 

 

The following animated image shows you how to auto select cell address and apply the same 
formula to other rows. 

 

Mistakes to avoid when working with formulas in Excel 
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1. Remember the rules of Brackets of Division, Multiplication, Addition, & 
Subtraction (BODMAS). This means expressions are brackets are evaluated first. For 
arithmetic operators, the division is evaluated first followed by multiplication then 
addition and subtraction is the last one to be evaluated. Using this rule, we can rewrite the 
above formula as =(A2 * D2) / 2. This will ensure that A2 and D2 are first evaluated then 
divided by two. 

2. Excel spreadsheet formulas usually work with numeric data; you can take advantage of 
data validation to specify the type of data that should be accepted by a cell i.e. numbers 
only. 

3. To ensure that you are working with the correct cell addresses referenced in the formulas, 
you can press F2 on the keyboard. This will highlight the cell addresses used in the 
formula, and you can cross check to ensure they are the desired cell addresses. 

4. When you are working with many rows, you can use serial numbers for all the rows and 
have a record count at the bottom of the sheet. You should compare the serial number 
count with the record total to ensure that your formulas included all the rows. 

 

What is Function in Excel? 

FUNCTION IN EXCEL is a predefined formula that is used for specific values in a particular order. 
Function is used for quick tasks like finding the sum, count, average, maximum value, and 
minimum values for a range of cells. For example, cell A3 below contains the SUM function which 
calculates the sum of the range A1:A2. 

 SUM for summation of a range of numbers 

 AVERAGE for calculating the average of a given range of numbers 

 COUNT for counting the number of items in a given range 

The importance of functions 

Functions increase user productivity when working with excel. Let’s say you would like to get the 
grand total for the above home supplies budget. To make it simpler, you can use a formula to get 
the grand total. Using a formula, you would have to reference the cells E4 through to E8 one by 
one. You would have to use the following formula. 

= E4 + E5 + E6 + E7 + E8 

With a function, you would write the above formula as 

=SUM (E4:E8) 

As you can see from the above function used to get the sum of a range of cells, it is much more 
efficient to use a function to get the sum than using the formula which will have to reference a lot of 
cells. 

Common functions 

Let’s look at some of the most commonly used functions in ms excel formulas. We will start with 
statistical functions. 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

01 SUM Math & Trig Adds all the values in a range of cells =SUM(E4:E8) 

02 MIN Statistical Finds the minimum value in a range of cells =MIN(E4:E8) 

03 MAX Statistical Finds the maximum value in a range of cells =MAX(E4:E8) 

04 AVERAGE Statistical 
Calculates the average value in a range of 
cells 

=AVERAGE(E4:E8) 
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S/N FUNCTION CATEGORY DESCRIPTION USAGE 

05 COUNT Statistical Counts the number of cells in a range of cells =COUNT(E4:E8) 

06 LEN Text 
Returns the number of characters in a string 
text 

=LEN(B7) 

07 SUMIF Math & Trig 
Adds all the values in a range of cells that 
meet a specified criteria. 
=SUMIF(range,criteria,[sum_range]) 

=SUMIF(D4:D8,”>=1000″,C4:C8) 

08 AVERAGEIF Statistical 
Calculates the average value in a range of 
cells that meet the specified criteria. 
=AVERAGEIF(range,criteria,[average_range]) 

=AVERAGEIF(F4:F8,”Yes”,E4:E8) 

09 DAYS Date & Time 
Returns the number of days between two 
dates 

=DAYS(D4,C4) 

10 NOW Date & Time Returns the current system date and time =NOW() 

 

Numeric Functions 

As the name suggests, these functions operate on numeric data. The following table shows some of 
the common numeric functions. 

S/N FUNCTION CATEGORY DESCRIPTION 

1 ISNUMBER Information Returns True if the supplied value is numeric and False if it is not numeric 

2 RAND Math & Trig Generates a random number between 0 and 1 

3 ROUND Math & Trig Rounds off a decimal value to the specified number of decimal points 

4 MEDIAN Statistical Returns the number in the middle of the set of given numbers 

5 PI Math & Trig Returns the value of Math Function PI(̟) 

6 POWER Math & Trig 
Returns the result of a number raised to a power.
POWER( number, power ) 

7 MOD Math & Trig Returns the Remainder when you divide two numbers 

8 ROMAN Math & Trig Converts a number to roman numerals 

 

String functions 

These basic excel functions are used to manipulate text data. The following table shows some of the 
common string functions. 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

1 LEFT Text 
Returns a number of specified characters from the start (left-hand 
side) of a string 

=LEFT(“GURU99”,4)

2 RIGHT Text 
Returns a number of specified characters from the end (right-hand 
side) of a string 

=RIGHT(“GURU99”,2)

3 MID Text 
Retrieves a number of characters from the middle of a string from a 
specified start position and length. 
=MID (text, start_num, num_chars) 

=MID(“GURU99”,2,3)

4 ISTEXT Information Returns True if the supplied parameter is Text =ISTEXT(value)

5 FIND Text 
Returns the starting position of a text string within another text 
string. This function is case-sensitive. 
=FIND(find_text, within_text, [start_num]) 

=FIND(“oo”,”Roofing”,1)

6 REPLACE Text 
Replaces part of a string with another specified string. 
=REPLACE (old_text, start_num, num_chars, new_text) 

=REPLACE(“Roofing”,2,2,”xx”)
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Date Time Functions 

These functions are used to manipulate date values. The following table shows some of the 
common date functions 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

1 DATE Date & Time 

Returns the 
number that 
represents the date 
in excel code 

=DATE(2015,2,4) 

2 DAYS Date & Time 
Find the number of days between two 
dates 

=DAYS(D6,C6) 

3 MONTH Date & Time Returns the month from a date value =MONTH(“4/2/2015”) 

4 MINUTE Date & Time Returns the minutes from a time value =MINUTE(“12:31”) 

5 YEAR Date & Time Returns the year from a date value =YEAR(“04/02/2015”) 

 

Formula vs Function 

Formula in Excel  Function in Excel  

The user writes a formula.     
A function is pre-existing in the excel 
spreadsheet.  

You can use any operation within a formula 
to calculate whatever values you need.    

Functions cannot be customised. A user can 
choose from numerous functions available to 
perform the calculations.    

Formulas can be used to calculate values 
within a range of cells or a single cell.  

Functions can be used to find maximum or 
minimum values throughout the spreadsheet. 
Few other functions include – finding the 
lowest or highest digit or arranging values in 
ascending or descending order and for many 
other functions.   

A Formula cannot be modified according to 
your requirements.  

But a function can be modified based on the 
developer’s requirements.  

A formula cannot be used as a function.  A function can be used as a formula.  

Simple calculations can be performed 
manually using a formula.   

While complex calculations using a function 
are more difficult to do.  

Formulas do not have a particular syntax in 
excel.  

Whereas, Functions follow a particular syntax 
in excel. Syntax has to be followed in order.   

Predefined parameters are not relevant to a 
formula.  

Functions have their own set of pre-designed 
parameters on which to operate to get 
outcomes.  
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3.4 Working Across Sheets 

Most of the time, we create or insert formulas for a single worksheet in Excel. But sometimes, we 
need to create formulas for multiple Excel worksheets. By doing so, we can save a lot of time. In this 
tutorial, we will learn how to calculate data across worksheets with formulas in Excel easily. 

4 Easy Ways to Calculate Data Across Worksheets with Formulas in Excel 

This article will guide you with four easy ways to calculate data across 
worksheets with formulas in Excel. To demonstrate the methods, we will use a dataset (B4:E9) that 
contains the Names and marks of Math, History and Economics of some students. We will use 
some excellent examples with explanations so that anyone can easily understand them. So without 
further delay, let’s get started. 

 

 

1. Calculate Data Across Worksheets Using Excel Formula with Shift Key 

In the first method, we will use the Shift key for inserting formulas in Excel to calculate data across 
worksheets. Here, we will use the SUM function in Excel for calculating the total marks 
in Math for all the tests (Test 1, Test 2, Test 3, Test 4 & Test 5). For this, we will use the dataset 
(B4:E9) below. The steps are below. 

 

Steps: 
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 Firstly, click on the Shift Key tab located at the bottom of the worksheet. 

 Secondly, select cell C5. 

 

 Thirdly, enter the SUM function in cell C5. 

 

 Now, click on the Test1 sheet tab. 

 Consequently, you can see Test1 in the Formula Bar. 
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 After that, click on the Test5 tab holding down the Shift key. 

 

 Then, select cell C5 of the Test1 worksheet. 

Lovely Professional University70



Unit 03: Spreadsheet Calculations  

 

Notes 

 

 Thereupon, go to the Formula Bar and close the parentheses (see screenshot). 

 The final formula is given below: 

=SUM(‘Test1:Test5’!C5) 

 

 

 Finally, press the Enter key to get the result in cell C5. 
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 To copy the formula in the rest of the cells, drag the fill handle to the right (up to cell E5). 

 After dragging to the right, select them and double-click on the plus sign to autofill the 
next cells. 

 In this way, we can calculate the total marks for all subjects (see the picture below). 

 

2. Manually Insert Formulas to Calculate Data for Several Excel Worksheets 

Here, we will insert a formula manually for several worksheets to calculate the total marks of 
the History of the dataset (B4:E9) below. We will insert the formula in cell D5 of the dataset. Follow 
the steps below to insert the formula. 
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Steps: 

 First of all, go to cell D5. 

 Next, to get the total marks of History, enter the following formula in cell D5: 

=Test1!D5+Test2!D5+Test3!D5+Test4!D5+Test5!D5 

 After that, press the Enter key. 

 Therefore, you will get the total marks of History for all the tests in cell D5. 

 

 

Finally, drag the fill handle to copy the formula up to cell D9 (see screenshot). 
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 Similarly, we can also calculate the total marks of Math by inserting the 
following formula in cell C5 and then use the fill handle tool up to cell C9: 

=Test1!C5+Test2!C5+Test3!C5+Test4!C5+Test5!C5 

 Moreover, calculate the total marks of Economics by typing the formula below in 
cell E5 and then autofill the next cells by double-clicking on the plus sign: 

=Test1!E5+Test2!E5+Test3!E5+Test4!E5+Test5!E5 

 The final result is in the picture below. 

 

 

Summary 

 Remember the rules of Brackets of Division, Multiplication, Addition, & 

Subtraction (BODMAS). This means expressions are brackets are evaluated first. For 

arithmetic operators, the division is evaluated first followed by multiplication then addition 

and subtraction is the last one to be evaluated. Using this rule, we can rewrite the above 

formula as =(A2 * D2) / 2. This will ensure that A2 and D2 are first evaluated then divided by 

two. 

 Excel spreadsheet formulas usually work with numeric data; you can take advantage of data 

validation to specify the type of data that should be accepted by a cell i.e. numbers only. 
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 To ensure that you are working with the correct cell addresses referenced in the formulas, you 

can press F2 on the keyboard. This will highlight the cell addresses used in the formula, and 

you can cross check to ensure they are the desired cell addresses. 

 When you are working with many rows, you can use serial numbers for all the rows and have 

a record count at the bottom of the sheet. You should compare the serial number count with 

the record total to ensure that your formulas included all the rows. 

 

Keywords 

 Range: A group or selection of cells in Excel. 

 Cell: A single unit within a range that holds data. 

 Selection: The act of choosing a range or multiple cells in Excel. 

 Reference: A cell or range address used in formulas or functions. 

 Range Name: A defined name given to a specific range of cells. 

 Merge Cells: Combining multiple adjacent cells into a single larger cell. 

 Copy Range: Duplicating a range of cells and placing it elsewhere in the worksheet. 

 Paste Range: Placing copied or cut cells into a new location in the worksheet. 

 Fill Range: Automatically filling a range of cells with a series, such as numbers or dates. 

 Sort Range: Reordering the cells within a range based on certain criteria. 

 Filter Range: Displaying only the cells within a range that meet specific conditions. 

 Conditional Formatting: Applying formatting rules to a range based on specified criteria. 

 Sum Range: Calculating the sum of a range of cells. 

 Average Range: Calculating the average value of a range of cells. 

 Max Range: Finding the maximum value within a range of cells. 

 Min Range: Finding the minimum value within a range of cells. 

 Count Range: Counting the number of cells that contain data within a range. 

 Relative Reference: A reference that changes based on the location of the formula when 

copied or filled to other cells. It adjusts automatically to its new position relative to the 

original cell. 

 Absolute Reference: A reference that remains constant when copied or filled to other cells. 

It always refers to the same cell, regardless of its new location. 

 Mixed Reference: A reference that contains both relative and absolute components. You 

can lock either the row or column reference while allowing the other to change. 

 $ Symbol: The dollar sign ($) is used to indicate an absolute reference in Excel. Placing a $ 

before the column letter or row number locks that component of the reference. 

 F4 Key: Pressing the F4 key on your keyboard can toggle between different reference types 

(relative, absolute, mixed) when editing a formula in Excel. It helps quickly switch 

between reference modes. 

 

Self Assessment 

1. Microsoft Excel is used for? 
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A. Analysis 
B. Data Entry 
C. Data Management 
D. All of the above 

2. What is the collection of worksheets called? 

A. Ledger 
B. Book 
C. Testbook 
D. Workbook 

3. How do you display current date only in MS Excel? 

A. Date () 
B. Today () 
C. Now () 
D. Time () 

 

4. What does COUNTA () function do? 
A. Counts cells having alphabets 
B. Counts empty cells 
C. Counts cells having number 
D. Counts non-empty cells 

 

5. You can check the conditions against __________ when applying conditional formatting 
A. Cell value 
B. Formula 
C. Both of above 
D. None of above 

 

6. It is much important to give a ………………………… sign at the beginning of the formula. 
A. plus sign  
B. minus sign                   
C. Hyphen                  
D. is equal to sign 

 

7. It shows the types of operations 
A. Operators  
B. symbols                        
C. Operands                  
D. None of these 

 

8. This type of operators are used for performing mathematical calculations. 
A. Comparison 
B. Logical 
C. Arithmetic 
D. All of the above 

 

9. This type of operators are used for making comparison between two values. 
A. Comparison 
B. Logical 
C. Arithmetic 
D. All of the above 
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10. When you copy a formula? 
A. Excel erases the original copy of the formula 
B. Excel edits cell references in the newly copied formula 
C. Excel adjusts absolute cell references 
D. Excel doesn’t adjust relative cell references 
 
11. Which of the following is an absolute cell reference? 
A. A.!A!1 
B. B.$A$1 
C. C.#a#1 
D. D.A1 

 

12. When a range is selected, how can you activate the previous cell? 

A. Press the Alt key 
B. Press Tab 
C. Press Enter 
D. None of above 

 
13. Where can you set the shading color for a range of cells in Excel? 
A. Choose required color form Patterns tab of Format Cells dialog box 
 
B. Choose required color on Fill Color tool in Formatting toolbar 

C. Choose required color on Fill Color tool in Drawing toolbar 

D. All of above 

 
14. The Name box on to the left of formula bar 

A. Shows the name of workbook currently working on 

B. Shows the name of worksheet currently working on 

C. Shows the name of cell or range currently working on 

D. None of above 

 
15. If you need to remove only the formatting done in a range (numbers and formula typed 

there should not be removed), you must 
A. From Edit menu choose Clear and then Formats 
B. From Edit menu choose Delete 
C. Click on Remove Formatting tool on Standard Toolbar 
D. Double click the Format Painter and then press Esc key in keyboard 

 
16. You cannot use a named range in a formula that references another worksheet. 
A. True 
B. False 

 

Answers for Self Assessment 

1. D 2. D 3. B 4. D 5. C 

6. D 7. A 8. C 9. A 10. B 

11. B 12. D 13. D 14. C 15. A 

16. B         
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Review Questions 

1. What is the difference between a formula and a function in Excel? Provide examples of each. 

2. How can you use the SUM function to add up a range of cells in Excel? Provide an example. 

3. What is the purpose of using absolute references ($) in formulas? Give an example where 

absolute references are useful. 

4. How can you nest functions within a formula in Excel? Provide an example of a nested 

function. 

5. What is the IF function in Excel, and how is it used? Provide an example of an IF function 

formula. 

6. How can you reference a cell from a different sheet in a formula? Provide an example. 

7. What is the purpose of using the sheet name in a cell reference? How can you include the 

sheet name in a reference? 

8. How can you perform calculations across multiple sheets using the SUM function in Excel? 

Provide an example. 

9. How do you create a 3D reference to calculate across multiple sheets? Explain the syntax 

and provide an example. 

10. What are the potential challenges or considerations when performing calculations across 

sheets in Excel? How can you overcome these challenges? 

 

 

Further Readings 

 https://www.javatpoint.com/range-in-excel 

 https://www.excel-easy.com/introduction/range.html 

 https://trumpexcel.com/find-range-in-excel/ 

 https://trumpexcel.com/named-ranges-in-excel/ 

 https://www.w3schools.com/excel/excel_formulas.php 

 https://www.guru99.com/introduction-to-formulas-and-functions-in-excel.html 

 https://www.excel-easy.com/introduction/formulas-functions.html 

 https://www.wallstreetmojo.com/basic-excel-formulas/ 

 https://edu.gcfglobal.org/en/excelformulas/functions/1/# 

 https://trumpexcel.com/excel-functions/ 

 https://www.exceldemy.com/how-to-calculate-formulas-across-worksheets-in-

excel/ 
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Objectives  

After this unit, you will be able to 

• understand the process of formatting excel sheets. 

• understand borders and their use in MS - Excel. 

• Change horizontal cell alignment. 

• Change vertical cell alignment. 

• Change text control 

• Change text orientation 

• Understand different number formats in Excel. 

 

Introduction 

• All cell content uses the same formatting by default, which can make it difficult to read a 
workbook with a lot of information.  

• Basic formatting can customize the look and feel of your workbook, allowing you to draw 
attention to specific sections and making your content easier to view and understand.  

• One can also apply number formatting to tell Excel exactly what type of data you’re using in 
the workbook, such as percentages (%), currency ($), and so on. 

 

4.1 Formatting Excel Sheets 

To change Font 

• By default, the font of each new workbook is set to Calibri.  

• However, Excel provides many other fonts you can use to customize your cell text.  

Dr. Jaskiran Kaur, Lovely Professional University 
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• In the example below, we'll format our title cell to help distinguish it from the rest of the 
worksheet. 

• Select the cell(s) you want to modify. 

 

• Click the drop-down arrow next to the Font command on the Home tab. The Font drop-
down menu will appear. 

• Select the desired font. A live preview of the new font will appear as you hover the mouse 
over different options. In our example, we'll choose Georgia. 

 

• The text will change to the selected font. 

 

Note: 

• When creating a workbook in the workplace, you'll want to select a font that is easy to 
read.  
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• Along with Calibri, standard reading fonts include Cambria, Times New Roman, and 
Arial. 

To change the font size: 

• Select the cell(s) you want to modify. 

 

• Click the drop-down arrow next to the Font Size command on the Home tab. The Font 
Size drop-down menu will appear. 

• Select the desired font size. A live preview of the new font size will appear as you hover 
the mouse over different options. In our example, we will choose 16 to make the 
text larger. 

 

• The text will change to the selected font size. 
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Note: 

• You can also use the Increase Font Size and Decrease Font Size commands or enter 
a custom font size using your keyboard. 

 

 

To change the font colour: 

• Select the cell(s) you want to modify. 

 

• Click the drop-down arrow next to the Font Color command on the Home tab. 
The Color menu will appear. 

• Select the desired font color. A live preview of the new font color will appear as you hover 
the mouse over different options. In our example, we'll choose Green. 
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• The text will change to the selected font color. 

 

To use the Bold, Italic, and Underline commands: 

• Select the cell(s) you want to modify. 

 

• Click the Bold (B), Italic (I), or Underline (U) command on the Home tab. In our example, 
we'll make the selected cells bold. 

 

 The selected style will be applied to the text. 
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Note: You can also press Ctrl+B on your keyboard to make selected text bold, Ctrl+I to 
apply italics, and Ctrl+U to apply an underline. 

Text alignment 

By default, any text entered into your worksheet will be aligned to the bottom-left of a cell, while 
any numbers will be aligned to the bottom-right. Changing the alignment of your cell content 
allows you to choose how the content is displayed in any cell, which can make your cell content 
easier to read. 

To change horizontal text alignment: 

In our example below, we'll modify the alignment of our title cell to create a more polished look 
and further distinguish it from the rest of the worksheet. 

1. Select the cell(s) you want to modify. 

 

2. Select one of the three horizontal alignment commands on the Home tab. In our example, 
we'll choose Center Align. 

 

3. The text will realign. 
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To change vertical text alignment: 

1. Select the cell(s) you want to modify. 

 

2. Select one of the three vertical alignment commands on the Home tab. In our example, 
we'll choose Middle Align. 

 

3. The text will realign. 

 

You can apply both vertical and horizontal alignment settings to any cell. 

Cell borders and fill colors 
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Cell borders and fill colors allow you to create clear and defined boundaries for different sections 
of your worksheet. Below, we'll add cell borders and fill color to our header cells to help 
distinguish them from the rest of the worksheet. 

To add a border: 

1. Select the cell(s) you want to modify. 

 

2. Click the drop-down arrow next to the Borders command on the Home tab. 
The Borders drop-down menu will appear. 

3. Select the border style you want to use. In our example, we will choose to display All 
Borders. 

 

4. The selected border style will appear. 

 

You can draw borders and change the line style and color of borders with the Draw Borders tools 
at the bottom of the Borders drop-down menu. 
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To add a fill color: 

1. Select the cell(s) you want to modify. 

 

2. Click the drop-down arrow next to the Fill Color command on the Home tab. The Fill 
Color menu will appear. 

3. Select the fill color you want to use. A live preview of the new fill color will appear as you 
hover the mouse over different options. In our example, we'll choose Light Green. 

 

4. The selected fill color will appear in the selected cells. 
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Format Painter 

If you want to copy formatting from one cell to another, you can use the Format Painter command 
on the Home tab. When you click the Format Painter, it will copy all of the formatting from the 
selected cell. You can then click and drag over any cells you want to paste the formatting to. 

 

Cell styles 

Instead of formatting cells manually, you can use Excel's predesigned cell styles. Cell styles are a 
quick way to include professional formatting for different parts of your workbook, such 
as titles and headers. 

To apply a cell style: 

In our example, we'll apply a new cell style to our existing title and header cells. 

1. Select the cell(s) you want to modify. 

 

2. Click the Cell Styles command on the Home tab, then choose the desired style from the 
drop-down menu. In our example, we'll choose Accent 1. 
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3. The selected cell style will appear. 

 

Applying a cell style will replace any existing cell formatting except for text alignment. You may 
not want to use cell styles if you've already added a lot of formatting to your workbook. 

Formatting text and numbers 

One of the most powerful tools in Excel is the ability to apply specific formatting for text and 
numbers. Instead of displaying all cell content in exactly the same way, you can use formatting to 
change the appearance of dates, times, decimals, percentages (%), currency ($), and much more. 

To apply number formatting: 

In our example, we'll change the number format for several cells to modify the way dates are 
displayed. 

1. Select the cells(s) you want to modify. 

 

2. Click the drop-down arrow next to the Number Format command on the Home tab. 
The Number Formatting drop-down menu will appear. 

3. Select the desired formatting option. In our example, we will change the formatting 
to Long Date. 
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4. The selected cells will change to the new formatting style. For some number formats, you 
can then use the Increase Decimal and Decrease Decimal commands (below the Number 
Format command) to change the number of decimal places that are displayed. 

 

Click the buttons in the interactive below to learn about different text and number formatting 
options. 
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4.2 Borders and Shades in Excel 

 MS Excel is powerful spreadsheet software that helps users store data across multiple 

worksheets. Each worksheet contains several cells formed by the intersection of rows and 

columns. By default, the Excel cells have no borders and use white shades. However, 

borders or shades can help make data easy to read or highlight when we have a large data 

set. 
 Apart from this, it becomes too complex to read when we take prints of worksheet data 

without borders. Excel allows us to add a border and color shades to one or more desired 

cells within the worksheet. 

• Borders in Excel are outlined in data tables or a specific range of cells.  

• In Excel, borders are used to separate the data in borders from the rest of the text.  

• It is a good way of representing data.  

• In addition, it helps the user to look for specific data easily.  

• These borders are available in the “Home” tab in the fonts section. 

• We can add the border to a single cell or multiple cells.  

• Borders are of different styles and can be used as per the requirement. 

• Borders help present the data set in a more presentable format in Excel. 

• We can use borders for tabular format data or headlines to emphasize a specific set of data 
or can be used to distinguish different sections. 

• We can use it to define or divide the sections of a worksheet. 

• We can use it to emphasize specific data. 

• We can also make the data more understandable and presentable. 
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Borders and Shades (Shading) 

In Excel, borders refer to a line drawn across any or all of four sides of a cell in a worksheet. When 
adding a border to one or more cells, we can choose specific sides to include or exclude. Moreover, 
we can also manually draw borders for custom or desired sides of cells. For example, we can add 
(or draw) borders to the top and bottom of the cell and leave the other sides open. 

 

Furthermore, shading refers to an artistic design or color used as the background of a cell in a 
worksheet. When adding shading (background color) to one or more cells, we can choose one of the 
pre-defined colors set for a specific cell. Additionally, we can also choose a custom color for the 
desired cell. 

 

 

Applying Borders in Excel 

Creating a border is one of the easiest things to do in Excel. Although there are several methods, 
this is usually done using the following two methods: 

Applying Borders from Ribbon 

Excel Ribbon is the primary area for accessing most existing commands or tools. While creating a 
border in Excel, we can take advantage of the Excel ribbon and apply a border to the desired cell 
using the following steps: 

o First, we need to select the effective Excel cells where we wish to insert borders. We can 

hold down the mouse's left button and drag the selected shading from one cell to the 

others. Besides, while selecting non-adjacent (or non-contiguous) cells in Excel, we must 

click on individual cells while holding down the Ctrl key. 
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o After selecting the effective cell, we need to go to the Home tab on the ribbon and click on 

the drop-down icon next to Border, as shown in the following image: 

 

o In the next window, Excel will display various pre-defined border styles. We must click 

on the desired border style to apply it. 

 

o After clicking on the desired border (for example, All Border) from the list, the same will 

be instantly inserted into the selected Excel cells.  
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Although there are many existing border options, sometimes, we may need to insert a 

border on specific sides of the cell manually. For example, suppose we need to add or 

insert a border on any cell's left and right sides. We can manually draw borders using 

the Draw Border option from the drop-down list in such a case. 

 

After selecting the Draw Border option, our mouse cursor will convert into a pencil icon. 

We can click or drag on the desired grids to draw corresponding borders. 

 

Similarly, we can choose Line Color or Line Style options to color the desired borders or 

choose border-style like a single line, multi-line, etc. 

Applying Borders from Format Cells dialogue box 

Since adding a border is part of the Excel formatting tool, we can also apply a border using the 
Format Cells dialog box. We can perform the following steps to access the Format Cells dialog box 
and insert a border in the desired Excel cell: 
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First, we need to select/ highlight the effective cells in the worksheet. 

Once the desired cells are selected, we need to launch the Format Cells dialogue box. The easiest 
option to access/open it is to use the keyboard shortcut 'Ctrl + 1'. However, we must only press the 
key '1' from the keyboard area, not the number keypad. 

In the Format Cells dialogue box, we need to click on the Border tab, as shown below: 

 
We can adjust the cell's borders in multiple ways using different sections displayed in the above 

dialogue box: 

1. The Line Style section helps us select the desired design for the borders, such as single line 

border, dotted line border, double-line border, etc. 

2. The Color section or drop-down list under the Line category allows us to choose any desired 

color for the border. We can either choose the pre-defined colors or choose our custom color 

using the More Colors option. 

3. The Presets section helps us apply quick borders to the selected cells in the worksheet. 

Using Presets, we can select between None (no border), Outline (all sides borders), 

or Inside (borders in the connected sides of cells). 

4. The Border section helps us to choose different border styles. We can click on the displayed 

block to choose the top border, bottom border, left border, right border, diagonal border, etc. 

The preview section displays the border style as per the selected preference or settings in the 

dialogue box. 

After adjusting the settings for the borders, we must click the OK button to close the dialogue box 

and apply the changes in the worksheet. 

Deleting Borders in Excel 

To remove/delete border in the Excel worksheet, we can use any of the following methods: 

o First, we need to select the cells from which we wish to remove borders. Next, we must go 

to Home > Border > No Border. This will remove the borders from selected cells. For 
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selecting specific cells to remove the border, we can hold down the Ctrl key while clicking 

the corresponding cells. 

o We can also delete borders using the Erase border tool. For this, we must go to Home > 

Border > Erase Border. This will convert the mouse cursor into the eraser icon, using 

which we can erase or delete the desired border in the worksheet. 

o We can select the cells and go to Home > Clear > Clear Formatting. Although this method 

helps remove borders, it also removes other formatting like font color, background color, 

etc. Thus, this method may not be suitable in all conditions. 

Applying Shades in Excel 

Applying shades in Excel is as easy as creating borders. The following are the most commonly used 
methods for applying shades to an Excel cell or worksheet: 

Applying Shades from Ribbon 

The Ribbon provides quick access to Excel's existing tools, and it is very easy to apply color shades 
from the Ribbon area. We can perform the following steps and use any desired shade or 
background color for the cell: 

o First, we need to select the cells where we want to apply the shading. 

 

o After selecting the desired cells, we must navigate the Home tab and click the drop-down 

icon next to the 'Fill Color' option, as shown below: 

 

o Excel displays various colors under the Theme Colors and Standard Colors in the next 

window.  
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o We can click on any desired color, and the same will be immediately applied to the 

selected cell as a background color. 

 

o If we don't find the color we want, we can click on the 'More Colors' button from the 

window and choose any custom color accordingly. 
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o Applying Shades from Format Cells dialogue box 

We can use the Format Cells dialogue box to apply any desired color shades in Excel cells, like 
applying the border. We must select the cells, open the Format Cells dialogue box (Ctrl + 1), click 
the 'Fill' tab, and adjust the preference accordingly. The Fill tab contains the following sections or 
preference options: 

 

In the above dialogue box, we can apply or modify the color shades in various ways using different 
sections, such as: 

1. This section displays a set of pre-defined colors. We can select the desired color by clicking on 

the respective block. 

2. This section allows us to choose gradient-style shades. We can choose between one color or 

multi-color shades and gradient direction. 

3. This section enables us to choose the color that is not available within the displayed blocks. 

Using this section (button), we can create any custom color we want. 

4. This section allows us to choose the color for the pattern style we want to add along with the 

shades. 

5. This section contains various pattern styles that can be applied along with the selected color 

shades. This includes dotted gray patterns, horizontal and vertical lines, diagonals, diagonal 

crosshatches, etc. 

After adjusting the settings for the shades, we need to click on the OK button to close the dialogue 
box and apply the selected color shades to the desired cells within the worksheet. 

Deleting Shades in Excel 

When deleting or removing shades or background color of Excel cell(s), we can use any of the 
following methods: 

 First, we need to select the cells from which we wish to remove shades. Next, we must go 

to Home > Fill > No Fill. This will immediately remove the color shades from the selected 

Lovely Professional University98



Unit 04: Formatting Spreadsheets  

 

Notes 

cells. To remove colors from the entire sheet, we can use the keyboard shortcut 'Ctrl + A' to 

select all cells in the sheet, then choose 'No Fill'. To select specific cells, we can hold down 

the Ctrl key while clicking the corresponding cells. 

 If we have just applied the shades in the cell, we can click Undo (Ctrl + Z) to remove them. 

 We can select the cells and go to Home > Clear > Clear Formatting. Although this method 

helps remove color shading, it also removes other formattings like font color, border, etc. 

Thus, this method may not be suitable in all conditions. 

Border Colors 

• Colored borders are added by selecting a color before adding the border. 

• The color can be changed in the Border Color menu: 

 

 

Border Style 

• Borders styles can be changed. 
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• The menu is accessed in the Border Style menu. 

• Excel offers 6 different border styles: 

 Solid line 

 Dashed line 

 Dotted line 

 Medium line 

 Thick line 

 Double line 

 

 

4.3 Alignment Tools 

 By default, Microsoft Excel aligns numbers to the bottom-right of cells and text to the 

bottom-left.  

 However, you can easily change the default alignment by using the ribbon, keyboard 

shortcuts, Format Cells dialog or by setting your own custom number format. 

 

 

How to change alignment in Excel using the ribbon? 

• To change text alignment in Excel, select the cell(s) you want to realign, go to 
the Home tab > Alignment group, and choose the desired option: 
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Example of the Horizontal Alignments 

 

Example of the Vertical Alignments 

 

Vertical alignment 

If you'd like to align data vertically, click one of the following icons: 

•     Top Align -  aligns the contents to the top of the cell.  

•     Center Align -  centers the contents between the top and bottom of the cell. 

•      Bottom Align - aligns the contents to the bottom of the cell (the default one). 

Please note that changing vertical alignment does not have any visual effect unless you increase 
the row height. 

Horizontal alignment 

• To align your data horizontally, Microsoft Excel provides these options: 

•       Align Left - aligns the contents along the left edge of the cell. 
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•      Center - puts the contents in the middle of the cell. 

•       Align Right - aligns the contents along the right edge of the cell. 

 

Combining Vertical and Horizontal Alignment 

• By combining different vertical and horizontal alignments, you can arrange the cell 
contents in different ways, for example: 

 

Change Text Orientation (Rotate Text) 

• Click the Orientation button on the Home tab, in the Alignment group, to rotate text up or 
down and write vertically or sideways.  

• These options come in especially handy for labelling narrow columns: 

 

 

Indent text in a cell 

• In Microsoft Excel, the Tab key does not indent text in a cell like it does, say, in Microsoft 
Word; it just moves the pointer to the next cell. To change the indentation of the cell 
contents, use the Indent icons that reside right underneath the Orientation button. 

• To move text further to the right, click the Increase Indent icon. If you have gone too far 
right, click the Decrease Indent icon to move the text back to the left. 

 

How to align text in Excel using the Format Cells dialog? 
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• Another way to re-align cells in Excel is using the Alignment tab of the Format 
Cells dialog box. To get to this dialog, select the cells you want to align, and then either: 

• Press Ctrl + 1 and switch to the Alignment tab, or 

• Click the Dialog Box Launcher arrow at the bottom right corner of the Alignment. 

 

• In addition to the most used alignment options available on the ribbon, the Format 
Cells dialog box provides several less used (but not less useful) features: 

 

Text alignment options 

• Apart from aligning text horizontally and vertically in cells, these options allow you to 
justify and distribute the cell contents as well as fill an entire cell with the current data. 

How to fill cell with the current contents? 

• Use the Fill option to repeat the current cell content for the width of the cell.  

• For example, you can quickly create a border element by typing a period in one cell, 
choosing Fill under Horizontal alignment, and then copying the cell across several 
adjacent columns: 

 

How to justify text in Excel? 
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• To justify text horizontally, go to the Alignment tab of the Format Cells dialog box, and 
select the Justify option from the Horizontal drop-down list.  

• This will wrap text and adjust spacing in each line (except for the last line) so that the first 
word aligns with the left edge and last word with the right edge of the cell: 

 

 

Text control options 

• These options control how your Excel data is presented in a cell. 

• Wrap text - if the text in a cell is larger than the column width, enable this feature to 
display the contents in several lines. For more information, please see How to wrap text in 
Excel. 

• Shrink to fit - reduces the font size so that the text fits into a cell without wrapping. The 
more text there is in a cell, the smaller it will appear. 

• Merge cells - combines selected cells into one cell. For more information, please see How 
to merge cells in Excel without losing data. 

 

Changing Text Direction 

• The bottom-most section of the Alignment tab, named Right-to-left, controls the text 
reading order.  

• The default setting is Context, but you can change it to Right-to-Left or Left-to-Right.  

• In this context, "right-to-left" refers to any language that is written from right to left, for 
example Arabic.  

• If you don't have a right-to-left Office language version installed, then you will need to 
install an appropriate language pack. 

 

4.4 Number Formats 

What are number formats? 

• Whenever you're working with a spreadsheet, it's a good idea to use appropriate number 
formats for your data.  

• Number formats tell your spreadsheet exactly what type of data you're using, such as 
percentages (%), currency ($), times, dates, and so on. 

 

Why use number formats? 

Number formats don't just make your spreadsheet easier to read—they also make it easier to use. 
When you apply a number format, you're telling your spreadsheet exactly what kinds of values are 
stored in a cell. For example, the date format tells the spreadsheet that you're entering specific 
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calendar dates. This allows the spreadsheet to better understand your data, which can help ensure 
that your data remains consistent and that your formulas are calculated correctly. 

If you don't need to use a specific number format, the spreadsheet will usually apply 
the general number format by default. However, the general format may apply some small 
formatting changes to your data. 

 

Applying number formats 

Just like other types of formatting, such as changing the font color, you'll apply number formats by 
selecting cells and then choosing the desired formatting option. Every spreadsheet program allows 
you to add number formatting, but the process will vary depending on which application you're 
using: 

 For Microsoft Excel 2007-2019, go to the Home tab, click the Number Format drop-down 
menu in the Number group, and select the desired format. You can also click one of the 
quick number-formatting commands below the drop-down menu. 

 

 For Excel 2003 and earlier, go to Format > Cells. 

 For Google Sheets, click the More Formats button near the left side of the toolbar—this 
button will look like the numbers 123. To the left of the command, you can also click 
the Currency or Percent commands to quickly apply those formats. 

For most versions of Microsoft Excel, you can also select the desired cells and press Ctrl+1 on your 
keyboard to access more number-formatting options. 

In this example, we've applied the Currency number format, which adds currency symbols ($) and 
displays two decimal places for any numerical values. 
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If you select any cells with number formatting, you can see the actual value of the cell in the 
formula bar. The spreadsheet will use this value for formulas and other calculations. 

 

Using number formats correctly 

There's more to number formatting than selecting cells and applying a format. Spreadsheets can 
actually apply a lot of number formatting automatically based on the way you enter data. This 
means you'll need to enter data in a way the program can understand, and then ensure that those 
cells are using the proper number format. For example, the image below shows how to use number 
formats correctly for dates, percentages, and times: 

 

Now that you know more about how number formats work, we'll look at a few different number 
formats in action. 

 

Percentage formats 

One of the most helpful number formats is the percentage (%) format. It displays values as 
percentages, such as 20% or 55%. This is especially helpful when calculating things like the cost of 
sales tax or a tip. When you type a percent sign (%) after a number, the percentage number format 
will be be applied to that cell automatically. 
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As you may remember from math class, a percentage can also be written as a decimal. So 15% is the 
same thing as 0.15, 7.5% is 0.075, 20% is 0.20, 55% is 0.55, and so on. You can review this 
lesson from our Math tutorial to learn more about converting percentages to decimals. 

There are many times when percentage formatting will be useful. For example, in the images 
below, notice how the sales tax rate is formatted differently for each spreadsheet (5, 5%, and 0.05): 

 

As you can see, the calculation in the spreadsheet on the left didn't work correctly. Without the 
percentage number format, our spreadsheet thinks we want to multiply $22.50 by 5, not 5%. And 
while the spreadsheet on the right still works without percentage formatting, the spreadsheet in the 
middle is easier to read. 

Date formats 

Whenever you're working with dates, you'll want to use a date format to tell the spreadsheet that 
you're referring to specific calendar dates, such as July 15, 2014. Date formats also allow you to 
work with a powerful set of date functions that use time and date information to calculate an 
answer. 

Spreadsheets don't understand information the same way a person would. For instance, if you 
type October into a cell, the spreadsheet won't know you're entering a date so it will treat it like 
any other text. Instead, when you enter a date, you'll need to use a specific format your 
spreadsheet understands, such as month/day/year (or day/month/year depending on which 
country you're in). In the example below, we'll type 10/12/2014 for October 12, 2014. Our 
spreadsheet will then automatically apply the date number format for the cell. 
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Now that we have our date correctly formatted, we can do lots of different things with this data. 
For example, we could use the fill handle to continue the dates through the column, so a different 
day appears in each cell: 
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If the date formatting isn't applied automatically, it means the spreadsheet did not understand the 
data you entered. In the example below, we've typed March 15th. The spreadsheet did not 
understand that we were referring to a date, so this cell is still using the general number format. 

 

On the other hand, if we type March 15 (without the "th"), the spreadsheet will recognize it as a 
date. Since it doesn't include a year, the spreadsheet will automatically add the current year so the 
date will have all of the necessary information. We could also type the date several other ways, 
such as 3/15, 3/15/2014, or March 15 2014, and the spreadsheet would still recognize it as a date. 

 

Other Date Formatting Options 

Some programs have more date formatting options, which can change the way dates appear in 
your spreadsheet. Again, this process this may vary slightly based on the spreadsheet program 
you're using. To access these options in Excel 2007-2019, select the Number Format drop-down 
menu and choose More Number Formats. 
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A dialog box will appear. From here, you can choose the desired date formatting option. 

 

As you can see in the formula bar, a custom date format doesn't change the actual date in our cell—
it just changes the way it's displayed. 

 

Lovely Professional University110



Unit 04: Formatting Spreadsheets  

 

Notes 

Number Formatting Tips 

Here are a few tips for getting the best results with number formatting: 

 Apply number formatting to an entire column: If you're planning to use one column for a 
certain type of data, like dates or percentages, you may find it easiest to select the entire 
column by clicking the column letter and then applying the desired number formatting. 
This way, any data you add to this column in the future will already have the correct 
number format. Note that the header row usually won't be affected by number formatting. 

 

 Double-check your values after applying number formatting: If you apply number 
formatting to existing data, you may have unexpected results. For example, 
applying percentage (%) formatting to a cell with a value of 5 will give you 500%, not 5%. 
In this case, you'd need to retype the values correctly in each cell. 
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 If you reference a cell with number formatting in a formula, the spreadsheet may 
automatically apply the same number formatting to the new cell. For example, if you use a 
value with currency formatting in a formula, the calculated value will also use the 
currency number format. 

 

 If you want your data to appear exactly as entered, you'll need to use the text number 
format. This format is especially good for numbers you don't want to perform calculations 
with, such as phone numbers, zip codes, or numbers that begin with 0: for example, 
"02415". For best results, you may want to apply the text number format before entering 
data in those cells. 

Benefits of using Excel number formats 

Here are some benefits that users may experience when using Excel number format: 

 Makes information easy to understand: You can use Excel number formats to make the 
information within a spreadsheet easier to understand since you may view data in different 
layouts. 

 Keeps information the same: When rearranging the data using number formats, you can 
change the format of a spreadsheet while keeping the information the same. 

 Offers quicker organization: You may organize the data within your spreadsheet quicker 
by using the number format. The process provides automated formatting procedures, which 
allow you to select a number format you may use to sort your data automatically, rather 
than organizing it manually, which may take longer. 

 Provides a more professional look: Most number formats allow you to decide on the 
number of decimals that each cell value displays, which may give your spreadsheet a more 
professional, consistent and formatted look. 
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Summary 

 Formatting Excel sheets involves modifying the appearance and layout of the data in a 

spreadsheet. 

 Borders in MS Excel are used to create visual divisions between cells or ranges of cells. 

 Horizontal cell alignment refers to the positioning of text within a cell from left to right. 

 Vertical cell alignment determines the positioning of text within a cell from top to bottom. 

 Text control allows you to manipulate the display of text, such as making it bold, italic, or 

underlined. 

 Text orientation in Excel enables you to rotate or tilt the text within a cell to different 

angles. 

 Excel provides various number formats, such as currency, percentage, and date, to 

represent numeric values in different ways. 

 Number formats allow you to control decimal places, thousand separators, and other 

display options for numerical data. 

 Understanding number formats is important for presenting data accurately and in a 

visually appealing manner. 

 By mastering these Excel formatting techniques, you can enhance the readability and 

professionalism of your spreadsheets. 

 

Keywords 

 Formatting: Modifying the appearance and layout of data in a specific manner. 

 Excel sheets: Spreadsheets created and managed using Microsoft Excel software. 

 Borders: Lines or outlines that can be applied to cells or ranges in Excel to visually 

separate or highlight them. 

 Use: The purpose or function of something, in this case, the purpose and application of 

borders in MS Excel. 

 Horizontal: Referring to the left-to-right positioning of elements, such as text, within cells. 

 Cell alignment: The positioning of text or data within a cell, either horizontally or 

vertically. 

 Change: Modifying or adjusting the existing settings or attributes. 

 Text control: Manipulating the display of text within cells, such as applying formatting 

options like bold, italic, or underlined. 

 Text orientation: The angle or direction at which text is displayed within cells, allowing 

rotation or tilting of the text. 

 Number formats: The different ways in which numeric values can be displayed, such as 

currency, percentage, or date formats, in Excel. 

 

Self Assessment 

1. Which tool you will use to join some cells and place the content at the middle of joined cell? 

A. From Format Cells dialog box click on Merge Cells check box  

B. From Format Cells dialog box select the Centered alignment  

C. From Format Cells dialog box choose Merge and Center check box  

D. Click on Merge and Center tool on formatting toolbar 
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2. If you need a text to show vertically in a cell. How will you achieve this? 

A. Choose Vertical on Text alignment in Format Cells dialog box  

B. Choose 90 Degrees in Orientation of Format Cells dialog box  

C. Choose Distributed from the Vertical drop down list of Format Cells dialog box  

D. Choose Center Across Selection from Horizontal combo box in Format Cells dialog box  

 

3. Merge cells option can be applied from 

A. Format Cells dialog box Alignment Tab  

B. Formattingtoolbar  

C. Both of above 

D. None of above 

 

4. You can set page border in excel from: __________? 

A. From Border tab in Format Cells dialog box 

B. From Border tool in Formatting toolbar 

C. From Line Style tool in Drawing toolbar 

D. You can not set page border in Excel 

 

5. Which of the following format you can decide to apply or not in Auto format dialog box? 

A. Number format 

B. Border format 

C. Font format 

D. All of above 

 

6. How can you remove borders applied in cells? 

A. Choose None on Border tab of Format cells 

B. Open the list on Border tool in Format Cell toolbar then choose first tool (none) 

C. Both of above 

D. None of above 

 

7. You can set page border in excel from -  

A. From Border tab in Format Cells dialog box 

B. From Border tool in Formatting toolbar 

C. From Line Style tool in Drawing toolbar 

D. You can not set page border in Excel 

 

8. Tab scroll buttons are place on excel screen 

A. Towards the bottom right corner 

B. Towards the bottom left corner 

C. Towards the top right corner 

D. Towards the top left corner 

 

9. Formatting a cell in Number format you can’t set 
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A. Decimal Places        

B. Use 1000 separator   

C. Negative numbers  

D. Currency Symbol 

 

10. Which of the following format you can decide to apply or not in AutoFormat dialog box? 

A. Number format   

B. Border format   

C. Font format   

D. All of above 

 

11.It is used to display the worksheets attractive and legible manner. 

A. Editing 

B. Formatting 

C. Polishing 

D. None of these 

 

12. It refers to the position in which data is placed within the cell. 

A. Alignment  

B. Location                    

C. Destination                   

D. All of these 

 

13. It is the process of converting the selected cells into the one cell. 

A. Combining    

B. Mixing                         

C. Conversion                    

D. Merging 

 

14. In Excel, by default the sheets tabs colour is 

A. Black            

B. white                                         

C. yellow                            

D. Red 

 

15. This feature In Excel means formatting to the selected data gets applied only if the values of 

the cell meets the specified condition. 

A. Argument formatting 

B. Exceptional Formatting 

C. Conditional formatting 

D. All of the above 
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Answers for Self Assessment 

1. D 2. B 3. A 4. D 5. D 

6. C 7. D 8. B 9. D 10. D 

11. B 12. A 13. D 14. B 15. C 

 

Review Questions 

1. What is the process of formatting Excel sheets? 

2. How can borders be used in MS Excel, and what is their purpose? 

3. How can you change the horizontal cell alignment in Excel? 

4. How can you change the vertical cell alignment in Excel? 

5. What does text control refer to in Excel, and how can it be changed? 

6. How can you change the text orientation within cells in Excel? 

7. What is the significance of understanding different number formats in Excel? 

 

 
Further Readings 

• https://edu.gcfglobal.org/en/excel2013/formatting-cells/1/# 

• https://www.javatpoint.com/borders-and-shades-in-excel 

• https://www.educba.com/borders-in-excel/ 

• https://edu.gcfglobal.org/en/excelformulas/understanding-number-formats/1/# 

• https://www.indeed.com/career-advice/career-development/excel-number-
formats 
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Objectives 

• understand the use of Find and Replace Functions. 

• understand the use of text functions. 

• understand the use of filtering data. 

• understand the use of sorting data. 

• understand the use of conditional formatting. 

 

Introduction 

• The Find and Replace feature of Excel looks for a data value and replaces it with another 
data value.  

• This data value can be a text string, number, date or special character.  

• The Find and Replace feature can search within a worksheet or workbook, by rows or 
columns, and within formulas, values or comments. 

• For example, in a financial report of Excel, the text string “asset” may need to be replaced 
with “assets.” 

• The purpose of using the Find and Replace feature in Excel is to locate certain information 
in a database.  

• It also allows modifying the existing data values with a few clicks.  

• By default, the Find and Replace excel feature looks for a partial match. But, it can also 
look for an exact match if the option “match entire cell contents” is selected. 

 

5.1 How to Access the Find and Replace Feature of Excel? 

The shortcuts to the Find and Replace excel feature are stated as follows: 

Dr. Jaskiran Kaur, Lovely Professional University 
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 “Ctrl+F” opens the Find tab of the Find and Replace feature. 

 “Ctrl+H” opens the Replace tab of the Find and Replace feature. 

Alternatively, the “find” and “replace” options can be clicked from the “find & select” drop-down 
(“editing” group) of the Home tab. These options open the Find and Replace tabs of the Find and 
Replace feature of Excel. 

Let us consider some examples to understand the working of the Find and Replace feature of Excel. 

Example #1–Find a Partial Match in a Worksheet 

The following image shows two worksheets titled “Jan” and “Feb.” These worksheets contain 
datasets that report the sales made (column C) to different customers (column B) in January and 
February. 

The names of the products, cost of goods sold (COGS), profits, and regions are also displayed in 
columns A, D, E, and F respectively. A similar dataset (with different numbers) is in columns H to 
M as well. 

Find the name “Mitchel” in the worksheet “Jan.” Use the Find and Replace feature of Excel. 

The steps to use find and replace function in excel is follows: 

1. Go to the worksheet “Jan.” Next, press the keys “Ctrl+F” together. The Find tab of the 
“find and replace” dialog box opens. This is shown in the following image. 
 
Note: By default, Excel searches in the currently active worksheet. 

 

 

2. Type the word to be searched in the “find what” box. We type “Mitchel.” 

 
Note that this search is not case-sensitive. So, even if the worksheet contains “MITCHEL,” it will 

show up in the search results. 
 

 

3. Press either the “Enter” key or the “find next” option. The first occurrence of the name 
“Daniel Mitchel” is selected. So, cell B7 is selected, as shown in the following image. 
Clicking “find next” again and again selects the subsequent occurrences of “Mitchel.” 
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Notice that though we entered “Mitchel” in the “find what” box, Excel has selected the 
name “Daniel Mitchel.” This is called a partial match. It implies that if there are any 
additional words preceding or succeeding the search value, the entire string containing the 
search value is returned in the result. 

 

 

 

Click “find all” to see all the strings containing “Mitchel.” The results are shown in the 
following image. These results display the following information: 
The column “book” displays the name of the workbook containing the search value. 
The column “sheet” displays the name of the worksheet containing the search value. 
The column “cell” displays the reference of the cells containing the search value. 
The column “value” displays the entire string containing the search value. 
 
 

Notice that at the bottom of the dialog box, Excel displays the number of cells containing the 
search value. In this case, there are 8 cells in the worksheet “Jan,” which contain either “Mitchel” 
or “Daniel Mitchel.” 
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Difference between “find all” and “find next”: The “find all” option shows all the occurrences of 
the search value. Further, clicking any of the entries shown by this option takes the user to the 
corresponding cell. 

The “find next” option helps scan through the different cells containing the search value. Clicking 
“find next” for the first time selects the first occurrence of the search value. Likewise, clicking “find 
next” the second time selects the second occurrence of the search value, and so on. 

Example #2–Find a Partial Match in a Workbook 

Working on the dataset of example #1, find the name “Mitchel” in the entire workbook. Use the 
Find and Replace feature of Excel. 

The steps to search the stated string in the entire workbook are listed as follows: 

Step 1: Press the keys “Ctrl+F” together. The Find tab of the “find and replace” window opens. 
Type the name “Mitchel” in the “find what” box. 

Next, click “options,” shown within a black box in the following image. 

 

Step 2: Clicking “options” expands the “find and replace” dialog box. Click the drop-down next to 
the option “within” and select “workbook.” 

The selection is shown in the following image. 
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Step 3: Click “find all” to see all the results. The results are shown in the following image. This time 
the string “Mitchel” has been found in 16 cells of the workbook. 

Clicking any of the entries will select the respective cell. 

 

Example #3–Find an Exact Match in a Workbook 

Working on the dataset of example #1, find an exact match of “Mitchel” in the entire workbook. 
Use the Find and Replace feature of Excel. 

The steps to search the exact name in the entire workbook are listed as follows: 

Step 1: Press the keys “Ctrl+F.” In the Find tab of the “find and replace” window, perform the 
following tasks: 

 Click “options” to expand the “find and replace” window. 

 Enter the name “Mitchel” in the “find what” box. 

 Select “workbook” in the box adjacent to “within.” 
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 Select the checkbox of “match entire cell contents.” 

 Leave the “search” and “look in” parameters to default values which are “by rows” and 
“formulas” respectively. 

The name of the “find what” box and the selections are shown in the following image. 

Note: When the option “match entire cell contents” is selected, the Find and Replace excel feature 
looks for exactly those data values that have been entered in the “find what” box. 

 

Step 2: Click “find all” to view all the exact matches of the name “Mitchel.” In the current 
workbook, 8 cells contain the exact name. 

The results (shown in the following image) display the cell references, exact value, and the names 
of the worksheet and the workbook. 

 

 

Example #4–Replace the Range Reference of a Formula 
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The following image shows the names (column A), salaries per annum (in $ in column B), salaries 
per month (in $ in column C), and departments (column D) of some employees of an organization. 

The total salary per annum is shown in cell G3. This sum incorrectly considers the range B2:B10 in 
place of the range B2:B22. Rectify the range of the formulas in cells G3 and H3 so that the total 
salary per annum is calculated accurately. Use the Find and Replace feature of Excel. 

 

The steps to edit a formula by using the Find and Replace feature of Excel are listed as follows: 

Step 1: Copy the SUM formula of cell G3. For this, perform the given tasks: 

 Select cell G3. The formula [=SUM(B2:B10)] appears in the formula bar. 

 Copy this formula by pressing the keys “Ctrl+C” together. 

 Press the Escape (Esc) key once the formula has been copied. This will help exit the 
formula bar. 

Alternatively, copy the formula of cell H3 by pressing the keys “Ctrl+C.” Next, press “Ctrl+H.” 

Step 2: The Replace tab of the “find and replace” window opens. Paste the copied formula in the 
“find what” box, as shown in the following image. For pasting the formula, press the keys “Ctrl+V” 
together. 

Note: Instead of copying and pasting, one can type the formula directly in the “find what” box. 

 

Step 3: Enter the correct formula in the “replace with” box. So, type the formula “=SUM(B2:B22)” 
without the beginning and ending double quotation marks. This is shown in the following image. 
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Next, click “replace all.” 

 

Step 4: Click “Ok” in the message stating the number of replacements made. The formulas of cells 
G3 and H3 change from “=SUM(B2:B10)” to “=SUM(B2:B22).” As a result, the total salary per 
annum changes. 

The new output is shown within a red box in the following image. Hence, the total salary paid to 
the given 21 employees is $11,179,954 per annum. 

 

 

Example #5–Replace the Existing Text to Make Two Strings Identical 

There are two images titled “image 1” and “image 2.” Both images are in different worksheets. 
Further, the following information is given: 

 Image 1 shows the product code (column A) and prices (in $ in column B) of 21 products 
of a multinational organization. 

 Image 2 shows the product code (column A) and a blank column (column B) for the prices 
of the 21 products. 

Notice that the product codes of both images consist of some letters prefixed to a number. The 
letters are different in both images, but the subsequent numbers are the same. 

Make the product code identical in both images by using the Find and Replace feature of Excel. 
This will help fetch the prices of “image 1” in “image 2” (column B) with the VLOOKUP function. 
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The steps to make the product code identical by using the Find and Replace feature of Excel are 
listed as follows: 

Step 1: Press the keys “Ctrl+H” to open the Replace tab of the “find and replace” window. 
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Step 2: Enter “pdc” in the “find what” box. Enter “prdct” in the “replace with” box. Next, click 
“replace all.” A message stating the number of replacements made is displayed. Click “Ok” to 
proceed. 

The entries and the outputs are shown in the following image. Now, one can easily apply the 
VLOOKUP function to fetch the prices in this image. Had the replacements not been made, the 
VLOOKUP function could not have been applied. 

 

Difference between “replace all” and “replace”: The “replace all” option replaces all the 
occurrences of the search value in one go. In contrast, the “replace” option replaces one occurrence 
at a time. 

Therefore, use “replace” when not sure which occurrence needs to be replaced. Use “replace all” 
when all occurrences of the search value need to be replaced. 

Example #6–Replace the Old Formatting of a Cell 

The following image shows some departments of an organization. Cell A4 is in grey and cells B5, 
C2, and D5 are in blue. We want all the cells containing “marketing” to be in one color. 

Therefore, replace the grey color of cell A4 with blue color. Use the Find and Replace feature of 
Excel. 

 

The steps to change the formatting with the Find and Replace feature of Excel are listed as follows: 

Step 1: Select the dataset whose formatting needs to be changed. We have selected the range A2:D6. 
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Next, press the keys “Ctrl+H” to open the Replace tab of the “find and replace” window. In this 
tab, click “options” shown on the right side. 

This entire step is shown in the following image. 

Step 2: Once “options” is clicked, the “find and replace” window expands. Click the drop-down 
arrow of the first “format” option (to the right of the “find what” box). Next, select “choose format 
from cell.” 

The selection is shown within a black box in the following image. 

 

Step 3: Select the cell whose formatting needs to be changed. We select cell A4. As a result, the “no 
format set” on the left of “format” changes to “preview.” This “preview” option reflects the color of 
cell A4, as shown in the following image. 

Note: The “preview” option of the following image and cell A4 of the first image (at the beginning 
of this example) show a slight variation in color. Please ignore this variation, which may be due to 
different Excel versions being used to create images. 

 

Step 4: Click the drop-down arrow of the second “format” option (to the right of the “replace with” 
box). Select “choose format from cell” and click any of the blue cells (B5, C2 or D5). Consequently, 
the “preview” option appears in blue, as shown in the following image. 

Next, click “replace all.” 
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Step 5: Excel shows the number of replacements made. Click “Ok” to proceed. The output is shown 
in the following image. 

Hence, cell A4 has also been colored blue. In this way, the formatting of a cell can be searched and 
replaced. So, we have searched for the grey color and replaced it with the blue color. Now, all cells 
containing “marketing” are in a single color. 

Note: Alternatively, one can select the “format” option from both the “format” drop-downs. 
Thereafter, from the respective “fill” tabs, select the color to be searched and the color to be 
replaced with. 

 

 

Example #7–Find a Comment in a Worksheet 

The following image contains two datasets (range A1:D11 and range A13:D23) that show the gross 
sales (column B), cost of goods sold (COGS in column C), and profits (column D) of ten products of 
an organization. Further, the following information is given: 

 Both datasets pertain to different time periods. The figures in brackets in column D are the 
losses suffered by the organization. 

 In both datasets, each cell of column D contains comments. This is indicated by the small, 
red triangles at the top-right side of each cell. 

 There are three kinds of comments, namely, “no commission,” “commission @ 5%,” and 
“commission @ 10%.” 

Find the comment “no commission” in the current worksheet, which has been renamed 
“comment.” Use the Find and Replace feature of Excel. 
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The steps to search a specific comment by using the Find and Replace feature of Excel are listed as 
follows: 

Step 1: Open the Find tab of the “find and replace” dialog box. For this, press the keys “Ctrl+F” 
together. Next, click “options.” Make the following selections in this window: 

 Select “sheet” and “by rows” in the “within” and “search” parameters. These are the 
default selections of Excel. 

 Select the option “comments” from the drop-down of “look in.” 

The selection of the second pointer is shown within a black box in the following image. 
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Step 2: In the “find what” box, enter the string of the comment that needs to be searched. We have 
entered “no commission,” as shown in the following image. 

Next, click “find all.” 

 

Step 3: The search results are shown in the following image. Notice that 13 cells (refer to the bottom 
of the image) contain the comment “no commission.” 

The references to cells containing the specific comment (no commission) are displayed in the 
column “cell.” The formulas (of column D) and the names of the workbook and worksheet are 
displayed in columns “formula,” “book,” and “sheet” respectively. 

Clicking any of the entries of these results will select the cell containing the comment. 

 

The Key Points Related to the Find and Replace Feature of Excel 

The important points related to the Find and Replace feature of Excel are listed as follows: 

 The search can be limited to a specific range of the worksheet. For such restriction, select 
the range prior to opening the Find tab of the “find and replace” window. If no range is 
selected, Excel searches in the currently active sheet. If the search value cannot be found in 
the selected range or the active worksheet, a message stating the same is displayed. 
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 The replacements can also be restricted to a specific region of the worksheet. For this, 
select the area (or range) prior to opening the Replace tab of the “find and replace” 
window. If no range is selected, Excel makes the replacements in the entire active sheet. 

 The Find and Replace excel feature can replace the existing formatting of cells with the 
new formatting. For this, make use of the two “format” drop-downs of the Replace tab. 

 The search value can be looked up in a protected worksheet, but a replacement cannot be 
made. For replacing, unprotect the sheet first. 

 

5.2 Text Functions 

Excel is mostly about the numerical data, but at times you can come across the data which has too 
much text and that is the time when Text Functions in Excel will help you to simplify the things 
easily. 

 

Left() & Right() 

• You can use the Left function when you want to extract the leftmost characters from a 
string.  

• Syntax =left(text, num_char) or right(text, num_char) 

• Similarly, you can also use the Right function to extract the rightmost characters from a 
string. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Len() 

• Len function in Excel helps you to know the length of a string that is number of characters 
in a string.  

• Syntax = LEN(text) 

• Note: Spaces are included while calculating length. 

 

Lovely Professional University 131



Spreadsheet Modelling (Using Excel)  

 

Notes 

 

 

Mid () 

• Mid function in Excel is used to extract the characters from the middle of a string.  

• Syntax = MID(text, start_char, num_chars) 

 

 

Find () 

• Find function in Excel is used when you want to know the position of certain characters in 
a particular string.  

• Syntax =FIND(find_text, within_text,[start_num]) 

 

 

Proper () 

• Proper function in Excel capitalizes each word in the string that is, it converts the case into 
proper case.  

• Syntax =PROPER(Text) 
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Rept () 

• Rept function in Excel is used when you want a certain text to be repeated certain number 
of times. 

• Syntax =REPT(Text, number_times) 

 

 

Trim() 

• Trim function in Excel removes the unnecessary spaces from a particular string. 

• Syntax =TRIM(Text ) 

 

 

Upper() 

• Upper function in Excel converts the text into Upper case from lower case.  

• Syntax =UPPER(Text ) 
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Substitute () 

• Substitute function in Excel helps to replace existing text with a new text in a particular 
string. 

• Syntax =SUBSTITUTE(text, old_text, new_text, instance number) 

 

 

Concatenate () 

• Concatenate function in Excel helps to join the text of two or more cells.  

• Syntax =CONCATENATE(text1, text2,….) 

 

 

5.3 Filtering 

If your worksheet contains a lot of content, it can be difficult to find information quickly. Filters can 
be used to narrow down the data in your worksheet, allowing you to view only the information 
you need. 

• The filter in excel helps display relevant data by eliminating the irrelevant entries 
temporarily from the view.  

• The data is filtered as per the given criteria. The purpose of filtering is to focus on the crucial 
areas of a dataset.  

• For example, the city-wise sales data of an organization can be filtered by the location. 
Hence, the user can view the sales of selected cities at a given time. 
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• A filter is necessarily required when working with a huge database.  

• Being a widely used tool, the filter converts a comprehensive view into an easy-to-
understand one.  

• To apply filters, the dataset must contain a header row which specifies the name of every 
column. 

 

 

To filter data: 

In our example, we'll apply a filter to an equipment log worksheet to display only the laptops and 
projectors that are available for checkout. 

1. In order for filtering to work correctly, your worksheet should include a header row, 
which is used to identify the name of each column. In our example, our worksheet is 
organized into different columns identified by the header cells in row 
1: ID#, Type, Equipment Detail, and so on. 

 

2. Select the Data tab, then click the Filter command. 
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3. A drop-down arrow will appear in the header cell for each column. 

4. Click the drop-down arrow for the column you want to filter. In our example, we will 
filter column B to view only certain types of equipment. 

 

5. The Filter menu will appear. 

6. Uncheck the box next to Select All to quickly deselect all data. 
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7. Check the boxes next to the data you want to filter, then click OK. In this example, we will 
check Laptop and Projector to view only these types of equipment. 

 

8. The data will be filtered, temporarily hiding any content that doesn't match the criteria. In 
our example, only laptops and projectors are visible. 

 

Filtering options can also be accessed from the Sort & Filter command on the Home tab. 
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To apply multiple filters: 

Filters are cumulative, which means you can apply multiple filters to help narrow down your 
results. In this example, we've already filtered our worksheet to show laptops and projectors, and 
we'd like to narrow it down further to only show laptops and projectors that were checked out in 
August. 

1. Click the drop-down arrow for the column you want to filter. In this example, we will add 
a filter to column D to view information by date. 

 

2. The Filter menu will appear. 

3. Check or uncheck the boxes depending on the data you want to filter, then click OK. In 
our example, we'll uncheck everything except for August. 
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4. The new filter will be applied. In our example, the worksheet is now filtered to show only 
laptops and projectors that were checked out in August. 

 

 

To clear a filter: 

After applying a filter, you may want to remove—or clear—it from your worksheet so you'll be 
able to filter content in different ways. 

1. Click the drop-down arrow for the filter you want to clear. In our example, we'll clear the 
filter in column D. 
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2. The Filter menu will appear. 

3. Choose Clear Filter From [COLUMN NAME] from the Filter menu. In our example, we'll 
select Clear Filter From "Checked Out". 

 

 

4. The filter will be cleared from the column. The previously hidden data will be displayed. 
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To remove all filters from your worksheet, click the Filter command on the Data tab. 

 

 

Advanced filtering 

If you need a filter for something specific, basic filtering may not give you enough options. 
Fortunately, Excel includes several advanced filtering tools, including search, text, date, 
and number filtering, which can narrow your results to help find exactly what you need. 

To filter with search: 

Excel allows you to search for data that contains an exact phrase, number, date, and more. In our 
example, we'll use this feature to show only Saris brand products in our equipment log. 

1. Select the Data tab, then click the Filter command. A drop-down arrow will appear in the 
header cell for each column. Note: If you've already added filters to your worksheet, you 
can skip this step. 

2. Click the drop-down arrow for the column you want to filter. In our example, we'll filter 
column C. 
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3. The Filter menu will appear. Enter a search term into the search box. Search results will 
appear automatically below the Text Filters field as you type. In our example, we'll 
type saris to find all Saris brand equipment. When you're done, click OK. 

 

4. The worksheet will be filtered according to your search term. In our example, the 
worksheet is now filtered to show only Saris brand equipment. 
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To use advanced text filters: 

Advanced text filters can be used to display more specific information, like cells that contain a 
certain number of characters or data that excludes a specific word or number. In our example, we'd 
like to exclude any item containing the word laptop. 

1. Select the Data tab, then click the Filter command. A drop-down arrow will appear in the 
header cell for each column. Note: If you've already added filters to your worksheet, you 
can skip this step. 

2. Click the drop-down arrow for the column you want to filter. In our example, we'll filter 
column C. 

 

3. The Filter menu will appear. Hover the mouse over Text Filters, then select the desired 
text filter from the drop-down menu. In our example, we'll choose Does Not Contain... to 
view data that does not contain specific text. 
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4. The Custom AutoFilter dialog box will appear. Enter the desired text to the right of the 
filter, then click OK. In our example, we'll type laptop to exclude any items containing this 
word. 

 

5. The data will be filtered by the selected text filter. In our example, our worksheet now 
displays items that do not contain the word laptop. 
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To use advanced number filters: 

Advanced number filters allow you to manipulate numbered data in different ways. In this 
example, we'll display only certain types of equipment based on the range of ID numbers. 

1. Select the Data tab on the Ribbon, then click the Filter command. A drop-down arrow will 
appear in the header cell for each column. Note: If you've already added filters to your 
worksheet, you can skip this step. 

2. Click the drop-down arrow for the column you want to filter. In our example, we'll filter 
column A to view only a certain range of ID numbers. 

 

3. The Filter menu will appear. Hover the mouse over Number Filters, then select the 
desired number filter from the drop-down menu. In our example, we'll choose Between to 
view ID numbers between a specific number range. 
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4. The Custom AutoFilter dialog box will appear. Enter the desired number(s) to the right of 
each filter, then click OK. In our example, we want to filter for ID numbers greater than or 
equal to 3000 but less than or equal to 6000, which will display ID numbers in the 3000-
6000 range. 

 

5. The data will be filtered by the selected number filter. In our example, only items with an 
ID number between 3000 and 6000 are visible. 
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To use advanced date filters: 

Advanced date filters can be used to view information from a certain time period, such as last year, 
next quarter, or between two dates. In this example, we'll use advanced date filters to view only 
equipment that has been checked out between July 15 and August 15. 

1. Select the Data tab, then click the Filter command. A drop-down arrow will appear in the 
header cell for each column. Note: If you've already added filters to your worksheet, you 
can skip this step. 

2. Click the drop-down arrow for the column you want to filter. In our example, we'll filter 
column D to view only a certain range of dates. 

 

3. The Filter menu will appear. Hover the mouse over Date Filters, then select the desired 
date filter from the drop-down menu. In our example, we'll select Between... to view 
equipment that has been checked out between July 15 and August 15. 
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4. The Custom AutoFilter dialog box will appear. Enter the desired date(s) to the right of 
each filter, then click OK. In our example, we want to filter for dates after or equal to July 
15, 2015, and before or equal to August 15, 2015, which will display a range between these 
dates. 

 

5. The worksheet will be filtered by the selected date filter. In our example, we can now see 
which items have been checked out between July 15 and August 15. 

Lovely Professional University148



Unit 05: Data Analysis  

 

Notes 

 

 

5.4 Sorting 

As you add more content to a worksheet, organizing this information becomes especially 
important. You can quickly reorganize a worksheet by sorting your data. For example, you could 
organize a list of contact information by last name. Content can be sorted alphabetically, 
numerically, and in many other ways. 

Sorting data in MS Excel rearranges the rows based on the contents of a particular 

column. You may want to sort a table to put names in alphabetical order. Or, 

maybe you want to sort data by Amount from smallest to largest or largest to 

smallest. 

Types of sorting 

When sorting data, it's important to first decide if you want the sort to apply to the entire 
worksheet or just a cell range. 

Sort sheet organizes all of the data in your worksheet by one column. Related information across 
each row is kept together when the sort is applied. In the example below, the Contact 
Name column (column A) has been sorted to display the names in alphabetical order. 

 

 

 

Sort range sorts the data in a range of cells, which can be helpful when working with a sheet that 
contains several tables. Sorting a range will not affect other content on the worksheet. 
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To sort a sheet: 

In our example, we'll sort a T-shirt order form alphabetically by Last Name (column C). 

Select a cell in the column you want to sort by. In our example, we'll select cell C2. 

 

Select the Data tab on the Ribbon, then click the A-Z command to sort A to Z, or the Z-A 
command to sort Z to A. In our example, we'll sort A to Z. 
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The worksheet will be sorted by the selected column. In our example, the worksheet is now sorted 
by last name. 

 

To sort a range: 

In our example, we'll select a separate table in our T-shirt order form to sort the number of shirts 
that were ordered in each grade. 

Select the cell range you want to sort. In our example, we'll select cell range G2:H6. 

 

Select the Data tab on the Ribbon, then click the Sort command. 

 

The Sort dialog box will appear. Choose the column you want to sort by. In our example, we want 
to sort the data by the number of T-shirt orders, so we'll select Orders. 
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Decide the sorting order (either ascending or descending). In our example, we'll use Largest to 
Smallest. 

Once you're satisfied with your selection, click OK. 

 

The cell range will be sorted by the selected column. In our example, the Orders column will be 
sorted from highest to lowest. Notice that the other content in the worksheet was not affected by 
the sort. 

 

If your data isn't sorting properly, double-check your cell values to make sure they are entered into 
the worksheet correctly. Even a small typo could cause problems when sorting a large worksheet. 
In the example below, we forgot to include a hyphen in cell A18, causing our sort to be slightly 
inaccurate. 
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Custom sorting 

Sometimes you may find that the default sorting options can't sort data in the order you need. 
Fortunately, Excel allows you to create a custom list to define your own sorting order. 

To create a custom sort: 

In our example below, we want to sort the worksheet by T-Shirt Size (column D). A regular sort 
would organize the sizes alphabetically, which would be incorrect. Instead, we'll create a custom 
list to sort from smallest to largest. 

Select a cell in the column you want to sort by. In our example, we'll select cell D2. 

 
1. Select the Data tab, then click the Sort command. 
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The Sort dialog box will appear. Select the column you want to sort by, then choose Custom 
List... from the Order field. In our example, we will choose to sort by T-Shirt Size. 

 

The Custom Lists dialog box will appear. Select NEW LIST from the Custom Lists: box. 

Type the items in the desired custom order in the List entries: box. In our example, we want to sort 
our data by T-shirt size from smallest to largest, so we'll type Small, Medium, Large, and X-Large, 
pressing Enter on the keyboard after each item. 

 

Click Add to save the new sort order. The new list will be added to the Custom lists: box. Make 
sure the new list is selected, then click OK. 
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The Custom Lists dialog box will close. Click OK in the Sort dialog box to perform the custom sort. 

 

The worksheet will be sorted by the custom order. In our example, the worksheet is now organized 
by T-shirt size from smallest to largest. 
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Sorting levels 

If you need more control over how your data is sorted, you can add multiple levels to any sort. 
This allows you to sort your data by more than one column. 

To add a level: 

In our example below, we'll sort the worksheet by T-Shirt Size (Column D), and then 
by Homeroom Number (column A). 

Select a cell in the column you want to sort by. In our example, we'll select cell A2. 

 

Click the Data tab, then select the Sort command. 
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The Sort dialog box will appear. Select the first column you want to sort by. In this example, we 
will sort by T-Shirt Size (column D) with the custom list we previously created for the Order field. 

Click Add Level to add another column to sort by. 

 

 
 

Select the next column you want to sort by, then click OK. In our example, we'll sort by Homeroom 
# (column A). 
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The worksheet will be sorted according to the selected order. In our example, the orders are sorted 
by T-shirt size. Within each group of T-shirt sizes, students are sorted by homeroom number. 

 

If you need to change the order of a multilevel sort, it's easy to control which column is sorted first. 
Simply select the desired column, then click the Move Up or Move Down arrow to adjust its 
priority. 

 

 

 

5.5 Conditional Formatting 

Let's say you have a worksheet with thousands of rows of data. It would be extremely difficult to 
see patterns and trends just from examining the raw information. Similar to charts and 
sparklines, conditional formatting provides another way to visualize data and make worksheets 
easier to understand. 

• Conditional Formatting in Excel enables you to the cells with certain color depending on 
the condition.  
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• It is an excellent way to visualize data in a spreadsheet.  

• You can also create rules with your own custom formulas.  

• This guide will provide you with step-by-step examples of the most popular conditional 
formatting functions. 

Understanding conditional formatting 

Conditional formatting allows you to automatically apply formatting—such as colors, icons, 
and data bars—to one or more cells based on the cell value. To do this, you'll need to create 
a conditional formatting rule. For example, a conditional formatting rule might be: If the value is 
less than $2000, color the cell red. By applying this rule, you'd be able to quickly see which cells 
contain values less than $2000. 

 

To create a conditional formatting rule: 

In our example, we have a worksheet containing sales data, and we'd like to see which salespeople 
are meeting their monthly sales goals. The sales goal is $4000 per month, so we'll create a 
conditional formatting rule for any cells containing a value higher than 4000. 

1. Select the desired cells for the conditional formatting rule. 

 

2. From the Home tab, click the Conditional Formatting command. A drop-down menu will 
appear. 
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3. Hover the mouse over the desired conditional formatting type, then select the desired 
rule from the menu that appears. In our example, we want to highlight cells that 
are greater than $4000. 

 

4. A dialog box will appear. Enter the desired value(s) into the blank field. In our example, 
we'll enter 4000 as our value. 

5. Select a formatting style from the drop-down menu. In our example, we'll choose Green 
Fill with Dark Green Text, then click OK. 

 

6. The conditional formatting will be applied to the selected cells. In our example, it's easy to 
see which salespeople reached the $4000 sales goal for each month. 
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You can apply multiple conditional formatting rules to a cell range or worksheet, allowing you to 
visualize different trends and patterns in your data. 

 

 

Conditional formatting presets 

Excel has several predefined styles—or presets—you can use to quickly apply conditional 
formatting to your data. They are grouped into three categories: 

 Data Bars are horizontal bars added to each cell, much like a bar graph. 
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 Color Scales change the color of each cell based on its value. Each color scale uses a two- 
or three-color gradient. For example, in the Green-Yellow-Red color scale, 
the highest values are green, the average values are yellow, and the lowest values are red. 

 

 Icon Sets add a specific icon to each cell based on its value. 

 

To use preset conditional formatting: 

1. Select the desired cells for the conditional formatting rule. 

 

2. Click the Conditional Formatting command. A drop-down menu will appear. 

3. Hover the mouse over the desired preset, then choose a preset style from the menu that 
appears. 
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4. The conditional formatting will be applied to the selected cells. 

 

Removing conditional formatting 
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To remove conditional formatting: 

1. Click the Conditional Formatting command. A drop-down menu will appear. 

2. Hover the mouse over Clear Rules, and choose which rules you want to clear. In our 
example, we'll select Clear Rules from Entire Sheet to remove all conditional formatting 
from the worksheet. 

 

3. The conditional formatting will be removed. 

 

Click Manage Rules to edit or delete individual rules. This is especially useful if you've 
applied multiple rules to a worksheet. 
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Summary 

• Find and Replace Functions: These tools allow users to locate specific data within a 

worksheet or workbook and replace it with new values. Options like "Match case" help 

ensure precise replacements. 

• Text Functions: Excel offers various text functions to manipulate and analyze text strings. 
Examples include UPPER() to convert text to uppercase and CONCATENATE() for joining 
text. 

• Filtering Data: Data filtering helps users narrow down large datasets by displaying only the 
rows that meet specified criteria. Multiple criteria can be applied simultaneously for more 
precise results. 

• Sorting Data: Sorting arranges data in ascending or descending order based on one or more 
selected columns. It helps organize information and identify patterns easily. 

• Conditional Formatting: This feature allows users to apply formatting (e.g., colors, font 
styles) to cells based on predefined rules or formulas. It visually highlights data based on 
specific conditions. 

• Find and Replace Tip: To search for cells with a specific format, use the "Find All" button in 
the Find dialog box, and then click "Find Next" to cycle through the results. 

• Text Functions Tip: The LEFT(), RIGHT(), and MID() functions are valuable for extracting 
specific parts of a text string, such as the first characters, last characters, or a segment in the 
middle. 

• Filtering Data Tip: Advanced filtering allows users to extract unique records from a dataset, 
which is helpful when creating reports or summaries. 

• Sorting Data Tip: To sort data based on more than one column, use the "Sort" option and 
specify the column priority to arrange data accordingly. 

• Conditional Formatting Tip: To ensure that conditional formatting rules apply correctly, set 
the rule precedence by arranging rules in the desired order of execution. 

 

Keywords 

• Find and Replace Functions: Features in software applications (like Excel) that allow users 
to locate specific pieces of data and replace them with new values throughout a document 
or dataset. It helps streamline data modification and cleanup tasks. 

• Text Functions: Specialized formulas or functions within software (such as Excel) that 
enable users to manipulate and analyze text strings. These functions can perform 
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operations like extracting specific characters, joining strings, or converting text to different 
cases. 

• Filtering Data: The process of narrowing down a dataset based on specific criteria to 
display only the rows that meet those conditions. Filtering helps users focus on relevant 
information and simplifies data analysis. 

• Sorting Data: The process of arranging data in a specific order, typically based on the 
values in one or more columns. Sorting allows users to organize data systematically, 
making it easier to identify patterns and trends. 

• Conditional Formatting: A feature that allows users to apply formatting styles (e.g., colors, 
fonts) to cells based on predefined conditions or rules. It visually highlights data based on 
specific criteria, enhancing data visualization and analysis. 

 

Self Assessment 

1. While Finding and Replacing some data in Excel, which of the following statement is valid? 

A. You can Find and Replace within the sheet or workbook 

B. Excel does not have option to match case for find 

C. Both are valid 

D. None are valid 

 

2. Which of the following is not true about Find and Replace in Excel 

A. You can search for bold and replace with italics 

B. You can decide whether to look for the whole word or not 

C. You can search in formula too 

D. You can search by rows or columns or sheets 

 

3. How can you find specific information in a list? 

A. Select Tools > Finder from the menu 

B. Click the Find button on the standard toolbar 

C. Select Insert > Find from the menu 

D. Select Data > Form from the menu to open the Data Form dialog box and click the Criteria 
button 

 

4. What is the shortcut key to replace a data with another in sheet? 

A. Ctrl + R 

B. Ctrl + Shift + R 

C. Ctrl + H 

D. Ctrl + F 

 

5. Text formulas: 

A. Replace cell references 

B. Return ASCII values of characters 

C. Concatenate and manipulate text 

D. Show formula error value 
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6. How do you insert a row? 

A. Right-click the row heading where you want to insert the new row and select Insert from the 
shortcut menu 

B. Select the row heading where you want to insert the new row and select Edit >Row from the 
menu 

C. Select the row heading where you want to insert the new row and click the Insert Row button 
on the standard toolbar 

D. All of the above 

 

7 If you need a text to show vertically in a cell. How will you achieve this? 

A) Choose Vertical on Text alignment in Format Cells dialog box 

B) Choose 90 Degrees in Orientation of Format Cells dialog box 

C) Choose Distributed from the Vertical drop down list of Format Cells dialog box 

D) Choose Center Across Selection from Horizontal combo box in Format Cells dialog box 

 

8. You can automatically adjust the size of text in a cell if they do not fit in width by 

A) Double clicking on the right border of column header 

B) From Format choose Columns and then Autofit Selection 

C) From Format Cells dialog box mark Shrink to fit check box 

D) All of above 

 

9. What is entered by the function =today() 

A) The date value for the day according to system clock 

B) The time value according to system clock 

C) Today’s date as Text format 

D) All of above 

 

10. Long text can be broken down into many lines within a cell. You can do this through 

A) Wrap Text in Format >> Cells 

B) Justify in Edit >> Cells 

C) Text Wrapping in Format >> Cells, Layout tab 

D) All of above 

 

11. Borders can be applied to 

A) Cells 

B) Paragraph 

C) Text 

D) All of above 

 

12. How do you rearrange the data in ascending or descending order? 
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A. Data Sort 

B. Data Form 

C. Data Table 

D. Data Subtotals 

 

13. You can check the conditions against __________ when applying conditional formatting 

A. Cell value 

B. Formula 

C. Both of above 

D. None of above 

 

14. Which of the following is not true regarding Conditional Formatting? 

A. You can add more than one condition to check 

B. You can set condition to look for Bold and apply Italics on them 

C. You can apply Font border and pattern formats that meets the specified conditions 

D. You can delete any condition from Conditional Formatting dialog box if it is not required 

 

15. Thick Borders cannot be applied in MS Excel 

A. True 

B. False 

 

Answers for Self Assessment 

1. A 2. A 3. D 4. C 5. C 

6. A 7. B 8. C 9. A 10. D 

11. D 12. A 13. C 14. B 15. B 

 

Review Questions 

1. How can you access the Find and Replace dialog box in Microsoft Excel? 

2. What is the purpose of using the "Match case" option in the Find and Replace function? 

3. Explain the difference between finding and replacing values in a specific range versus the 

entire worksheet. 

4. How can you convert a text string to uppercase in Excel using a text function? 

5. What is the function of the CONCATENATE function, and how is it different from the "&" 

operator for combining text strings? 

6. How do you extract a specific portion of a text string using the MID function in Excel? 

7. What is data filtering, and how does it help in data analysis? 

8. How can you apply multiple criteria simultaneously to filter data in Excel? 

9. Explain the difference between filtering data and sorting data in terms of their purposes 

and outcomes. 
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10. How can you sort data in Excel based on multiple columns, and what is the significance of 

the sort order (ascending vs. descending)? 

11. What is conditional formatting, and how can it be used to highlight specific cells in Excel? 

12. How do you create a custom conditional formatting rule based on a formula? 

13. Is it possible to apply more than one conditional formatting rule to a single cell, and if so, 

how is the precedence determined? 

 

 
Further Readings 

• https://www.wallstreetmojo.com/excel-find-and-replace/#popmake-95356 

• https://www.edupristine.com/blog/text-functions-excel 

• https://www.excelfunctions.net/excel-text-functions.html 

• https://edu.gcfglobal.org/en/excel/filtering-data/1/# 

• https://www.wallstreetmojo.com/add-filter-in-excel/ 

• https://edu.gcfglobal.org/en/excel2016/sorting-data/1/# 

• https://www.tutorialspoint.com/excel/excel_data_sorting.htm 
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Unit 06: Spreadsheet Printing 
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Objectives 

After this unit you will be able to -  

 Understand the concept and use of printing in MS-Excel. 

 Understand the concept and use of print preview, orientation, margins, scaling,  headers and 

footers in MS-Excel. 

 

Introduction 

Living in a digital world, we still need a printed copy every now and then. At first sight, printing 
Excel spreadsheets is super easy. Just click the Print button, right? In reality, a well-organized and 
beautifully formatted sheet that looks great on a monitor is often a mess on a printed page. This is 
because Excel worksheets are designed for comfortable viewing and editing on screen, not to fit on 
a sheet of paper. 

 

How to print Excel spreadsheet 

For starters, we will provide high-level instructions on how to print in Excel. And then, we will 
have a closer look at the most important and useful features. 

To print an Excel worksheet, this is what you need to do: 

1. In your worksheet, click File > Print or press Ctrl + P. This will get you to the Print 

Preview window. 

2. In the Copies box, enter the number of copies you want to get. 

3. Under Printer, choose which printer to use. 

4. Under Settings, specify exactly what to print and configure the page margins, orientation, 

paper size, etc. 

5. Click the Print button. 

 

 

 

Dr. Jaskiran Kaur, Lovely Professional University 
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Choose what to print: selection, sheet or entire workbook 

To tell Excel which data and objects should be included in the printout, under Settings, click the 
arrow next to Print Active Sheets, and choose one of these options: 
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Below you will find a brief explanation of each setting shown in the screenshot above and how to 
correctly use them. 

Print selection / range 

To print only a specific range of cells, highlight it on the sheet, and then choose Print Selection. To 
select non-adjacent cells or ranges, hold the Ctrl key while selecting. 

Print entire sheet(s) 

To print the entire sheet that you currently have open, pick Print Active Sheets. 

To print multiple sheets, click on the sheet tabs while holding the Ctrl key, and then choose Print 
Active Sheets. 

Print entire workbook 

To print all sheets in the current workbook, select Print Entire Workbook. 

Print Excel table 

To print out an Excel table, click any cell within your table, and then choose Print Selected Table. 
This option appears only when the table or its part is selected. 

How to print the same range in multiple sheets 

When working with identically structured worksheets, such as invoices or sales reports, you will 
obvious want to print the same rage in all the sheets. Here's the fastest way to do this: 

1. Open the first sheet and select the range to print. 

2. While holding the Ctrl key, click on other sheet tabs to be printed. To select adjacent sheets, 
click the first sheet tab, hold the Shift key and click the last sheet tab. 

 

3. Click Ctrl + P and choose Print Selection in the drop-down list right under Settings. 

4. Click the Print button. 

Tip. To make sure Excel is going to print the data you want, check the number of pages at the 
bottom the Preview section. If you selected just one range per sheet, the number of pages should 
match the number of selected sheets. If two or more ranges are selected, each will be printed on a 
separate page, so you multiply the number of sheets by the number of ranges. For full control, use 
the right and left arrows to go through each printable page preview. 
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Tip. To set the print area in multiple sheets, you can use these Print Area macros. 

How to print Excel spreadsheet on one page 

By default, Excel prints sheets at their actual size. So, the bigger your worksheet, the more pages it 
will take. To print an Excel sheet on one page, choose one of the following Scaling options that 
reside at the end of the Settings section in the Print Preview window: 

 Fit Sheet on One Page – this will shrink the sheet so that it fits on one page. 

 Fit All Columns on One Page – this will print all the columns on one page while the rows may 
be split across several pages. 

 Fit All Rows on One Page – this will print all the rows on one page, but the columns may 
extend to multiple pages. 

To remove scaling, choose No Scaling in the list of options. 
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Please be very careful when printing on one page – in a huge sheet, your printout may become 
unreadable. To check how much scaling will actually be used, click Custom Scaling Options… . This 
will open the Page Setup dialog box, where you look at the number in the Adjust to box: 
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If the Adjust To number is low, a printed copy will be difficult to read. In this case, the following 
adjustments might be useful: 

 Change page orientation. The default Portrait orientation works well for worksheets that have 
more rows than columns. If your sheet has more columns than rows, change the page 
orientation to Landscape. 

 Adjust margins. The smaller the margins, the more room there will be for your data. 

 Specify the number of pages. To print an Excel spreadsheet on a predefined number of pages, 
on the Page tab of the Page Setup dialog, under Scaling, enter the number of pages in both Fit 
to boxes (wide and tall). Please note that using this option will ignore any manual page 
breaks. 

Print to file – save the output for later use 

Print to File is one of the most rarely used Excel print features underestimated by many. In short, 
this option saves output to a file instead of sending it to a printer. 

Why would you want to print to file? To save time when additional printed copies of the same 
document are needed. The idea is that you configure the print settings (margins, orientation, page 
breaks, etc.) only once and save the output to a .pdf document. Next time you need a hard copy, 
simply open that .pdf file and hit Print. 

Let's have a look at how that works: 

1. On the Page Layout tab, configure the required print settings and press Ctrl + P. 

2. In the Print Preview window, open the Printer drop-down list, and select Print to File. 

3. Click the Print button. 

4. Choose where to save a .png file containing the output. 
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Print preview in Excel 

It's always a good idea to preview outputs before printing to avoid unexpected results. There are a 
couple of ways to access print preview in Excel: 

 Click File > Print. 

 Press the print preview shortcut Ctrl + P or Ctrl + F2. 

Excel Print Preview is an extremely helpful tool in terms of saving your paper, ink and nerves. It 
not only shows exactly how your worksheets will look on paper, but also allows making certain 
changes directly in the preview window: 

 To preview the next and previous pages, use the right and left arrows at the bottom of the 
window or type the page number in the box and hit Enter. The arrows only appear when a 
selected sheet or range contains more than one printed page of data. 

 To display page margins, click the Show Margins button in the bottom-right corner. To make 
the margins wider or narrower, simply drag them using the mouse. You can also adjust 
the column width by dragging the handles at the top or bottom of the print preview window. 

 Though Excel Print Preview does not have a zoom slider, you can use a common shortcut Ctrl 
+ scroll wheel to do a little zooming. To get back to the original size, click the Zoom to 
Page button in the lower-right corner. 
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To exit Print Preview and return to your worksheet, click the arrow in the top-left corner of the Print 
Preview window. 

Excel print options and features 

The most frequently used print settings are available in the Print Preview window discussed above. 
Even more options are provided on the Page Layout tab of the Excel ribbon: 
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Apart from configuring page margins and paper size, here you can insert and remove page breaks, 
set print area, hide and show gridlines, specify the rows and columns to repeat on each printed 
page, and more. 

Advanced options for which there is no space on the ribbon are available in the Page Setup dialog 
box. To open it, click the dialog launcher  in the Page Setup group on the Page Layout tab. 

 

Note. The Page Setup dialog box can also be opened from the Print Preview window. In this case, 
some of the options, for example Print area or Rows to repeat at top, may be disabled. To enable these 
features, open the Page Setup dialog from the Page Layout tab. 

Excel print area 

To ensure that Excel prints a specific part of your spreadsheet and not all the data, set the print 
area. Here's how: 

1. Select one or more ranges that you want to print. 

2. On the Page Layout tab, in the Page Setup group, click Print Area > Set Print Area. 

 

The Print Area setting is saved when you save the workbook. So, whenever you print this 
particular sheet, a hard copy will only include the print area. 

For more information, please see How to set print area in Excel. 
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How to add a print button to Excel Quick Access Toolbar 

If you frequently print in Excel, it may be convenient to have the Print command on the Quick 
Access Toolbar. For this, just do the following: 

1. Click the Customize Quick Access Toolbar button (the down arrow at the far-right of the Quick 
Access toolbar). 

2. In the list of the displayed commands, select Print Preview and Print. Done! 

 

 

6.1 How to Insert Page Breaks in Excel 

When printing a huge spreadsheet, you can control how the data is split over multiple pages by 
inserting page breaks. Here's how it works: 

1. Click on the row or column that you want to move to a new page. 

2. On the Page Layout tab, in the Page Setup group, click Breaks > Insert Page Break. 

A page break is inserted. To visually see what data falls on different pages, switch to the View tab 
and enable Page Break Preview. 
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If you'd like to change the position of a certain page break, move it wherever you want by dragging 
the break line. 

For more information, please see How to insert and remove page breaks in Excel. 

How to print formulas in Excel 

To get Excel to print formulas instead of their calculated results, you just need to show formula in a 
worksheet, and then print it as usual. 

To have it done, switch to the Formulas tab, and click the Show Formulas button in the Formula 
Auditing group. 

 

 

How to print a chart in Excel 

To print only a chart without worksheet data, select the chart of interest and press Ctrl + P. In 
the Print Preview window, you will see a chart preview on the right and the Print Selected 
Chart option selected under Settings. If the preview looks as desired, click Print; otherwise adjust 
the settings:  
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Tips and notes: 

 To print all the contents of a sheet including the chart, press Ctrl + P without selecting 
anything on the sheet, and make sure the Print Active Sheets option is chosen under Settings. 

 It's not possible to adjust the scaling of a chart in the Print Preview window. If you wish the 
printed chart to fit the full page, resize your graph to make it bigger. 

 

How to print gridlines in Excel 

By default, all worksheets are printed without gridlines. If you want to print Excel spreadsheet with 
lines between your cells, here's what you need to do: 

1. Switch to the Page Layout tab. 

2. in the Sheet Options group, under Gridlines, check the Print box. 

 

What to change the printed gridlines color? The detailed instructions can be found in How to make 
Excel print gridlines. 

 

How to print titles in Excel 

In a multi-page Excel sheet, understanding what this or that data means can be tricky. The Print 
Titles feature lets you show the column and row headers on every printed page, which will make 
reading a printed copy a lot easier. 

To repeat header row or header column on every printed page, carry out these steps: 

1. On the Page Layout tab, in the Page Setup group, click Print Titles. 

2. On the Sheet tab of the Page Setup dialog box, under Print titles, specify which rows to repeat at 
top and/or which columns to repeat at left. 

3. When done, click OK. 
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For more information, please see How to print row and column headers on every page. 

 

How to print comments in Excel 

In case your notes are no less important than the spreadsheet data, you may want to get comments 
on paper too. For this, do the following: 

1. On the Page Layout tab, in the Page Setup group, click the dialog launcher (a small arrow in the 
lower-right corner of a group). 

2. In the Page Setup window, switch to the Sheet tab, click the arrow next to Comments and 
choose how you want them printed: 
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6.2 Print Preview and Adjustments, Orientation, Margins and Scale, 
Headers and Footers 

When the report or data is ready, we usually send the data online to the user. However, there is a 
situation where we need to share offline with the users by printing them. In such cases, you need to 
know how to print a large amount of data. 

1. Assume you have a large amount of data like the below. 

 

 

2. To print this, first select the entire data. 

 

3. Then, press the excel shortcut key “Ctrl + P.” 

4. It will take us to the window below. 
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5. We can see two slabs in the above image. The left side is “Print Setting Options,” and the right 

is the “Print Preview” window. 

We can see one more slab at the bottom, showing how many sheets it will print. The above says 1 of 
36, i.e., out of 36 sheets, a print preview is visible for the 1st sheet. 

Now, look at the data headers and compare them with “Print Preview.” 

 

6. We have a 11 headers in our data. Below are the headers in order. 

“First_name,” “Last_name,” “Company_name,” “Address,” “City,” “County,” “State,” “Zip,” 
“Phone1,” “Phone2,” and “Email.” 

When we print this data, we usually expect the data to come in a single sheet only. But look at the 
“Print Preview” now. 
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Out of 11 headers, we could see only 4 headers. After printing these columns first, then it will print 
the remaining columns. After we get all the print copies, we need to arrange them in order. 

Setup the Page to Preview Print 

To set the page first, select the data first, then go to Page Layout >> Print Area >> Set Print Area. 

 

It will set what the area we are going to print is. Now, press “Ctrl + P” once again to see the “Print 
Preview.” 
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We can still see the same view. The problem here is we could be able to see only 4 columns out of 
11 columns. So, we need to set the setting as “Fit All Column on One Page” under page scaling. 

Click on the “No Scaling” dropdown list to view all the options. 

 

Select “Fit All Columns on One Page” to fit all the columns on one page. 
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Now, it has fitted all the columns under one page. Since the data is large, it has trimmed the size of 
the fonts to very small. 
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Even though we printed this, we could not be able to read the contents, so how do we overcome 
this issue now? 

To adjust the scaling, we need to change the page’s orientation from “Portrait” to “Landscape.” 
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Now, we can read the contents a little better than the previous one. 

 

Now, the total pages have been reduced from 36 to 13. 

Like this option, we can set up the print area, adjust columns, decide on the page’s orientation, and 
do many other settings with the help of the Excel “Print Preview” option. 
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Summary 

 Page Setup: Before printing in Microsoft Excel, users should set up the page according to their 

needs. This includes configuring page orientation (portrait or landscape), margins, and paper 

size through the Page Layout tab. 

 Print Preview: Excel provides a Print Preview feature, allowing users to see how the 

spreadsheet will look when printed. It helps identify and rectify potential layout issues. 

 Page Scaling: Page scaling allows users to adjust the size of the spreadsheet content to fit the 

available paper size. This is helpful when dealing with larger or smaller data sets. 

 Headers and Footers: Excel allows for customization of headers and footers, where you can 

include information like page numbers, titles, and dates. These elements provide context and 

professionalism to printed documents. 

 Gridlines and Formulas: Users can choose whether to include gridlines and formulas in their 

printed spreadsheets. Gridlines help with data alignment, while printing formulas can be 

useful for reference. 

 Repeat Rows/Columns: To improve readability, Excel enables users to repeat specific rows or 

columns on each printed page, such as column or row headers. 

 Print Options: Excel offers various print options, like selecting a specific print area, setting the 

number of copies, and choosing the printer. Users should review these settings in the Print 

dialog box before confirming the print job. 

 

Keywords 

 Print Preview: Spreadsheet software offers a Print Preview feature, allowing users to preview 
and fine-tune the layout of their printouts before sending them to the printer. This feature 
helps ensure that the printed document will appear as expected. 

 Page Orientation: Page orientation determines whether the printed page is in portrait 
(vertical) or landscape (horizontal) format. Selecting the appropriate orientation can optimize 
the presentation of your data. 

 Page Margins: Page margins specify the space between the content and the edges of the 
printed page. Adjusting margins can impact the aesthetics and readability of the document. 

 Page Scale: Page scaling enables users to adjust the size of the printed content, making it 
larger or smaller to fit within the available space. This feature is useful when trying to fit a 
large spreadsheet onto a single page or when printing at a specific scale. 

 Headers and Footers: Headers and footers are areas at the top and bottom of printed pages 
where you can include information such as page numbers, titles, dates, and custom text. They 
help provide context and professionalism to printed documents. 

 

Self Assessment 

1. What is the primary purpose of the Print Preview feature in spreadsheet software? 

A. To print the spreadsheet 

B. To adjust the page orientation 

C. To view and customize the print layout before printing 

D. To set page margins 

 

2. Which option allows you to change the size of the printed spreadsheet to fit on a specific 

number of pages? 

A. Page orientation 

B. Margins 
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C. Page scale 

D. Headers and footers 

 

3. Which of the following is not a common page orientation in spreadsheet printing? 

A. Landscape 

B. Portrait 

C. Square 

D. Legal 

 

4. What do page margins determine in spreadsheet printing? 

A. The font size of the content 

B. The space between the header and footer 

C. The space around the edges of the printed page 

D. The alignment of text 

 

5. Which feature in spreadsheet software allows you to add information, such as page 

numbers and titles, at the top and bottom of printed pages? 

A. Headers and footers 

B. Page orientation 

C. Page margins 

D. Page scale 

 

6. What does adjusting the page scale in the print settings do? 

A. Changes the paper size 

B. Increases or decreases the size of the printed content 

C. Sets the print area 

D. Adjusts the page orientation 

 

7. In spreadsheet printing, what does the term "landscape" refer to? 

A. The printout of a beautiful landscape picture 

B. The orientation of the page where the width is greater than the height 

C. The use of green ink for printing 

D. The inclusion of footer information 

 

8. If you want to print a spreadsheet with more columns on a single page, which setting 

should you adjust? 

A. Page orientation 

B. Page margins 

C. Page scale 

D. Headers and footers 

 

9. Which of the following is not typically found in the headers and footers of a printed 

spreadsheet? 

A. Page numbers 

B. Date and time 

C. Cell formulas 

D. Title of the document 
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10. What is the default page orientation for most spreadsheet applications? 

A. Portrait 

B. Landscape 

C. Square 

D. Legal 

 

11. What does increasing the top and bottom margins in a spreadsheet do? 

A. Widens the page 

B. Increases the content size 

C. Adds more space between the header and footer 

D. Adjusts the page orientation 

 

12. In spreadsheet printing, what is the purpose of setting the paper size? 

A. To determine the color of the paper 

B. To specify the dimensions of the paper being used for printing 

C. To change the font size 

D. To adjust the page scale 

 

13. Which option allows you to include a company logo and contact information in the header 

of a printed spreadsheet? 

A. Page orientation 

B. Page margins 

C. Page scale 

D. Headers and footers 

 

14. What does the "Fit to Page" option typically do in spreadsheet printing? 

A. Adjusts the content to fit the page size 

B. Changes the paper color 

C. Sets the page orientation 

D. Changes the font style 

 

15. In the context of headers and footers in spreadsheet printing, what does the term "center 

alignment" refer to? 

A. Placing the header and footer content in the middle of the page 

B. Adjusting the page orientation 

C. Changing the font style 

D. Including company information 

 

Answers for Self Assessment 

1. C 2. C 3. C 4. C 5. A 

6. B 7. B 8. C 9. C 10. A 

11. C 12. B 13. D 14. A 15. A 
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Review Questions 

1. What is the primary purpose of the Print Preview feature in spreadsheet software? 

2. How does page orientation affect the layout of a printed spreadsheet? 

3. Why are page margins important in spreadsheet printing, and how can you adjust them? 

4. What does adjusting the page scale in spreadsheet printing allow you to do? 

5. How do headers and footers enhance the quality of printed spreadsheets? 

6. What is the default page orientation for most spreadsheet applications? 

7. When might you want to increase the top and bottom margins when printing a spreadsheet? 

8. Explain how you can customize the content in headers and footers for a printed spreadsheet. 

9. How does the "Fit to Page" option typically work in spreadsheet printing? 

10. Why is it essential to use the Print Preview function before printing a spreadsheet? 

 

 
Further Readings 

 https://www.ablebits.com/office-addins-blog/print-excel-spreadsheet/ 

 https://edu.gcfglobal.org/en/excel-tips/5-tips-for-printing-excel-spreadsheets/1/ 

 https://www.educba.com/print-in-excel/ 

 https://www.wallstreetmojo.com/print-in-excel/ 

 https://www.wallstreetmojo.com/print-preview-in-excel/ 

 https://www.ablebits.com/office-addins-blog/excel-header-footer-add-change-

remove/ 

 

 

 

Lovely Professional University 193



Unit 07: Charts and Graphs  

 

Notes 

Unit 07: Charts and Graphs 

CONTENTS 

Objectives 

Introduction 

7.1 Basic Chart Types 

7.2 Move and Resize Charts 

7.3 Change Chart Styles and Types 

7.4 Modification in Chart Elements 

Summary 

Keywords 

Self Assessment 

Answers for Self Assessment 

Review Questions 

Further Readings 

 

Objectives  

 To understand charts offered by MS-Excel 

 To gain insight to moving and resizing charts 

 To know how to change chart styles and types 

 To learn modification in chart elements 

 

Introduction 

It is sometimes difficult to interpret the Excel data due to complexity and size of data. So, charts are 
a way to represent the data graphically and interpret the data easily. Charts are the visual 
representation of data. 

Excel provides charts to take advantage of graphical representation. The data represented through 
charts is more understandable than the data stored in an Excel table. This makes the process of 
analyzing data fast. Excel users can fast analyze the data. 

Graphical representation of data using charts makes complex data analysis easier to understand. 
Excel has a variety of charts, each with its own different functionality and representation style. 

 

7.1 Basic Chart Types 

Excel offers many charts to represent the data in different manners, such as - Pie charts, Bar charts, 
Line charts, Stock charts, Surface charts, Radar charts, and many more. You can use them according 
to your data and analysis. 

There is a list of basic and advanced level of charts used for different purposes to interpret the data. 

Column Chart 

Line Chart 

Bar Chart 

Area chart 

Pie chart or Doughnut chart 

Dr. Jaskiran Kaur, Lovely Professional University 
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Surface chart 

These are the most used charts of Excel that an Excel user usually requires. 

Microsoft Excel introduce one newer chart called Tree map chart for 2016 and newer version. It has 
come with some advanced features and representation styles. 

We will illustrate each chart and its functionality with an example in this chapter. Learn carefully 
and use them accordingly. 

Column Charts 

A column chart is basically a vertical chart that is used to represent the data in vertical bars. It 
works efficiently with different types of data, but it is usually used for comparing the information. 

 

For example, a company wants to see each month sell graphically and also wants to 
compare them. Column charts are best for it that help to analyze and compare each 
month's data with each other. 

 

 

Line Chart 

Line charts are most useful for showing trends. Using this chart, you can easily analyze the ups and 
downs in your data over time. In this chart, data points are connected with lines. 
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For example, a company wants to analyze the sell of products for the last five years 
graphically. Additionally, it also wants to analyze the ups and downs of each year 
product sell. 

Bar chart 

Bar charts are horizontal bars that work like column charts. Unlike column charts, Bar charts are 
horizontally plotted. Or you can say that bar charts and column charts are just opposite to each 
other. 

For example, a company uses the bar chart to analyze the data through vertical bars to represent the 
data graphically. You can see as well as compare the values to each other, respective to data. 

 

Area chart 

Area charts are just like line charts. Unlike the line charts, gaps are filled with color in area charts. 
Area charts are easy to analyze the growth in business as its shows ups and downs through line. 

 

Similar to the line charts, data points in area charts are connected with lines. 

Pie chart 
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A pie chart is a rounded shape graph that is divided into slices of pie. Using this chart, you can 
easily analyze data that is divided into slices. It makes the data easy to compare the proportion. 

 

Pie charts make it easy to analyze which values make up the percentage of whole. Pie chart is also 
known as Doughnut chart. Excel offers 2D and 3D pie charts. 

 

Surface chart 

Surface chart is actually a 3D chart that helps to represent the data into a 3D landscape. These 
charts are best to use with a large dataset. This chart allows to displaying a variety of data at the 
same time. 

 

A large dataset is not easy to represent using other charts. Surface chart solve this problem that 
allows displaying large datasets using this 3D chart. 

Choose your charts wisely 

Excel offers too many charts as well as their 2D and 3D type. You can use any of them but choose 
them wisely according to your data. Different scenario requires different charts. Though, it can 
display all and correct information. 

We have a list of some points for each type of chart that helps you to choose the chart wisely. Read 
them carefully - 

 Chart Type When to choose this chart 
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1. Column Chart 
Use the column chart when you want to compare the multiple values across 
a few categories. The values are shown through vertical bars. 

2. Line Chart 
Choose this chart when you want to show the treads (ups and downs) over 
a period of time, like for months or years. 

3. Bar Chart 
Like the column chart, use this chart to compare the values across a few 
categories. 
In this chart, values are displayed in the horizontal bar. 

4. Area chart 
Area chart has the same pattern as the line chart. This chart is best to use for 
indicating a change among different sets. 

5. 
Pie or 
Doughnut chart 

Pie chart is best to use when you want to quantify the values and show 
them as percentage. 

6. Surface chart 
Surface chart is different than other charts. Use it when you need to analyze 
the optimum combination between two sets of data. 

How to insert a chart? 

Excel enables easy to use user interface using which you can easily insert a required chart for your 
data. You need to follow few simple steps, Excel > Insert tab > Chart section > choose a chart. 

We will illustrate these steps from start to end for creating the chart for Excel data. Following are 
the steps to insert a chart in Excel. 

Step 1: We have the following dataset (Animal population rate for six years from 2015-2020) for 
which you want to create a chart in Excel. 

 

Step 2: Select the data, including column header and row label for which you want to create a chart. 
This data will be the source data for your chart. 
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Step 3: Navigate to the Insert tab in the Excel header, where you will see a charts section that 
contains a list of all these charts. 

 

Step 4: Choose a chart from here according to your data. We have chosen a 3D Column  
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Step 5: The selected chart is inserted into your Excel worksheet. Initially, the chart looks like this for 
the data selected in step 2. 

 

Currently, this chart does not have a valid title, clear values for analysis, and more. You can set up 
all these things in your chart by modifying it. 

Step 6: Double-tap on the Chart Title to make it editable and then provide a new valid title that 
suites to it. 
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Here, Blue color vertical bar is representing to Dolphin, Orange vertical bar to Penguin, and Grey 
vertical bar to White Bear population count. 

Step 7: You can also define each vertical bar for its year so that the user can easily analyze the 
values. Click on the Chart Filters icon here. 

Step 8: Click on the Select data present at the bottom of the list to replace the years 2015 for each 
vertical bar. 

 

Step 9: Here, select the number 1 to replace it with year 2015 and click the Edit button. 
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Step 10: Enter the year and click OK. 

 

Step 11: The year 2015 will immediately reflect on the chart, and all other become blank. Now, to 
put all other years for each vertical bar, click one more time here. 

 

Step 12: Add more years from 2016 to 2020 inside curly braces separated by a comma and click OK. 

{2015,2016,2017,2018,2019,2020} 
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Step 13: All values are now added. So, click OK. 

 

Step 14: See the charts that the years are reflected on the chart correspond to each vertical bar. 

 

You can see that the exact value is not defined at the end of each bar. Only the graph is showing. 
Excel enables the users to choose a detailed bar. 

Step 15: Choose another chart style for the Column chart for detailed description from the Chart 
Style in the ribbon. We have chosen Style 2. 
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Note: The Chart Style option enables only when the chart inserted in your Excel sheet is selected. 
So, make sure chart is selected. 

Step 16: You can now see the exact value is also showing for each bar in this chart. 

 

Similarly, you can insert, create, and modify other charts in your Excel worksheet for your data. 

 

7.2 Move and Resize Charts 

In Excel, by default, the charts are moved and sized with cells. Whenever we change the size of cells 
in an excel sheet, the excel will automatically adjust the size of the chart accordingly. Excel also 
provides us the option for chart positioning without changing the cell’s size. Usually, we move or 
change the size of the chart within excel to ensure that the chart will not cover its underlying data. 
We can move the chart to a new location in the worksheet or to a new or existing worksheet. Also, 
we resize or change the size of the chart for a better fit in the worksheet. 

Note: We can resize the chart, move a chart within a worksheet or we can also move to a new 
worksheet. 

Moving Charts in Excel 

In Excel, We can easily move charts. Let us discuss with the help of an example. Suppose we have a 
chart that represents random sales data in different cities of 3 different states(You can use any 
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dataset and insert a chart using the dataset and implement the following moving and resizing 
behavior). Now we will move this chart. 

Move a chart within a worksheet 

In this example, we will move a char within the same excel worksheet. Usually, we perform these 
operations in order to avoid the overlapping between the data and the charts. Following is the step-
by-step implementation. 

Step 1: Insert and Select the chart   

In this step, first, we’ll need to insert a chart(Here, we are using Bar Chart). Once we have created a 
chart then we need to select it, for this, we have to click over our chart and select it. 

Step 2: Position the chart 

Once we have selected the chart, we can position the chat to a new location by dragging it using the 
chart’s border (We can also do that by double-clicking to hold the chart and drag to a new position 
and rest it there). 

 

  

Move a chart to another worksheet 

In this example, we will learn to move our chart to a new worksheet. This will create a new 
worksheet with the specified sheet name and contains the chart. to do this follow the step by step 
implementation 

Step 1: Insert and Select the chart   

In this step, first, we will need to insert a chart(Here, we are using Bar Chart). Once we have created 
our chart we need to select it, for this, we have to click over the chart and select it. 

Step 2: Position the char on a new worksheet 

Once we have selected the chart we need to go to Chart Design > Move Chart it will pop up a 
window asking about the new position to place the chart. 
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After we click on the Move Chart option, the excel will popup window where we need to put the 
new worksheet. 

 

Once we click on the OK button excel will create a new worksheet with the name we have provided 
as “Sales Chart Report”. 

 

Resizing Charts in Excel 

Resizing of the chart includes an increase or decrease in the length or breadth of the chart. This 
could be easily done by holding the graph’s endpoint and dragging them to increase or decrease 
the size of the graph. Following is the step-by-step implementation. 
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Step 1: Insert and Select the chart   

In this step, first, we will need to insert a chart(Here, we are using Bar Chart). Once we have created 
the chart we need to select it, for this, we have to click over our chart and select it. 

Step 2: Resizing the chart 

In this step, we will resize the chart. For resizing the chart excel provides eight sizing handles in the 
chart. We can click on these handles and drag the size of the chart according to our requirements. 

 

 

7.3 Change Chart Styles and Types 

An easy way to change the look and feel of a chart is by applying one of the built-in layouts or 
styles that are available in Excel. 

Apply a Chart Layout 

Built-in chart layouts can quickly adjust the overall layout of a chart with different combinations of 
titles, labels, and chart orientations. 

1. Select the chart you want to format. 

2. Click the Design tab. 

3. Click the Quick Layout button. 

4. Select the layout you want to use. 
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The selected layout is applied to the chart. 

Apply a Chart Style 

Built-in chart styles allow you to adjust the format of several chart elements all at once. Styles 
quickly change colors, shading, and other formatting properties. 

1. Select the chart 

2. Click the Design tab. 

3. Click the Chart Styles More button. 

If the style you want to use is already displayed in the gallery, there is no need to expand the menu, 
just select it. 

1. Select a new style. 
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Change Colors 

You can maintain the general look of a style while updating just the colors to better suit your needs. 

1. Select the chart 

2. Click the Design tab. 

3. Click the Change Colors button. 

4. Select a new color set. 

 

The new color set is applied to the chart. 
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Assume you have a data set like the below one. 

 

Step 1 – We must select the data and insert the COLUMN chart in Excel. 

 

When inserting the column chart for the selected data range, we get this default chart. However, 
most people do not go beyond this step because they do not care about the beauty of the chart. 

Step 2 – To open the “FORMAT DATA SERIES” option, select the bars and press “Ctrl + 1.” 
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Step 3 – In the “FORMAT DATA SERIES” window, choose the “FILL” option, click on “FILL,” and 
check the box “Vary color by point.” 

 

Steps to Apply Different Themes or Styles to The Chart 

We need to apply some themes or different styles to the chart. For this, we need to follow the below 
simple steps. 

 Step 1: First, we must select the chart first. 

 Step 2: Two extra tabs open on the ribbon as soon as we choose the chart. 
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We can see the main heading as “Chart Tools,” and under this, we have two tabs, i.e., “Design” and 
“Format.” 

 

 Step 3: We must go to the “DESIGN” tab. Under this, we can see many design options. Next, 
go to the “Chart Style” section. 

 

 Step 4: As we can see under “Chart Styles,” we can see many designs. As per our current chart 
style, the first one will appear. 
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In Excel 2013, we have a total of 16 chart styles. So, click on the drop-down list of the chart style to 
see the list. 

 

There is no specific name for each chart style. Rather, these styles are referred to as “Style 1”, “Style 
2”, “Style 3,” and so on. 

We will see each style and how they look when we apply them. 

Style 1: Apply only Grid Lines. 

If we choose the first style, it will display only GRIDLINES in Excel to the chart. Below is a preview 
of the same. 

 

Style 2: Show Data Labels in a Vertical way 

“Data Labels” are the data or numbers of each column bar. Suppose we select the “Style 2″ option. 
We will get below the chart style. 
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Style 3: To Apply Shaded Column Bars 

This style will modify the style of the bars from plain to shades. Below is a preview of the same. 

 

 

Note: “Data Labels” do not default in this style since we have selected “Style 2” in the 
previous step; it has come automatically. 

Style 4: To Apply Increased Width of Column Bars and Shadow of Column Bars. 

This style will increase the width of the column bars and give each bar’s shadow. 
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Style 5: To Apply Grey Background. 

This style will apply a grey background to ”Style 4.” 

 

Style 6: To Apply Light Color to the Column Bars. 

This style will apply light colors to the column bars. 

 

Style 7: To Apply Light Gridlines. 

This style will apply light grid lines to the chart. 
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Style 8: To Apply rectangular Gridlines. 

This style will apply a rectangular box type of gridline with shades. 

 

Style 9: To Apply Black Background. 

This style will apply a dark black colored background. 

 

Style 10: To Apply Smoky Bottom to the Column Bars. 

This style will apply the bottom of each column bar as smoky. 
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Style 11: Apply only borders to the Column Bars. 

This style will apply only outside borders to the column bars. 

 

Style 12: Similar to Style 1. 

This style is similar to “Style 1.” 

 

Style 13: To Apply Classy Style Type 1 

This style will make the chart more beautiful, as shown below. 
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Style 14: To Apply Classy Style Type 2 

This style will make the chart more beautiful, as below. 

 

Style 15: To Apply Increased bar without Gridlines 

This style will remove gridlines but increase the width of the column bars. 

 

Style 16: To Apply Intense Effect to the Column Bars 
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This style will apply the “Intense Effect” to the column bars. 

 

 

7.4 Modification in Chart Elements 

After you have created a chart in Excel, what's the first thing you usually want to do with it? Make 
the graph look exactly the way you've pictured it in your mind! 

In modern versions of Excel, customizing charts is easy and fun. Microsoft has really made a big 
effort to simplify the process and place the customization options within easy reach. 

How to add title to Excel chart 

This section demonstrates how to insert the chart title in different Excel versions so that you know 
where the main chart features reside. And for the rest of the tutorial, we will focus on the most 
recent versions of Excel. 

Add title to chart in Excel 

In Excel 2013 - 365, a chart is already inserted with the default "Chart Title". To change the title text, 
simply select that box and type your title: 

 

You can also link the chart title to some cell on the sheet, so that it gets updated automatically every 
time the liked cell is updated. The detailed steps are explained in Linking axis titles to a certain cell 
on the sheet. 

If for some reason the title was not added automatically, then click anywhere within the graph for 
the Chart Tools tabs to appear. Switch to the Design tab, and click Add Chart Element > Chart 
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Title > Above Chart I (or Centered Overlay). 

 

Or, you can click the Chart Elements button in the upper-right corner of the graph, and put a tick in 
the Chart Title checkbox. 

 

Additionally, you can click the arrow next to Chart Title and chose one of the following options: 

 Above Chart - the default option that displays the title at top of the chart area and changes the 
graph's size. 

 Centered Overlay - overlays the centered title on the chart without resizing the graph. 

For more options, go to the Design tab > Add Chart Element > Chart Title > More Options. 

Or, you can click the Chart Elements button and click Chart Title > More Options… 

Clicking the More Options item (either on the ribbon or in the context menu) opens the Format Chart 
Title pane on the right side of your worksheet, where you can select the formatting options of your 
choosing. 

Add title to chart in Excel 2010 and Excel 2007 

To add a chart title in Excel 2010 and earlier versions, execute the following steps. 

1. Click anywhere within your Excel graph to activate the Chart Tools tabs on the ribbon. 

2. On the Layout tab, click Chart Title > Above Chart or Centered Overlay. 
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Link the chart title to some cell on the worksheet 

For most Excel chart types, the newly created graph is inserted with the default Chart Title 
placeholder. To add your own chart title, you can either select the title box and type the text you 
want, or you can link the chart title to some cell on the worksheet, for example the table heading. In 
this case, the title of your Excel graph will be updated automatically every time you edit the linked 
cell. 

To link a chart title to a cell, perform the following steps: 

1. Select the chart title. 

2. On your Excel sheet, type an equal sign (=) in the formula bar, click on the cell that contains 
the needed text, and press Enter. 

In this example, we are linking the title of our Excel pie chart to the merged cell A1. You can also 
select two or more cells, e.g. a couple of column headings, and the content of all selected cells will 
appear in the chart title. 

 

Move the title within the chart 
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If you want to move the title to a different place within the graph, select it and drag using the 
mouse: 

 

Remove the chart title 

If you don't want any title in your Excel graph, you can delete it in two ways: 

 On the Design tab, click Add Chart Element > Chart Title > None. 

 On the chart, right-click the chart title, and select Delete in the context menu. 

 

Change font and formatting of chart title 
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To change the font of the chart title in Excel, right-click the title and choose Font in the context 
menu. The Font dialog window will pop up where you can choose different formatting options. 

 

For more formatting options, select the title on your chart, go to the Format tab on the ribbon, and 
play with different features. For example, this is how you can change the title of your Excel graph 
using the ribbon: 
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In the same way, you can change the formatting of other chart elements such as axis titles, axis 
labels and chart legend. 

For more information about chart title, please see How to add titles to Excel charts. 

Customizing axes in Excel charts 

For most chart types, the vertical axis (aka value or Y axis) and horizontal axis (aka category or X 
axis) are added automatically when you make a chart in Excel. 

You can show or hide chart axes by clicking the Chart Elements button , then clicking the 
arrow next to Axes, and then checking the boxes for the axes you want to show and unchecking 
those you want to hide. 

For some graph types, such as combo charts, a secondary axis can be displayed: 
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When creating 3-D charts in Excel, you can make the depth axis to appear: 

 

You can also make different adjustments to the way that different axis elements are displayed in 
your Excel graph (the detailed steps follow below): 

 

Add axis titles to a chart 
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When creating graphs in Excel, you can add titles to the horizontal and vertical axes to help your 
users understand what the chart data is about. To add the axis titles, do the following: 

1. Click anywhere within your Excel chart, then click the Chart Elements button and check 
the Axis Titles box. If you want to display the title only for one axis, either horizontal or 
vertical, click the arrow next to Axis Titles and clear one of the boxes: 

 

2. Click the axis title box on the chart, and type the text. 

To format the axis title, right-click it and select Format Axis Title from the context menu. The Format 
Axis Title pane will appear with lots of formatting options to choose from. You can also try different 
formatting options on the Format tab on the ribbon, as demonstrated in Formatting the chart title. 

Link axis titles to a certain cell on the sheet 

As is the case with chart titles, you can link an axis title to some cell on your worksheet to have it 
automatically updated every time you edit the corresponding cells on the sheet. 

Lovely Professional University226



Spreadsheet Modelling (Using Excel)  

 

Notes 

To link an axis title, select it, then type an equal sign (=) in the formula bar, click on the cell you 
want to link the title to, and press the Enter key. 

 

Change the axis scale in the chart 

Microsoft Excel automatically determines the minimum and maximum scale values as well as the 
scale interval for the vertical axis based on the data included in the chart. However, you can 
customize the vertical axis scale to better meet your needs. 

1. Select the vertical axis in your chart, and click the Chart Elements button . 

2. Click the arrow next to Axis, and then click More options… This will bring up the Format 

Axis pane. 

3. On the Format Axis pane, under Axis Options, click the value axis that you want to change and 

do one of the following: 

 To set the starting point or ending point for the vertical axis, enter the corresponding 
numbers in the Minimum or Maximum 

 To change the scale interval, type your numbers in the Major unit box or Minor unit box. 

 To reverse the order of the values, put a tick in the Values in reverse order box. 
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Because a horizontal axis displays text labels rather than numeric intervals, it has fewer scaling 
options that you can change. However, you can alter the number of categories to display between 
tick marks, the order of categories, and the point where the two axes cross: 
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Change the format of axis values 

If you want the numbers of the value axis labels to display as currency, percentage, time or in some 
other format, right-click the axis labels, and choose Format Axis in the context menu. On the Format 
Axis pane, click Number and choose one of the available format options: 
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Tip. To revert back to the original number formatting (the way the numbers are formatted in your 
worksheet), check the Linked to source box. 

If you don't see the Number section in the Format Axis pane, make sure you've selected a value axis 
(usually the vertical axis) in your Excel chart. 

Adding data labels to Excel charts 

To make your Excel graph easier to understand, you can add data labels to display details about the 
data series. Depending on where you want to focus your users' attention, you can add labels to one 
data series, all the series, or individual data points. 

1. Click the data series you want to label. To add a label to one data point, click that data point 
after selecting the series. 

 

2. Click the Chart Elements button, and select the Data Labels option. 

For example, this is how we can add labels to one of the data series in our Excel chart: 
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For specific chart types, such as pie chart, you can also choose the labels location. For this, click the 
arrow next to Data Labels, and choose the option you want. To show data labels inside text bubbles, 
click Data Callout. 

 

How to change data displayed on labels 

To change what is displayed on the data labels in your chart, click the Chart Elements button > Data 
Labels > More options… This will bring up the Format Data Labels pane on the right of your 
worksheet. Switch to the Label Options tab, and select the option(s) you want under Label Contains: 
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If you want to add your own text for some data point, click the label for that data point and then 
click it again so that only this label is selected. Select the label box with the existing text and type 
the replacement text: 

 

If you decide that too many data labels clutter your Excel graph, you can remove any or all of them 
by right-clicking the label(s) and selecting Delete from the context menu. 

Data label tips: 

 To change the position of a given data label, click it and drag to where you want using the 
mouse. 
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 To change the labels' font and background color, select them, go to the Format tab on the 
ribbon, and choose the formatting options you want. 

Moving, formatting or hiding the chart legend 

When you create a chart in Excel, the default legend appears at the bottom of the chart, and to the 
right of the chart in Excel 2010 and earlier versions. 

To hide the legend, click the Chart Elements button  in the upper-right corner of the chart and 
uncheck the Legend box. 

To move the chart legend to another position, select the chart, navigate to the Design tab, click Add 
Chart Element > Legend and choose where to move the legend. To remove the legend, select None. 

 

Another way to move the legend is to double-click on it in the chart, and then choose the desired 
legend position on the Format Legend pane under Legend Options. 
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To change the legend's formatting, you have plenty of different options on the Fill & 
Line and Effects tabs on the Format Legend pane. 

Showing or hiding the gridlines on the Excel chart 

In Excel 2013, 2016 and 2019, turning the gridlines on or off is a matter of seconds. Simply click 
the Chart Elements button and either check or uncheck the Gridlines box. 

 

Microsoft Excel determines the most appropriate gridlines type for your chart type automatically. 
For example, on a bar chart, major vertical gridlines will be added, whereas selecting the Gridlines 
option on a column chart will add major horizontal gridlines. 

To change the gridlines type, click the arrow next to Gridlines, and then choose the desired 
gridlines type from the list, or click More Options… to open the pane with advanced Major 
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Gridlines options. 

 

Hiding and editing data series in Excel graphs 

When a lot of data is plotted in your chart, you may want to temporary hide some data series so 
that you could focus only on the most relevant ones. 

To do this, click the Chart Filters button  on the right of the graph, uncheck the data series 
and/or categories you want to hide, and click Apply. 

To edit a data series, click the Edit Series button to the right of the data series. The Edit Series button 
appears as soon as you hover the mouse on a certain data series. This will also highlight the 
corresponding series on the chart, so that you could clearly see exactly what element you will be 
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editing. 

 

Changing chart type and style 

If you decide that the newly created graph is not well-suited for your data, you can easily change it 
to some other chart type. Simply select the existing chart, switch to the Insert tab and choose 
another chart type in the Charts group. 

Alternatively, you can right-click anywhere within the graph and select Change Chart Type… from 
the context menu. 
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To quickly change the style of the existing graph in Excel, click the Chart Styles button  on 
the right of the chart and scroll down to see the other style offerings. 

 

Or, choose a different style in the Charts Styles group on the Design tab: 
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Changing chart colors 

To change the color theme of your Excel graph, click the Chart Styles button, switch to the Color tab 
and select one of the available color themes. Your choice will be immediately reflected in the chart, 
so you can decide whether it will look well in new colors. 

 

To choose the color for each data series individually, select the data series on the chart, go to 
the Format tab > Shape Styles group, and click the Shape Fill button: 
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How to swap X and Y axes in the chart 

When you make a chart in Excel, the orientation of the data series is determined automatically 
based on the number of rows and columns included in the graph. In other words, Microsoft Excel 
plots the selected rows and columns as it considers the best. 

If you are not happy with the way your worksheet rows and columns are plotted by default, you 
can easily swap the vertical and horizontal axes. To do this, select the chart, go to the Design tab and 
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click the Switch Row/Column button. 

 

How to flip an Excel chart from left to right 

Have you ever made a graph in Excel only to find out that data points appear backwards from 
what you expected? To rectify this, reverse the plotting order of categories in a chart as shown 
below. 

Right click on the horizontal axis in your chart and select Format Axis… in the context menu. 
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If you prefer working with the ribbon, go to the Design tab and click Add Chart 
Element > Axes > More Axis Options… 

 

Either way, the Format Axis pane will show up, you navigate to the Axis Options tab and select 
the Categories in reverse order option. 
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Apart from flipping your Excel chart from left to right, you can also change the order of categories, 
values, or series in your graph, reverse the plotting order of values, rotate a pie chart to any angle, 
and more.  

 

Summary 

 Basic Chart Types: Excel offers various chart types such as bar charts, line charts, pie 
charts, and more to represent data visually. 

 Inserting Charts: You can insert charts by selecting your data and then going to the 
"Insert" tab, choosing the desired chart type, and customizing it as needed. 

 Moving and Resizing Charts: To reposition a chart, click and drag it to a new location on 
the worksheet. To resize, click and drag the chart's corner or edge. 

 Changing Chart Styles: Excel provides preset chart styles that you can apply to change the 
appearance of your chart, such as colors and fonts. 

 Changing Chart Types: You can switch between chart types easily by selecting the chart 
and going to the "Design" tab, then choosing a new chart type from the "Change Chart 
Type" option. 

 Modifying Chart Data: To update the data in a chart, you can right-click on the chart and 
choose "Select Data." This allows you to add or remove data series or edit the data range. 

 Formatting Chart Elements: Excel allows you to format specific elements of a chart like 
titles, axes, data points, and legends. Simply select the element and apply formatting 
changes. 

 Data Labels and Data Tables: You can add data labels to display values on data points or 
include a data table to show the underlying data in your chart. 
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 Chart Titles and Axis Labels: Customize the chart title and axis labels to make your chart 
more informative and visually appealing. 

 Legend and Gridlines: You can show or hide the legend, which explains the data series, 
and gridlines, which aid in reading values on the chart. 

 

Keywords 

 Basic Chart Types: Different fundamental visual representations of data, such as bar charts, 

pie charts, and line charts, used to convey information in Microsoft Excel. 

 Move Charts: The action of relocating a chart within an Excel worksheet to a different 

position, typically to improve layout or visibility. 

 Resize Charts: Changing the dimensions of a chart in Excel, either by adjusting its width and 

height or by scaling it to fit within a specified area. 

 Change Chart Styles: Altering the visual appearance of a chart, including its colors, fonts, and 

other design elements, to better suit the desired presentation. 

 Change Chart Types: The process of switching from one chart format to another in Excel, such 

as changing a bar chart to a line chart or a pie chart to a scatter plot. 

 Modification: The act of making adjustments or alterations to various aspects of a chart in 

Excel, such as data series, titles, labels, or formatting. 

 Chart Elements: The individual components that make up a chart, including axes, data points, 

legends, titles, and other graphical and textual elements used to represent data visually. 

 Microsoft Excel: A popular spreadsheet software application developed by Microsoft, widely 

used for data analysis, organization, and presentation, including the creation of charts and 

graphs. 

 Data Visualization: The practice of presenting data in a visual format, like charts and graphs, 

to make complex information more accessible and understandable. 

 Chart Customization: The ability to personalize the appearance and content of charts in Excel, 

allowing users to tailor them to specific needs and preferences. 

 

Self Assessment 

1. Which of the following is not a basic chart type in Excel? 

A. Scatter Plot  

B. Gantt Chart  

C. Bar Chart  

D. Line Chart  

 

2. What is the purpose of moving a chart in Excel? 

A. To copy the chart  

B. To resize the chart  

C. To change its data  

D. To change its position on the worksheet  

 

3. How can you resize a chart in Excel?  

A. Right-click and select "Resize Chart"  

B. Click and drag the chart's corner or edge  

C. Use the "Format Chart" dialog box  

D. Double-click the chart title  
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4. Which tab in Excel allows you to change chart styles and types? 

A. Data  

B. Home  

C. Insert  

D. Design  

 

5. What does modifying chart elements in Excel involve? 

A. Changing the software version  

B. Altering the data source  

C. Making adjustments to various chart components  

D. Deleting the chart  

 

6. Which Excel function allows you to switch from one chart type to another?  

A. SWITCHCHART  

B. CHARTCHANGE  

C. CHARTSWITCH  

D. Change Chart Type  

 

7. What is the purpose of a legend in a chart? 

A. Show data labels  

B. Explain the data series  

C. Change the chart's colors  

D. Resize the chart  

 

8. Which of the following is an example of a basic chart type for comparing data values across 

different categories?  

A. Scatter Plot  

B. Pie Chart  

C. Radar Chart  

D. Histogram  

 

9. What does the "Select Data" option in Excel allow you to do?  

A. Choose a different chart type  

B. Pick a new chart style  

C. Add or edit data series in a chart  

D. Resize the chart area  

 

10. In Excel, what can you format within a chart element?  

A. Only the chart title  

B. Only data points  

C. Specific elements like titles, axes, labels, and more  

D. The entire worksheet  

 

11. Which of the following is not a type of data label in Excel charts? 

A. Category Name  

B. Series Name  
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C. Data Point Value  

D. Chart Title  

 

12. What is the primary function of gridlines in Excel charts?  

A. To add a decorative border to the chart  

B. To highlight the legend  

C. To assist in reading values on the chart  

D. To create a background color  

 

13. Which Excel feature is used for personalizing the appearance and content of charts?  

A. Format Painter  

B. Chart Wizard  

C. Chart Customization  

D. Graphical Editor  

 

14. What is a common use of a line chart in Excel?  

A. Showing the distribution of data  

B. Comparing values across different categories  

C. Displaying hierarchical data  

D. Analyzing trends over time  

 

15. Which chart type is often used for displaying hierarchical data with branches and sub-

branches?  

A. Bar Chart  

B. Tree Map  

C. Radar Chart  

D. Scatter Plot  

 

16. What is a secondary axis used for in Excel charts?  

A. To adjust chart dimensions  

B. To change the chart type  

C. To compare two different data series with different scales  

D. To hide the legend  

 

Answers for Self Assessment 

1. B 2. D 3. B 4. D 5. C 

6. D 7. B 8. B 9. C 10. C 

11. D 12. C 13. C 14. D 15. B 

16. C         

 

Review Questions 

1. What is the purpose of using basic chart types in Excel? 

2. How do you insert a chart in Microsoft Excel? 
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3. Explain why it is important to move a chart within an Excel worksheet. 

4. Describe two methods for resizing a chart in Excel. 

5. Where can you find the options to change chart styles and types in Excel? 

6. What does "modification in chart elements" refer to in Excel? 

7. How can you change the chart type of an existing chart in Excel? 

8. Why is it useful to add data labels to a chart? 

9. Name three chart elements in Excel that you can format. 

10. How do you edit the data source for a chart in Excel? 

11. What is the purpose of a legend in an Excel chart? 

12. Explain the role of gridlines in Excel charts. 

13. What is chart customization, and why is it important? 

14. When would you typically use a line chart in Excel? 

15. What is the significance of a secondary axis in an Excel chart? 

 

 
Further Readings 

 https://www.javatpoint.com/type-of-charts-in-excel 

 https://www.geeksforgeeks.org/how-to-move-and-resize-a-chart-in-excel/ 

 https://edu.gcfglobal.org/en/excelxp/editing-charts/1/ 

 https://www.customguide.com/excel/change-chart-style-in-excel 

 https://www.tutorialspoint.com/excel_charts/excel_charts_styles.htm 

 https://www.wallstreetmojo.com/change-chart-style-in-excel/ 

 https://www.tutorialspoint.com/excel_charts/excel_charts_elements.htm 

 https://www.ablebits.com/office-addins-blog/excel-charts-title-axis-legend/ 
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Objectives 

After this lecture , you will gain insight to the following topics: 

 If Statement Analysis 

 Nested If 

 Count If and Count Ifs 

 Sum If and Sum Ifs 

 Average If and Average Ifs 

 

Introduction 

Elementary modeling is a foundational concept in various fields, including mathematics and 
computer science. It involves simplifying complex systems or real-world scenarios to create 
mathematical or computational representations. These models provide a framework for analysis 
and decision-making, making it easier to understand and manipulate complex data or situations. 

 

8.1 What is an Excel IF Statement? 

The Excel IF Statement tests a given condition and returns one value for a TRUE result and another 
value for a FALSE result. For example, if sales total more than $5,000, then return a “Yes” for 
Bonus; otherwise, return a “No” for Bonus. We can also use the IF function to evaluate a single 
function, or we can include several IF functions in one formula. Multiple IF statements in Excel are 
known as nested IF statements. 

Dr. Jaskiran Kaur, Lovely Professional University 
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As a financial analyst, the IF function is used often to evaluate and analyze data by evaluating 
specific conditions. 

The function can be used to evaluate text, values, and even errors. It is not limited to only checking 
if one thing is equal to another and returning a single result. We can also use mathematical 
operators and perform additional calculations, depending on our criteria. We can also nest multiple 
IF functions together to perform multiple comparisons. 

IF Formula 

=IF(logical_test, value_if_true, value_if_false) 

The function uses the following arguments: 

1. Logical_test (required argument) – This is the condition to be tested and evaluated as 
either TRUE or FALSE. 

2. Value_if_true (optional argument) – The value that will be returned if the logical_test 
evaluates to TRUE. 

3. Value_if_false (optional argument) – The value that will be returned if the logical_test 
evaluates to FALSE. 

When using the IF function to construct a test, we can use the following logical operators: 

 = (equal to) 

 > (greater than) 

 >= (greater than or equal to) 

 < (less than) 

 <= (less than or equal to) 

 <> (not equal to) 

How to use the Excel IF Function 

To understand the uses of the Excel IF statement function, let’s consider a few examples: 

 

Example 1 – Simple Excel IF Statement 

Suppose we wish to do a very simple test. We want to test if the value in cell C2 is greater than or 
equal to the value in cell D2. If the argument is true, then we want to return some text stating “Yes 
it is”, and if it’s not true, then we want to display “No it isn’t”. 

You can see exactly how the Excel IF statement works in the simple example below. 

Result when true: 
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Result when false: 

 

 

Example 2 – Excel IF Statement 

Suppose we wish to test a cell and ensure that an action is taken if the cell is not blank. We are 
given the data below: 

 

In the worksheet above, we listed AGM-related tasks in Column B. Remarks contain the date of 
completion. In Column C, we will use a formula to check if the cells in Column D are empty or not. 
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If a cell is blank, the formula will assign the status “Open.” However, if a cell contains a date, then 
the formula will assign a status of “Closed.” The formula used is: 

 

We get the results below: 

 

 

Example 3 – Excel IF Statement 

Sellers frequently provide a discount based on the quantity purchased. Suppose we are given the 
following data: 
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Using multiple IF functions, we can create a formula to check multiple conditions and perform 
different calculations depending on what amount range the specified quantity falls in. To calculate 
the total price for 100 items, the formula will be: 

 

We get the result below: 

 

Things to remember about the IF Function 

1. The Excel IF function will work if the logical_test returns a numeric value. In such a case, any 
non-zero value is treated as TRUE and zero is treated as FALSE. 
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2. #VALUE! error – Occurs when the given logical_test argument cannot be evaluated as TRUE 
or FALSE. 

3. When any of the arguments are provided to the function as arrays, the IF function will 
evaluate every element of the array. 

4. If we wish to count conditions, we should use the COUNTIF and COUNTIFS functions. 

5. If we wish to add up conditions, we should use the SUMIF and SUMIFS functions. 

Reasons to use an Excel IF Statement 

There are many reasons why an analyst or anyone who uses Excel would want to build IF formulas. 

Common examples include: 

 To test if an argument is true or false 

 To output a NUMBER 

 To output some TEXT 

 To generate a conditional formula (e.g., the result is C3+B4 if true and N9-E5 if false) 

 To create scenarios to be used in financial modeling 

 To calculate a debt schedule or a fixed asset depreciation schedule in accounting 

 

8.2 Nested If 

In Excel, the Nested IF function means we can use another logical or conditional function with the 
IF function to test more than one condition. For example, suppose there are two conditions to be 
tested. In that case, we can use the logical AND or OR function depending upon the situation, or 
we can use the other conditional functions, even more, IFs inside a single IF. 

For example, suppose we have a dataset consisting of the age and names of employees. We need to 
check if any employees are less than the required eligibility to work, i.e., 20 years. We can use the 
Nested IF function in Excel in such a scenario. Using this function may display “TRUE” if it met 
with the first condition, i.e., age is more or equal to 20 years. Conversely, it may indicate “FAIL” if 
it does not satisfy the first condition. If the logical test is “FALSE,” we can execute the second IF. It 
will perform until the formula finds the “TRUE” test result. If none of the results is “TRUE,” it will 
execute the final “FALSE” result. 

 

Example 1. Classic nested IF formula 

Here's a typical example of Excel If with multiple conditions. Supposing you have a list of students 
in column A and their exam scores in column B, and you want to classify the scores with the 
following conditions: 

 Excellent: Over 249 

 Good: between 249 and 200, inclusive 

 Satisfactory: between 199 and 150, inclusive 

 Poor: Under 150 

And now, let's write a nested IF function based on the above criteria. It's considered a good practice 
to begin with the most important condition and keep your functions as simple as possible. Our 
Excel nested IF formula goes as follows: 

=IF(B2>249, "Excellent", IF(B2>=200, "Good", IF(B2>150, "Satisfactory", "Poor"))) 
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And works exactly as it should: 

 

Understanding Excel nested IF logic 

I've heard some people say that Excel multiple If is driving them crazy :) Try looking at it at a 
different angle: 

 

What the formula actually tells Excel to do is to evaluate the logical_test of the first IF function and, 
if the condition is met, return the value supplied in the value_if_true argument. If the condition of 
the 1st If function is not met, then test the 2nd If statement, and so on. 

IF(check if B2>=249, if true - return "Excellent", or else 

IF(check if B2>=200, if true - return "Good", or else 

IF(check if B2>150, if true - return "Satisfactory", if false - return "Poor"))) 

 

Example 2. Multiple If with arithmetic calculations 

Here's another typical task: the unit price varies depending on the specified quantity, and your goal 
is to write a formula that calculates the total price for any amount of items input in a specific cell. In 
other words, your formula needs to check multiple conditions and perform different calculations 
depending on what amount range the specified quantity falls in: 

Unit Quantity Price per unit 

1 to 10 $20 

11 to 19 $18 

20 to 49 $16 

50 to 100 $13 

Over 101 $12 
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This task can also be accomplished by using multiple IF functions. The logic is the same as in the 
above example, the only difference is that you multiply the specified quantity by the value returned 
by nested IFs (i.e. the corresponding price per unit). 

Assuming the user enters the quantity in cell B8, the formula is as follows: 

=B8*IF(B8>=101, 12, IF(B8>=50, 13, IF(B8>=20, 16, IF( B8>=11, 18, IF(B8>=1, 20, ""))))) 

And the result will look something similar to this: 

 

As you understand, this example demonstrates only the general approach, and you can easily 
customize this nested If function depending on your particular task. 

For example, instead of "hard-coding" the prices in the formula, you can reference the cells 
containing those values (cells B2 to B6). This will enable your users to edit the source data without 
having to update the formula: 

=B8*IF(B8>=101,B6, IF(B8>=50, B5, IF(B8>=20, B4, IF( B8>=11, B3, IF(B8>=1, B2, ""))))) 

 

Or, you may want to include an additional IF function(s) that fixes an upper, lower or both bounds 
of the amount range. When the quantity is outside the range, the formula will display an "out of the 
range" message. For example: 

=IF(OR(B8>200,B8<1), "Qty. out of range", B8*IF(B8>=101,12, IF(B8>=50, 13, IF(B8>=20, 16, IF( 
B8>=11, 18, IF(B8>=1, 20, "")))))) 
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The nested IF formulas described above work in all versions of Excel. In Excel 365 and Excel 2021, 
you can also use the IFS function for the same purpose. 

 

8.3 Count(), Countif(), Countifs() function 

Count() function is used to count the number cells between two ranges that contains numberical 
data; it doesn't count the cell containing string data. 

Let's take below as an example. In 'I4', we have written '=COUNT(A4:G4)', it count 7 columns data. 

 

The result is only 5 as shown below because only 5 columns (Sl. No., Age, Salary, PPF, Total) 
columns having numberical data. 

 

Similarly, we are trying to count the rows that contains numberical data. 
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As you can see that both A19 and B19 cell is using same formula to count row 3 to 17 but the result 
would be below. 

Lovely Professional University 257



 Spreadsheet Modelling (Using Excel)  

 

Notes 

 

As A column contains numberic data so it is giving number of rows, but B column has all string 
data so the result is 0. 

CountIf() function 

CountIf function is used to count cells based on one criteria only (less than, greater than, equal to 
etc.). The criteria can be either for numerical value or string value. 

Look at the below example. In D21 cell, the formula is written as '=COUNTIF(D4:D17, "<18")', it 
means that Count only those cells having value less than 18 and in this case only one cell D13 valid 
so the result we are getting is 1. 
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We can even use wildcard characters in CountIf function. 
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This is counting cells whose string value starts with "S". 

CountIfs() function 

CountIfs function is used to count cells based on multiple criteria (separated by comma). In below 
example, D21 cell contains '=COUNTIFS(B4:B17, "S*", D4:D17, "<26")' formula that says 

 count those cells from B4:B17 (cell range) whose string starts with "S*" (this will give 3 

records) and also 

 D4:D17 cells whose value is '<26' (this will remove two records 'Sheo' & 'Sohan'). 

So if both criteria is met then only that particular record will be counted.  
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So the result is 1. 

How to count cells with specific text in Excel? 

To count cells with specific text in Excel, we can use CountIf() function. Select a blank cell and write 
formula like this '=COUNTIF(B4:B17, "Sheo")'. In this case I want to find 'Sheo' text. 
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and here is my result in B21. 

As written earlier, we can use wild card characters also to count the occurences, like 

1. Count cells starting with 'Sh' - '=COUNTIF(B4:B17, "Sh*")' 

2. Count cells ending with 'eo' - '=COUNTIF(B4:B17, "*eo")' 

3. Count cells contains 'h' - '=COUNTIF(B4:B17, "*h*")' 

How to count non blank cells in Excel? 

To count Non Blank cell in excel, use the same COUNTIF function but the 2nd parameter would be 

'<>'. So the formula to count non blank cells is '=COUNTIF(G4:G19, "<>")' where the 
range of cells it is counting is G4 to G19. 
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See here non blank cell is 9. 

How to count blank cells in Excel? 

To count blank cells in Excel, use the COUNTIF function with 2nd parameter as "". So here is the 
formula '=COUNTIF(G4:G19, "")'. 
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The number of blank cells between G4 to G19 is 7. 

 

8.4 Sumif() and Sumifs() Function 

Without a doubt, one of the most useful functions of Excel is the SUMIF function. 

It enables conditional summing up in Excel. And so, you can make sense of large diverse datasets 
by only summing up the values that meet a specified criterion. 

And what if that’s not a criterion but multiple criteria? No worries – to deal with multiple 
conditions, we have the SUMIFS function to the rescue. 

How to use SUMIF 
The SUMIF function sums up only those values (from a defined range) that meet a specified 
condition. Let’s see how. 

The dataset below shows the sale of four products. 
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Out of this data, can we quickly sum up the sales for “Apple” only? To do so: 

1. Begin writing the SUMIF function as shown below. 

=SUMIF ( 

2. Create a reference to the range (based on which the sum is to be performed). 

=SUMIF (A2:A5, 

 

We have created a reference to the cell range A2:A5. 

This range contains the product names (and we want to sum up the sales for apples only). So our 
range is the “Products” column. 

3. Next, define the criteria based on which Excel must sum the values. 

We want to sum up the sales for “Apple” only and that makes our criteria. 

=SUMIF (A2:A5, “Apple”, 
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We have defined “Apple” as the next argument. This tells Excel to look out for the word “Apple” in 
the range specified above. 

4. Create a reference to the range to be summed up (Sales in this case). 

As we want Excel to sum up the sales for “Apple”, we are creating a reference to cells B2:B5. 

=SUMIF (A2:A5, “Apple”, B2:B5) 

 

5. Hit “Enter” and there you go. 

Excel displays the sum of sales of “Apple” only. 
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SUMIF formula examples 

The basic application of the SUMIF function is more like child’s play. 

But that’s not it – the criteria of the SUMIF function can take different formats. Like the number, 
text, and date format. 

Look into the examples for each criteria format below. 

SUMIF with number criteria 

Here comes the sales data for three different cities for different months. 

 

Out of this data, can we only sum up the sales that exceed $225? To do so: 

1. Start writing the SUMIF function as follows. 

=SUMIF ( 

2. Define the range (based on which the cells are to be summed up) as the first argument. 

=SUMIF (C2:C10, 
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We want to sum up the sales that exceed $225, so our range is sales. 

3. Define the criteria for summing up the values as shown in the following formula. 

=SUMIF(C2:C10,”>225” 

 

As we want to filter out sales greater than $225, we have defined the criteria using a “greater than” 
operator (>225). 

4. Create a reference to the range to be summed up (the sales) as the third argument. 

The sum range argument, in this case, is the same as our criteria range (C2:C10). 

=SUMIF(C2:C10,”>225”,C2:C10) 
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Now, hit enter. 

And here comes the sum of the sales that exceed $225. 

 

Turns out $2,243 is the sum of all the sales that exceed $225. 

SUMIF with text criteria 

Continuing with the previous example, what if we want to sum sales of New York only? 
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1. Write the SUMIF function as follows. 

= SUMIF ( 

2. Define the range against which the criterion must be evaluated (Cities). 

=SUMIF (B2:B10, 

 

We want to sum the sales for NewYork (a particular city) only so our range is the Cities column. 

3. Define the criterion for summing up sales. 

This time our criteria is a text i.e. “New York”. 

=SUMIF(B2:B10,”New York”, 
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4. Select the sum range (the sales) as the third argument. 

=SUMIF(B2:B10,”New York”,C2:C10) 

 

5. Hit “Enter”. 
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And there you have the total sales of New York City for all the months  

SUMIF with date criteria. 

So far we’ve learned how the SUMIF function works with a number and text criteria. 

It’s time we check if the SUMIF function works with the date criteria too. 

With the same data as above, let’s now sum the sales for 31/1/2022 only. 

 

1. Start writing the SUMIF function as follows. 

=SUMIF( 

2. Define the range as the first argument (Months in this case). 

=SUMIF(A2:A10, 
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3. Define the criteria as “31/1/2022”; the date for which we want to sum up the sales. 

=SUMIF(A2:A10,”31/1/2022”, 

 

5. Press “Enter” to get the results as follows. 
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And there you go! Excel sums up the sales for 31/1/2022 only. 

 

8.5 Average Function 

The AVERAGE function in Excel calculates the arithmetic mean of the supplied values. Such values 
can be numbers, percentages or times. In the mean (or average), the sum of all the items is divided 
by the number of items on the list. Apart from numbers, an average of Boolean values (true and 
false) can also be found if they are typed directly in the AVERAGE formula. 

For example, the formula “=AVERAGE(10,24,35,true,false)” returns 14. The “true” and “false” 
values are counted as 1 and 0 respectively. So, the mean is (10+24+35+1+0)/5=14. 

The purpose of using the AVERAGE function in Excel is to calculate the center or mean of a list. A 
mean includes every value of the list in the calculation. As a result, it is impacted by the extreme 
values or outliers (very small or very big values) of a list. The AVERAGE function is categorized as 
a Statistical function of Excel. 

Syntax of the AVERAGE Function of Excel 

The syntax of the AVERAGE function of Excel is shown in the following image: 

 

The AVERAGE function of Excel accepts the following arguments: 

 Number 1: This is the first number for which the average is to be calculated. 

 Number 2, number 3,…number n: These are the subsequent numbers for which the average is 

to be calculated. 

The numbers can be supplied as direct numbers, named ranges or cell references containing 
numeric values. The first number is required, while the subsequent numbers are optional. 
However, for computing an average, at least two numbers are needed. 
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Note: The output of other Excel functions can also serve as an input to the AVERAGE 
function. However, such an output must necessarily be a numeric value. 

Features of the AVERAGE function of Excel 

The features of the AVERAGE function of Excel are listed as follows: 

 It can be supplied with a maximum of 255 arguments in a single formula. 

 It ignores the logical values (or Boolean values) if they have been supplied as cell references. 
However, logical values entered directly in the formula are counted by the function. 

 It counts those cell references that contain numbers formatted as text. 

 It treats the text strings as follows: 

 If the entire range reference consists of a few numbers and some text strings, the average 

of only the numbers is returned. In this case, the text strings supplied in the range 

reference are ignored by the function. 

 If the entire range reference consists of text strings, the “#DIV/0!” error is returned by the 

function. 

 If text strings are entered directly in the formula, it returns the “#VALUE!” error. 

 It excludes the empty cells from the count. But, the cells containing the number zero are 
counted. 

 It returns an error if the arguments supplied are error values. 

Note: To include the zero values and exclude the empty cells from the count, follow the listed steps: 

a. Click “options” from the File tab. The “Excel options” window opens. 

b. Click “advanced” displayed on the left side. 

c. Under “display options for this worksheet,” select the checkbox of “show a zero in cells that 

have zero value.” 

The zero values of cells will be displayed and included in the count by the AVERAGE function of 
Excel. Deselecting the checkbox in point “c” will hide the zero values and display empty cells in 
their place. 

How to Use the AVERAGE Function of Excel? 

The AVERAGE function is one of the most used functions of Excel. It is frequently used in 
the financial sector to calculate the average revenue generated by an organization in a specific time 
period. It is also used to do financial modeling and analyze datasets. 

Let us consider a few examples to understand the working of the AVERAGE function of Excel. 

 

Example #1–Average in Five Different Cases 

The following image shows a list of numbers in the range B3:B7. Use the AVERAGE function of 
Excel to perform the tasks stated within the following cases: 

 Case 1: Calculate the average by supplying a vertical range reference. 

 Case 2: Calculate the average by supplying the numbers directly to the function. 

 Case 3: Calculate the average by supplying the numbers in words. Enclose the text strings 
within double quotation marks. 

 Case 4: Calculate the average by supplying the references of cells containing the number 
names. 

 Case 5: Calculate the average by supplying the numbers directly within double quotation 
marks. 

Write a conclusion for each case. 
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Case 1: Supply a vertical range reference 

The steps are listed as follows: 

Step 1: Enter the following formula in cell C3. 

“=AVERAGE(B3:B7)” 

 

Step 2: Press the “Enter” key. The output in cell C3 is 4. So, the mean of the given numbers is 4. This 
is shown within a red box in the following image. 
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Conclusion: For calculating the average, the numbers can be supplied as a range reference. It is also 
possible to supply cell references of non-adjacent cells. 

Simply select the cell or range in order to supply it to the AVERAGE function. Further, ensure that 
the non-contiguous cells or ranges are separated by commas. 

Case 2: Supply the numbers directly to the AVERAGE function 

The steps are listed as follows: 

Step 1: Enter the following formula in cell C4. 

“=AVERAGE(2,3,5,4,6)” 

 

Step 2: Press the “Enter” key. The output is shown in cell C4 of the following image. Hence, the 
mean is again 4. 
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Conclusion: It is possible to supply the numbers directly to the AVERAGE function. One need not 
enclose such numbers within double quotation marks. 

However, when there are too many numbers in the list, it becomes difficult to enter them directly. 
In such cases, it is easier to supply cell references. 

Case 3: Supply the numbers in words 

The steps are listed as follows: 

Step 1: Enter the following formula in cell C5. 

“=AVERAGE(“Two”,”Three”,”Five”,”Four”,”Six”)” 

 

Step 2: Press the “Enter” key. The output in cell C5 is the “#VALUE!” error. This is shown in the 
following image. 

 

Conclusion: When the number names are supplied directly to the AVERAGE function, it returns 
the“#VALUE!” error. This implies that the AVERAGE function does not work with text strings, 
even if such strings are enclosed within double quotation marks. 
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Case 4: Supply the references to cells containing the number names 

The steps are listed as follows: 

Step 1: Write the names of the numbers in the range A3:A7. Next, enter the following formula in 
cell C6. 

“=AVERAGE(A3:A7)” 

 

Step 2: Press the “Enter” key. The output in cell C6 is the “#DIV/0!” error. This is shown in the 
following image. 

 

Conclusion: If number names are supplied as cell references, the AVERAGE function returns the 
“#DIV/0!” error. This implies that whether text strings are supplied directly or as cell references, 
the AVERAGE function does not work with them. 

Notice the green triangles appearing on the top-left corner of cells C5 and C6. These triangles 
indicate that there is an error in the formulas of these cells. 

 

Note: To include the text strings supplied as cell references, use the AVERAGEA 
function of Excel. This function counts such text strings as zero and ignores the empty 
cells. However, the text strings entered directly in the AVERAGEA formula can cause 
errors. 

Case 5: Supply the numbers directly within double quotation marks 

The steps are listed as follows: 

Step 1: Enter the following formula in cell C7. 

“=AVERAGE(“2”,“3”,“5”,“4”,“6”)” 
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Step 2: Press the “Enter” key. The output in cell C7 is 4. Hence, the mean is 4. This is shown within 
a red box in the following image. 

 

Conclusion: If numbers are supplied directly within double quotation marks, the AVERAGE 
function returns their average (or mean). Hence, whether numbers are supplied as cell references or 
direct values (with or without double quotation marks), the AVERAGE function returns their 
mean. 

 

Example #2–Average by Supplying a Horizontal Range Reference 

The following image shows the names (column C), IDs (column B), and scores (in five subjects in 
columns D to H) of 20 students of a class. Given that the maximum marks of each subject are 100, 
calculate the average score obtained by each student. 

Use the AVERAGE function of Excel. 

 

The steps to calculate the average are listed as follows: 

Step 1: Enter the following formula in cell I4. 

“=AVERAGE(D4:H4)” 

So, we have supplied the cell references of row 4 to the AVERAGE function of Excel. 
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Step 2: Press the “Enter” key. The output in cell I4 is 79.4. Hence, the average score of the student 
Ashwin is 79.4. 

 

Step 3: Drag the formula of cell I4 till cell I23. For dragging, use the excel fill handle appearing at 
the bottom-right side of cell I4. 

The outputs are shown in the following image. The formula bar shows the formula of the currently 
selected cell (I23). 
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Example #3–Average and Maximum Average Revenue by AVERAGE, LOOKUP, and 
MAX Functions 

The following image shows the monthly revenues (in $ in columns C to F) generated by an 
organization from four zones, namely, east, west, central, and north-south. We want to perform the 
listed tasks: 

a. Calculate the average revenue for each month. 

b. Calculate the average revenue for each zone. 

c. Find the zone with the maximum average revenue. 

Use the AVERAGE function of Excel for tasks “a” and “b.” For task “c,” use the LOOKUP and 
MAX functions. Further, explain the formula used for task “c.” 
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a. The steps to calculate the average revenue for each month are listed as follows: 

Step 1: Enter the following formula in cell C18. 

“=AVERAGE(C4:F4)” 

Since the average for each row of the dataset needs to be calculated, we have supplied the range 
reference of row 4. 

 

Step 2: Press the “Enter” key to obtain the output. This is shown in cell C18 of the following image. 
So, the average revenue for January is $105,000. 
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Step 3: Drag the formula of cell C18 till cell C29 with the help of the fill handle. The average 
revenues for all the months are shown in the following image. In this image, the formula bar 
displays the formula of the currently active cell (C29). 
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b. The steps to calculate the average revenue for each zone are listed as follows: 

Step 1: Enter the following formula in cell G18. 

“=AVERAGE(C4:C15)” 

This time we supply the cell references of column C in the AVERAGE formula. This is because the 
average for the entire column needs to be calculated. 
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Step 2: Press the “Enter” key. The output of cell G18 is shown in the following image. Likewise, we 
have entered the following formulas in cells G19, G20, and G21 respectively: 

•“=AVERAGE(D4:D15)” 
•“=AVERAGE(E4:E15)” 
• “=AVERAGE(F4:F15)” 

Hence, the averages for each zone have been calculated in the range G18:G21. 
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c. The steps to find the zone with the maximum average revenue are listed as follows: 

Step 1: Enter the following formula in cell H18. 

“=LOOKUP(MAX(G18:G21),G18:G21,F18:F21)” 

This is shown in the following image. 

 

Step 2: Press the “Enter” key. The output is shown in the following image. Hence, the average 
revenue of the west zone is maximum. 

 

Explanation of the formula: In the formula of step 1, we have used the vector form of the LOOKUP 
function. This formula works as follows: 

a. The MAX function looks for the maximum number of the range G18:G21. The output of the 
MAX function is 100000. This output becomes the “lookup_value” of the LOOKUP function. 
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b. Next, the LOOKUP function searches the number 100000 (lookup_value) in the range 
G18:G21 (lookup_vector). It returns the result from the range F18:F21 (result_vector). So, the 
given “lookup_value” corresponds with the west zone. 

Hence, the output of the formula of step 1 is “west zone.” 

 

Note: The LOOKUP function searches for a value (lookup_value) in a one-row or one-
column range (lookup_vector) and returns a corresponding match from the same 
position of another range (result_vector). The MAX function returns the maximum 
number from a dataset of numeric values. 

For the syntax of the LOOKUP and MAX functions, click the hyperlinks of points “b” and “a” 
respectively. 

 

Example #4–Average of Top Four Scores by AVERAGE and LARGE Functions 

The following image shows the names (column B) and scores (columns C to G) of 16 students in 
five subjects. We want to perform the listed tasks: 

a. Calculate the average of five scores of the student Lini (row 4). Use the AVERAGE function of 
Excel. 

b. Calculate the average of the top four scores of each student. Use the AVERAGE and LARGE 
functions of Excel. 

Explain the formula used for task “b.” 

 

a. The steps to calculate the average of the five scores of row 4 are listed as follows: 

Step 1: Enter the following formula in cell H4. 

“=AVERAGE(C4:G4)” 
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Step 2: Press the “Enter” key. The output is 79.8, as shown in the following image. Hence, Lini’s 
average of five scores is 79.8. 

 

Note: To find the average (of five scores) for all the students, simply drag the formula of 
cell H4 till cell H19. For dragging, use the fill handle at the bottom-right corner of cell 
H4. 

 

b. The steps to calculate the average of the top four scores of each student are listed as follows: 
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Step 1: Enter the following formula in cell H4. 

“=AVERAGE(LARGE(C4:G4,{1,2,3,4}))” 

 

Step 2: Press the “Enter” key. The output is shown in cell H4 of the following image. Hence, Lini’s 
average of the top four scores is 83. 

 

Step 3: Drag the formula of cell H4 till cell H19. The outputs for all rows are shown in the following 
image. Notice that all these outputs are the averages of the top four scores of each student. 
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Explanation of the formula: In the formula of step 1, the inner function (LARGE function) is 
processed first, followed by the outer function (AVERAGE function). This formula works as 
follows: 

a. An array of numbers {1,2,3,4} has been supplied to the LARGE function. These numbers 
represent the position from which values will be returned. So, the LARGE function searches 
for the first highest, second highest, third highest, and fourth highest values in the range 
C4:G4. As a result, the LARGE function returns an array of numbers, which is {89,89,78,76}. 

b. The array of numbers returned by the LARGE function {89,89,78,76} serves as the argument of 
the AVERAGE function. The AVERAGE function calculates the average of these numbers, 
which is (89+89+78+76)/4=83. 

Likewise, the average of the top four scores has been obtained for all the students of the range 
B4:B19. 

 

Note: The LARGE function returns a value from the specified position of the supplied 
range. This position begins from the highest value of the dataset. So, the number 1 
corresponds to the maximum value of the dataset, 2 corresponds to the second highest 
value, 3 corresponds to the third highest value, and so on. 

For the syntax of the LARGE function, click the hyperlink given in point “a” of the preceding 
explanation. 

 

Example #5–Average of Last Three Numbers by AVERAGE, LOOKUP, LARGE, IF, 
ISNUMBER, and ROW Functions 

The following image shows some numeric and textual values in column B. Calculate the average of 
the last three numeric values, which are in cells B15, B17, and B18. 

Use the AVERAGE, LOOKUP, LARGE, IF, ISNUMBER, and ROW functions of Excel. Further, 
explain the formula used for the given task. 
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The steps to calculate the average of the last three numeric cells are stated as follows: 

Step 1: Enter the following formula in cell C3. 

“=AVERAGE(LOOKUP(LARGE(IF(ISNUMBER(B3:B18),ROW(B3:B18)),{1,2,3}),ROW(B3:B18),B3:B1
8))” 
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Step 2: Press the keys “Ctrl+Shift+Enter” together. For Excel for Mac, press the keys 
“Command+Shift+Enter.” 

Once the CSE (Ctrl+Shift+Enter) keys are pressed, the formula is enclosed within curly braces. This 
is shown in the following image. The output is also shown in cell C3. 

Hence, the average of the last three numeric values (110000, 90000, and 50000) is 83333.3. 

 

Explanation of the formula: The formula of step 1 works as follows: 

a. In the formula “ISNUMBER(B3:B18),ROW(B3:B18),” the ROW function returns the row numbers 
of the range B3:B18. So, the ROW function returns the following array of values: 

{3;4;5;6;7;8;9;10;11;12;13;14;15;16;17;18}. 

b. The ISNUMBER function processes each value returned by the ROW function. The ISNUMBER 
function returns “true” if a cell of column B contains a number. It returns “false” if a cell of column 
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B contains a text string. Consequently, the ISNUMBER function returns the following array of 
logical values: 

{TRUE;TRUE;FALSE;TRUE;TRUE;TRUE;TRUE;FALSE;TRUE;TRUE;FALSE;TRUE;TRUE;FALSE;TR
UE;TRUE} 

c. Next, the IF function operates. The “logical_test” of the IF function is “ISNUMBER(B3:B18)” and 
the “value_if_true” is “ROW(B3:B18).” The “value_if_false” has been omitted. Therefore, the IF 
function processes each value of the array returned by the ISNUMBER function. The IF function 
returns the row number for each “true” value and “false” for each “false” value. So, the IF function 
returns the following array of values: 

{3;4;FALSE;6;7;8;9;FALSE;11;12;FALSE;14;15;FALSE;17;18} 

d. The LARGE function has been supplied the array {1,2,3} in the formula 
“LARGE(IF(ISNUMBER(B3:B18),ROW(B3:B18)),{1,2,3}).” So, the LARGE function searches for the 
first highest, second highest, and third highest values in the array returned by the IF function. The 
LARGE function returns the following array of three values: 

{18,17,15} 

e. Next, the LOOKUP function processes the formula “LOOKUP({18,17,15},ROW(B3:B18),B3:B18).” 
So, the LOOKUP function searches for the values 18, 17, and 15 in the array returned by the 
formula “ROW(B3:B18).” The array returned by this ROW formula is the same as that of point “a.” 
Therefore, the LOOKUP function returns a corresponding match of the values 18, 17, and 15 from 
the range B3:B18. As a result, the following array is returned by the LOOKUP function: 

{50000,90000,110000} 

f. Finally, the AVERAGE function calculates the mean of the three values returned by the LOOKUP 
function. It returns 83333.3 [(50000+90000+110000)/3] as the average. 

Notice that the formula of step 1 works as an array formula as it has been completed by pressing 
the CSE (Ctrl+Shift+Enter) keys. Therefore, the LOOKUP function also returns an array of 
corresponding matches (50000, 90000, and 110000) for the multiple “lookup_values” (18, 17, and 15) 
supplied to it. 

However, the regular LOOKUP function looks for a single “lookup_value” and returns a single 
corresponding match. Moreover, it is completed by pressing the “Enter” key. 

Note 1: The ROW function returns the row numbers of the supplied cell reference. The ISNUMBER 
function checks whether the supplied value or cell reference is numeric or not. It returns “true” if 
the supplied value (or reference) is numeric, otherwise it returns “false.” 

The IF function checks whether the supplied condition (logical_test) is true or false. If the condition 
is true, it returns the “value_if_true.” If the condition is false, it returns the “value_if_false.” If the 
logical test evaluates to false and the “value_if_false” is omitted, the IF function returns “false.” 

For the syntax of the ROW, ISNUMBER, and IF functions, click the hyperlinks given in points “a,” 
“b,” and “c” of the preceding explanation. The definitions of the LOOKUP and LARGE functions 
are given in the notes at the end of examples #3 and #4 respectively. 

Note 2: To view the array returned by each function, follow the listed steps: 

a. Select cell C3 that contains the formula. 

b. Double-click within the selected cell. Alternatively, press the key F2 to enter the Edit 
mode. 

c. Select that part of the formula whose array needs to be viewed. For instance, to view the 
array returned by the ISNUMBER function, select “ISNUMBER(B3:B18).” 

d. Press the key F9 once a selection has been made in the preceding step. 

To stop editing the formula, press the escape (Esc) key. 

 

Summary 

 IF statements allow you to perform conditional logic in Excel. 
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 They evaluate a specified condition and return one value if the condition is true and another 

value if it's false. 

 Nested IF statements in Excel allow you to have multiple levels of conditional logic. 

 You can use them to create more complex decision trees by embedding one IF statement 

within another. 

 COUNTIF counts the number of cells within a range that meet a single specified condition. 

 COUNTIFS extends this functionality by allowing you to count cells based on multiple criteria 

simultaneously. 

 SUMIF calculates the sum of values in a range that meet a single specified condition. 

 SUMIFS can sum values based on multiple criteria, making it useful for more complex 

calculations. 

 AVERAGEIF calculates the average of values in a range that meet a single specified condition. 

 AVERAGEIFS extends this capability to calculate the average based on multiple criteria. 

 In IF statements, the logical test is a condition that is evaluated as either true or false. 

 It determines which value (value_if_true or value_if_false) is returned by the IF statement. 

 These are the values that the IF statement returns based on whether the logical test is true or 

false. 

 Value_if_true is returned when the condition is true, and Value_if_false is returned when the 

condition is false. 

 COUNTIFS, SUMIFS, AVERAGEIFS, and nested IF statements are valuable when you need to 

evaluate and work with multiple conditions simultaneously. 

 The syntax for these functions typically includes specifying a range of cells and one or more 

criteria to apply to those cells. 

 It's essential to ensure that your conditions and ranges are correctly specified to avoid errors 

in your IF statements and related functions. 

 

Keywords 

 IF Statement - A logical function in Excel that allows you to perform conditional calculations 

and return different values based on a specified condition. 

 Nested IF - Using multiple IF statements within one another to create complex conditional 

logic with multiple levels of conditions. 

 Countif - An Excel function used to count the number of cells within a range that meet a single 

specified condition. 

 Countifs - An Excel function that extends the functionality of COUNTIF by allowing you to 

count cells based on multiple criteria simultaneously. 

 Sumif - An Excel function used to calculate the sum of values in a range that meet a single 

specified condition. 

 Sumifs - An Excel function that extends the capability of SUMIF by allowing you to sum 

values based on multiple criteria. 

 Averageif - An Excel function used to calculate the average of values in a range that meet a 

single specified condition. 

 Averageifs - An Excel function that extends the capability of AVERAGEIF by allowing you to 

calculate the average based on multiple criteria. 

 Logical Test - The condition or expression in an IF statement that determines whether a 

specified action is taken. 
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 Criteria - The conditions or requirements that you specify in functions like COUNTIF, 

COUNTIFS, SUMIF, SUMIFS, AVERAGEIF, and AVERAGEIFS to filter and calculate values 

in a dataset. 

Self Assessment 

1. What is the purpose of an IF statement in Excel? 

A. To count cells 

B. To sum numbers 

C. To perform conditional logic 

D. To format text 

 

2. Which function is used in Excel to check if a condition is true or false and return different 

values accordingly? 

A. SUMIF 

B. AVERAGEIF 

C. IF 

D. COUNTIF 

 

3. In Excel, which of the following functions can be used to count the number of cells that meet a 

specific condition? 

A. SUMIF 

B. AVERAGEIF 

C. IF 

D. COUNTIF 

 

4. What is the syntax for a simple IF statement in Excel? 

A. IF(logical_test, value_if_true) 

B. IF(value_if_true, logical_test) 

C. IF(logical_test, value_if_true, value_if_false) 

D. IF(value_if_true, value_if_false, logical_test) 

 

5. In Excel, which function can be used to perform conditional calculations based on multiple 

criteria? 

A. SUMIF 

B. AVERAGEIF 

C. COUNTIFS 

D. IF 

 

6. What does a nested IF statement in Excel allow you to do? 

A. Combine multiple Excel workbooks 

B. Perform calculations on large datasets 

C. Perform multiple levels of conditional testing 

D. Sum a range of values 

 

7. In a nested IF statement, what happens if none of the conditions are met? 

A. The first condition is applied 

B. The last condition is applied 
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C. An error is returned 

D. The default value is applied 

 

8. What is the purpose of the COUNTIFS function in Excel? 

A. To count cells that meet multiple criteria 

B. To sum cells that meet multiple criteria 

C. To average cells that meet multiple criteria 

D. To perform conditional formatting 

 

9. Which function is used in Excel to sum the values in a range based on a specified condition? 

A. SUMIF 

B. AVERAGEIF 

C. COUNTIF 

D. IF 

 

10. Which of the following Excel functions is used to calculate the average of values in a range 

that meet a specific condition? 

A. AVERAGEIF 

B. SUMIF 

C. COUNTIF 

D. IF 

 

11. In Excel, what is the primary difference between SUMIF and SUMIFS? 

A. SUMIF can only handle one condition, while SUMIFS can handle multiple conditions. 

B. SUMIF can handle multiple conditions, while SUMIFS can only handle one condition. 

C. SUMIF and SUMIFS are used interchangeably. 

D. There is no difference between SUMIF and SUMIFS. 

 

12. Which Excel function can be used to count the number of cells that meet multiple conditions? 

A. COUNTIF 

B. AVERAGEIF 

C. COUNTIFS 

D. IF 

 

13. In Excel, what is the purpose of the AVERAGEIFS function? 

A. To find the average of a range of values 

B. To find the sum of a range of values 

C. To count the number of cells that meet multiple conditions 

D. To average a range of values based on multiple criteria 

 

14. How is the logical_test parameter structured in an IF statement? 

A. It is a required parameter. 

B. It is optional. 

C. It can only be a number. 

D. It can only be text. 

 

15. Which Excel function is used to sum a range of values based on a single condition? 
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A. SUMIF 

B. AVERAGEIF 

C. COUNTIF 

D. IF 

 

16. In a nested IF statement, how many levels of conditions can you have? 

A. Two 

B. Three 

C. Four 

D. Unlimited 

 

17. What does the COUNTIF function return in Excel? 

A. The sum of values that meet a condition 

B. The average of values that meet a condition 

C. The count of values that meet a condition 

D. The maximum value that meets a condition 

 

18. In Excel, which function can be used to find the sum of values that meet multiple conditions? 

A. SUMIF 

B. AVERAGEIF 

C. SUMIFS 

D. IF 

 

19. What is the primary purpose of using the IF function in Excel? 

A. To perform mathematical calculations 

B. To format cells 

C. To perform conditional testing and return different values 

D. To create charts 

 

20. Which of the following is NOT a valid function in Excel for conditional calculations? 

A. IF 

B. SUM 

C. COUNT 

D. AVERAGE 

 

Answers for Self Assessment 

1. C 2. C 3. D 4. A 5. C 

6. C 7. D 8. A 9. A 10. A 

11. A 12. C 13. D 14. A 15. A 

16. D 17. C 18. C 19. C 20. B 
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Review Questions 

1. What is the main purpose of an IF statement in Excel? 

2. How does a nested IF statement differ from a regular IF statement? 

3. When would you use the COUNTIF function in Excel, and what does it return? 

4. Explain the difference between SUMIF and SUMIFS in Excel. 

5. What does the SUMIF function do, and how is it structured? 

6. In Excel, when might you use the AVERAGEIF function, and how does it work? 

7. What is the primary purpose of the COUNTIFS function in Excel, and how is its syntax 

different from COUNTIF? 

8. How do you structure a simple IF statement in Excel? 

9. Describe a scenario in which you might use the SUMIFS function. 

10. How does the AVERAGEIFS function differ from AVERAGEIF, and what kind of calculations 

can it perform? 

 

 
Further Reading 

 https://corporatefinanceinstitute.com/resources/excel/excel-if-statement-guide/ 

 https://www.w3schools.com/excel/excel_if.php 

 https://www.perfectxl.com/excel-glossary/how-to-use-if-function-excel/ 

 https://www.wallstreetmojo.com/if-excel-function/ 

 https://www.excel-easy.com/examples/if.html 

 https://exceljet.net/formulas/nested-if-function-example 

 https://www.ablebits.com/office-addins-blog/excel-nested-if-statement/ 

 https://www.ablebits.com/office-addins-blog/nested-if-excel-multiple-conditions/ 

 https://www.javatpoint.com/nested-if-function-in-excel 

 https://www.wallstreetmojo.com/excel-nested-if-function/ 

 https://www.wallstreetmojo.com/nested-if-excel-multiple/ 

 https://www.ablebits.com/office-addins-blog/excel-countifs-multiple-criteria/ 

 https://techfunda.com/howto/1194/count-countif-countifs 

 https://www.exceldemy.com/countif-vs-countifs/ 

 https://www.makeuseof.com/use-countif-countifs-function-excel/ 

 https://trumpexcel.com/multiple-criteria-in-excel-countif/ 

 https://spreadsheeto.com/sumif-and-sumifs/ 

 https://www.ablebits.com/office-addins-blog/excel-sumifs-multiple-

criteria/#:~:text=SUMIF%20can%20evaluate%20just%20one,the%20first%20and%20req

uired%20argument. 

 https://www.wallstreetmojo.com/average-function-in-excel/ 

 https://www.myonlinetraininghub.com/excel-average-averageif-and-averageifs 

 https://www.kmacims.com.ng/the-averageif-and-averageifs-function-in-excel/ 
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Objectives 

After this unit, you will be able to  

 Understand the concept and use of VLOOKUP function in MS-EXCEL. 

 Understand the concept and use of HLOOKUP function in MS-EXCEL. 

 Understand the concept and use of Index and Match function in MS-EXCEL. 

 

Introduction 

Look-up functions are a crucial component in spreadsheet software and programming languages. 
They enable users to search for specific data within a dataset or table and retrieve corresponding 
information. Common examples include VLOOKUP and HLOOKUP in Excel, which are essential 
for data analysis and organization. 

 

9.1 VLOOKUP Function 

The VLOOKUP function is a premade function in Excel, which allows searches across columns. 

It is typed =VLOOKUP and has the following parts: 

=VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

Note: The column which holds the data used to lookup must always be to the left. 

Note: The different parts of the function are separated by a symbol, like comma , or semicolon ; 

The symbol depends on your Language Settings. 

Lookup_value: Select the cell where search values will be entered. 

Table_array: The table range, including all cells in the table. 

Col_index_num: The data which is being looked up. The input is the number of the column, 
counted from the left: 
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Range_lookup: TRUE if numbers (1) or FALSE if text (0). 

Note: Both 1 / 0 and True / False can be used in Range_lookup. 

How to use the VLOOKUP function. 

1. Select a cell (H4) 

2. Type =VLOOKUP 

3. Double click the VLOOKUP command 

4. Select the cell where search value will be entered (H3) 

5. Type (,) 

6. Mark table range (A2:E21) 

7. Type (,) 

8. Type the number of the column, counted from the left (2) 

9. Type True (1) or False (0) (1) 

10. Hit enter 

11. Enter a value in the cell selected for the Lookup_value H3(7) 

Let's have a look at an example! 

Use the VLOOKUP function to find the Pokemon names based on their ID#: 
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H4 is where the search result is displayed. In this case, the Pokemons names based on their ID#. 

 

 

H3 selected as lookup_value. This is the cell where the search query is entered. In this case the 
Pokemons ID#. 
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The range of the table is marked at table_array, in this example A2:E21. 

 

The number 2 is entered as col_index_number. This is the second column from the left and is the 
data that is being looked up. 
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An illustration for selecting col_index_number 2. 
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Ok, so next - 1 (True) is entered as range_lookup. This is because the most left column has numbers 
only. If it was text, 0 (False) would have been used. 

 

Good job! The function returns the #N/A value. This is because there have not been entered any 
value to the Search ID# H3. 

Let us feed a value to it, type H3(7): 

 

Have a look at that! The VLOOKUP function has successfully found the Pokemon Squirtle which 
has the ID# 7. 

One more time, type (H3)4: 
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It still works! The function returned Charmanders name, which has 4 as its ID#. That's great. 

 

9.2 HLOOKUP Function 

How to use HLOOKUP in Excel 

HLOOKUP in Excel stands for ‘Horizontal Lookup’. It is a function that makes Excel search for a 
certain value in a row (the so called ‘table array’), in order to return a value from a different row in 
the same column. 

Definition HLOOKUP function 

A HLOOKUP function in Excel exists of 4 components: 

1. The value you want to look up; 

2. The range in which you want to find the value and the return value; 

3. The number of the row within your defined range, that contains the return value; 

4. 0 or FALSE for an exact match with the value your are looking for; 1 or TRUE for an 
approximate match. 

Syntax: HLOOKUP([value], [range], [row number], [false or true]) 

HLOOKUP example 

In our example we show how many pieces of fruits are sold per day in the first week of May. We 
want to find out how many oranges were sold each day of the week. 

First, select a cell in which you want to publish the sold amount of oranges. We start with ‘Day 1’: 
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In our example we show how many pieces of fruits are sold per day in the first week of May. We 
want to find out how many oranges were sold each day of the week. 

First, select a cell in which you want to publish the sold amount of oranges. We start with ‘Day 1’: 

 

Then we select the value (from row 1) we want to look up, in this case it’s ‘Orange’ in cell F1. 

We can insert this value as a string: “Orange” (image 1), or as a cell reference: F1 (image 2): 

 

Image 1, Value as a String 
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Image 2, Value as a Cell Reference 

Next we enter ‘;’ and select the range (or table array) in which we want to find the lookup value 
and the return value. In this case it is range (B1:H8): 

 

Then we enter ‘;’ and the number of the row within the defined range in which we want to look for 
the return value. In this case it is row 2 (for day 1), followed by ‘;’ and ‘0’ or ‘FALSE for an exact 
match with the lookup value ‘Orange’: 

 

When we press enter, we get the amount of oranges sold on day 1: 
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To look up the value for day 2, we can copy the HLOOKUP formula, and replace row 2 with row 3: 

=HLOOKUP(“Orange”;B1:H8;3;0): 

 

We can repeat this process for each formula within the formula range B12:H12. 

In this example we only have a small list of dates, but imagine you have a long list that publishes 
several years and you wish to use a certain value in other worksheets! Using HLOOKUP 
(and VLOOKUP) the user only has to change a certain value in one worksheet and it will 
automatically be changed in all other relevant places. 

But what if you’re not certain about your lookup value? Then you can consider an approximate 
match (set False to True). 

Approximate Match in HLOOKUP 

When we enter the word ‘Ornage’ in our HLOOKUP function, because we are not sure about the 
spelling of the value that we’re looking for. The formula as we designed it gets confused, because it 
can’t find this value in the table array. It returns the standard Excel error #N/A: 

Lovely Professional University 309



Unit 09: Look Up Functions  

 

Notes 

 

Let us change the ‘0’ (or ‘False’) component of our HLOOKUP function to ‘1’ or ‘TRUE’: 

=HLOOKUP(“Ornage”;B1:H8;2;1) 
Now we have asked the function to look for an approximate match with ‘Ornage’. If it can’t find the 
exact match, it will look for the closest match to the value ‘Ornage’, less than ‘Ornage’, which is 
‘Orange’: 

 

Would we enter ‘Arange’ instead of “Orange”, the function returns 21, because then ‘Apple’ is the 
closest match less than ‘Orange’ (based on the alphabet): 

 

 

9.3 INDEX and MATCH Functions 

Since the aim of this tutorial is to demonstrate an alternative way to do a vlookup in Excel by using 
a combination of INDEX and MATCH functions, we won't dwell much on their syntax and uses. 
We will cover only the minimum necessary for understanding the general idea and then take an in-
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depth look at formula examples that reveal all the advantages of using INDEX MATCH instead of 
VLOOKUP. 

INDEX function - syntax and usage 

The Excel INDEX function returns a value in an array based on the row and column numbers you 
specify. The syntax of the INDEX function is straightforward: 

INDEX(array, row_num, [column_num]) 

Here is a very simple explanation of each parameter: 

 array - a range of cells that you want to return a value from. 

 row_num - the row number in array from which you want to return a value. If omitted, the 
column_num is required. 

 column_num - the column number in array from which you want to return a value. If omitted, 
row_num is required. 

For more information, please see Excel INDEX function. 

And here is an example of the INDEX formula in its simplest form: 

=INDEX(A1:C10,2,3) 

The formula searches in cells A1 through C10 and returns a value of the cell in the 2nd row and the 
3rd column, i.e. cell C2. 

Very easy, right? However, when working with real data you would hardly ever know which row 
and column you want, that's where the MATCH function comes in handy. 

MATCH function - syntax and usage 

The Excel MATCH function searches for a lookup value in a range of cells and returns the relative 
position of that value in the range. 

The syntax of the MATCH function is as follows: 

MATCH (lookup_value, lookup_array, [match_type]) 

 lookup_value - the number or text value you are looking for. 

 lookup_array - a range of cells being searched. 

 match_type - specifies whether to return an exact match or the nearest match: 

 1 or omitted - finds the largest value that is less than or equal to the lookup value. 

Requires sorting the lookup array in ascending order. 

 0 - finds the first value that is exactly equal to the lookup value. In the INDEX / MATCH 

combination, you almost always need an exact match, so you set the third argument of 

your MATCH function to 0. 

 -1 - finds the smallest value that is greater than or equal to lookup_value. Requires 

sorting the lookup array in descending order. 

For example, if the range B1:B3 contains the values "New-York", "Paris", "London", the below 
formula returns the number 3, because "London" is the third entry in the range: 

=MATCH("London",B1:B3,0) 

For more information, please see Excel MATCH function. 

At first sight, the usefulness of the MATCH function may seem questionable. Who cares about the 
position of a value in a range? What we do want to know is the value itself. 

Let me remind you that the relative position of the lookup value (i.e. row and column numbers) is 
exactly what you need to supply to the row_num and column_num arguments of the INDEX 
function. As you remember, Excel INDEX can find the value at the juncture of a given row and 
column, but it cannot determine which exactly row and column you want. 

How to use INDEX MATCH function in Excel 
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Now that you know the basics, I believe it has already started making sense how MATCH and 
INDEX work together. In a nutshell, INDEX finds the lookup value by column and row numbers, 
and MATCH provides those numbers. That's it! 

For vertical lookup, you use the MATCH function only to determine the row number and supply 
the column range directly to INDEX: 

INDEX (column to return a value from, MATCH (lookup value, column to look up against, 0)) 

Still having difficulties to figure that out? It might be easier to understand from an example. 
Suppose you have a list of national capitals and their population: 

 

To find the population of a certain capital, say the capital of Japan, use the following INDEX 
MATCH formula: 

=INDEX(C2:C10, MATCH("Japan", A2:A10, 0)) 

Now, let's analyze what each component of this formula actually does: 

 The MATCH function searches for the lookup value "Japan" in the range A2:A10, and returns 

the number 3, because "Japan" is third in the lookup array. 

 The row number goes directly to the row_num argument of INDEX instructing it to return a 

value from that row. 

So, the above formula turns into a simple INDEX(C2:C,3) that says to search in cells C2 through C10 
and pull the value from the 3rd cell in that range, i.e. C4 because we start counting from the second 
row. 

Don't want to hardcode the city in the formula? Input it in some cell, say F1, supply the cell 
reference to MATCH, and you will get a dynamic lookup formula: 
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=INDEX(C2:C10, MATCH(F1,A2:A10,0)) 

 

 

Important note! The number of rows in the array argument of INDEX should match the 
number of rows in the lookup_array argument of MATCH, otherwise the formula will 
produce an incorrect result. 

Wait, wait… why don't we simply use the following Vlookup formula? What's the point in wasting 
time trying to figure out the arcane twists of Excel MATCH INDEX? 

=VLOOKUP(F1, A2:C10, 3, FALSE) 

In this case, no point at all :) This simple example is for demonstration purposes only, so that you 
get a feel of how the INDEX and MATCH functions work together. Other examples that follow 
below will show you the real power of this combination that easily copes with many complex 
scenarios when VLOOKUP stumbles. 

Excel INDEX MATCH - formula examples 

Knowing the reasons to learn the MATCH INDEX function, let's get to the most interesting part 
and see how you can apply the theoretical knowledge in practice. 

INDEX MATCH formula to look up from right to left 

As already mentioned, VLOOKUP cannot look at its left. So, unless your lookup values are is the 
leftmost column, there's no chance that a Vlookup formula will bring you the result you want. The 
INDEX MATCH function in Excel is more versatile and does not really care where the lookup and 
return columns are located. 

 

For this example, we will add the Rank column to the left of our sample table and try to 
figure out how the Russian capital, Moscow, ranks in terms of population. 

With the lookup value in G1, use the following formula to search in C2:C10 and return a 
corresponding value from A2:A10: 

=INDEX(A2:A10,MATCH(G1,C2:C10,0)) 
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Tip. If you plan to use your INDEX MATCH formula for more than one cell, be sure to lock both 
ranges with absolute cell references (like $A$2:$A$10 and $C$2:4C$10) so they won't get distorted 
when copying the formula. 

INDEX MATCH MATCH to search in rows and columns 

In the above examples, we used INDEX MATCH as the replacement for classic VLOOKUP to 
return a value from a predefined one-column range. But what if you need to look up in multiple 
rows and columns? In other words, what if you want to perform the so-called matrix or two-
way lookup? 

This may sound tricky, but the formula is very similar to the basic Excel INDEX MATCH function, 
with just one difference. Guess what? 

Simply, use two MATCH functions – one to get a row number and the other to get a column 
number. And I congratulate those of you who have guessed right :) 

INDEX (array, MATCH (vlookup value, column to look up against, 0), MATCH (hlookup 
value, row to look up against, 0)) 

And now, please take a look at the below table and let's build an INDEX MATCH MATCH formula 
to find the population (in millions) in a given country for a given year. 

With the target country in G1 (vlookup value) and the target year in G2 (hlookup value), the 
formula takes this shape: 

=INDEX(B2:D11, MATCH(G1,A2:A11,0), MATCH(G2,B1:D1,0)) 

 

How this formula works 

Whenever you need to understand a complex Excel formula, break it down into smaller parts and 
see what each individual function does: 

MATCH(G1,A2:A11,0) – searches through A2:A11 for the value in cell G1 ("China") and returns its 
position, which is 2. 

MATCH(G2,B1:D1,0)) – searches through B1:D1 to get the position of the value in cell G2 ("2015"), 
which is 3. 

The above row and column numbers go to the corresponding arguments of the INDEX function: 

INDEX(B2:D11, 2, 3) 

As the result, you get a value at the intersection of the 2nd row and 3rd column in the range 
B2:D11, which is the value in cell D3. Easy? Yep! 

Excel INDEX MATCH to look up multiple criteria 

If you had a chance to read our Excel VLOOKUP tutorial, you have probably already tested a 
formula to Vlookup with multiple criteria. However, a significant limitation of that approach is the 
necessity to add a helper column. The good news is that Excel's INDEX MATCH function can look 
up with two or more criteria too, without modifying or restructuring your source data! 

Here's the generic INDEX MATCH formula with multiple criteria: 

{=INDEX(return_range, MATCH(1, (criteria1=range1) * (criteria2=range2), 0))} 
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Note. This is an array formula that must be completed with the Ctrl + Shift + Enter 
shortcut. 

In the sample table below, supposing you want to find the amount based on 2 
criteria, Customer and Product. 

The following INDEX MATCH formula works a treat: 

=INDEX(C2:C10, MATCH(1, (F1=A2:A10) * (F2=B2:B10), 0)) 

Where C2:C10 is the range to return a value from, F1 is criteria1, A2:A10 is the range to compare 
against criteria1, F2 is criteria 2, and B2:B10 is the range to compare against criteria2. 

Remember to enter the formula correctly by pressing Ctrl + Shift + Enter, and Excel will 
automatically enclose it curly brackets as shown in the screenshot: 

 

If you'd rather not use array formulas in your worksheets, add one more INDEX function to the 
formula and complete it with a usual Enter hit: 

 

 

Summary 

VLOOKUP: 
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1. Purpose: VLOOKUP is used to search for a value in the leftmost column of a table or range 
and retrieve a corresponding value from a specified column. 

2. Structure: VLOOKUP consists of four main arguments: the lookup value, table array, column 
index number, and range lookup (which determines if it's an exact or approximate match). 

3. Table Format: VLOOKUP works best with data arranged in vertical tables, with the lookup 
column on the left. 

4. Approximate Match: By default, VLOOKUP performs an approximate match, returning the 
closest value if an exact match isn't found. 

5. Exact Match: To perform an exact match, set the range lookup argument to FALSE or 0. 

6. Error Handling: If the lookup value is not found, VLOOKUP returns a #N/A error, which can 
be managed using error handling techniques. 

HLOOKUP: 

7. Purpose: HLOOKUP performs a horizontal lookup, searching for a value in the top row of a 
table and returning a corresponding value from a specified row. 

8. Table Format: HLOOKUP is suitable for data organized in horizontal tables, with the lookup 
row at the top. 

9. Usage: HLOOKUP is less commonly used than VLOOKUP but can be valuable when dealing 
with transposed data. 

INDEX and MATCH: 

10. Purpose: INDEX and MATCH functions are often used together to provide a more flexible 
and powerful way to look up values in Excel. 

11. INDEX: The INDEX function returns the value of a cell in a specified row and column within a 
range or array. 

12. MATCH: The MATCH function is used to find the relative position of a value within a range 
or array. 

13. Flexibility: INDEX and MATCH can handle both vertical and horizontal data arrangements, 
making them versatile for various lookup scenarios. 

14. Multiple Criteria: INDEX and MATCH can be used to perform lookups based on multiple 
criteria, which is challenging with VLOOKUP or HLOOKUP. 

15. Error Handling: If a value is not found using MATCH, it returns a #N/A error, and INDEX 
can be used to manage this error and return customized results. 

16. Two-Way Lookups: INDEX and MATCH are especially useful for two-way lookups, where 
you need to find a value at the intersection of a row and column. 

17. Array Formulas: When used together, INDEX and MATCH often require being entered as 
array formulas (Ctrl+Shift+Enter) to handle multiple results. 

18. Performance: In some cases, INDEX and MATCH can be more resource-efficient than 
VLOOKUP, especially in large datasets. 

19. Versatility: The combination of INDEX and MATCH provides a versatile alternative to 
VLOOKUP and HLOOKUP, offering greater control and adaptability in lookup tasks. 

 

Keywords 

 VLOOKUP: A function in Excel used to vertically look up a value in a table and retrieve a 

corresponding value from a specified column. 

 HLOOKUP: A function in Excel used to horizontally look up a value in a table and retrieve a 

corresponding value from a specified row. 

 INDEX: A function in Excel that returns the value of a cell within a specified range or array 

based on row and column numbers. 
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 MATCH: A function in Excel used to find the relative position of a value within a range or 

array. 

 Lookup Value: The value you want to find in a table when using VLOOKUP or HLOOKUP, or 

the value you want to locate with MATCH. 

 Table Array: The range or array where the data is stored from which you want to retrieve a 

value using VLOOKUP or HLOOKUP, or the range within which you want to search using 

MATCH. 

 Column Index Number: The argument in VLOOKUP that specifies which column from the 

table array to return a value from, or the argument used with INDEX to specify the column 

number. 

 Range Lookup: An optional argument in VLOOKUP that determines whether to perform an 

approximate or exact match; it's typically set to TRUE for approximate matches and FALSE 

for exact matches. 

 

Self Assessment 

1. What does the V in VLOOKUP stand for? 

A. Vertical 

B. Value 

C. Variable 

D. Viable 

 

2. Which Excel function is used to look up a value in a vertical table and return a 

corresponding value from a specified column? 

A. HLOOKUP 

B. VSEARCH 

C. MATCH 

D. VLOOKUP 

 

3. In a VLOOKUP function, which column is used to find the lookup value? 

A. Lookup column 

B. Result column 

C. Table array column 

D. Index column 

 

4. What happens if the lookup value is not found in the table array for a VLOOKUP 

function? 

A. An error is returned 

B. The last value in the table array is returned 

C. The first value in the table array is returned 

D. None of the above 

 

5. In Excel, what is the purpose of the HLOOKUP function? 

A. To look up values in a vertical table 

B. To look up values in a horizontal table 

C. To perform mathematical calculations 

D. To create charts 
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6. Which of the following is not a required parameter for the VLOOKUP function? 

A. Lookup value 

B. Table array 

C. Column index number 

D. Match type 

 

7. What does the H in HLOOKUP stand for? 

A. Horizontal 

B. Highlight 

C. Header 

D. Helper 

 

8. Which function is used to search for a value in the top row of a table and return a 

corresponding value from a specified row? 

A. VLOOKUP 

B. HSEARCH 

C. INDEX 

D. HLOOKUP 

 

9. What does the INDEX function in Excel do? 

A. Looks up values in a table and returns corresponding values 

B. Returns the position of a specified value in a range 

C. Returns the value of a specified cell 

D. Returns the row or column number of a specified cell 

 

10. Which function is used to search for a value in a range and return its relative position 

within that range? 

A. MATCH 

B. LOOKUP 

C. INDEX 

D. SEARCH 

 

11. What is one advantage of using the INDEX and MATCH functions over VLOOKUP? 

A. INDEX and MATCH can handle multiple criteria 

B. VLOOKUP is faster than INDEX and MATCH 

C. INDEX and MATCH are easier to use 

D. VLOOKUP can handle multiple lookup values 

 

12. In the INDEX function, what does the "row_num" argument specify? 

A. The column number 

B. The row number 

C. The lookup value 

D. The table array 

 

13. Which function combination is commonly used to perform a two-way lookup in Excel? 

A. VLOOKUP and HLOOKUP 
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B. INDEX and MATCH 

C. LOOKUP and SEARCH 

D. IF and THEN 

 

14. What is the primary advantage of using the INDEX and MATCH combination over 

VLOOKUP or HLOOKUP? 

A. INDEX and MATCH can handle more extensive datasets 

B. INDEX and MATCH are faster in processing 

C. VLOOKUP and HLOOKUP are obsolete functions 

D. VLOOKUP and HLOOKUP can't perform two-way lookups 

 

15. In a MATCH function, what does the "match_type" argument specify? 

A. The type of lookup to perform 

B. The position of the match 

C. The lookup value 

D. The table array 

 

16. In Excel, which of the following is a limitation of the VLOOKUP function that can be 

overcome by using INDEX and MATCH? 

A. Inability to perform approximate matches 

B. Inability to handle text values 

C. Inability to work with tables with multiple criteria 

D. None of the above 

 

17. What does the INDEX function return if no match is found? 

A. #N/A error 

B. 0 

C. The first value in the specified range 

D. Blank cell 

 

18. What type of lookup can the VLOOKUP function perform by default? 

A. Exact match 

B. Approximate match 

C. Partial match 

D. Case-sensitive match 

 

19. When would you use the INDEX function with multiple parameters? 

A. To return an entire row or column of data 

B. To search for a value in a specific range 

C. To perform arithmetic calculations 

D. To create a chart 

 

20. In a MATCH function, which argument is optional and typically omitted when 

performing an exact match? 

A. Lookup_value 

B. Lookup_array 

C. Match_type 
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D. All arguments are required 

 

Answers for Self Assessment 

1. A 2. D 3. A 4. A 5. B 

6. D 7. A 8. D 9. A 10. A 

11. A 12. B 13. B 14. A 15. A 

16. C 17. A 18. B 19. A 20. C 

 

Review Questions 

1. What is the primary purpose of the VLOOKUP function in Excel? 

2. Explain the key components of a VLOOKUP function, including the lookup value, table array, 

column index number, and range lookup. 

3. What does the "range_lookup" argument in the VLOOKUP function control, and what are the 

two possible values for it? 

4. In Excel, how does the HLOOKUP function differ from the VLOOKUP function in terms of 

table orientation and operation? 

5. When using VLOOKUP, what should you do if you want to find an exact match in the lookup 

table? 

6. What does the "#N/A" error mean when it appears as a result of a VLOOKUP function, and 

how can you handle it? 

7. What is the primary purpose of the INDEX function in Excel, and how does it differ from 

VLOOKUP? 

8. Describe the syntax and parameters of the INDEX function, including the array and 

row/column number. 

9. How does the MATCH function complement the INDEX function, and what does it return? 

10. In what scenarios might you prefer to use the INDEX and MATCH functions instead of 

VLOOKUP or HLOOKUP, and why? 

 

 
Further Readings 

 https://www.w3schools.com/excel/excel_vlookup.php 

 https://www.simplilearn.com/tutorials/excel-tutorial/vlookup-in-excel 

 https://edu.gcfglobal.org/en/excel-tips/how-to-use-excels-vlookup-function/1/ 

 https://www.perfectxl.com/excel-glossary/how-to-use-hlookup-excel/ 

 https://www.simplilearn.com/tutorials/excel-tutorial/excel-h-lookup 

 https://www.ablebits.com/office-addins-blog/excel-hlookup-formula-examples/ 

 https://exceljet.net/functions/hlookup-function 

 https://exceljet.net/articles/index-and-match 

 https://www.ablebits.com/office-addins-blog/excel-index-match-function-

vlookup/ 

 https://www.excel-easy.com/examples/index-match.html 
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 https://www.geeksforgeeks.org/index-and-match-function-in-excel/ 
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Objectives 

After this unit, you will be able to understand- 

 Introduction to Pivot Table 

 Filter Data Using Slicers in Multiple Pivot Table 

 Visualize Aggregate Data Using Pivot Table 

 

Introduction 

Pivot tables are a powerful tool in data analysis and reporting, widely used in spreadsheet software 
like Microsoft Excel. They allow users to summarize and transform data, making it easier to draw 
insights and generate meaningful reports. Pivot tables are invaluable for business intelligence, 
financial analysis, and any scenario where large datasets need to be distilled into manageable 
information. 

 

Introduction to Pivot Table 

A pivot table is a statistics tool that summarizes and reorganizes selected columns and rows of data 
in a spreadsheet or database table to obtain a desired report. The tool does not actually change the 
spreadsheet or database itself, it simply “pivots” or turns the data to view it from different 
perspectives. 

Pivot tables are especially useful with large amounts of data that would be time-consuming to 
calculate by hand. A few data processing functions a pivot table can perform include identifying 
sums, averages, ranges or outliers. The table then arranges this information in a simple, meaningful 
layout that draws attention to key values. 

Pivot table is a generic term, but is sometimes confused with the Microsoft trademarked term, 
PivotTable. This refers to a tool specific to Excel for creating pivot tables. 
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10.1 How Pivot Tables Work 

When users create a pivot table, there are four main components: 

1. Columns- When a field is chosen for the column area, only the unique values of the field are 
listed across the top. 

2. Rows- When a field is chosen for the row area, it populates as the first column. Similar to the 
columns, all row labels are the unique values and duplicates are removed. 

3. Values- Each value is kept in a pivot table cell and display the summarized information. The 
most common values are sum, average, minimum and maximum. 

4. Filters- Filters apply a calculation or restriction to the entire table. 

 

For example, a store owner might list monthly sales totals for a large number of 
merchandise items in an Excel spreadsheet. If they wanted to know which items sold 
better in a particular financial quarter, they could use a pivot table. The sales quarters 
would be listed across the top as column labels and the products would be listed in the 
first column as rows. The values in the worksheet would show the sum of sales for each 
product in each quarter. A filter could then be applied to only show specific quarters, 
specific products or averages. 

Uses of a pivot table 

A pivot table helps users answer business questions with minimal effort. Common pivot table uses 
include: 

 To calculate sums or averages in business situations. For example, counting sales by 
department or region. 

 To show totals as a percentage of a whole. For example, comparing sales for a specific product 
to total sales. 

 To generate a list of unique values. For example, showing which states or countries have 
ordered a product. 

 To create a 2x2 table summary of a complex report. 

 To identify the maximum and minimum values of a dataset. 

 To query information directly from an online analytical processing (OLAP) server. 

Using PivotTables to answer questions 

Consider the example below. Let's say we wanted to answer the question What is the amount sold 
by each salesperson? Answering it could be time consuming and difficult; each salesperson appears 
on multiple rows, and we would need to total all of their different orders individually. We could 
use the Subtotal command to help find the total for each salesperson, but we would still have a lot 
of data to work with. 
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Fortunately, a PivotTable can instantly calculate and summarize the data in a way that will make it 
much easier to read. When we're done, the PivotTable will look something like this: 

 

Once you've created a PivotTable, you can use it to answer different questions by rearranging—
or pivoting—the data. For example, let's say we wanted to answer What is the total amount sold in 
each month? We could modify our PivotTable to look like this: 

 

To create a PivotTable: 

1. Select the table or cells (including column headers) you want to include in your PivotTable. 
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2. From the Insert tab, click the PivotTable command. 

 

3. The Create PivotTable dialog box will appear. Choose your settings, then click OK. In our 
example, we'll use Table1 as our source data and place the PivotTable on a new worksheet. 
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4. A blank PivotTable and Field List will appear on a new worksheet. 
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5. Once you create a PivotTable, you'll need to decide which fields to add. Each field is simply 
a column header from the source data. In the PivotTable Field List, check the box for each field 
you want to add. In our example, we want to know the total amount sold by each salesperson, 
so we'll check the Salesperson and Order Amount fields. 
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6. The selected fields will be added to one of the four areas below. In our example, 
the Salesperson field has been added to the Rows area, while Order Amount has been added 
to Values. Alternatively, you can drag and drop fields directly into the desired area. 

 

7. The PivotTable will calculate and summarize the selected fields. In our example, the 
PivotTable shows the amount sold by each salesperson. 
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Just like with normal spreadsheets, you can sort the data in a PivotTable using the Sort & 
Filter command on the Home tab. You can also apply any type of number formatting you want. For 
example, you may want to change the number format to Currency. However, be aware that some 
types of formatting may disappear when you modify the PivotTable. 

 

If you change any of the data in your source worksheet, the PivotTable will not update 

automatically. To manually update it, select the PivotTable and then go to Analyze Refresh. 

Pivoting data 

One of the best things about PivotTables is that they can quickly pivot—or reorganize—your data, 
allowing you to examine your worksheet in several ways. Pivoting data can help you 
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answer different questions and even experiment with your data to discover new trends and 
patterns. 

To add columns: 

So far, our PivotTable has only shown one column of data at a time. In order to show multiple 
columns, you'll need to add a field to the Columns area. 

1. Drag a field from the Field List into the Columns area. In our example, we'll use 
the Month field. 
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2. The PivotTable will include multiple columns. In our example, there is now a column for each 
person's monthly sales, in addition to the grand total. 

 

To change a row or column: 

Changing a row or column can give you a completely different perspective on your data. All you 
have to do is remove the field in question, then replace it with another. 

1. Drag the field you want to remove out of its current area. You can also uncheck the 
appropriate box in the Field List. In this example, we've removed 
the Month and Salesperson fields. 
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2. Drag a new field into the desired area. In our example, we'll place the Region field 
under Rows. 
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3. The PivotTable will adjust—or pivot—to show the new data. In our example, it now shows 
the amount sold by each region. 
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10.2 Filter Data Using Slicers in Multiple Pivot Table 

Excel 2010 version of the Pivot Table was jazzed up by the entry of a new super cool feature – 
Slicers. 

A Pivot Table Slicer enables you to filter the data when you select one or more than one options in 
the Slicer box (as shown below). 

 

In the example above, Slicer is the orange box on the right, and you can easily filter the Pivot 
Table by simply clicking on the region button in the Slicer. 

Inserting a Slicer in Excel Pivot Table 

Suppose you have a dataset as shown below: 
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This is a dummy data set (US retail sales) and spans across 1000 rows. Using this data, we have 
created a Pivot Table that shows the total sales for the four regions. 

 

Once you have the Pivot Table in place, you can insert Slicers. 

One may ask – Why do I need Slicers?  

You may need slicers when you don’t want the entire Pivot Table, but only a part of it. For example, 
if you don’t want to see the sales for all the regions, but only for South, or South and West, then you 
can insert the slicer and quickly select the desired region(s) for which you want to get the sales 
data. 

Slicers are a more visual way that allows you to filter the Pivot Table data based on the selection. 

Here are the steps to insert a Slicer for this Pivot Table: 

 Select any cell in the Pivot Table. 

 Go to Insert –> Filter –> Slicer. 

 

 In the Insert Slicers dialog box, select the dimension for which you the ability to filter the data. 
The Slicer Box would list all the available dimensions and you can select one or more than one 
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dimensions at once. For example, if I only select Region, it will insert the Region Slicer box 
only, and if I select Region and Retailer Type both, then it’ll insert two Slicers. 

 

 Click OK. This will insert the Slicer(s) in the worksheet. 

Note that Slicer would automatically identify all the unique items of the selected dimension and list 
it in the slicer box. 

Once you have inserted the slicer, you can filter the data by simply clicking on the item. For 
example, to get the sales for South region only, click on South. You’ll notice that the selected item 
gets a different shade of color as compared with the other items in the list. 
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You can also choose to select multiple items at once. To do that, hold the Control Key and click on 
the ones that you want to select. 

 

If you want to clear the selection, click on the filter icon (with a red cross) at the top right. 

 

Inserting Multiple Slicers in a Pivot Table 

You can also insert multiple slicers by selecting more than one dimension in the Insert Slicers dialog 
box. 

To insert multiple slicers: 

 Select any cell in the Pivot Table. 

 Go to Insert –> Filter –> Slicer. 
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 In the Insert Slicers dialog box, select all the dimensions for which you want to get the Slicers. 

 Click OK. 

  

This will insert all the selected Slicers in the worksheet. 
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Note that these slicers are linked to each other. For example, If I select ‘Mid West’ in the Region 
filter and ‘Multiline’ in the Retailer Type filter, then it will show the sales for all the Multiline 
retailers in Mid West region only. 

 

Also, if I select Mid West, note that the Specialty option in the second filter gets a lighter shade of 
blue (as shown below). This indicates that there is no data for Specialty retailer in the Mid West 
region. 

 

 

10.3 Visualize Aggregate Data Using Pivot Table 

In today's world, Excel is used in almost all industries, whether it be financial services, IT services, 
automotive, manufacturing, or many others. Excel deals with large amounts of data and finds 
insights in it. Without summarizing the information in a chart, understanding can become quite 
hectic. The need for visualization tools in Excel is undeniable. 

In a previous guide, we learned about various aspects of PivotTables with very little emphasis on 
Pivot Charts. In this series of two guides (beginner and advanced) on Pivot Charts, we will further 
explore the topic and visualize data using Pivot Charts. 

Describing Data 

We will be using a dummy data set consisting of data related to colleges in various countries, their 
fee structures, and their minimum acceptable test scores (GRE and GMAT). Given below is the 
original data set, which holds eight columns and 10 rows: 
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Pivot Chart Basics 

To build a pivot chart, the first thing you need to do is to construct a PivotTable. Here we have 
constructed a PivotTable using column names Country and Program under the Rows section and 
the sum of the tuition fee, accommodation fee, and miscellaneous charges under the Values section. 

Row Labels 
Sum of Tuition 
Fee 

Sum of Accommodation 
Fee 

Sum of Misc 
Charges 

England 243000 94000 29000 

Master's (Biz) 157000 38000 17000 

Ph.D. 86000 56000 12000 

India 40000 15000 2000 

Master's (Engg) 40000 15000 2000 

Japan 124000 87000 14000 

Master's (Biz) 56000 32000 8000 

Ph.D. 68000 55000 6000 

United States of 
America 

1261555 118000 35000 

Master's (Biz) 1010000 42000 18000 

Master's (Engg) 251555 76000 17000 

Grand Total 1668555 314000 80000 

Next, to build any of the Pivot Charts on the given PivotTable, you first need to select those 
columns you need to visualize, then in the menu bar click on Insert, and then click on 
the PivotChart icon. This will popup a new dialog box with the name Insert Chart. Now, you can 
select any of the given charts to plot your selected data. 
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1. Bar Chart 

If you are dealing with numerical data, then bar charts are the first visualization tool that comes to 
mind. There are a variety of bar charts that can help you summarize numerical data and show you 
its relative importance. To get a brief understanding of how bar charts work, you can visit the bar 
chart webpage on the Investopedia website. 

We will now learn how to make a variety of bar charts on the PivotTable described in the above 
section. If you are in the Insert Chart popup dialog box, you can click on the Bar tab, which will 
show you six types of bar charts. There are really three main kinds of these charts, namely, 
clustered, stacked, and 3D charts; the remaining are merely a combination of these three charts with 
the inclusion of a hundred percent stacked theme. 

Clustered 

 

100% Stacked Column 

 

3-D 100% Stacked Column 
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You can use any of the above three charts or the remaining three charts to analyze the given 
PivotTable data. As you can observe, the bar charts make it very clear as to which program in 
which country has the highest and the lowest fee structure in terms of tuition, accommodation, and 
miscellaneous charges. 

You can also control the Chart Elements, including Axes, Axis Title, Chart Title, Data Labels, Data 
Table, Gridlines, and Legend, using the + sign available outside the chart. 

2. Line Chart 

A line chart can be used to plot either a single or multiple numerical data columns. You can explore 
more about line charts and their use on the Investopedia line chart web page. 

To learn how to make a line chart in Excel's PivotTable, we will be using the same PivotTable as 
above and all of the three numerical data types, i.e., tuition fee, accommodation fee, and 
miscellaneous charges. 

To create a line chart from multiple numerical data columns, you need to first select the data from 
the complete PivotTable and follow the same procedure as during the bar chart creation. The only 
difference is that you need to select line instead of bar inside the Insert Chart dialogue box. Inside 
the line section, you will observe seven types of available line charts. In this example, we create a 
line chart with markers, as shown below: 
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3. Scatter Plot 

A scatter plot can be used to show a relationship between two numerical quantities or one 
numerical and one non-numerical quantity. For a brief overview, you can visit this webpage on the 
Statistics how to website. 

Sadly, we cannot create a scatter plot on a PivotTable directly using its data. However, there is no 
restriction on copying the data from a PivotTable and then using it to create a scatter plot. In this 
section, we will learn how to create a basic scatter plot based on one numerical quantity and one 
non-numerical quantity. 

First of all, we create a new PivotTable using the College column under the Rows section and 
the Min GMAT Score column under the Values section. We filter the result based on 
the Program column and further select only the Master's (Biz). Once we are done with this process, 
we have a PivotTable as shown below: 

Program Master's (Biz) 

Row Labels Sum of Min GMAT Score 

Harvard University 770 

Kyoto University 715 

London Business School 700 

London School of Economics 720 

Grand Total 2905 

The follow the given steps to create a scatter plot on this PivotTable data: 1. Copy the text and the 
GMAT score data of these four universities and paste them in two new blank columns somewhere 
in the same sheet. 

Harvard University 770 

Kyoto University 715 
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London Business School 700 

London School of Economics 720 

2. Next, click on a new empty cell and go to the Insert tab under the menu bar. Locate 
the Charts section, which is available just before the PivotChart section. Click on the scatter 
plot icon. This will bring an empty scatter plot on the worksheet. 

3. Moving ahead, right-click on the empty scatter plot and click on Select Data.... This will open 
up a new dialogue box as shown below: 

 

4. Click on the Add button, which opens up a new dialog box where you can input the series 
name and its X and Y data values. I have used Master's (Biz) as the series name, but you can 
select anything you want. Now select the college names in the series X data and select the 
GMAT score as part of the Y data. For me, the completed dialog box looks like this: 

 

5. Now press OK a few times and after a bit of tweaking the Chart Elements, you can have a 
scatter plot like this: 
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Summary 

Pivot Table Keywords: 

1. Pivot Table: A data summarization tool in Excel that allows you to analyze and manipulate 
large datasets by creating custom tables. 

2. Data Source: The range or table containing the raw data that you want to analyze with a Pivot 
Table. 

3. Field: A column in the data source that you can add to a Pivot Table for analysis. Fields can be 
categorized as rows, columns, values, or filters. 

4. Rows: The area of a Pivot Table where you place fields that will be used as row labels. This 
defines the structure of the rows in the Pivot Table. 

5. Columns: The area of a Pivot Table where you place fields that will be used as column labels. 
This defines the structure of the columns in the Pivot Table. 

6. Values: The area of a Pivot Table where you place fields whose data you want to summarize, 
such as sum, count, average, etc. 

7. Filters: The area of a Pivot Table where you place fields that allow you to filter data within the 
Pivot Table, making it easier to analyze specific subsets of data. 

Slicer Keywords: 

8. Slicer: A visual filtering tool in Excel that allows users to easily filter data in a Pivot Table or 
Pivot Chart by selecting specific items from a list or button interface. 

9. Selection: The specific item or items chosen in a slicer to filter the data displayed in the 
associated Pivot Table or Pivot Chart. 

10. Visual Filtering: The process of using slicers to interactively filter data by clicking on items in 
a slicer's user interface, providing a more user-friendly and intuitive way to filter data 
compared to traditional methods. 

 

Keywords 

 Data Analysis: Pivot Tables are powerful tools for data analysis in Excel, allowing you to 
summarize and extract meaningful insights from large datasets. 

 Structure: Pivot Tables consist of rows, columns, values, and filters, with each component 
serving a specific purpose in organizing and presenting data. 

 Aggregation: You can use Pivot Tables to perform aggregation functions like sum, count, 
average, and more on your data to analyze trends and patterns. 

 Data Source: Pivot Tables require a data source, which can be a range of cells or an external 
data connection, from which they draw their data. 

 Drag-and-Drop: Creating a Pivot Table is user-friendly, as you can simply drag and drop 
fields to define rows, columns, and values. 

 Flexibility: Pivot Tables are highly flexible and allow you to rearrange and modify the 
structure quickly to view data from different angles. 
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 Filtering: You can filter data within a Pivot Table using slicers or field filters, enabling you to 
focus on specific subsets of data. 

 Visual Filters: Slicers are visual filtering tools that provide an intuitive way to filter data in a 
Pivot Table or Pivot Chart by selecting items from a list or button interface. 

 Interactivity: Slicers enhance interactivity by allowing users to filter data dynamically, making 
it easier to explore data without the need for complex filtering options. 

 Multiple Pivot Tables: You can use a single slicer to control multiple Pivot Tables or Pivot 
Charts on the same worksheet, streamlining the analysis process. 

 Customization: Slicers can be customized in terms of appearance, size, and style to fit the 
design of your Excel reports or dashboards. 

 Clear Presentation: Slicers provide a clear and user-friendly way to present filtering options, 
making it easier for others to understand and use your Excel reports. 

 Compatibility: Slicers are compatible with both Pivot Tables and Pivot Charts, offering 
consistent and efficient data filtering across various types of data visualizations. 

 Multiple Selections: Users can select multiple items within a slicer, making it possible to filter 
for multiple criteria simultaneously. 

 Clearing Selections: Slicers include a "Clear All" button to quickly reset all selections and 
display the full dataset. 

 Highlighting Selections: When an item is selected in a slicer, it is visually highlighted, 
providing immediate feedback to users about the active filter. 

 

Self Assessment 

1. What is the primary purpose of a Pivot Table in Excel? 

A. To create charts and graphs 

B. To perform calculations on data 

C. To summarize and analyze data 

D. To import data from external sources 

 

2. Which Excel feature allows you to group data in a Pivot Table based on specific criteria? 

A. Slicers 

B. Filters 

C. Grouping 

D. Sorting 

 

3. What is a "pivot" in the context of a Pivot Table? 

A. A mathematical operation 

B. A way to rotate data 

C. A type of chart 

D. A cell reference 

 

4. Which part of an Excel Pivot Table allows you to drag and drop fields to organize and 

analyze data? 

A. The Values area 

B. The Columns area 

C. The Rows area 

D. The PivotTable Field List 
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5. What is a PivotTable report filter used for? 

A. To format the Pivot Table 

B. To filter data in the Pivot Table 

C. To sort data in the Pivot Table 

D. To calculate totals and subtotals 

 

6. In a Pivot Table, what does the "Values" area allow you to do? 

A. Group data 

B. Sort data 

C. Calculate data summaries 

D. Filter data 

 

7. Which of the following is NOT a function that can be applied to data in the "Values" area 

of a Pivot Table? 

A. Sum 

B. Count 

C. Average 

D. Concatenate 

 

8. What is the primary purpose of using a slicer in Excel? 

A. To slice and dice data 

B. To create Pivot Tables 

C. To filter Pivot Tables visually 

D. To calculate totals and subtotals 

 

9. Which of the following elements can be controlled using a slicer in a Pivot Table? 

A. Cell color 

B. Font size 

C. Chart type 

D. Data filtering 

 

10. In Excel, where can you find the slicer option? 

A. In the Data tab 

B. In the Home tab 

C. In the PivotTable Analyze tab 

D. In the Insert tab 

 

11. What happens when you select multiple items in a slicer? 

A. All selected items are highlighted 

B. Only the first selected item is applied 

C. A new slicer is created for each selected item 

D. An error message appears 

 

12. What type of data visualization does a slicer provide for filtering data? 

A. Dropdown menu 

B. Checkbox list 

C. Slider bar 
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D. Button interface 

 

13. In Excel, can you use the same slicer to filter multiple Pivot Tables on the same worksheet? 

A. Yes, but only if they share the same data source 

B. No, each Pivot Table requires a separate slicer 

C. Yes, by linking the slicer to all Pivot Tables 

D. No, slicers cannot be used for multiple Pivot Tables 

 

14. When applying a slicer to a Pivot Table, what type of filter control does it provide? 

A. Dropdown menu 

B. Checkbox list 

C. Slider bar 

D. Radio buttons 

 

15. How can you clear all selections in a slicer in Excel? 

A. Right-click and choose "Clear Filter" 

B. Click the "Clear All" button within the slicer 

C. Use the "Ctrl" key and click each selected item 

D. There is no way to clear all selections 

 

16. Can you format a slicer in Excel, such as changing its color or style? 

A. Yes, through the slicer's context menu 

B. No, slicers cannot be formatted 

C. Yes, using the Format tab in the Excel Ribbon 

D. Only in Excel Online, not in the desktop version 

 

Answers for Self Assessment 

1. C 2. C 3. B 4. D 5. B 

6. C 7. D 8. C 9. D 10. D 

11. A 12. D 13. C 14. D 15. B 

16. A         

 

Review Questions 

1. Describe the steps to create a Pivot Table in Excel, including selecting the data source and 
defining rows, columns, and values. 

2. What is the role of filters in a Pivot Table, and how do they assist in data analysis? 

3. What is the primary function of a slicer in Excel, and how does it improve the user experience 
when working with Pivot Tables? 

4. Explain how to create a slicer for a Pivot Table, including selecting the fields to filter and 
customizing its appearance. 

5. How can you use a slicer to filter data across multiple Pivot Tables on the same worksheet? 

6. Describe the difference between a single-select slicer and a multi-select slicer, and provide an 
example of when each might be used. 
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7. What are some best practices for designing and formatting slicers to make them more visually 
appealing and user-friendly in Excel reports? 

8. Explain the key components of a Pivot Table, including rows, columns, values, and filters. 

 
Further Readings 

 https://www.techtarget.com/searchdatamanagement/definition/pivot-table 

 https://www.tutorialspoint.com/excel_pivot_tables/excel_pivot_tables_overview.ht

m 

 https://edu.gcfglobal.org/en/excel2016/intro-to-pivottables/1/# 

 https://www.simplilearn.com/tutorials/excel-tutorial/pivot-table 

 https://excelchamps.com/pivot-table/link-slicer-to-multiple-pivot-tables/ 

 https://www.myexcelonline.com/blog/connect-slicers-to-multiple-excel-pivot-

tables/ 

 https://www.simplesheets.co/blog/Connect-Slicers-to-Multiple-Pivot-Tables 

 https://trumpexcel.com/slicers-excel-pivot-table/ 

 https://www.pluralsight.com/guides/visualizing-data-with-pivotchart 
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Objectives 

After this unit, you will be able to understand: 

 Understand the concept and use of creating and recording a macro. 

 understand the concept and use of Excel VBA MsgBox. 

 understand the concept of declaring variables in MS-Excel. 

 Understand the concept and use of subroutines and functions in MS-Excel. 

 

Introduction 

Macros are sets of automated actions or scripts that can be recorded and executed in spreadsheet 
programs. They are valuable for automating repetitive tasks, improving efficiency, and reducing 
human error. Recording a macro simplifies the process, allowing users to create custom functions 
without extensive programming knowledge. MsgBox, short for Message Box, is a function used in 
various programming languages, including Visual Basic for Applications (VBA). It displays a pop-
up message or prompt to the user, providing information or requesting input. MsgBox is vital for 
communicating with users in software applications and automating decision-making processes. In 
programming, declaring variables is the process of specifying the data type and name of a variable 
that will store data. Proper variable declaration is crucial for memory management, data 
manipulation, and maintaining code clarity and organization. Subroutines and functions are 
essential components of VBA programming. Subroutines are sequences of code that perform a 
specific task, while functions return a value based on the provided input. These are building blocks 
for creating custom functions and automating tasks within Microsoft Excel and other VBA-
supported applications. 

 

11.1 Creating and Recording a Macro 

What is a Macro? 

If you’re a newbie to VBA, let me first tell you what a macro is – after all, I will keep using this term 
in the entire tutorial. 

Dr. Jaskiran Kaur, Lovely Professional University 
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A macro is a code written in VBA (Visual Basic for Applications) that allows you to run a chunk of 
code whenever it is executed. 

Often, you will find people (including myself) refer to a VBA code as a macro – whether it’s 
generated by using a macro recorder or has been written manually. 

When you record a macro, Excel closely watches the steps you’re taking and notes it down in a 
language that it understands – which is VBA. 

And since Excel is a really good note taker, it creates a very detailed code (as we will see later in 
this tutorial). 

Now, when you stop the recording, save the macro, and run it, Excel simply goes back to the VBA 
code it generated and follows the exact same steps. 

This means that even if you know nothing about VBA, you can automate some tasks just by letting 
Excel record your steps once and then reuse these later. 

Now let’s dive in and see how to record a macro in Excel. 

Getting the Developer Tab in the Ribbon 

The first step to record a macro is to get the Developer tab in the ribbon. 

If you can already see the developer tab in the ribbon, go to the next section, else follow the below 
steps: 

 Right-click on any of the existing tabs in the ribbon and click on ‘Customize the Ribbon’ 
option. It will open the Excel Options dialogue box. 

 

 In the Excel Options dialogue box, you will have the Customize the Ribbon options. On the 
right, within the Main Tabs pane, check the Developer option. 
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 Click OK. 

The above steps would make the Developer tab available in the ribbon area. 

 

Recording a Macro in Excel 

Now that we have everything in place, let’s learn how to record a macro in Excel. 

Let’s record a very simple macro – one that selects a cell and enters the text ‘Excel’ in it. I am using 
the text ‘Excel’ while recording this macro, but feel free to enter your name or any other text that 
you like. 

Here are the steps to record this macro: 

1. Click the Developer tab. 

2. In the Code group, click on the Macro button. This will open the ‘Record Macro’ dialog box. 
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3. In the Record Macro dialog box, enter a name for your macro. I am using the name EnterText. 
There are some naming conditions that you need to follow when naming a macro. For 
example, you can not use spaces in between. I usually prefer to keep my macro names as a 
single word, with different parts with a capitalized first alphabet. You can also use underscore 
to separate two words – such as Enter_Text. 

 

4. (Optional Step) You can assign a keyboard shortcut if you want. In this case, we will use the 
shortcut Control + Shift + N. Remember that the shortcut you assign here would override any 
existing shortcuts in your workbook. For example, if you assign the shortcut Control + S, you 
will not be able to use this for saving the workbook (instead, every time you use it, it will 
execute the macro). 
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5. In the ‘Store macro in’ option, make sure ‘This Workbook’ is selected. This step ensures that 
the macro is a part of the workbook. It will be there when you save it and reopen again, or 
even if you share it with someone. 

 

6. (Optional Step) Enter a description. I usually don’t do this, but if you’re extremely organized, 
you may want to add what the macro is about. 

7. Click OK. As soon as you click OK, it starts to record your actions in Excel. You can see the 
‘Stop recording’ button in the Developer tab, which indicates that the macro recording is in 
progress. 
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8. Select cell A2. 

9. Enter the text Excel (or you can use your name). 

10. Hit the Enter key. This will select cell A3. 

11. Click on the Stop Recording button the Developer tab. 

.  

Example of recording a macro in Excel 

To see how it works in practice, let's record a macro that applies some formatting to the selected 
cells. For this, do the following: 

1. Select one or more cells that you want to format. 

2. On the Developer tab or Status bar, click Record Macro. 

3. In the Record Macro dialog box, configure the following settings: 

 Name the macro Header_Formatting (because we are going to format column headers). 

 Place the cursor in the Shortcut key box, and press Shift + F keys simultaneously. This will 

assign the Ctrl + Shift + F shortcut to the macro. 

 Choose to store the macro in this workbook. 

 For Description, use the following text explaining what the macro does: Makes text bold, adds 

fill color, and centers. 

 Click OK to start recording. 
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4. Format the pre-selected cells the way you want. For this example, we use the bold text 
formatting, light blue fill color and center alignment. 

Tip. Do not select any cells after you've started recording the macro. This will ensure that all the 
formatting applis to the selection, not a specific range. 

 

5. Click Stop Recording on either the Developer tab or the Status bar. 

That's it! Your macro has been recorded. Now, you can select any range of cells in any sheet, press 
the assigned shortcut (Ctrl+ Shift + F), and your custom formatting will be immediately applied to 
the selected cells. 
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How to work with recorded macros in Excel 

All main options Excel provides for macros can be accessed via the Macro dialog box. To open it, 
click the Macros button on the Developer tab or press the Alt+ F8 shortcut. 

 

In the dialog box that opens, you can view a list of macros available in all open workbooks or 
associated with a particular workbook and make use of the following options: 

 Run - executes the selected macro. 

 Step into - allows you to debug and test the macro in the Visual Basic Editor. 

 Edit - opens the selected macro in the VBA Editor, where you can view and edit the code. 

 Delete - permanently deletes the selected macro. 

 Options – allows changing the macro's properties such as the 
associated Shortcut key and Description. 

 

How to view macros in Excel 

The code of an Excel macro can be viewed and modified in the Visual Basic Editor. To open the 
Editor, press Alt + F11 or click the Visual Basic button on the Developer tab. 
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If you see the VB Editor for the first time, please do not feel discouraged or intimidated. We are not 
going to talk about the structure or syntax of the VBA language. This section will just give you 
some basic understanding of how Excel macros work and what recording a macro actually does. 

The VBA Editor has several windows, but we'll focus on the two main ones: 

Project Explorer - displays a list of all open workbooks and their sheets. Additionally, it shows 
modules, user forms and class modules. 

Code Window - this is where you can view, edit and write VBA code for each object displayed in 
the Project Explorer. 

 

When we recorded the sample macro, the following things occurred in the backend: 

 A new module (Moduel1) was inserted. 

 The VBA code of the macro was written in the Code window. 

To see the code of a specific module, double-click the module (Module1 in our case) in the Project 
Explorer window. Normally, a macro code has these parts: 

Macro name 

In VBA, any macro starts with Sub followed by the macro name and ends with End Sub, where 
"Sub" is short for Subroutine (also called Procedure). Our sample macro is 
named Header_Formatting(), so the code starts with this line: 

Sub Header_Formatting()  
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If you wish to rename the macro, simply delete the current name and type a new one directly in the 
Code window. 

Comments 

Lines prefixed with an apostrophe (') and displayed in green by default are not executed. These are 
comments added for information purposes. The comment lines can be safely removed without 
affecting the functionality of the code. 

Usually, a recorded macro has 1 - 3 comment lines: macro name (obligatory); description and 
shortcut (if specified before recording). 

Executable code 

After comments, there comes the code that executes the actions you've recorded. Sometimes, a 
recorded macro may have a lot of superfluous code, which may still be useful for figuring out how 
things work with VBA :) 

The below image shows what each part of our macro's code does: 

 

How to run a recorded macro 

By running a macro, you tell Excel to go back to the recorded VBA code and execute the exact same 
steps. There are a few ways to run a recorded macro in Excel, and here are the fastest ones: 

 If you've assigned a keyboard shortcut to the macro, press that shortcut. 

 Press Alt + 8 or click the Macros button on the Developer tab. In the Macro dialog box, select 
the desired macro and click Run. 
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It is also possible to run a recorded macro by clicking your own button. Here are the steps to make 
one: How to create a macro button in Excel. 

How to save macros in Excel 

Whether you recorded a macro or wrote VBA code manually, to save the macro, you need to save 
the workbook as macro enabled (.xlms extension). Here's how: 

1. In the workbook containing the macro, click the Save button or press Ctrl + S. 

2. In the Save As dialog box, choose Excel Macro-Enabled Workbook (*.xlsm) from the Save as 
type drop-down list, and then click Save: 
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11.2 Excel VBA MsgBox 

VBA MsgBox function is like an output function used to display the generalized message provided 
by the developer. It is like a print statement. This function or statement has no arguments. The 
personalized messages in this function are written under double quotes, while one must provide 
the variable reference for the values. 

When we start learning VBA, the first thing we try to learn is the Message Box or MsgBox function. 
It is nothing but a small box that holds the message to the user. This tutorial will show you how to 
show a message, customize the message box, icon change, button change, and other modalities of 
the message box. 

MsgBox Function Syntax 

We can see the syntax in the module when we type the word MsgBox. Now, we will introduce you 
to the syntax. 

 

 Prompt: This is the first and mandatory argument. In the above example, we must type the 
word “Welcome to VBA” as the Prompt. It is nothing but the message we need to show. We 
can show up to 1,024 characters. 

 Button: This is nothing but what kind of button we need to show on the MsgBox. For example, 
In our previous example, the default button was “OK.” 

 Title: This is the title of the message box. We can customize this title and give our name to the 
message box in double quotes. 

 [HelpFile]: This is nothing but the help icon you want to show users. If they have doubts and 
if you have already specified the suggestions, then they can click on this hell file to learn more. 

 [Context]: This is the numerical value assigned to the appropriate help topic. 

How to Create a MessageBox using VBA Code? 

Follow the below steps to create a simple msg box using the VBA code. 

Step 1: Open Visual Basic Editor 

Go to the DEVELOPER tab and click on VISUAL BASIC. 
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Alternative: You can click the shortcut key ALT + F11. 

 

Step 2: Insert Module 

Now, click on INSERT and select MODULE. 

 

It will insert the new MODULE in your VBA editor. 
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Step 3: Start Subprocedure 

Start your excel macro by typing SUB, the head of the macro. Give a MACRO a name and press the 
“Enter” key. 

 

Step 4: Start Writing Code for MsgBox 

 In between the Head & Tail of the macro, we need to write the code. So start the 
word Msgbox. It will display the MsgBox function. 

 

 As soon as you see the word Msgbox press tab, it will start to show the Msgbox syntax. 
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 Now, type the word Welcome to VBA in double-quotes. 

 

 We have created a simple message box macro. 

Step 5: Run the Code 

 Now inside the macro, place a cursor and press the key F5, the shortcut key to run a macro. 

 

Step 6: Output 

You can see the message box in your Excel window as soon as you run the macro. 
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Structure of Message Box 

Now, we will introduce you to the structure of the Message Box. It consists of four elements. 

 

#1 – Title 

By default, the message box displays the message box’s title as Microsoft Excel. However, we can 
modify this as well. For example, after we supply Prompt, we can give our name to the MsgBox. 

Step 1: First, give a Prompt, i.e., the message you want to show. 

 

Step 2: Now, the next argument is Buttons. Ignore this and jump to the next argument, i.e., Title. 

 

Step 3: We have completed it now. Now, run the macro by using the F5 key. 
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Now, you can see the difference in the title of the message box. Instead of the default title, Microsoft 
Excel, it now shows Introduction to VBA as the title. 

#2 – Buttons 

We have learned how to show a message box and alter the message box title. Now, we will see the 
option of the message box button. 

Once we supply the prompt input, the next thing in the syntax is the message box button. 

 

We have as many as 20 kinds of Message Box button options, including Yes/No. You can select any 
one of the available 20 buttons. For example, we have selected vbYesNoCancel. 

 

Now, run the macro. We will see different message box buttons instead of the default “OK” button. 
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#3 – Combination of Icon & Buttons 

We have seen how to modify message box buttons. Along with the message box button, we can 
also show icons like the image below. 

 

There are four kinds of icons available. vbCritical, vbQuestion, vbExclamation, and vbInformation. 

To show the button and the icon, we need to combine both by entering the plus (+) icon together. 

#1 – vbQuestion Marks Icon 

Code: 

Sub SerialNumber () 
MsgBox “Welcome to VBA”, vbYesNoCancel + VbQuestion,”Introduction to VBA” 
End Sub 

Result: 

 

#2 – vbCritical Marks Icon 

Code: 
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Sub MessageBoxExample () 
MsgBox “Welcome to VBA”, vbYesNoCancel + VbCritical, “Introduction to VBA” 
End Sub 

Result:   

 

#3 – vbExclamation Marks Icon 

Code: 

Sub MessageBoxExample () 
MsgBox “Welcome to VBA”, vbYesNoCancel + VbExclamation, “Introduction to VBA” 
End Sub 

Result: 

 

#4 – vbInformation Marks Icon 

Code: 

Sub MessageBoxExample () 
MsgBox “Welcome to VBA”, vbYesNoCancel + VbInformation, “Introduction to VBA” 
End Sub 

Result: 
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11.3 VBA Variable Declaration 

Before moving to the VBA variable declaration, let us first understand what variables are, the use of 
variables, and when we should use them. 

What are the variables in VBA? 

The word “variable” defines variables as the name of memory in your location, which holds some 
value. You can pass a value in a code based on the variable type. The value will be used while 
executing the code, and you will get the output. 

What is the use of Variable? 

Creating a program or a code consists of instructions that pass the information to the system about 
what to do with data. The data consist of two types of values, fixed and variable. Fixed values are 
also called “constant.” One may define variables by certain data types: Integer, Byte, String, etc. It 
helps us to identify the nature of the data we are entering, i.e., Text, Number, Boolean, etc. 

How to Declare a Variable? 

To declare a variable in code, you should assign a name to that variable. You can assign any name 
to a variable. However, selecting a variable name that relates to data is advisable so that other users 
can understand it easily. For example, if you need to pass Integer data in the code, then the name 
variables like i_count or out. If you need to pass a string value, you can name that variable like 
strName. 

One can declare variables anywhere in the VBA code. However, the coder must declare them at the 
start of the code so that every user can understand the code very easily. The variable should be 
declared using Dim. 
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VBA Variable Declaration Example #1 – Integer 

One may need the VBA Integer when one needs to store the whole numbers. For example, integers 
can store values between 32,768 to 32,767. If you need to pass values beyond this, use the Long Data 
type in VBA. 

Code: 

Sub VBA_Code1() 

 Dim Score As Integer 

 Score = 101 

 MsgBox "Sachin Scored " & Score 

End Sub 

The above code’s result will show “Sachin Scored 101.” See below. 
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VBA Variable Declaration Example #2 – String 

The VBA string data type can store data as text. 

Code: 

Sub VBA_Code_String() 

 Dim strName As String 

 strName = "Ram" 

 Range("A1:A10") = "Ram" 

End Sub 

When you run the above code, this will enter “Ram” in every cell between Range A1:A10. 

 

VBA Variable Declaration Example #3 – Date 
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The date data type in VBA can store data like the date. Therefore, it will be in the format of 
MM/DD/YYYY. 

Code: 

Sub VBA_Code_Date() 

Dim DOB As Date 

 DOB = "04/04/1990" 

MsgBox "I was born on " & DOB 

End Sub 

When you run the above code, this will show the result below. 

 

VBA Variable Declaration Example #4 – Boolean 

Boolean Datatype in VBA has only two values True or False. 

Code: 

Sub VBA_Code_Boolean() 

 Dim bgender As Boolean 

 bgender = False 

 If bgender = True Then 

 Range("A1") = "Male" 

 Else 

 Range("A1") = "Female" 

 End If 

End Sub 

When you run the code, the result in the A1 cell will be “Female.” 
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VBA Variable Declaration Example #5 – Long 

The Data type Long is also used to store numbers. They can store numbers between -2,147,483,648 
to 2,147,483,647. Here, you must have a question: if Integer and Long can store numbers, why do 
we use Integer? 

Here is the answer. Integer takes two bytes of space. However, Long needs 8 bytes of space. So, you 
should not use Long when you know one can store a number as an Integer. Else, your program 
running time will increase. 

Suppose you need to show the distance between the North Pole and the South Pole in “Meter.” You 
know that the distance in the meter is outside the range of -32,768 to 32,767. So, you will use the 
Data type Long. 

Code: 

Sub VBA_Code_long() 

Dim distance As Long 

distance = 13832000 

MsgBox "Distance between the North Pole and  

the South Pole is " & distance & " Meter" 

End Sub 

The result will be “Distance between the North Pole. The South Pole is 13832000 Meter. 
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11.4 Subroutines and Functions 

VBA has two types of procedures for creating and executing codes: Subroutine (or simply Sub) 
and Function. 

Subroutine 

A Sub can be used to execute another Sub: 

    Sub sub_main() 

        sub_auxiliary1 

        sub_auxiliary2 

    End Sub 

    Sub sub_auxiliary1() 

        MsgBox "One Sub executing another Sub" 

    End Sub 

    Sub sub_auxiliary2() 

        MsgBox "One Sub executing a second Sub" 

    End Sub 

For this and further examples, just run the sub_main. By clicking anywhere between the line Sub 
sub_main() and the first End Sub. 

A Sub can also accept an argument: 

    Sub sub_main() 

        sub_argument(10) '10 is an argument 

    End Sub 

    Sub sub_argument(x as Integer) 

        MsgBox x 

    End Sub 
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You can assign an argument to the Sub using a single space: 

    sub_argument 10 '10 is an argument 

Or multiple arguments: 

    Sub sub_main() 

        Dim score As Single 

        Dim student As String 

        score=10 

        student="Paulo" 

        Call sub_argument (score, student) 'score is an argument, student is another argument 

    End Sub 

    Sub sub_argument(s_exam as Single, name as String) 

        MsgBox name & "'s score was " & s_exam 

    End Sub 

To have more than one argument into a Sub, you can use the Call instruction before the name of 
the Sub you want to call. 

You can also execute a Sub with multiple arguments omitting the Call instruction and the 
parentheses: 

sub_argument score, student 

Have the practice of declaring the variables in the same data types that the Sub requires as 
arguments. 
E.g.score and s_exam. 

Subs can also be accessed from different modules: 

 

Types of Sub 

The types of Sub available are Private and Public: 

Public Sub: Creates a public procedure that can be accessed by any procedure of any module, and is 

displayed in the Macros ( + ). 

Private Sub: Creates a private procedure that can be accessed only by procedures of the same 

module, and is not displayed in the Macros ( + ). 

 

An undefined Sub is considered Public by VBA. 

Functions 

Functions work similarly to Subroutines with arguments. The main difference is that the Function 
will necessarily return a value and should be called by some other procedure. 

    Sub sub_main() 

        result = multiply_2(10) 

        Msgbox result 

    End Sub 

    Function multiply_2(x As Single) 

        multiply_2 = x*2 
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    End Function 

 It is not possible to pass arguments to a function through the single space if it is being associated 
with a variable. 

    result = multiply_2 10 'Will result in error! 

Note that: 

MsgBox resultado 'It will not result in an error because there is no association. 

You can not run a Function by itself. It is necessary to be called by another procedure. 
E.g. Sub sub_main(). 

Once defined, functions can be used normally by the user in the Excel spreadsheet environment. 
Just call by the name of the function, as with any other predefined function (SUM, AVERAGE, etc.). 

 

We can also define in the declaration the type of result that the Function will return: 

  Function multiply_2(x As Single) As Integer 

      multiply_2 = x*2 

  End Function 

Note that now the function will only return rounded results, given the return specification As 
Integer. 

There are many predefined functions in VBA. MsgBox is one of them. 

        Msgbox "This should be shown" 'MsgBox works without the parentheses 

        Msgbox ("This should be shown") 'and works with the parentheses 

 
Naming a Function 

When you create a function it needs to be followed by a name that must comply with the following 
rules: 

It must initiate with an alphabetical character 

It must not contain especial characters, such as: #, $, %, &, ! 

It must not contain whitespace characters, dots or commas 

It must not be a VBA reserved word like: And, Or, Sub 

 

Function Errors 

Question: What if the user inserts unexpected values into my function? 

Answer: Create an error to warn him. 

This procedure can be done through the predefined CVErr function, which uses an integer value to 
specify an error. 

The possible value it accepts are: 

2000 (ou xlErrNull) which returns a #NULL! error 

2007 (ou xlErrDiv0) which returns a #DIV/0 error 

2015 (ou xlErrValue) which returns a #VALUE! error 

2023 (ou xlErrRef) which returns a #REF! error 

2029 (ou xlErrName) which returns a #NAME? error 

2036 (ou xlErrNum) which returns a #NUM! error 

2042 (ou xlErrNA) which returns a #N/A error 
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Compare how an User Defined Function (UDF) to calculate the area of a triangle should be changed 
to apply the CVErr 

Function AreaTriangle(Base As Single, Height As Single) As Double 

    'As Double above specifies the return type of AreaTriangle 

    AreaTriangle = (Base * Height) / 2 

End Function 

Negative values are not expected for the area calculation, so let's create an error if the user enters 
them: 

Function AreaTriangle(Base As Single, Height As Single) As Variant  

'As Variant is defining the data type of AreaTriangle 

    If Base < 0 Or Height < 0 Then 

        AreaTriangle = CVErr(2036) 

    Else 

        AreaTriangle = (Base * Height) / 2 

    End If 

End Function 

In this way, if the user inserts negative values, the following error will appear in the cell of the 

function:  

The data type of CVErr(2036) is Error. This data type besides not being common is also 
incompatible with numeric data (that will be necessary for the calculation of the area). Therefore we 
assign to AreaTriangle the data type Variant. In this way, AreaTriangle will accept both 
the Error data type, if it occurs, and the Double data type, which will be returned if the calculation 
proceeded properly. 

 

Sub VS Function 

Subroutines do not return values if called. Functions return values 

Subroutines can be assigned to buttons and shapes in Excel, Functions can't 

Functions created in VBA can be used in your Excel worksheet 

 

Summary 

 Macros are sequences of Excel actions that can be recorded and played back to automate 
repetitive tasks. 

 To create a macro, go to the Developer tab, click on "Record Macro," perform the actions you 
want to record, and then stop recording. 

 Recorded macros can be assigned to buttons or keyboard shortcuts for easy execution. 

 Macros can save time by automating tasks such as data formatting, calculations, and report 
generation. 

 MsgBox is a VBA function used to display pop-up message boxes in Excel. 

 It can be used to provide information, warnings, or prompts to users interacting with an Excel 
workbook. 

 MsgBox syntax includes the message to display, an optional title, and various buttons and 
icons to customize the appearance. 

 Variables in Excel VBA are used to store and manipulate data. 
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 Variables must be declared before use using the "Dim" statement, specifying the variable's 
name and data type. 

 Proper variable declaration and naming conventions help improve code readability and 
maintainability. 

 Subroutines (Subs) and Functions are reusable blocks of code in VBA. 

 Subroutines do not return a value, while Functions return a value. 

 Subroutines are defined using the "Sub" keyword, and Functions use the "Function" keyword. 

 Subroutines and Functions can accept parameters (inputs) and perform actions or calculations 
based on them. 

 Subroutines and Functions are fundamental for organizing and modularizing VBA code, 
making it more efficient and easier to maintain. 

 

Keywords 

 Macro: A macro is a sequence of automated commands or actions that can be recorded and 

played back in Microsoft Excel to perform repetitive tasks. 

 Excel VBA: Excel Visual Basic for Applications (VBA) is a programming language integrated 

into Excel that allows users to create and automate custom functions and procedures. 

 MsgBox: MsgBox is a VBA function in Excel used to display message boxes or dialog boxes 

that provide information, warnings, or prompts to users. 

 Variable Declaration: Variable declaration is the process of specifying the name and data type 

of a variable before using it in VBA code. It helps define the variable's purpose and how it will 

be used. 

 Data Types: Data types in VBA specify the type of data that can be stored in a variable. 

Common data types include Integer, String, Double, and Boolean. 

 Subroutine: A subroutine, often referred to as a "Sub," is a block of VBA code that performs a 

specific task or set of tasks. Subroutines are used for code organization and reusability. 

 Function: A function is a reusable block of VBA code that returns a value. It accepts input 

parameters, processes them, and produces an output result. 

 Parameter: A parameter is a variable or value that is passed into a subroutine or function as 

input. It is used within the subroutine or function to perform specific operations. 

 Automation: Automation in Excel VBA refers to the process of using macros and code to 

perform tasks automatically, reducing the need for manual intervention. 

 Code Modularity: Code modularity is a programming concept that involves breaking down a 

program into smaller, reusable modules or blocks of code, such as subroutines and functions. 

This makes the code more organized, easier to understand, and maintainable. 

 

Self Assessment 

1. What is a macro in Microsoft Excel? 

A. A type of chart 

B. A sequence of automated actions 

C. A data analysis tool 

D. A built-in function 

 

2. How can you create a macro in Excel? 

A. Using the "Insert" menu 
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B. By typing code in the formula bar 

C. Through the "Developer" tab and "Record Macro" option 

D. Using the "File" menu 

 

3. What is the purpose of recording a macro? 

A. To generate random data 

B. To automate repetitive tasks 

C. To create pivot tables 

D. To insert images into a worksheet 

 

4. Which tab in Excel contains the "Record Macro" option? 

A. Home 

B. Insert 

C. Data 

D. Developer 

 

5. What is the primary purpose of the MsgBox function in Excel VBA? 

A. To calculate formulas 

B. To create charts 

C. To display messages to the user 

D. To perform data validation 

 

6. Which parameter of the MsgBox function specifies the message to be displayed? 

A. Title 

B. Buttons 

C. Prompt 

D. Icon 

 

7. What does the "Buttons" parameter in the MsgBox function define? 

A. The message box title 

B. The message to be displayed 

C. The buttons and their options in the message box 

D. The message box icon 

 

8. Which of the following is NOT a valid icon option for the MsgBox function? 

A. vbExclamation 

B. vbQuestion 

C. vbAlert 

D. vbCritical 

 

9. What is variable declaration in Excel VBA? 

A. Creating new Excel worksheets 

B. Defining the data type of a variable 

C. Recording a macro 

D. Printing Excel documents 

 

10. Which keyword is used to declare a variable in Excel VBA? 

Lovely Professional University 379



  Unit 11: VBA Macros programming I  

 

Notes 

A. Data 

B. Dim 

C. Variable 

D. Define 

 

 

11. Why is variable declaration important in VBA? 

A. It generates random values. 

B. It improves code readability and performance. 

C. It creates macros. 

D. It adds new worksheets to the workbook. 

 

12. Which of the following is NOT a valid data type for a variable in VBA? 

A. Integer 

B. Text 

C. Double 

D. Boolean 

 

13. What is the key difference between a subroutine and a function in Excel VBA? 

A. Subroutines return values, and functions do not. 

B. Subroutines accept parameters, and functions do not. 

C. Subroutines can be called from other subroutines, and functions cannot. 

D. Functions return values, and subroutines do not. 

 

14. Which keyword is used to define a subroutine in Excel VBA? 

A. Func 

B. Sub 

C. Proc 

D. Def 

 

15. In Excel VBA, what is the purpose of passing parameters to a subroutine or function? 

A. To display a message box 

B. To perform data validation 

C. To provide input data for processing 

D. To create a new worksheet 

 

16. Which keyword is used to define a function in Excel VBA? 

A. Func 

B. Sub 

C. Proc 

D. Def 

 

17. What does a function return in Excel VBA? 

A. A message box 

B. A Boolean value 

C. A result or value 
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D. A chart 

 

Answers for Self Assessment 

1. B 2. C 3. B 4. D 5. C 

6. C 7. C 8. C 9. B 10. B 

11. B 12. B 13. A 14. B 15. C 

16. D 17. C       

 

Review Questions 

1. What is a macro in Excel, and why are they useful? 

2. Describe the basic steps to create a macro in Microsoft Excel. 

3. How can you assign a macro to a button or a keyboard shortcut? 

4. Give an example of a task that can be automated using a macro. 

5. What is the primary purpose of the MsgBox function in Excel VBA? 

6. Explain the syntax of the MsgBox function, including its key parameters. 

7. Name and describe two commonly used icons in MsgBox. 

8. How can you customize the buttons displayed in a MsgBox? 

9. Why is it important to declare variables in VBA code? 

10. What keyword is used to declare a variable in Excel VBA, and how is it used in code? 

11. Name three common data types used when declaring variables in VBA and explain when to 
use each. 

12. What is the main difference between a subroutine and a function in Excel VBA? 

13. What is the keyword used to define a subroutine, and how is it structured? 

14. How are parameters used in subroutines and functions, and why are they important? 

15. Give an example of when you might use a function in Excel VBA. 

 

 
Further Readings 

 https://trumpexcel.com/record-macro-vba/ 

 https://www.ablebits.com/office-addins-blog/record-macro-excel/ 

 https://spreadsheeto.com/make-a-macro/ 

 https://www.javatpoint.com/how-to-record-a-macro-in-excel 

 https://www.wallstreetmojo.com/recording-macros-in-excel/ 

 https://www.wallstreetmojo.com/vba-msgbox/ 

 https://www.wallstreetmojo.com/vba-variable-declaration/ 

 https://www.superexcelvba.com/en/tutorial/014-sub-and-function 

 https://corporatefinanceinstitute.com/resources/excel/vba-sub-vs-function/ 
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Objectives 

After this unit, you will be able to understand- 

 If Then Statement 

 Case Statement 

 For Loop 

 While Loop and Do Until 

 Worksheet and Range Object 

 

Introduction 

These are fundamental control structures in programming. The "If-Then" statement is used for 
conditional execution, the "Case" statement for multiple branching conditions, "For" loops for 
iterative processes, and "While" and "Do Until" loops for repetitive tasks. They are essential tools 
for directing the flow of a program and automating complex operations. In spreadsheet 
programming like VBA, worksheets and ranges are fundamental objects. Worksheets represent 
individual sheets within a workbook, while ranges define specific cell selections or data subsets. 
These objects are essential for manipulating data, performing calculations, and formatting within a 
spreadsheet. 

 

12.1 What is IF Else Statement in VBA? 

The If Else or If Then Else statement of VBA executes a set of instructions depending on whether 
the specified condition is met or not. If the condition (logical test) is true, one set of actions is 
performed. However, if the condition is false, an alternative set of actions is performed. 

For example, in a call center, an employee is given a target of making 50 outbound calls in a day. If 
he/she achieves the target, a sum of money is paid as an incentive. However, if the target is not 
achieved, no incentive is paid. 

Dr. Jaskiran Kaur, Lovely Professional University 
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The condition here is x>=50. So, if x is greater than or equal to 50, an incentive is paid. Otherwise, it 
is not paid. 

Hence, if the condition is true, the output should be the message “incentive paid.” Otherwise, the 
output should be the message “incentive not paid.” Rather than checking the number of calls made 
by each employee manually, one can use the If Else statement of VBA. 

A condition is an expression that evaluates to true or false. It is placed between the If and Then 
keywords. To create a condition, the conditional operators like “equal to” (=), “not equal to” (<>), 
“greater than” (>), “less than” (<), “less than or equal to” (<=), and “greater than or equal to” (>=) 
are used. 

The purpose of using the If Else statement is to evaluate a condition and perform an action 
accordingly. If the condition is true, the code following the If Then keywords is run. However, if the 
condition is false, the code following the Else keyword is run. 

The If Else statement works in VBA and not in Excel. However, the logical test of the If Else 
statement works similar to that of the IF function of Excel. 

The Syntax of the VBA If Else Statement 

The syntax of the VBA If Else statement is stated as follows: 

IF <Logical Test> Then 

    If the Logical Test is TRUE  

Else 

    If the Logical Test is FALSE 

End IF 

The condition (logical test) is required, while the Else statement is optional. 

The Working of the VBA If Else Statement 

First, the VBA If Else statement checks the supplied logical test. If the supplied logical test is true, 
an action (task) is performed. However, if the test is false, an alternative action is performed. An 
action is performed by the execution of the code. 

Let us understand the working of the If Else statement with the help of an example. We want to 
supply the condition 10>11 as the logical test. 

If the given condition is true, the output should be the message “10 is greater.” However, if the 
condition is false, the output should be the message “10 is lesser.” 

To write the code, the details are specified as follows: 

a. Enter the task to be performed if the condition evaluates to true. 

b. Enter the keyword Else followed by an alternative task to be performed. This alternative task 
will be performed if the condition evaluates to false. 

The code for the given example is written as follows: 

Sub IF_Else_Example1() 

    If 10 > 11 Then 

       MsgBox "10 is greater" 

    Else 

       MsgBox "10 is lesser" 

    End If 

End Sub 
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Execute the code and the result appears as shown in the succeeding image. Since the condition 
(10>11) evaluates to false, the message following the Else statement is returned. Hence, the output 
is “10 is lesser.” 

It must be noted that the preceding code returns at least one of the specified messages. This implies 
that either the If block or the Else block is executed at a given time. Both these blocks cannot be 
executed together in a single run. 

 

VBA IF Else Example 

The following table shows the cost price (in $ in column B) of seven products (column A). We want 
to find the status (column C) of each product based on its price. For this, the criteria are mentioned 
as follows: 

 If the cost price>$50, the status should be “expensive.” 

 If the cost price<$50, the status should be “not expensive.” 
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The logical test is cost price>50. If this condition is true, the output in column C should be 
“expensive.” However, if the given condition is false, the alternative result should be “not 
expensive.” 

Prior to writing the code, copy and paste the preceding table to an Excel worksheet. The steps for 
writing the code are listed as follows: 

Step 1: Start the sub procedure. 

Sub IF_ELSE_Example2() 

End Sub 

 

Step 2: Declare the variable “k” as an integer. So, the data type is integers. 

Dim k As Integer 

 

Step 3: Use the For Next loop to loop through the given cells and perform tasks on all of them. 

The For Next loop is used because the code needs to be executed a specific number of times. 
Moreover, multiple cell values need to be tested. 
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Since the test needs to be conducted on rows 2 to 8, the For Next loop begins from 2 and runs till 8. 
The same is shown in the following code and image. 

For k = 2 To 8 

Next k 

 

Step 4: Enter the logical test within the For Next loop. For this, open the If statement and select the 
first cell with the help of the cells property. The cells(k, 2) implies row “k” and column 2. 

The same is shown in the following code and image. 

If Cells(k, 2).Value > 50 Then 

 

Step 5: Enter the action to be performed following the If Then statement. 

If the value in cell (k, 2) is greater than 50 (the condition evaluates to true), the output should be 
“expensive” in the adjacent cell of column C. 

The same is shown in the following code and image. 

Cells(k, 3).Value = "Expensive" 
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Step 6: Enter the Else statement. This will run if the logical test (cost price>50) evaluates to false. 
Going by the Else statement, the cells (k, 3) must display the message “not expensive” if the cost 
price is less than $50. 

The same is shown in the following code and image. 

Sub IF_ELSE_Example2() 

    Dim k As Integer 

    For k = 2 To 8 

        If Cells(k, 2).Value > 50 Then 

            Cells(k, 3).Value = "Expensive" 

        Else 

            Cells(k, 3).Value = "Not Expensive" 

        End If 

    Next k 

End Sub 

 

Step 7: Run the code and the output appears, as shown in the following image. The code loops 
through rows 2 to 8, tests every value of column B, and arrives at a result accordingly. 
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Hence, the logical test for cells B2, B4, B6, and B8 evaluates to true. So, the status in the 
corresponding cells of column C appears as “expensive.” 

For the remaining cells of column C, the status appears as “not expensive.” These are the ones 
whose related cost price is less than $50. 

 

Likewise, the If Else statement can be used to obtain different results. 

 

12.2 Excel VBA Case Statement 

VBA Case Statement is one of the logical functions. The Case Statement tests multiple logical tests 
and arrives at the result in two ways: if the result or logical test is TRUE, one set of results. If the 
result or logical test is FALSE, then the second set of results. 

Typically, one conducts logical tests using IF formulas, whether a worksheet formula or VBA 
coding. On both platforms, this function helps us to conduct many kinds of complicated 
calculations. However, few of us realize that we have an alternative to the IF statement in VBA i.e., 
“Case Statement.” This article provides you with full details about this logical statement. 

Syntax 

Below is the syntax of the “Select Case” statement. 

Select Case “Value to be Test” 

       Case Is “Logical Test” 

            Result if  Case 1 is TRUE 

       Case Is “Logical Test” 

            Result if Case 2 is TRUE 

       Case Is “Logical Test” 

             Result if Case 3 is TRUE 

      Case Else 

           If none of the results are TRUE 

End Select 
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It is almost similar to IF statement syntax. But instead of using ELSEIF, we use Case 1, Case 2, Case 
3, and so on. 

Examples of VBA Case Statement 

 

Example #1 

In cell A1, we have entered the number 240. 

 

Now, we will test whether this number is greater than 200 or not by using the SELECT CASE 
statement. 

Step 1: Open the Select Case statement now. 

Code: 

Sub Select_Case_Example1() 

    Select Case 

End Sub 

 

Step 2: Once we open the “Select Case,” we need to supply what is the value we are testing. In this 
case, we are testing cell A1 values. 

Code: 

Sub Select_Case_Example1() 

     Select Case Range("A1").Value 

End Sub 

 

Step 3: Once we give the value to the test, we need to apply logical tests in excel using the “Case Is” 
word.. 

Code: 
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Sub Select_Case_Example1() 

     Select Case Range("A1").Value 

     Case Is > 200 

End Sub 

 

Step 4: In the next line, we need to supply the “result” value if the applied logical test is TRUE. In 
the message box, we need the result as “Number is >200”. 

Code: 

Sub Select_Case_Example1() 

     Select Case Range("A1").Value 

     Case Is > 200 

       MsgBox "Number is >200" 

End Sub 

 

Step 5: We need only two results in this example, so we will not use more “Case Is” statements. 
Next, we will use the “Case Else” word to close the VBA “Select Case” statement. 

Code: 

Sub Select_Case_Example1() 

     Select Case Range("A1").Value 

     Case Is > 200 

        MsgBox "Number is >200" 

     Case Else 

        MsgBox "Number is <200" 

End Sub 
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Step 6: Once we supply all the cases, we need to close the select case statement using the “End 
Select” word. 

Code: 

Sub Select_Case_Example1() 

     Select Case Range("A1").Value 

     Case Is > 200 

        MsgBox "Number is >200" 

     Case Else 

        MsgBox "Number is <200" 

     End Select 

End Sub 

 

Step 7: Now, run the code and see what the result we get in the VBA message box is. 
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The result is “Number is >200” because, in cell A1, the value is 240, which is >200. 

 

Example #2 

Now, we will see some practical real-time examples of testing scores. First, look at the VBA 
code below. 

Code: 

Sub Select_Case_Example2() 

     Dim ScoreCard As Integer 

     ScoreCard = Application.InputBox("Score should be b/w 0 to 100", "What is the score you want 
to test") 

     Select Case ScoreCard 

         Case Is >= 85 

             MsgBox "Distinction" 

         Case Is >= 60 

             MsgBox "First Class" 

         Case Is >= 50 

             MsgBox "Second Class" 

         Case Is >= 35 

             MsgBox "Pass" 

         Case Else 

             MsgBox "Fail" 

     End Select 

End Sub 
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Let us explain the code line by line to understand it better. 

First, we have declared the variable as “Integer.” Then, for this variable, we have assigned 
the InputBox in VBA, where a user must enter the score between 0 and 100. 

When we run the code, we will see the input box like the one below. In this input box, you need to 
enter the score. 

 

Whatever we enter in the input box will be stored in the variable “ScoreCard.” 

In the next line, we have applied a select case statement to test this score. 

First, it will test whether the ScoreCard >=85 or not. If this is TRUE, we will get the value in the 
message box as “Distinction.” 

Select Case ScoreCard 

    Case Is >= 85 

        MsgBox "Distinction" 

Similarly, in the following lines, we have applied the second test as ScoreCard >=60. Again, if this is 
TRUE, it will show the result as “First.” 

Case Is >= 60 

    MsgBox "First Class" 

Like this, we have also applied other tests. In the end, we have used the “Case Else” statement. If all 
the applied logical tests are FALSE, we will get the result as “Fail.” 

Case Else 

    MsgBox "Fail" 
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Now, we have supplied 68 as the score. Therefore, we should get the “First Class” result in the 
message box. 

 

 

Example #3 – Using the “To” keyword 

In the above example, we have used student scores to arrive at the result. However, one can 
conduct the same test using the “To” word to determine the lower limit and upper limit of the 
logical test. 

Code: 

Sub Select_Case_Example3() 

  Dim ScoreCard As Integer 

  ScoreCard = Application.InputBox("Score should be b/w 0 to 100", "What is the score you want to 
test") 

     Select Case ScoreCard 

         Case 85 To 100 

             MsgBox "Distinction" 

         Case 60 To 84 

             MsgBox "First Class" 

         Case 50 To 59 

             MsgBox "Second Class" 

         Case 35 To 49 

             MsgBox "Pass" 

         Case Else 

             MsgBox "Fail" 

     End Select 

End Sub 
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We have used the same code as above. But, the only yellow-colored area we have changed here. We 
will get the result based on the number we type in the input box accordingly. 

 

 

12.3 VBA For Loop In Excel 

1. What are VBA For Loops in Microsoft Excel? 

VBA for Loops are a programming concept that allows a program to repeat itself. They help to 
refract your code, reducing the number of specifically-coded actions that are written to help 
improve the speed and efficiency of your applications. 

Loops are flexible tools, giving you the option to repeat a certain action (such as changing cell 
values) a set number of times. A loop could also be combined with other statements, such as For 
and If, that help to determine how often, and for how long, a script should run. 

2. What are VBA For Loops used for? 

Using a VBA For Loop is essential for creating macros that will run continuously as you work 
through your spreadsheet. Loops like this aren’t unique to VBA—indeed, they’re a common feature 
in most programming languages, allowing a program or script to run continuously in a sequence 
with a start and end point. 
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In VBA, a For Loop repeats an action (or set of actions) for a set number of times in a sequence. For 
instance, if you had a macro (written in VBA) that inserted values into a column, you could use a 
For Loop to do so, filling each cell sequentially (eg. A1, A2, A3, etc) until an end value is reached. 

 

For instance, the VBA code snippet shown previously demonstrates such an action. In this example, 
the VBA macro is designed to insert values into cells in column A, from 1 to 10, and increase in 
single-digit increments. Once 10 is reached, the script stops. 

This is a basic example, but For Loops are powerful enough to perform almost any action you 
desire in Excel repeatedly. While this guide isn’t a full VBA tutorial (and it assumes you have a 
certain level of basic VBA experience already), it should allow you to create basic VBA loops using 
For to repeat an action in sequence. 

3. How do VBA For Loops work in Excel? 

Let’s assume that you already have an idea in mind as to how your VBA macro should work. 
Introducing a For Loop into the mix allows you to set your code (or part of your code) to repeat 
itself a certain number of times. 

We’ll explain the process using a simple-to-understand example. As VBA For Loops are useful for 
finite repetitive actions, let’s assume you want a pop-up to appear when you press a button (with 
the class name Button). 
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Pressing the button causes a pop-up box to appear a set number of times, in sequence, using the 
variable varButton as the end number (in this case, 10). This pop-up box displays the current 
variable, starting with zero. It then repeats this 9 more times until the varButton variable (10) is 
reached. 

The action of pressing the button begins the loop. As the test has a start and end variable, the loop 
has a finite number of runs before it finishes. By default, the values increase by 1 (starting with 0, 1, 
2, etc) but this can be changed by adding a Step value. For instance, changing this to 5 would mean 
only three pop-ups appear. 

 

Once the end value is reached, the loop exits and the macro stops. You could, however, add 
additional actions to perform at this point, such as changing another cell’s value or creating a 
different pop-up message. You could nest the For Loop within other logical tests, such as a Do 
While or If statement. 

This example contains all of the typical criteria needed to complete a For Loop using VBA, 
however. The code identifies how many times the action will be performed in a sequence 
(varButton) and the increment value used to iterate through the sequence (Step). 
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The only optional part of this example is the button used to start the macro. You don’t necessarily 
need to link your macro code to a button press, as you could easily begin this loop and activate the 
macro manually by pressing Developer > Macros > Run instead.  

4. Things to consider before using a VBA For Loop in Excel 

A VBA For Loop is a flexible and wide-ranging method that allows your code to perform an action 
sequentially and only stopping if (and when) certain criteria are met. 

To help you create this kind of macro in Excel, there are some pointers you’ll need to consider. 
These include: 

 If you want to create a way for your For Loop to end before the final value is reached, you’ll 
need to add an Exit For statement to your code. This exits the loop and moves on to the next 
line of code outside of the loop (if your code continues). For instance, you could stop the loop 
when you press a button. 

 A VBA For Loop can be used to cycle through a set number of numerical values in sequence in 
a basic way using a For Next Loop, but you can also cycle through more complex objects (such 
as workbooks in your spreadsheet) in sequence using a more complex VBA For Each Loop. 

 VBA For Loops can be nested with other logical statements, such as an If or Do 
While statement. This allows you to integrate more complex decision-making into your code. 

 A VBA For Loop will iterate in a sequence, but by changing the Step value, you can change 
how much the loop counter increases by during each iteration. For instance, if you want your 
loop to move ahead in a sequence that increases the value by 2, you’d need to use a Step value 
of 2. If you don’t provide a Step value, the loop counter will increase in increments of 1. 

 If your VBA For Loop can’t be performed, or if your code has errors, VBA will exit into debug 
mode with an error. You’ll need to troubleshoot your code to fix this problem in Excel’s built-
in VBA Editor. 

While these examples are important, you should also consider any known VBA limitations that 
aren’t listed here (such as a lack of an undo function when using VBA) before you write your code. 

5. How to add VBA For Loops in Excel using the Visual Basic Editor 

You can create, test, and run a VBA For Loop in Excel by using the Visual Basic Editor. This is 
Excel’s built-in VBA editor that allows you to create your own macros using VBA, or edit existing 
macros created using the Macro Recorder tool. 

To begin creating a VBA macro using a For Loop in the Visual Basic Editor, you can follow these 
steps: 

Step 1: Open the VBA Editor 

You’ll need to start by opening the Visual Basic Editor in your Excel workbook. 

You can do this by pressing the Alt + F11 keys on your keyboard (or Option + F11 on Mac). If 
you’ve already enabled the Developer tab on the ribbon bar in your Excel’s settings menu, you can 
also press Developer > Visual Basic to open the editor instead. 

 

Step 2: Create a new VBA Module 
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The VBA Editor will open in a new window at this point. The next step is to insert your VBA For 
Loop (and additional code) as a new VBA module. Modules are used to organize VBA code into 
groups. 

To do this, right-click your workbook listed in the tree menu on the left. From the drop-down 
menu, select Insert > Module. 

 

Step 3: Insert your VBA For Loop code 

A new window for your code will appear on the right. This is where you can type or insert the VBA 
code containing your For Loop. For instance, the following code will insert sequential values into 
cells A1 to A20 on any active worksheet: 

Sub LoopVal() 

Dim i As Integer 

For i = 1 To 10 

Range(“A” & i).Value = i 

Next i 

End Sub 
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Step 4: Rename your module and test your code 

Once you’ve inserted your code, you’ll need to rename the module which contains the code in 
order to make it easy to refer to later. To do this, select the module name in the tree menu on the 
left, then rename it by typing a new module name into the Properties box underneath. 

 

When you’re ready to test your code, press the Run Sub/User Form button. This will run the code 
in your active worksheet, allowing you to see the macro in action. 
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Assuming your VBA code worked as intended, you can then proceed to save your workbook with 
the macro included. 

If it doesn’t work, a debug message will appear, and you’ll need to troubleshoot the issue further. 

Step 5: Save your workbook 

With your VBA macro ready, you’ll need to save your Excel workbook as a Macro-enabled 
workbook in the XLSM format. 

To do this, press Ctrl + S on your keyboard, or press File > Save As. 

 

Step 6: Run your VBA code 

Your macro (containing a VBA For Loop) is ready to run once you’ve saved your workbook. 

To do this, press Alt + F8 on your keyboard to open the Macro window (or Option + F8 on Mac). 
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Select your macro (matching the Module name) from the list provided, then press Run. 

Alternatively, if your VBA For Loop is scheduled to activate based on another action (such as a cell 
value being reached, a button being pressed, etc), you’ll need to perform this action to begin the 
process. 

 

12.4 Excel DO Loops 

Do While Loop 

A ‘Do While’ loop allows you to check for a condition and run the loop while that condition is met 
(or is TRUE). 

There are two types of syntax in the Do While Loop. 

Do [While condition] 

[Code block to Execute] 

Loop 

and 

Do 

[Code block to Execute] 

Loop [While condition] 

The difference between these two is that in the first, the While condition is checked first before any 
code block is executed, and in the second case, the code block is executed first and then the While 
condition is checked. 
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This means that if the While condition is False is both the cases, the code will still run at least once 
in the second case (as the ‘While’ condition is checked after the code has been executed once). 

Now let’s see some examples of using Do While loops in VBA. 

 

Example 1 – Add First 10 Positive Integers using VBA 

Suppose you want to add the first ten positive integers using the Do While loop in VBA. 

To do this, you can use the Do While loop until the next number is less than or equal to 10. As soon 
as the number is greater than 1o, your loop would stop. 

Here is the VBA code that will run this Do While loop and the show the result in a message box. 

Sub AddFirst10PositiveIntegers() 

Dim i As Integer 

i = 1 

Do While i <= 10 

Result = Result + i 

i = i + 1 

Loop 

MsgBox Result 

End Sub 

The above loop continues to work until the value of ‘i’ becomes 11. As soon as it becomes 11, the 
loop ends (as the While condition becomes False). 

Within the loop, we have used a Result variable that holds the final value Once the loop is 
completed, a message box shows the value of the ‘Result’ variable. 

Sub AddFirst10PositiveIntegers() 

Dim i As Integer 

i = 1 

Do While i <= 10 

Result = Result + i 

i = i + 1 

Loop 

MsgBox Result 

End Sub 

The above loop continues to work until the value of ‘i’ becomes 11. As soon as it becomes 11, the 
loop ends (as the While condition becomes False). 

Within the loop, we have used a Result variable that holds the final value Once the loop is 
completed, a message box shows the value of the ‘Result’ variable. 

The above code would enter all the dates in the first column of the worksheet (starting from A1). 
The loops continue till the Month value of the variable ‘CMDate’ matches that of the current month. 

Do Until Loop 

‘Do Until’ loops are very much like the ‘Do While’ loops. 

In ‘Do While’, the loop runs till the given condition is met, while in ‘Do Until’, it loops until the 
specified condition is met. 

There are two types of syntax in the Do Until Loop. 

Do [Until condition] 
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[Code block to Execute] 

Loop 

and 

Do 

[Code block to Execute] 

Loop [Until condition] 

The difference between these two is that in the first, the Until condition is checked first before any 
code block is executed, and in the second case, the code block is executed first and then the Until 
condition is checked. 

This means that if the Until condition is TRUE is both cases, the code will still run at least once in 
the second case (as the ‘Until’ condition is checked after the code has been executed once). 

Now let’s see some examples of using Do Until loops in VBA. 

Note: All the examples for Do Until are the same as that of Do While. These have been modified to 
show you how the Do Until loop works. 

 

Example 1 – Add First 10 Positive Integers using VBA 

Suppose you want to add the first ten positive integers using the Do Until loop in VBA. 

To do this, you need to run the loop until the next number is less than or equal to 10. As soon as the 
number is greater than 1o, your loop would stop. 

Here is the VBA code that will run this loop and show the result in a message box. 

Sub AddFirst10PositiveIntegers() 

Dim i As Integer 

i = 1 

Do Until i > 10 

Result = Result + i 

i = i + 1 

Loop 

MsgBox Result 

End Sub 

The above loop continues to work until the value of ‘i’ becomes 11. As soon as it becomes 11, the 
loop ends (as the ‘Until’ condition becomes True). 

 

Example 2 –  Enter Dates For the Current Month 

Let’s say you want to enter all the dates of the current month into a worksheet column. 

You can do that by using the following Do Until loop code: 

Sub EnterCurrentMonthDates() 

Dim CMDate As Date 

Dim i As Integer 

i = 0 

CMDate = DateSerial(Year(Date), Month(Date), 1) 

Do Until Month(CMDate) <> Month(Date) 

Range("A1").Offset(i, 0) = CMDate 
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i = i + 1 

CMDate = CMDate + 1 

Loop 

End Sub 

The above code would enter all the dates in the first column of the worksheet (starting from A1). 
The loop continues until the Month of variable CMDate is not equal to that of the current month. 

 

12.5 What is VBA Range? 

The VBA Range Object represents a cell or multiple cells in your Excel worksheet. It is the most 
important object of Excel VBA. By using Excel VBA range object, you can refer to, 

 A single cell 

 A row or a column of cells 

 A selection of cells 

 A 3-D range 

As we discussed in our previous tutorial, that VBA is used to record and run Macro. But how VBA 
identify what data from the sheet needs to be executed. This is where VBA Range Objects is useful. 

Introduction to Referencing Objects in VBA 

Referencing Excel’s VBA Range Object and the Object Qualifier. 

 Object Qualifier: This is used for referencing the object. It specifies the workbook or worksheet 
you are referring to. 

To manipulate these cell values, Properties and Methods are used. 

 Property: A property stores information about the object. 

 Method: A method is an action of the object it will perform. Range object can perform actions 
like selected, copied, cleared, sorted, etc. 

VBA follow object hierarchy pattern to refer object in Excel. You have to follow the following 
structure. Remember the .dot overhere connects the object at each of the different levels. 

Application.Workbooks.Worksheets.Range 

There are two main types of default objects. 

How to refer to Excel VBA Range Object using Range property 

Range property can be applied in two different types of objects. 

 Worksheet Objects 

 Range Objects 

Syntax for Range Property 

1. The keyword “Range.” 

2. Parentheses that follow the keyword 

3. Relevant Cell Range 

4. Quotation (” “) 

Application.Workbooks("Book1.xlsm").Worksheets("Sheet1").Range("A1") 

When you refer Range object, as shown above, it is referred as fully qualified reference. You have 
told Excel exactly which range you want, what sheet and in what worksheet. 
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Example: MsgBox Worksheet(“sheet1”).Range(“A1”).Value 

Using Range property, you can perform many tasks like, 

 Refer to a Single cell using range property 

 Refer to a Single cell using the Worksheet.Range Property 

 Refer to an entire row or column 

 Refer to merged cells using Worksheet.Range Property and many more 

As such it will be too lengthy to cover all scenarios for range property. For scenarios mentioned 
above, we will demonstrate an example only for one. Refer to a Single cell using range property. 

Refer to a Single cell using the Worksheet.Range Property 

To refer to a single cell, you have to refer to a single cell. 

Syntax is simple “Range(“Cell”)”. 

Here, we will use “.Select” command to select the single cell from the sheet. 

Step 1) In this step, open your excel. 

 

Step 2) In this step, 

 Click on  button. 

 It will open a window. 
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 Enter your program name here and click ‘OK’ button. 

 It will take you to main Excel file, from top menu click on ‘stop’ record button to stop 

recording Macro. 

 

Step 3) In next step, 

 Click on Macro button  from the top menu. It will open the window below. 

 In this window, Click on the ‘edit’ button. 
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Step 4) The above step will open VBA code editor for file name “Single Cell Range”. Enter the code 
as shown below for selecting range “A1” from the excel. 

 

Step 5) Now save the file  and run the program as shown below. 
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Step 6) You will see Cell “A1” is selected after execution of the program. 

 

Likewise, you can select a cell with a particular Name. For example, if you want to search cell with 
name “Guru99- VBA Tutorial”. You have to run the command as shown below. It will select the cell 
with that name. 

Range(“Guru99- VBA Tutorial”).Select 

To apply other range object here is the code sample. 

Range for selecting cell in Excel Range declared 

For single Row Range(“1:1”) 

For single Column Range(“A: A”) 

For Contiguous Cells Range(“A1:C5”) 

For Non-Contiguous Cells Range(“A1:C5, F1:F5”) 

For Intersection of two ranges 

Range(“A1:C5 F1:F5”) 

(For intersection cell, remember there is no comma 
operator) 

To merge Cell 
Range(“A1:C5”) 

(To merge cell use “merge” command) 

Cell Property 
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Similarly to the range, in VBA you can also you “Cell Property”. The only difference is that it has an 
“item” property that you use to reference the cells on your spreadsheet. Cell property is useful in a 
programming loop. 

For example, 

Cells.item(Row, Column). Both the lines below refer to cell A1. 

 Cells.item(1,1) OR 

 Cells.item(1,”A”) 

Range Offset property 

Range offset property will select rows/columns away from its original position. On the basis of the 
range declared, cells are selected. See example below. 

For example, 

Range("A1").offset(Rowoffset:=1, Columnoffset:=1).Select 

The result for this will cell B2. The offset property will move A1 cell to 1 column and 1 row away. 
You can change the value of rowoffset / columnoffset as per requirement. You can use a negative 
value (-1) to move cells backward. 

 

Summary 

 VBA Case Statement: The VBA Case statement is used for conditional branching in Excel 

VBA. It allows you to compare a value against multiple possible values or conditions and 

execute different code blocks based on the match. 

 VBA IF Else Statement: The VBA IF Else statement is used for conditional execution of code. It 

checks a condition and executes one block of code if the condition is true and another block if 

it's false. 

 VBA For Loop: The VBA For Loop is used for repetitive execution of a block of code. It allows 

you to specify the number of times the code should be executed and control the loop with a 

counter variable. 

 Do Until Loop in VBA: The Do Until loop in VBA continues to execute a block of code until a 

specified condition becomes true. It's useful when you want to repeat a task until a certain 

condition is met. 

 Do While Loop in VBA: Similar to the Do Until loop, the Do While loop in VBA repeats a 

block of code, but it continues execution as long as a specified condition remains true. 

 Excel VBA Range Object: The Range object in Excel VBA represents a cell, a group of cells, or a 

named range in a worksheet. It's a fundamental object used to interact with and manipulate 

data within Excel. 

 Select Case Statement: This is an extension of the basic Case statement. It allows you to test a 

single expression against multiple values and execute code blocks based on the matching 

value. 

 For Each Loop in VBA: The For Each loop in VBA is used to iterate through a collection of 

objects, such as a range of cells or a collection of worksheets, without the need for a counter 

variable. 

 Exit Statement: In VBA, the Exit statement is used to prematurely exit a loop (e.g., For, Do 

Until, Do While) or a subroutine based on a specified condition, helping to streamline code 

execution. 
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 Nested Loops: You can nest loops in VBA, meaning you can place one loop inside another. 

This is useful for complex scenarios where you need to perform repetitive tasks within 

repetitive tasks, allowing for more advanced coding techniques. 

 

Keywords 

1. VBA Case Statement: 

 Definition: The VBA Case Statement is a conditional control structure in VBA that allows 
you to evaluate a specific expression against multiple possible values or conditions. It is 
used to execute different blocks of code depending on the match between the expression 
and the specified values. 

2. VBA IF Else Statement: 

 Definition: The VBA IF Else Statement is a conditional control structure in VBA used to 
make decisions in code execution. It checks a condition, and if the condition is true, it 
executes one block of code; otherwise, it executes another block of code. 

3. VBA For Loop: 

 Definition: The VBA For Loop is a control structure that allows you to execute a specific 
block of code repeatedly for a defined number of iterations. It is commonly used to 
perform tasks that require repetitive actions, such as iterating through a range of cells. 

4. Do Until Loop in VBA: 

 Definition: The Do Until Loop in VBA is a type of loop that repeatedly executes a block of 
code until a specified condition becomes true. It is useful for situations where you want to 
continue a task until a certain condition is met. 

5. Do While Loop in VBA: 

 Definition: The Do While Loop in VBA is another type of loop that repeatedly executes a 
block of code as long as a specified condition remains true. It is used when you want to 
continue executing a task while a condition holds true. 

6. Excel VBA Range Object: 

 Definition: The Excel VBA Range Object is an object in VBA that represents a single cell, a 
group of cells, or a named range within an Excel worksheet. It is used to interact with and 
manipulate data within Excel, such as reading or modifying cell values. 

7. Select Case Statement: 

 Definition: The Select Case Statement in VBA is an extended version of the basic Case 
statement. It allows you to evaluate a single expression against multiple values or 
conditions and execute different code blocks based on the matching value. 

8. For Each Loop in VBA: 

 Definition: The For Each Loop in VBA is used for iterating through a collection of objects, 
such as a range of cells or a collection of worksheets. It does not require a counter variable 
and is useful for working with collections. 

9. Exit Statement: 

 Definition: The Exit Statement in VBA is used to prematurely exit a loop (e.g., For, Do 
Until, Do While) or a subroutine based on a specified condition. It allows for early 
termination of code execution. 

10. Nested Loops: 

 Definition: Nested loops in VBA refer to the practice of placing one loop inside another. 
This technique is used to handle complex scenarios where repetitive tasks need to be 
performed within other repetitive tasks, allowing for more intricate coding structures. 
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Self Assessment 

1. What is the primary purpose of the VBA Case Statement? 

A. To create loops in VBA. 

B. To define custom functions. 

C. To evaluate a specific expression against multiple conditions. 

D. To perform file I/O operations. 

 

2. When is the VBA IF Else Statement used? 

A. To define custom functions. 

B. To create loops in VBA. 

C. To evaluate conditions and execute different code based on the result. 

D. To declare variables in VBA. 

 

3. Which VBA construct is used for repetitive execution of a block of code for a defined 

number of iterations? 

A. Do Until Loop 

B. Do While Loop 

C. For Loop 

D. Select Case Statement 

Do Until and Do While Loops VBA: 

 

4. In VBA, which loop continues execution until a specified condition becomes true? 

A. For Loop 

B. Do Until Loop 

C. Do While Loop 

D. Select Case Loop 

 

5. In Excel VBA, what does the Range object represent? 

A. A collection of worksheets. 

B. A single cell. 

C. A conditional statement. 

D. A custom function. 

 

6. Which of the following operations can you perform with the Excel VBA Range object? 

A. Creating custom macros. 

B. Calculating complex mathematical formulas. 

C. Reading and modifying cell values. 

D. Generating random numbers. 

 

7. What does "VBA" stand for? 

A. Visual Basic Analysis 

B. Virtual Basic Application 

C. Visual Basic for Applications 
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D. Visual Basic Advanced 

 

8. Which VBA construct allows you to prematurely exit a loop or subroutine based on a 

condition? 

A. Select Case Statement 

B. Exit Statement 

C. Do Until Loop 

D. For Each Loop 

 

9. What is the primary purpose of nesting loops in VBA? 

A. To increase code readability. 

B. To create complex custom functions. 

C. To perform repetitive tasks within repetitive tasks. 

D. To avoid using conditional statements. 

 

10. Which of the following is not a valid VBA control structure? 

A. If Statement 

B. For Loop 

C. Do Until Loop 

D. Cell Formula 

 

11. Which VBA construct is used to iterate through a collection of objects without the need for 

a counter variable? 

A. For Each Loop 

B. Do While Loop 

C. Select Case Statement 

D. Exit Statement 

 

12. In the context of VBA, what is the primary purpose of the "Else" keyword? 

A. To define custom functions. 

B. To indicate the end of a loop. 

C. To execute a code block if a condition is false. 

D. To perform mathematical calculations. 

 

13. Which of the following statements is true regarding the VBA Case Statement? 

A. It can only evaluate a single condition. 

B. It is used for arithmetic operations. 

C. It allows you to execute different code blocks based on multiple conditions. 

D. It can only be used in conjunction with the For Loop. 

 

14. Which VBA construct is used to perform repetitive tasks while a specified condition is 

true? 

A. For Loop 

B. Select Case Statement 

C. Do While Loop 

D. Exit Statement 
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15. What is the primary purpose of the VBA Range object? 

A. To control the appearance of Excel worksheets. 

B. To manage user interface elements. 

C. To interact with and manipulate data within Excel. 

D. To create custom dialog boxes. 

 

16. Which VBA construct allows you to evaluate a single expression against multiple values 

or conditions? 

A. For Loop 

B. Exit Statement 

C. Select Case Statement 

D. Do Until Loop 

 

17. In VBA, which loop is suitable for situations where you want to continue a task until a 

certain condition is met? 

A. For Each Loop 

B. Do Until Loop 

C. Select Case Loop 

D. Exit Loop 

 

18. Which VBA construct is used for conditional execution of code based on a specified 

condition? 

A. Exit Statement 

B. Do While Loop 

C. VBA Range Object 

D. IF Else Statement 

 

19. What type of Excel VBA object is used to represent a group of cells within a worksheet? 

A. Range Object 

B. Worksheet Object 

C. Cell Object 

D. Workbook Object 

 

20. Which VBA construct is used for repetitive execution of a block of code for a defined 

number of iterations? 

A. Do Until Loop 

B. Do While Loop 

C. For Loop 

D. Select Case Statement 

 

Answers for Self Assessment 

1. C 2. C 3. C 4. B 5. B 
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6. C 7. C 8. B 9. C 10. D 

11. A 12. C 13. C 14. C 15 C 

16. C 17. B 18. D 19. A 20. C 

Review Questions 

1. What is the primary purpose of the VBA Case Statement, and how does it differ from an IF 
Else Statement? 

2. Give an example of a situation where you would use a Select Case Statement in VBA. 

3. Explain the role of the IF Else Statement in VBA, and provide an example of its usage. 

4. How can you handle multiple conditions within an IF Else Statement in VBA? 

5. What is the primary use of a For Loop in VBA, and how is it structured? 

6. Describe a scenario where you might use a For Loop to automate a task in Excel. 

7. How do Do Until and Do While Loops in VBA differ in their behavior? Provide an 
example for each. 

8. When would you choose to use a Do Until Loop over a Do While Loop in VBA, and vice 
versa? 

9. What is the Excel VBA Range Object, and why is it essential in VBA programming for 
Excel? 

10. Give an example of a practical task where you would use the Range Object to interact with 
Excel data. 

 

 
Further Readings 

 https://www.wallstreetmojo.com/vba-if-else/#popmake-95356 

 https://www.wallstreetmojo.com/vba-case-statement/ 

 https://careerfoundry.com/en/blog/data-analytics/vba-for-loop-excel/ 

 https://analystcave.com/vba-for-loop-vs-for-each-loop/ 

 https://excelmacromastery.com/vba-for-loop/ 

 https://spreadsheeto.com/do-loops/#do-until 

 https://trumpexcel.com/vba-loops/#Do-While-Loop 

 https://www.guru99.com/vba-range-objects.html 
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Objectives 

 Understand the concept of goal seek in sensitivity analysis. 

 Understand the concept of data table in sensitivity analysis. 

 Understand the concept of scenario analysis in MS - Excel. 

 

Introduction 

Sensitivity analysis is a crucial tool in the world of finance, risk management, and decision-making. 
It allows analysts and decision-makers to understand how small changes in variables can impact 
financial models or investment decisions. By systematically varying key parameters, sensitivity 
analysis reveals the sensitivity of financial outcomes to different factors, helping to manage risks 
effectively. 

 

13.1 Goal Seek 

What-If Analysis is one of the most powerful Excel features and one of the least understood. In 
most general terms, What-If Analysis allows you to test out various scenarios and determine a 
range of possible outcomes. In other words, it enables you to see the impact of making a certain 
change without changing the real data. In this particular tutorial, we will focus on one of Excel's 
What-If Analysis tools - Goal Seek. 

What is Goal Seek in Excel? 

Goal Seek is Excel's built-in What-If Analysis tool that shows how one value in a formula impacts 
another. More precisely, it determines what value you should enter in an input cell to get the 
desired result in a formula cell. 

The best thing about Excel Goal Seek is that it performs all calculations behind the scenes, and you 
are only asked to specify these three parameters: 

 Formula cell 

 Target/desired value 

 The cell to change in order to achieve the target 

Dr. Jaskiran Kaur, Lovely Professional University 
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The Goal Seek tool is especially useful for doing sensitivity analysis in financial modeling and is 
widely used by management majors and business owner. But there are many other uses that may 
prove helpful to you. 

For instance, Goal Seek can tell you how much sales you have to make in a certain period to reach 
$100,000 annual net profit (example 1). Or, what score you must achieve for your last exam to 
receive an overall passing score of 70% (example 2). Or, how many votes you need to get in order to 
win the election (example 3). 

On the whole, whenever you want a formula to return a specific result but are not sure what input 
value within the formula to adjust to get that result, stop guessing and use the Excel Goal Seek 
function! 

How to use Goal Seek in Excel 

The purpose of this section is to walk you through how to use the Goal Seek function. So, we'll be 
working with a very simple data set: 

 

The above table indicates that if you sell 100 items at $5 each, minus the 10% commission, you will 
make $450. The question is: How many items do you have to sell to make $1,000? 

Let's see how to find the answer with Goal Seek: 

1. Set up your data so that you have a formula cell and a changing cell dependent on the formula 
cell. 

2. Go to the Data tab > Forecast group, click the What if Analysis button, and select Goal Seek… 

 

3. In the Goal Seek dialog box, define the cells/values to test and click OK: 

 Set cell - the reference to the cell containing the formula (B5). 

 To value - the formula result you are trying to achieve (1000). 

 By changing cell - the reference for the input cell that you want to adjust (B3). 
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4. The Goal Seek Status dialog box will appear and let you know if a solution has been found. If it 
succeeded, the value in the "changing cell" will be replaced with a new one. Click OK to keep 
the new value or Cancel to restore the original one. 

In this example, Goal Seek has found that 223 items (rounded up to the next integer) need to be sold 
to achieve a revenue of $1,000. 

 

If you are not sure you will be able to sell that many items, then maybe you can reach the target 
revenue by changing the item price? To test this scenario, do Goal Seek analysis exactly as 
described above except that you specify a different Changing cell (B2): 

 

As the result, you will find out that if you increase the unit price to $11, you can reach $1,000 
revenue by selling only 100 items: 
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Tips and notes: 

 Excel Goal Seek does not change the formula, it only changes the input value that you supply 
to the By changing cell box. 

 If Goal Seek is not able to find the solution, it displays the closest value it has come up with. 

 You can restore the original input value by clicking the Undo button or pressing the Undo 
shortcut (Ctrl + Z). 

Examples of using Goal Seek in Excel 

Below you will find a few more examples of using the Goal Seek function in Excel. The complexity 
of your business model does not really matter as long as your formula in the Set cell depends on the 
value in the Changing cell, directly or through intermediate formulas in other cells. 

 

Example 1: Reach the profit goal 

Problem: It is a typical business situation - you have the sales figures for the first 3 quarters and you 
want to know how much sales you have to make in the last quarter to achieve the target net profit 
for the year, say, 
$100,000.

 

Solution: With the source data organized like shown in the screenshot above, set up the following 
parameters for the Goal Seek function: 
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 Set cell - the formula that calculates the total net profit (D6). 

 To value - the formula result you are looking for ($100,000). 

 By changing cell - the cell to contain the gross revenue for quarter 4 (B5). 

 

Result: The Goal Seek analysis shows that in order to obtain $100,000 annual net profit, your fourth-
quarter revenue must be $185,714. 
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Example 2: Determine the exam passing score 

Problem: At the end of the course, a student takes 3 exams. The passing score is 70%. All the exams 
have the same weight, so the overall score is calculated by averaging the 3 scores. The student has 
already taken 2 out of 3 exams. The question is: What score does the student need to get for the 
third exam to pass the entire course? 

 

Solution: Let's do Goal Seek to determine the minimum score on exam 3: 

 Set cell - the formula that averages the scores of the 3 exams (B5). 

 To value - the passing score (70%). 

 By changing cell - the 3rd exam score (B4). 

 

Result: In order get the desired overall score, the student must achieve a minimum of 67% on the 
last exam: 
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Example 3: What-If analysis of the election 

 

 

Problem: You are running for some elected position where a two-thirds majority (66.67% of votes) is 
required to win the election. Assuming there are 200 total voting members, how many votes do you 
have to secure? 

Currently, you have 98 votes, which is quite good but not sufficient because it only makes 49% of 
the total voters: 

 

Solution: Use Goal Seek to find out the minimum number of "Yes" votes you need to get: 

 Set cell - the formula that calculates the percentage of the current "Yes" votes (C2). 

 To value - the required percentage of "Yes" votes (66.67%). 

 By changing cell - the number of "Yes" votes (B2). 
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Result: What-If analysis with Goal Seek shows that to achieve the two-thirds mark or 66.67%, you 
need 133 "Yes" votes: 

  

 

13.2 Data Table 

What is Sensitivity Analysis in Excel? 

Sensitivity analysis in excel helps us study the uncertainty in the model’s output with the changes in the 
input variables. It primarily does stress testing of our modeled assumptions and leads to value-added insights. 

In the context of DCF valuation, Sensitivity Analysis in excel is especially useful in finance for 
modeling share price or valuation sensitivity to assumptions like growth rates or cost of capital. 

#1 – One-Variable Data Table Sensitivity Analysis in Excel 

Let us take the Finance example (Dividend discount model) below to understand this in detail. 

Constant growth DDM gives us the Fair value of a stock as a present value of an infinite stream of 
dividends growing at a constant rate. 

Gordon Growth formula is as per below – 
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Where: 

 D1 = Value of dividend to be received next year 

 D0 = Value of dividend received this year 

 g   = Growth rate of dividend 

 Ke = Discount rate 

 

Now, let’s assume that we want to understand how sensitive the stock price is concerning the 
Expected Return (ke). There are two ways of doing this – 

 Donkey way :-) 

 What if Analysis 

#1 – Donkey Way 

Sensitivity Analysis in Excel using Donkey’s way is very straightforward but hard to implement 
when many variables are involved. 

 

Do you want to continue making this given 1000 assumptions? Not! 

Learn the following sensitivity analysis in excel technique to save yourselves from trouble. 

#2 – Using One Variable Data Table 

The best way to do sensitivity in excel is to use Data Tables. Data tables provide a shortcut for 
calculating multiple versions in one operation and a way to view and compare the results of all 
variations on your worksheet. 
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Below are the steps that you can follow to implement a one-dimensional sensitivity analysis in 
excel. 

1. Create the table in a standard format. 

In the first column, you have the input assumptions. In our example, inputs are the expected rate of 
return (ke). Also, please note a blank row (colored in blue in this exercise) below the table heading. 
This blank row serves an important purpose for this one-dimensional data table, which you will see 
in Step 2. 

 

 

2. Link the reference Input and Output as given the snapshot below. The space provided by the 
blank row is now used to provide input (expected return Ke) and the output formula. Why is 
it done like this? We will use What if Analysis; this is a way to instruct Excel that for the Input 
(ke), the corresponding formula provided on the right-hand side should be used to recalculate 
all the other input. 
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3. Select the What-if Analysis tool to perform Sensitivity Analysis in Excel. 

It is important to note that this is sub-divided into two steps. 

1. Select the table range starting from the left-hand side, starting from 10% until the lower right-
hand corner of the table. 

2. Click Data – What if Analysis – Data Tables 
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4. Data Table Dialog Box Opens Up. 

The dialog box seeks two inputs – Row Input and Column Input. Since there is only one input ,Ke, 
is under consideration, we will provide a single column input. 

 

5. Link the Column Input 

In our case, all input is provided in a column, and hence, we will link to the column input. 
Column input is linked to the Expected return (Ke). Please note that the input should be 
linked from the source and Not from the one inside the table. 

 

6. Enjoy the Output 
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#2 – Two-Variable Data Table Sensitivity Analysis in Excel 

Data tables are very useful for Sensitivity analysis in excel, especially in the case of DCF. Once a 
base case is established, DCF analysis should always be tested under various sensitivity scenarios. 
Testing involves examining the cumulative effect of changes in assumptions (cost of capital, 
terminal growth rates, lower revenue growth, higher capital requirements, etc.) on the fair value of 
the stock. 

Let us take the sensitivity analysis in excel with a finance example of Alibaba Discounted Cash 
Flow Analysis. 

With the base assumptions of the Cost of Capital as 9% and constant growth rate of 3%, we arrived 
at the fair valuation of $191.45 billion. 

 

Let us assume that you do not fully agree with the Cost of Capital Assumptions or the growth rate 
assumptions I have taken in Alibaba IPO Valuation. You may want to change the assumptions and 
assess the impact on valuations. 

One way is to change the assumptions and check each change’s results manually. (codeword – 
Donkey method!) 
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However, we are here to discuss a much better and more efficient way to calculate valuation using 
sensitivity analysis in excel that saves time and provides us with a way to visualize all the output 
details in an effective format. 

If we perform the What-if analysis in excel professionally on the above data, then we get the 
following output. 

 

 Here, row inputs consist of changes in Cost of capital or WACC (7% to 11%) 

 Column inputs consist of changes in growth rates (1% to 6%) 

 The point of intersection is Alibaba Valuation. E.g. using our base case of 9% WACC and 3% 
growth rates, we get the valuation as $191.45 billion. 

With this background, let us now look at how we can prepare such a sensitivity analysis in excel 
using two-dimensional data tables. 

Step 1 – Create the Table Structure as given below 

 Since we have two sets of assumptions – Cost of Capital (WACC) and Growth Rates (g), you 
need to prepare a table given below. 

 You are free to switch the row and column inputs. Instead of WACC, you may have growth 
rates and vice-versa. 

 

Step 2 – Link the Point of Intersection to the Output Cell. 

The point of intersection of the two inputs should be used to link the desired output. In this case, 
we want to see the effect of these two variables (WACC and growth rate) on Equity value. Hence, 
we have linked the intersecting cell to the output. 
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Step 3 – Open Two Dimensional Data Table 

 Select the table that you have created 

 Then click on Data -> What if Analysis -> Data Tables 

 

Step 4 – Provide the row inputs and column inputs. 

 Row input is the Cost of Capital or Ke. 

 The column input is the growth rate. 

 Please remember to link these inputs from the original assumption source and not from inside 
the table. 
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Step 5 – Enjoy the output. 

 Most pessimistic output values lie in the right-hand top corner, where the Cost of Capital is 
11%, and the growth rate is only 1% 

 The most optimistic Alibaba IPO Value is when Ke is 7%, and g is 6% 

 The base case we calculated for 9% ke and 3% growth rates lies in the middle. 

 This two-dimensional sensitivity analysis in the excel table provides the clients with an easy 
scenario analysis that saves a lot of time. 

 

#3 – Goal Seek for Sensitivity Analysis in Excel 

 The Goal Seek command is used to bring one formula to a specific value 

 It does this by changing one of the cells that is referenced by the formula 

 Goal Seek asks for a cell reference that contains a formula (the Set cell). It also asks for a 
value, which is the figure you want the cell to be equal 

 Finally, Goal Seek asks for a cell to alter to take the Set cell to the required value 

Let us have a look at the DCF of Alibaba IPO Valuation. 

 

As we know from DCF that growth rates and valuation are directly related. Increasing growth rates 
increase the share price of the stock. 

Let’s assume that we want to check at what growth rate will the stock price touches $80. 

As always, we can do this manually by changing the growth rates to continue to see the impact on 
the share price. This will, again, be a tedious process. In our case, we may have to input growth 
rates many times to ensure that the stock price matches $80. 

However, we can use a function like Goal Seek in excel to solve this in easy steps. 

Step 1 – Click on the cell whose value you wish to set. (The Set cell must contain a 
formula) 
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Step 2 – Choose Tools, Goal Seek from the menu, and the following dialog box 
appears: 

 The Goal Seek command automatically suggests the active cell as the Set cell. 

 This can be over-typed with a new cell reference, or you may click on the appropriate cell on 
the spreadsheet. 

 Now enter the desired value this formula should reach. 

 Click inside the “To Value” box and type in the value you want your selected formula to 
equal. 

 Finally, click inside the “By Changing Cell” box and either type or click on the cell whose 
value can be changed to achieve the desired result. 

 Click the OK button, and the spreadsheet will alter the cell to a value sufficient for the formula 
to reach your goal. 

 

Step 3 – Enjoy the output. 

Goal Seek also informs you that the goal was achieved. 
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13.3 Scenario Analysis 

What is a Scenario Manager in Excel? 

 Scenario manager in Excel is a part of three what-if-analysis tools in Excel, which are built-in 
in Excel. In simple terms, you can see the impact of changing input values without changing 
the actual data. Like a Data Table in excel, you now input values that must change to achieve 
a specific goal. 

 Scenario manager in Excel allows you to change or substitute input values for multiple cells 
(maximum up to 32). Therefore, you can view the results of different input values or different 
scenarios at the same time. 

 For example: What if I cut down my monthly traveling expenses? How much will I 
save? Here, we can store scenarios to apply them with a mouse click. 

Scenario Manager in Excel – Example #1 

A simple example could be your monthly family budget. You will spend on food, travel, 
entertainment, clothes, etc., and see how these affect your overall budget. 

Step 1: Create a below table that shows your list of expenses and income sources. 
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 In cell B5, you have total income. 

 

 In cell B17, you have total expenses for the month. 
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 In cell B19, total money left. 

 

You are ending up with only 5,550 after all the expenses. So, it would help if you cut your cost to 
save more for the future. 
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Step 2: From the top of Excel, click the Data menu > On the “Data” menu, locate the “Data Tools” 
panel > Click on the “What-If-Analysis” item and select the “Scenario Manager” in Excel from the 
menu. 

 

Step 3: When you click on the Scenario Manager below, the dialog box will open. 

 

Step 4: You need to create a new scenario. So, click on the Add button. Then, you will get the below 
dialog box. 
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By default, it shows cell C10, which means it is the currently active cell. So, first, type the scenario 
name in the box as the Actual Budget. 
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Now, you need to enter which cells your excel sheet will be changing. Nothing will change in this 
first scenario because this is my actual budget for the month. Still, we need to specify the cells that 
will be changing. 

Now, try to reduce the food expenses and clothes expenses. These are in cells B15 and 
B13,respectively. Now, the add scenario dialog box should look like this. 

 

Click “OK.” Excel will ask you for some values. Since we do not want any changes to this scenario, 
click “OK.” 

 

Now, you will be taken back to the scenario manager box. Now, the window will look like this. 
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Now, one scenario is done and dusted. Next, create a second scenario where you must change your 
food and clothes expenses. 

Click the Add button and give a “Scenario Name” as “Plan 2”. “Changing the cell” will be B15 and 
B13 (food and cloth expenses). 
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Now, below, the “Scenario Values” dialog box opens again. This time, we want to change the 
values. Enter the same ones as in the image below: 

 

These are the new values for our new scenario, Plan 2. Click “OK.” Now, you are back to the 
Scenario Manager window. Now, we have two scenarios named after Actual Budget and Plan 2. 

Lovely Professional University440



Spreadsheet Modelling (Using Excel)  

 

Notes 

 

Click the Add button and give a scenario name as “Plan 3.” “Changing  cells” will be B15 and B13 
(food and cloth expenses). 
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Now, below, the “Scenario Values” dialog box opens again. This time, we do want to change the 
values. Insert the same ones as in the image below: 

 

These are the new values for our new scenario, Plan 3. Click “OK.” Now you are back to the 
“Scenario Manager” window. Now, you have three scenarios named after Actual Budget, Plan 2, 
and Plan 3. 
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As you can see, we have our “Actual Budget,” “Plan 2,” and “Plan 3.” With “Plan 2” selected, click 
the “Show” button at the bottom. The values in your Excel sheet will change, and we will calculate 
the new budget. The image below shows what it looks like. 

 

Click on the Actual Budget and the Show button to see the differences. It will display initial values. 
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Do the same for “Plan 2” to look at the changes. 

 

So, scenario manager in Excel allows you to set different values and identify the significant 
changes. 

How to Create a Summary Report in Excel? 

After adding different scenarios, we can create a summary report in Excel from this scenario 
manager. To create a summary report in Excel, follow the below steps. 

 Click on the Data tab from the Excel menu bar. 

 Click on What-If-Analysis. 

 Under the what-if-analysis, click Scenario Manager in Excel. 

 Now, click on Summary. 
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 Click “OK” to create the summary report in Excel. 

 

Lovely Professional University 445



Unit 13: Sensitivity Analysis  

 

Notes 

 It will create the summary in the new sheet, as shown in the below image. 

 

 It shows the change in savings in three different scenarios. In the first scenario, the savings 
was 5,550. In the second scenario, savings are increased to 20,550 due to cost cut down in Food 
& Clothes section, and finally, the third scenario shows the other scenario. 

 All right, now we exercised a simple Family Budget Planner. It looks good enough to 
understand. Perhaps, this is enough to convince your family to change their lifestyle. 

 Scenario manager in Excel is a great tool when you need to do sensitivity analysis. You can 
instantly create the summary report in Excel to compare one plan with the other and decide 
the best alternative plan to get a better outcome. 

Scenario Manager in Excel Example #2: Take the below data and create new scenarios. 

Take the below data table and create new scenarios. 

 “If the Operating Cost Reduces by 10%.” 

 “If the Operating Cost Reduces by 15%.” 

 “If the Unit Price increases by five and all others remain the same.” 

The formula used in cell B4 is =B2*B3 & in cell B11 is = B4 – B9. 

 

In addition, your scenarios will look like the one below. 
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Summary 

 Purpose: Goal Seek is an Excel tool used for what-if analysis. It helps find the input value 
needed to achieve a specific result or goal. 

 Single Variable: Goal Seek is typically used when you have one input variable and want to 
determine its value to reach a desired outcome. 

 Example: It can be applied in financial modeling to find the required loan payment to reach a 
specific loan balance. 

 Process: To use Goal Seek, you specify a target value, a changing cell (input), and a desired 
result. Excel calculates the necessary input value. 

 Limitations: Goal Seek is limited to one-variable analysis and cannot handle multiple 
changing inputs or scenarios. 

 Purpose: Data Tables in Excel are used to analyze multiple scenarios by changing one or two 
variables while keeping the rest constant. 

 Types: There are one-variable and two-variable Data Tables. One-variable tables vary one 
input, while two-variable tables vary two inputs simultaneously. 

 Input Range: Data Tables require you to define an input range with different values or 
scenarios and an output cell with a formula to analyze. 

 Usage: Data Tables are commonly employed in financial modeling, sensitivity analysis, and 
assessing the impact of changing variables on outcomes. 

 Reports: Data Tables can generate summary reports that display the results of multiple 
scenarios in a structured format. 

 Purpose: Scenario Analysis in Excel allows for the examination of different sets of input values 
to understand how they affect outcomes. 

 Multiple Scenarios: It supports the creation and management of multiple scenarios, each with 
distinct input values. 

 Scenario Manager: Excel's Scenario Manager tool simplifies the creation and comparison of 
scenarios, offering a user-friendly interface. 

 Reports: Scenario Analysis often includes the creation of summary reports that provide a side-
by-side comparison of scenario results. 

 Applications: Scenario Analysis is valuable in risk assessment, decision-making, and project 
planning, helping users explore various "what-if" possibilities. 

 Data Separation: Scenarios can be stored in separate worksheet cells, making it easy to switch 
between them for analysis. 

 

Keywords 

1. Goal Seek: 
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 Meaning: Goal Seek is an Excel tool that allows you to find the input value needed to 
achieve a specific goal or target output by varying a single variable while keeping others 
constant. 

2. What-If Analysis: 

 Meaning: What-If Analysis refers to the process of changing input values in a model to 
observe the resulting changes in outcomes, helping to explore various scenarios. 

3. Data Table: 

 Meaning: A Data Table in Excel is a tool used to perform sensitivity analysis by changing 
one or two input variables and observing the impact on one or more output values. 

4. One-Variable Data Table: 

 Meaning: A one-variable Data Table allows you to vary a single input variable while 
keeping other variables constant to analyze different scenarios. 

5. Two-Variable Data Table: 

 Meaning: A two-variable Data Table enables the simultaneous variation of two input 
variables while keeping the rest constant, allowing for more complex scenario analysis. 

6. Scenario Analysis: 

 Meaning: Scenario Analysis involves the examination of different sets of input values to 
understand how they affect outcomes, often used for assessing risks and making informed 
decisions. 

7. Scenario Manager: 

 Meaning: Scenario Manager is an Excel tool that facilitates the creation, management, and 
comparison of multiple scenarios, making it easier to explore "what-if" possibilities. 

8. Sensitivity Analysis: 

 Meaning: Sensitivity Analysis is a broader term that encompasses various techniques, 
including Data Tables and Scenario Analysis, to assess how changes in input values 
impact the results of a model or analysis. 

9. Summary Report: 

 Meaning: A Summary Report is a document or presentation that provides a concise 
overview of the results and findings from scenario analysis, often presented in a 
structured format for decision-makers. 

10. Risk Assessment: 

 Meaning: Risk Assessment involves evaluating potential risks and uncertainties associated 
with different scenarios, helping organizations make informed choices to mitigate adverse 
outcomes. 

 

Self Assessment 

1. What is the primary purpose of the Goal Seek tool in Excel? 

A. To create data tables. 

B. To perform what-if analysis. 

C. To create scenarios. 

D. To insert comments in cells. 

 

2. When using Goal Seek, which of the following is typically unknown and needs to be 

determined? 

A. The initial input value. 

B. The target value or goal. 
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C. The formula to be used. 

D. The data table. 

 

3. In Goal Seek, which value remains constant while you change another value to reach a 

target? 

A. The target value. 

B. The formula. 

C. The initial input value. 

D. The scenario. 

 

4. What is a Data Table in Excel used for? 

A. To create custom functions. 

B. To format cells with specific colors. 

C. To analyze multiple scenarios by changing one or two variables. 

D. To insert charts into a worksheet. 

 

5. In a one-variable Data Table, how many input values can you specify? 

A. One 

B. Two 

C. Multiple 

D. None 

 

6. When creating a two-variable Data Table, what does the row input cell represent? 

A. The variable you want to change. 

B. The variable that remains constant. 

C. The target value. 

D. The formula to be used. 

 

7. What is Scenario Analysis in Excel used for? 

A. To create pivot tables. 

B. To analyze multiple sets of data by changing input values. 

C. To format cells with specific colors. 

D. To create custom functions. 

 

8. In Scenario Manager, what is a "scenario"? 

A. A type of chart. 

B. A defined set of input values. 

C. A comment attached to a cell. 

D. A data validation rule. 

 

9. How can you create different scenarios in Excel? 

A. By using the Goal Seek tool. 

B. By applying conditional formatting. 

C. By using the Scenario Manager. 

D. By inserting pivot tables. 

 

10. In Scenario Analysis, what does the "Summary" option allow you to do? 
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A. It generates random values for scenarios. 

B. It summarizes the results of multiple scenarios in a report. 

C. It formats the cells with specific colors. 

D. It creates custom formulas for analysis. 

 

11. Which Excel feature allows you to compare different scenarios side by side? 

A. Goal Seek 

B. Data Validation 

C. Scenario Analysis 

D. Data Table 

 

12. In Scenario Manager, what happens when you click the "Show" button for a specific 

scenario? 

A. The scenario is deleted. 

B. The scenario is added to a report. 

C. The scenario is highlighted. 

D. The scenario becomes the active data. 

 

13. Which of the following is not a common goal of these Excel tools (Goal Seek, Data Table, 

Scenario Analysis)? 

A. Analyzing historical data. 

B. Predicting future outcomes. 

C. Conducting what-if analysis. 

D. Finding optimal solutions. 

 

14. Which Excel tool is most suitable for determining a single input value needed to achieve a 

specific result? 

A. Goal Seek 

B. Data Table 

C. Scenario Manager 

D. VLOOKUP 

 

15. What is the primary difference between a Data Table and Scenario Analysis? 

A. Data Tables involve changing input values, while Scenario Analysis focuses on goal-

seeking. 

B. Data Tables allow for one-variable analysis, while Scenario Analysis supports multiple 

variables. 

C. Data Tables require a separate worksheet, while Scenario Analysis uses the same 

worksheet. 

D. Data Tables are used for charting, while Scenario Analysis is used for formatting. 

 

Answers for Self Assessment 

1. B 2. A 3. A 4. C 5. C 

6. A 7. B 8. B 9. C 10. B 

Lovely Professional University450



Spreadsheet Modelling (Using Excel)  

 

Notes 

11. C 12. D 13. A 14. A 15. B 

 

Review questions 

1. What is the primary purpose of the Goal Seek tool in Excel? 

2. How does Goal Seek work, and what does it help you find in a spreadsheet? 

3. When is Goal Seek most commonly used in financial modeling or analysis? 

4. What is the main purpose of a Data Table in Excel? 

5. How does a one-variable Data Table differ from a two-variable Data Table? 

6. In a Data Table, what are the input values, and what is the output value? 

7. What is Scenario Analysis, and how does it differ from Goal Seek and Data Tables? 

8. How does Scenario Manager simplify the process of conducting Scenario Analysis in Excel? 

9. Why is Scenario Analysis valuable in risk assessment and decision-making? 

10. What is the key benefit of using Summary Reports in Scenario Analysis? 

 

 
Further Readings 

 https://www.ablebits.com/office-addins-blog/goal-seek-excel-what-if-analysis/ 

 https://www.simplilearn.com/tutorials/excel-tutorial/goal-seek-excel 

 https://www.wallstreetmojo.com/sensitivity-analysis-in-excel/ 

 https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_goal_se

ek.htm 

 https://www.wallstreetmojo.com/sensitivity-analysis-in-excel/ 

 https://www.wallstreetmojo.com/scenario-manager-in-excel/ 

 https://trumpexcel.com/scenario-manager-in-excel/ 

 https://www.investopedia.com/terms/s/scenario_analysis.asp 

 https://www.excel-easy.com/data-analysis/what-if-analysis.html 

 https://www.exceldemy.com/scenario-analysis-excel/ 

 https://spreadsheeto.com/scenario-manager/ 
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Objectives 

• Understand the concept of monte carlo simulations. 

• Understand the concept of solver in MS-Excel. 

• Understand the concept of linear programming for optimization in MS-Excel 

• Understand the concept of calculation of intrinsic values in MS-Excel. 

 

Introduction  

Simulation plays a pivotal role in disaster preparedness and response. Emergency services and 
disaster management agencies use simulations to replicate crisis situations and test response 
strategies. By simulating various scenarios, such as natural disasters or terrorist attacks, these 
agencies can refine their protocols and enhance their readiness to mitigate potential threats. 
Optimization is fundamental in the realm of supply chain management. Businesses use 
optimization techniques to streamline the allocation of resources, minimize transportation costs, 
and maximize the efficiency of their supply chains. By optimizing routes, inventory levels, and 
production schedules, companies can achieve significant cost savings and improved customer 
service. 

 

14.1 Monte Carlo Simulations 

Monte Carlo simulation is a computerized mathematical technique to generate random sample data 
based on some known distribution for numerical experiments. This method is applied to risk 
quantitative analysis and decision making problems. This method is used by the professionals of 
various profiles such as finance, project management, energy, manufacturing, engineering, research 
& development, insurance, oil & gas, transportation, etc. 

Dr. Jaskiran Kaur, Lovely Professional University 
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This method was first used by scientists working on the atom bomb in 1940. This method can be 
used in those situations where we need to make an estimate and uncertain decisions such as 
weather forecast predictions. 

Monte Carlo Simulation ─ Important Characteristics 

Following are the three important characteristics of Monte-Carlo method − 

 Its output must generate random samples. 

 Its input distribution must be known. 

 Its result must be known while performing an experiment. 

Monte Carlo Simulation ─ Advantages 

 Easy to implement. 

 Provides statistical sampling for numerical experiments using the computer. 

 Provides approximate solution to mathematical problems. 

 Can be used for both stochastic and deterministic problems. 

Monte Carlo Simulation ─ Disadvantages 

 Time consuming as there is a need to generate large number of sampling to get the desired 
output. 

 The results of this method are only the approximation of true values, not the exact. 

Monte Carlo Simulation Method ─ Flow Diagram 

The following illustration shows a generalized flowchart of Monte Carlo simulation. 
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14.2 The Monte Carlo Simulation Formula 

Distribution Curves 

There are various distribution curves you can use to set up your Monte Carlo simulation.  And 
these curves may be interchanged based on the variable.  Microsoft doesn’t have a formula called 
“Do Monte Carlo Simulation” in the menu bar � 

Uniform Distribution 

In a uniform distribution, there is equal likelihood anywhere between the minimum and a 
maximum.  A uniform distribution looks like a rectangle. 

 

Normal (Gaussian) Distribution 

This is also your standard bell shaped curve.  This Monte Carlo Simulation Formula is 
characterized by being evenly distributed on each side (median and mean is the same – and no 
skewness).  The tails of the curve go on to infinity.  So this may not be the ideal curve for house 
prices, where a few top end houses increase the average (mean) well above the median, or in 
instances where there is a hard minimum or maximum.  An example of this may be the minimum 
wage in your locale. Please note that the name of the function varies depending on your version. 

 

Lognormal Distribution 

A distribution where the logarithm is normally distributed with the mean and standard 
deviation.  So the setup is similar to the normal distribution, but please note that the mean and 
standard_dev variables are meant to represent the logarithm. 

 

Poisson Distribution 

This is likely the most underutilized distribution.  By default, many people use a normal 
distribution curve when Poisson is a better fit for their models.  Poisson is best described when 
there is a large distribution near the very beginning that quickly dissipates to a long tail on one 
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side.  An example of this would be a call center, where no calls are answered before second 
ZERO.  Followed by the majority of calls answered in the first 2 intervals (say 30 and 60 seconds) 
with a quick drop off in volume and a long tail, with very few calls answered in 20 minutes 
(allegedly). 

 

The purpose here is not to show you every distribution possible in Excel, as that is outside the 
scope of this article.  Rather to ensure that you know that there are many options available for your 
Monte Carlo Simulation.  Do not fall into the trap of assuming that a normal distribution curve is 
the right fit for all your data modeling.  To find more curves, to go the Statistical Functions within 
your Excel workbook and investigate.  If you have questions, pose them in the comments section 
below. 

Building The Model 

For this set up we will assume a normal distribution and 1,000 iterations. 

Input Variables 

The setup assumes a normal distribution. A normal distribution requires three variables; 
probability, mean and standard deviation.  We will tackle the mean and standard deviation in our 
first step.  I assume a finance forecasting problem that consists of Revenue, Variable and Fixed 
Expenses.  Where Revenue minus Variable Expenses minus Fixed Expenses equals Profit.  The 
Fixed expenses are sunk cost in plant and equipment, so no distribution curve is 
assumed.  Distribution curves are assumed for Revenue and Variable Expenses. 

 

First Simulation 

The example below indicates the settings for Revenue.  The formula can be copy and pasted to cell 
D6 for variable expenses.  For Revenue and expenses we you the function NORM.INV() where the 
parameters are: 

Probability = the function RAND() to elicit a random number based on the other criteria within the 
distribution. 

Mean = The mean used in the Step 1.  For Revenue it is C3. 

Standard Deviation = The Standard Deviation used in Step 1.  For Revenue it is C4 
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Since RAND() is used as the probability, a random probability is generated at refresh.  We will use 
this to our advantage in the next step. 

1,000 Simulations 

There are several ways to do 1,000 or more variations.  The simplest option is to take the formula 
from step #2 and make it absolute.  Then copy and paste 1,000 times.  That’s simple, but not very 
fancy.  And if Ferris Bueller can save the world by showing a new Tic Tac Toe game to a computer, 
then we can spice up this analysis as well. Let’s venture into the world of tables. 

First we want to create an outline for a table.  We do this by listing the numbers 1 to 1,000 in 
rows.  In the example image below, the number list starts in B12. 

in the next column, in cell C12, we will reference the first iteration. 

 

Next highlight the area where we want to house the 1,000 iterations 

Select Data > Data Tables 

For Column input cell: Select a blank cell.  In the download file, cell D11 is selected 

Select OK 
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Once OK is selected from the previous step, a table is inserted that autopopulates the 1,000 
simulations 
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14.3 Summary Statistics 

Once the simulations are run, it is time to gather summary statistics.  This can be done a number of 
ways.  In this example I used the COUNTIF() function to determine the percentage of simulations 
that are unprofitable, and the likelihood of a profit greater than $1 Million.  As expected, the 
likelihood of greater than $1M hovers around 50%.  This is because we used normal distribution 
curves that are evenly distributed around the mean, which was $1M.  The likelihood of losing 
money is 4.8%.  This was gathered by using the COUNTIF() function to count the simulations that 
were less than zero, and dividing by the 1,000 total iterations. 

 

 

14.4 Introduction to Solver 

A solver is a mathematical tool present in MS-Excel that is used to perform calculations by working 
under some constraints/conditions and then calculates the solution for the problem. It works on the 
objective cell by changing the variable cells any by using sum constraints. 

Solver is present in MS- Excel but for using it we need to activate it. For activating the solver tool 
we need to do the following steps: 

Step 1: Go to File and select options. The following dialog box will appear. 
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Step 2: Now select the Add-ins option and click on Go and finally click on OK. 
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Step 3: After clicking OK, Select Solver Add-in and press OK. Now solver will be activated in 
Excel. 

 

Step 4: Now solver will appear in data section like this. 
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Now let’s understand how to use solver with the help of an example. 

 

Example: 

We went to a mall and we also have a gift voucher worth rs.10,000 and We want to purchase items 
in such a manner that all the money of the gift voucher gets utilized. 

So, suppose we purchased the following items. 

 

Suppose we purchased the above items in only one quantity and the total came out to be 9300 but 
the voucher was for rs.10,000. So now we want to use Solver for this purpose. Now let’s see how it 
will be done. 

Step 1: Firstly go on data and find solver there and click it. The following dialog box will appear. 
Now in this, we have to select the objective in which we want to change our value. 
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Step 2: In the set objective we have to select the total of the D column because want the value to 
change from 9300 to 10,000. After clicking on D7 following thing will be displayed on the set 
objective block. 
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Step 3: Now in the ‘By changing Variable cell’ we will select the Quantity cell because we want to 
change the quantity in such a way so that the total amount comes to 10,000. 

 

Step 4: Now we have to set some conditions under which we want our work to get done. So for 
setting some conditions /constraints, we will click on Add. 

 

Step 5– Now, a dialog box will appear and we will add 3 conditions. The first condition is that the 
total amount should be equal to the voucher amount. So we will select cell D7 in a cell reference 
and then = sign, and finally, we will select cell C11. Now the first condition is added. To add the 
next condition press Add. 
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Step 6: For the second condition we will select the Quantity cell because we want the quantity to be 
an integer value, a whole value. So in cell reference, we will select from B2 to B6 then int, and then 
again will press Add. 

 

Step 7- Now for the third condition, we want that our item quantity should never be un negative 
which is not possible in real life. So we will select cells from B2 to B6 and should be >= to zero. 
Then click Add and cancel. 

 

Step 8: Now the following dialog box will show all the 3 conditions that we used and now click on 
Solve. 
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Step 9: By clicking Solve the solver will provide the desired output and to keep the answer we will 
click on keep solver solution. 

 

So, this is what a solver is, How it is activated by not by default present in Excel and this is how it is 
used. 

 

14.5 Linear Programming for Optimization 

Linear Programming is the most important and fascinating aspect of applied mathematics, which 
helps in resource optimization (either minimizing the losses or maximizing the profit with given 
resources). If we have constraints and the objective function well defined, we can use the system to 
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predict an optimal solution for a given problem. In Excel, we have Excel Solver, which helps us 
solving the Linear Programming Problems a.k.a. LPP. We will see in this article how to use Excel 
Solver to optimize the resources associated with business problems with the help of Linear 
Programming. 

First thing first. Let’s see how we can enable Excel Solver (a key component of LPP under Excel). 

Methods to Solve Linear Programming through Excel Solver 

Let’s understand how to use Linear Programming through Excel Solver with some methods. 

Method #1 – Enabling Solver under Microsoft Excel 

In Microsoft Excel, we can find Solver under the Data tab, which can be found on the Excel 
Ribbon placed at the uppermost part, as shown below: 

 

If You can’t see this utility tool there, you must enable it through Excel Options. Follow the steps 
below to enable Solver under Excel. 

Step 1: Navigate to the File menu and click on Options, the last thing on that list. 

 

Step 2: A new window will pop up named Excel Options. Click on Add-ins from the list of options 
present on the left-hand side of the window. 
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Step 3: Under the Manage section at the bottom of the window, select Excel Add-ins from the 
dropdown list and click on the Go… button beside. 

 

Step 4: As soon as you click the Go… button, you will see the list of all Add-ins available under 
Excel in a new window. Tick to select the Solver Add-in so that you can use it under the Data tab 
for solving the equations. Click the OK button after tick selecting the Solver Add-in. 

 

This way, you can enable the Excel Solver under Microsoft Excel. 

Method #2 – Solving Linear Programming Problem using Excel Solver 

Now, we will try to solve the linear programming problem using the Excel Solver tool. 

Example: A chemical plant produces two products:: A. These two products need raw 
materials as shown below: Product A needs three types of raw materials – Material_1 20KG, 
Material_2 30KG, and Material_3 as 5 KG. Product B requires 10 kg of Material_1, 30 KG of 
Material_2, and 10 KG of Material_3 on similar lines. The manufacturer requires a minimum of 460 
kg of Material_1, 960 kg of Material_2, and 220 kg of Material_3. If the per-unit cost for Product A is 
$30 and the cost of Product B is $35, how many products should the manufacturer blend to meet 
the minimum material requirements at the lowest cost possible? Let’s use the information provided 
in this example for modeling the equations. 

Step 1: We can see all the equation constraints we can form using the information in the example 
above. 
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Step 2: Use these equations to add the constraints cell-wise under Excel across A2:C8 of the given 
sheet. See the screenshot below: 

 

Step 3: We need to use the formula Quantity * Per Unit Cost and sum it up for both products to get 
the actual material requirements. This is formulated under column D for all cells containing 
constraints B3, B4, C3). Please see the attached screenshot below: 

 

 

If you look closely at this formula, we have used B3 and C3 as fixed members for each formula 
across the different cells in column D. B3 and C3 are the cells denoting quantities for Product A and 
Product B, respectively. The quantities will appear once we solve these equations using an Excel 
solver. 
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Step 4: Click on the Data tab and then on Solver, which is present under Analyze section in the tab. 

 

Step 5: Once you click on Solver, a new tab named “Solver Parameter” will open up, under which 
you need to set the parameters for this set of equations to be solved. 

 

Step 6: The first thing we need to identify is Set Objective: Since our objective is to figure out the 
total cost involved to minimize it, set this to D4. 
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Step 7: Since we need to minimize the cost with the highest production possible, set the next 
parameter as Min. You can get this done by clicking on the Min radio button. 
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Step 8: under By Changing Variable Cells: we need to mention B3 and C3 since these cells will 
contain Quantities for Product A and Product B, respectively, after the problem gets solved. 
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Step 9: Now add the constraints. Click on Add button under the Subject to the Constraints: section, 
and it will open up a new window to add constraints. Under that window – B3:C3 as Cell 
Reference, >= and 0 as Constraints. This we are doing since the basic constraint in any LPP is that X 
and Y should be greater than zero. 

 

Step 10: Click again on the Add button, and this time use B3:C3 as Cell Reference and F6:F8 as 
Constraints with inequality as >=. Click the OK button to add this constraint as well under the 
solver. 

 

Solver now has all the parameters required to solve this set of linear equations, and it looks as 
below: 

Lovely Professional University472



Spreadsheet Modelling (Using Excel)  

 

Notes 

 

Step 11: Now, click the Solve button at the bottom of the window to solve this linear equation and 
find the optimal solution. 

 

As soon as we click on the solve button, the system starts searching for an optimal solution for the 
problem we have provided. We get the values for B3, and C3, using which we also get the values 
under column F for F4, F6:F8, which are the optimal costs and material values that can be used for 
Product A and Product B. 
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This solution informs us that if we need to minimize the cost of Production for Product A and 
Product B with optimal usage of Material_1, Material_2, and Material_3, we should produce 14 
quantities of Product A and 18 Quantities of Product B. 

 

14.6 Intrinsic Value Calculation Models 

What is an Intrinsic Value Formula? 

The formula for Intrinsic value represents the net present value of all the future free cash flows to 
equity (FCFE) of a company during the entire course. It reflects the actual worth of the business 
underlying the stock, i.e., the amount of money that can receive if the whole business and all of its 
assets are sold off today. 

Intrinsic Value Formula 

The intrinsic value formula for business and stock is represented as follows – 

#1 – Intrinsic Value Formula of a Business 

Mathematically, the intrinsic value formula of a business can be represented as, 

 

 where FCFEi = Free cash flow to equity in the ith year 

 FCFEi = Net income i + Depreciation & Amortisation i – Increase in Working Capital i – 
Increase in Capital Expenditure i – Debt Repayment on existing debt i + Fresh Debt raised i 

 r = Discount rate 

 n = Last projected year 
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#2 – Intrinsic Value Formula of a Stock 

The calculation of the intrinsic value formula of the stock is done by dividing the value of the 
business by the number of outstanding shares of the company in the market. The value of stock 
derived in this way is then compared with the market price to check if the stock is trading above / 
at par / below its intrinsic value 

Intrinsic Value Formula Stock  = Intrinsic Value Business / No. of outstanding shares 

Explanation of the Intrinsic Value Formula 

The calculation of the formula of the intrinsic value of a stock can be done by using the following 
steps: 

1. Firstly, determine the future FCFE for all the projected years based on the available 
financial plan. The projected FCFEs can be computed by taking the latest FCFE and 
multiply it with the expected growth rate. 

2. Now, the discount rate is determined based on the current market return from an 
investment with a similar risk profile. The discount rate is denoted by r. 

3. Now, calculate the PV of all the FCF by discounting them using the discount rate. 

4. Now, add up the PV of all the FCF calculated in step 3. 
 

 

5. Next, the terminal value is computed by multiplying the FCFE of the last projected year by 
a factor in the range of 10 to 20 (required rate of return). The terminal value represents the 
value of the business beyond the projected period until the business is shut down. 
 

Terminal value = FCFE n * Factor 

6. To arrive at the value for the entire business, add up the value of step 4 and the discounted 
value of step 5 along with any cash cash equivalents (if available). 

7. Finally, the intrinsic value per share can be derived by dividing the value in step 6 by the 
number of shares outstanding of the company. 

 

Let us take an example of a company XYZ Limited which is currently trading in the stock market 
at $40 per share with 60 million shares outstanding. An analyst intends to predict the stock’s 
intrinsic value based on the available market information. The prevailing required rate of return 
expected by the investors in the market is 5%. On the other hand, the company’s free cash flow is 
expected to grow at 8%. 

The following financial estimates are available for CY19 based on which the projections have to be 
made: 

All Amount 
in Millions 

CY19 
(E) 

Net Profit 
After Tax 

$200.00 

Depreciation 
& 

$15.00 

Lovely Professional University 475



Unit 14: Simulation  and Optimization  

 

Notes 

All Amount 
in Millions 

CY19 
(E) 

Amortisation 

Increase in 
Working 
Capital 

$20.00 

Capital 
Expenditure 

$150.00 

Debt 
Repayment 
on Existing 
Debt 

$50.00 

Fresh Debt 
Raised 

$100.00 

Required 
Rate of 
Return 

5.00% 

FCFE 
Growth Rate 

8.00% 

So, from the above-given data, we will first calculate the FCFE for CY19. 
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FCFE CY19 (in millions) = Net income + Depreciation & Amortisation – Increase in Working Capital 
– Increase in Capital Expenditure – Debt Repayment on existing debt + Fresh Debt raised 

 FCFE CY19 (in millions) = $200.00 + $15.00 – $20.00 – $150.00 – $50.00 + $100.00 

 = $95.00 

Now, using this FCFE of CY19 and FCFE growth rate we will calculate the Projected FCFE for CY20 
TO CY23. 

 Projected FCFE of CY20 

 

 Projected FCFE CY20 = $95.00 Mn * (1 + 8%) = $102.60 Mn 

 Projected FCFE of CY21 
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 Projected FCFE CY21 = $95.00 Mn * (1 + 8%)2 = $110.81 Mn 

 Projected FCFE of CY22 

 

 Projected FCFE CY22 = $95.00 Mn * (1 + 8%)3 = $119.67 Mn 

 Projected FCFE of CY23 

 

 Projected FCFE CY23 = $95.00 Mn * (1 + 8%)4 = $129.25 Mn 

Now we will calculate the Terminal Value. 
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 Terminal value  = FCFE CY23 * (1 / Required rate of return) 

 = $129.25 Mn * (1 / 5%) 

 = $2,584.93 Mn 

Therefore, the calculation of Intrinsic value for the company will be as follows – 

 

Calculation of Intrinsic Value for the Company 
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 Value of the company = $2,504.34 Mn 

After this, we will do the calculation of Intrinsic value per share, which is as follows – 

 

Calculation of Intrinsic value per share 
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 Intrinsic value formula = Value of the company / No. of outstanding shares 

 = $2,504.34 Mn / 60 Mn 

 = $41.74 

Therefore, the stock is trading below its fair value, and as such, it is advisable to purchase the stock 
at present as it is likely to increase in the future to attain the fair value. 

 

Summary 

 Monte Carlo simulations are a computational technique used for modeling and analyzing 

complex systems through random sampling. 

 They are named after the Monte Carlo Casino in Monaco, known for its games of chance, 

as they rely on random sampling. 

 Monte Carlo simulations involve repeated random sampling of input variables to estimate 

a range of possible outcomes. 

 These simulations are used in various fields, including finance, engineering, and science, 

to assess risk and make informed decisions. 

 In Excel, Monte Carlo simulations can be performed using random number generation 

and data tables. 

 You input parameters, create random scenarios, and analyze the results to gain insights 

into the system's behavior. 

 Monte Carlo simulations help in understanding the probability distribution of outcomes 

and can be valuable for decision-making under uncertainty. 

 They are particularly useful for evaluating complex models where analytical solutions are 

not readily available. 

 Sensitivity analysis can be performed to assess how changes in input parameters affect the 

output. 

 Monte Carlo simulations provide a powerful tool for risk assessment, optimization, and 

decision support in Excel. 
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 Solver is an Excel add-in tool used for optimization and solving linear and nonlinear 

programming problems. 

 It can be accessed in Excel by enabling the Solver add-in from the Add-Ins menu. 

 Solver helps find the optimal values of decision variables that maximize or minimize a 

defined objective function. 

 Decision variables are subject to constraints, such as budget limitations or resource 

availability. 

 Solver uses mathematical optimization techniques to search for the best solution, such as 

the Simplex method. 

 It is commonly used in business and finance for tasks like portfolio optimization and 

production planning. 

 Solver allows users to specify constraints, bounds on variables, and target goals. 

 It iteratively adjusts variables to find the optimal solution while respecting constraints. 

 Users can choose between linear and nonlinear solving methods based on the problem 

type. 

 Solver is a powerful tool for solving complex optimization problems in Excel, aiding in 

decision-making and resource allocation. 

 Linear programming (LP) is a mathematical technique used for optimizing linear objective 

functions subject to linear constraints. 

 Excel's Solver tool can be used to perform linear programming optimization. 

 In LP, decision variables are defined, and an objective function is formulated to maximize 

or minimize. 

 Constraints are established, representing limitations on the decision variables, such as 

resource availability or budget constraints. 

 Excel's Solver can handle both maximization and minimization problems. 

 LP is commonly used in supply chain management, production planning, and 

transportation optimization. 

 It provides an efficient way to allocate resources to maximize profits or minimize costs. 

 Excel's Solver uses the Simplex algorithm to find the optimal solution to LP problems. 

 Sensitivity analysis can be conducted to assess the impact of changes in coefficients or 

constraints on the optimal solution. 

 Linear programming in Excel is a valuable tool for optimizing decision-making processes 

in various industries. 

 Intrinsic value is a financial concept that represents the true or fair value of an asset or 

investment. 

 It is often used in stock valuation to determine whether a stock is overvalued or 

undervalued. 

 In Excel, intrinsic values for stocks can be calculated using various models, such as the 

discounted cash flow (DCF) method. 

 The DCF method involves estimating future cash flows and discounting them to present 

value using a chosen discount rate. 

 Other models, like the Gordon Growth Model for dividends, can also be used for intrinsic 

value calculations. 

 Users input key parameters like cash flows, growth rates, and discount rates into Excel. 

 Excel functions like NPV (Net Present Value) and FV (Future Value) can be used for these 

calculations. 
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 Intrinsic value calculations are essential for making informed investment decisions by 

comparing them to the current market price. 

 Different investors may use different models and assumptions, leading to varying intrinsic 

value estimates. 

 Excel is a versatile tool for performing these calculations, enabling investors to analyze 

and evaluate potential investments. 

 

Keywords 

 Random Sampling: The process of selecting data points or values randomly from a 
distribution to simulate uncertainty. 

 Stochastic: Involving randomness or probability in modeling and analysis. 

 Simulation: The imitation of a real-world process or system using a computer model to 
understand its behavior. 

 Risk Assessment: The evaluation of potential risks and uncertainties associated with a 
decision or scenario. 

 Probability Distribution: A mathematical function that describes the likelihood of various 
outcomes in a random event. 

 Sensitivity Analysis: The examination of how changes in input parameters impact the 
outcomes of a simulation. 

 Convergence: The process by which a Monte Carlo simulation approaches stable and reliable 
results with increasing iterations. 

 Objective Function: A mathematical function that represents the goal to be maximized or 
minimized in an optimization problem. 

 Decision Variables: The variables in an optimization problem that can be adjusted to achieve 
the desired objective. 

 Decision Support: The use of data and analysis to assist in making informed decisions. 

 Optimization: The process of finding the best solution among a set of possible alternatives. 

 Linear Programming: A mathematical method for solving optimization problems with linear 
objective functions and constraints. 

 Add-in: A software component that enhances the functionality of a program when installed. 

 Objective Function: A mathematical expression that quantifies the goal to be achieved in an 
optimization problem. 

 Constraints: Limitations or restrictions that must be satisfied in an optimization problem. 

 Simplex Method: An algorithm used in linear programming to find the optimal solution by 
iteratively adjusting variables. 

 Resource Allocation: The distribution of limited resources among various competing 
demands or projects. 

 Sensitivity Analysis: The examination of how changes in coefficients or constraints affect the 
optimal solution. 

 Decision Variables: The variables that represent the choices to be made in an optimization 
problem. 

 Feasible Solution: A solution that meets all constraints and is within the feasible region of the 
problem. 

 Intrinsic Value: The true or fair value of an asset, often used in financial analysis to assess 
investment opportunities. 
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 Discounted Cash Flow (DCF): A method of estimating the present value of future cash flows 
by applying a discount rate. 

 Valuation: The process of determining the worth or value of an asset or investment. 

 Future Value: The projected value of an investment at a specified point in the future. 

 Net Present Value (NPV): The difference between the present value of cash inflows and 
outflows in a DCF analysis. 

 Gordon Growth Model: A method for valuing stocks based on projected dividends and a 
constant growth rate. 

 Financial Modeling: The construction of mathematical models to analyze and forecast 
financial data. 

 Discount Rate: The rate used to discount future cash flows to their present value in DCF 
analysis. 

 Market Price: The current price at which an asset or security is traded in the market. 

 Assumptions: The factors, conditions, or variables used in financial modeling and intrinsic 
value calculations. 

 

Self Assessment 

1. Monte Carlo simulations are used primarily for: 

A. Solving linear programming problems 

B. Analyzing random data 

C. Predicting future values with certainty 

D. Drawing scatter plots 

 

2. What is the main benefit of using Monte Carlo simulations? 

A. Deterministic results 

B. Handling complex models with ease 

C. Reducing computational time 

D. Eliminating randomness 

 

3. In Monte Carlo simulations, what is "random sampling"? 

A. A technique for generating random numbers 

B. The process of selecting data points randomly from a distribution 

C. Eliminating uncertainty from simulations 

D. A deterministic approach to modeling 

 

4. Sensitivity analysis in Monte Carlo simulations helps in understanding: 

A. The impact of changes in input parameters on the output 

B. How to eliminate randomness 

C. Deterministic outcomes 

D. Probability distributions 

 

5. What type of problems are Monte Carlo simulations particularly useful for? 

A. Linear programming 
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B. Analyzing deterministic systems 

C. Solving algebraic equations 

D. Evaluating complex models under uncertainty 

 

6. What is the primary purpose of the Solver tool in MS-Excel? 

A. Creating random data sets 

B. Performing Monte Carlo simulations 

C. Solving linear and nonlinear optimization problems 

D. Formatting spreadsheets 

 

7. In linear programming, what are "decision variables"? 

A. Variables used for storing intermediate results 

B. Variables subject to optimization constraints 

C. Randomly generated numbers 

D. Constants with fixed values 

 

8. Which algorithm is commonly used by Solver in MS-Excel for linear programming 

problems? 

A. Monte Carlo method 

B. Simplex method 

C. Genetic algorithm 

D. Gradient descent 

 

9. What does the term "feasible solution" refer to in the context of linear programming? 

A. A solution that is easily attainable 

B. A solution that meets all constraints 

C. A solution with the highest objective value 

D. A random solution 

 

10. Sensitivity analysis in Solver helps in understanding how changes in constraints affect: 

A. The number of decision variables 

B. The feasibility of the solution 

C. The optimal solution and its objective value 

D. The linear programming model itself 

 

11. What does the term "intrinsic value" represent in financial analysis? 

A. The current market price of an asset 

B. The true or fair value of an investment 

C. The book value of a company 

D. The value of a stock's dividends 

 

12. Intrinsic value calculations often involve which method to estimate future cash flows? 
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A. Discounted Cash Flow (DCF) 

B. Monte Carlo simulations 

C. Moving averages 

D. Simplex method 

 

13. What is the Net Present Value (NPV) used for in intrinsic value calculations? 

A. Calculating future cash flows 

B. Determining the current market price 

C. Evaluating investment profitability 

D. Estimating dividend growth rates 

 

14. What role does the discount rate play in intrinsic value calculations? 

A. It represents the stock's current price. 

B. It is used to calculate future cash flows. 

C. It measures the risk associated with the investment. 

D. It determines the optimal solution in Solver. 

 

15. The Gordon Growth Model is commonly used for estimating the intrinsic value of: 

A. Real estate properties 

B. Government bonds 

C. Preferred stocks 

D. Common stocks with consistent dividends 

 

Answers for Self Assessment 

1. B 2. B 3. B 4. A 5. D 

6. C 7. B 8. B 9. B 10. C 

11. B 12. A 13. C 14. C 15. D 

 

Review Questions 

1. What is the primary objective of Monte Carlo simulations, and in which fields are they 
commonly applied? 

2. Explain the concept of "random sampling" in Monte Carlo simulations and its significance 
in modeling. 

3. How does sensitivity analysis help in the context of Monte Carlo simulations, and why is 
it important? 

4. Give an example of a real-world problem or application where Monte Carlo simulations 
could be useful. 

5. What is the primary purpose of the Solver tool in MS-Excel, and how does it work? 

6. Define "decision variables" in the context of linear programming and explain their role in 
optimization problems. 
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7. What is the Simplex method, and how is it used by Solver in MS-Excel for solving linear 
programming problems? 

8. What is meant by "feasible solutions" in linear programming, and why are they crucial in 
optimization? 

9. What is the significance of intrinsic value in financial analysis, and how is it typically 
calculated? 

10. Explain the Discounted Cash Flow (DCF) method and its role in estimating the intrinsic 
value of an investment. 

 

     Further Readings 

https://excel.tv/monte-carlo-simulation-excel-tutorial-download/ 

https://www.tutorialspoint.com/modelling_and_simulation/modelling_and_simulation_
monte_carlo_simulation.htm#:~:text=Monte%20Carlo%20simulation%20is%20a,analysis%2
0and%20decision%20making%20problems. 

https://www.geeksforgeeks.org/how-to-use-solver-in-excel/ 

https://www.tutorialspoint.com/microsoft-excel-solver-tutorial/index.asp 

https://www.wallstreetmojo.com/linear-programming-in-excel/ 

https://www.educba.com/linear-programming-in-excel/ 

https://www.tutorialspoint.com/excel_data_analysis/advanced_data_analysis_optimizatio
n_with_excel_solver.htm 

https://www.wallstreetmojo.com/intrinsic-value-formula/ 

https://www.wallstreetprep.com/knowledge/intrinsic-value/ 
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